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Welcome to This Guide

This guide describes how to administer TransactionVision and how to use 
the Transaction Management application in HP Business Service 
Management (BSM).

This chapter includes:

➤ How This Guide Is Organized on page 13

➤ Who Should Read This Guide on page 14

➤ Transaction Management Documentation on page 14

➤ How Do I Find the Information That I Need? on page 16

➤ Additional Online Resources on page 18

➤ Documentation Updates on page 19

How This Guide Is Organized

This guide contains the following parts:

 Part I TransactionVision Administration

Describes how to initially configure and maintain the TransactionVision 
deployment environment.

 Part II Business Transaction Administration

Describes how to define and maintain the Business Transaction CIs 
monitored by TransactionVision or HP Diagnostics. 
13
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 Part III Reports and Topologies

Describes how to view and customize reports and topologies of information 
related to the Business Transactions.

Who Should Read This Guide

This guide is intended for the following users of BSM:

➤ Transaction Management administrators

➤ Transaction Management end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with BSM and enterprise monitoring 
and management concepts.

Transaction Management Documentation

Transaction Management documentation provides information on using 
the Transaction Management application of BSM and deploying and 
administering the TransactionVision components in the BSM deployment 
environment.

The Transaction Management documentation includes: 

➤ The TransactionVision Deployment Guide describes the installation and 
configuration of the TransactionVision-specific components in the 
Business Availability Center deployment environment. This guide is 
available as a PDF in the BSM Online Documentation Library.

➤ The Using Transaction Management guide describes how to set up and 
configure TransactionVision to track transactions and how to view and 
customize reports and topologies of business transactions. This guide is 
available as the Transaction Management Portal or as a PDF in the BSM 
Online Documentation Library.

➤ The TransactionVision Planning Guide contains important information for 
sizing and planning new installations of TransactionVision.
14
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➤ The TransactionVision Advanced Customization Guide contains information 
for how the TransactionVision platform can be extended and customized 
to achieve further control over its various functions. It presents an 
architecture overview of the TransactionVision system and documents 
the different methods available to use and extend the Analyzer, the query 
service and the TransactionVision user interface. This guide is available as 
a PDF in the Transaction Management Portal > TransactionVision 
Administration > Advanced Customization Using the APIs topic.

Readme. Provides a list of version limitations and last-minute updates. From 
the HP Business Service Management DVD root directory, double-click 
readme<version>.html. You can also access the most updated readme file 
from the HP Software Support Web site.

What’s New. Provides a list of new features and version highlights. In 
HP Business Service Management, select Help > What’s New.

Online Documentation Library. The Documentation Library is an online 
help system that describes how to work with HP Business Service 
Management and the Transaction Management application. You access the 
Documentation Library using a Web browser. For a list of viewing 
considerations, see “Viewing the HP Business Service Management Site” in 
chapter 6 of the the HP Business Service Management Deployment Guide PDF.

To access the Documentation Library, in HP Business Service Management, 
select Help > Documentation Library. Context-sensitive help is available 
from specific HP Business Service Management pages by selecting Help > 
Help on this page and from specific windows by clicking the Help button. 
For details on using the Documentation Library, see “Working with the 
HP Business Service Management Documentation Library” in Platform 
Administration.
15
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How Do I Find the Information That I Need?

This guide is part of the HP Business Service Management Documentation 
Library. This Documentation Library provides a single-point of access for all 
Business Service Management documentation.

You can access the Documentation Library by doing the following:

➤ In Business Service Management, select Help > Documentation Library.

➤ From a Business Service Management Gateway Server machine, select 
Start > Programs > HP Business Service Management > Documentation.

Topic Types
Within this guide, each subject area is organized into topics. A topic 
contains a distinct module of information for a subject. The topics are 
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by 
dividing the documentation into the different types of information you 
may need at different times. 
16
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Three main topic types are in use: Concepts, Tasks, and Reference. The topic 
types are differentiated visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.

Tasks Instructional Tasks. 
Step-by-step guidance to help 
you work with the application 
and accomplish your goals. 
Some task steps include 
examples, using sample data. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.
17
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
18
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).
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1
Introducing TransactionVision

This chapter includes:

Concepts

➤ TransactionVision Overview on page 24

➤ Managing User Permissions on page 28

➤ Tips for Using Browsers on page 29

➤ The TransactionVision Demo on page 30

Tasks

➤ How to Administer TransactionVision on page 31

➤ How to Set Up the TransactionVision Demo on page 33
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Concepts

TransactionVision Overview

TransactionVision is a product that delivers a transaction tracing solution to 
the Transaction Management application. TransactionVision 
non-intrusively records individual events related to transactions flowing 
through a system. Then, TransactionVision's patented “Transaction 
Constructor” algorithm assembles those events into coherent business 
transactions. The reports and topologies of Transaction Management 
present the interaction of a business transaction among all the components 
of your system in tables and graphs. 

This section includes:

➤ "TransactionVision Architecture" on page 24

➤ "Event Flow" on page 26

➤ "What Events are Collected?" on page 27

➤ "Data Collection Filters" on page 27

➤ "What TransactionVision Can Tell You About Your Business Transactions" 
on page 28

TransactionVision Architecture
TransactionVision consists of the following major components:

➤ Processing Servers. Container for the TransactionVision components that 
deliver the core functionality of transaction tracing.

➤ Analyzers. Processes incoming events collected by the agents and 
constructs corresponding business transactions. 
24
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➤ Agents. Monitors transactional events in applications and collect those 
that meet certain criteria. Events are API level interactions between an 
application and the middleware it uses to carry out a transaction.

➤ Communication Links. Enables agents to communicate from the host on 
which an application is being monitored to the Analyzer. 
Communication links contains message queues which are managed by a 
messaging middleware product; either the built-in one can be used or one 
from a third-party. 

➤ Database. Contains a schema for the event information collected by each 
Analyzer. This database is independent from the Business Availability 
Center databases. 

The following diagram shows these components in a sample deployment 
environment. This environment has two Processing Servers that are each 
running two Analyzers. Each Analyzer is being sent events collected by 
agents. Agents are installed on the same host as the application they are 
monitoring:

TransactionVision 
Processing Server A

TransactionVision 
Processing Server B

Analyzer A

Analyzer C

Database
Schema AA
Schema AB
Schema BC
Schema BD

Agent 1

Agent 2

Agent 3

Agent 4

Comm 
Link

= host

BSM 
Gateway 
Server

Analyzer B

Analyzer D

Comm 
Link

Comm 
Link

Comm 
Link

Comm 
Link

Transaction 
Management 
Reports and 

Topologies in 
BSM
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Event Flow
Events flow through each component in the architecture as follows:

The numbered labels in the diagram have the following meaning: 

1 Agents collect event data based on criteria and populate event queues in 
the communication links. 

2 Analyzers pull event data from their associated event queues – this is 
known as raw event data. Analyzers process the raw event data and 
correlate events into business transactions. 

3 This business transaction information as well as event level data and 
correlation data is stored in the TransactionVision database.

4 The Processing Servers send business transaction metrics to HP Business 
Service Management, where they get stored in the Profile database. This 
process is managed by a built-in TransactionVision job named BSM 
Aggregate TV Data Sample. 

5 Transaction Management reports and topologies use this data, as well as 
other HP Business Service Management applications that report on the 
KPIs such as Service Health. 
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What Events are Collected?
An agent’s job is to watch transactional events in applications and collect 
those that meet certain criteria. Transactional events are API-level 
interactions between an application and the middleware it uses to hand off 
control or data to another component, for example:

➤ Messaging API calls, e.g. WebSphere MQ, TIBCO EMS

➤ J2EE Servlet or JSP invocations, JDBC calls, JMS calls, or EJB invocations 
(note: for J2EE there is a common install with the HP Diagnostics Agent)

➤ CICS API calls (File control, program control, etc)

➤ End user experience data. Real User Monitor can feed end user 
performance data to TransactionVision, capturing the timing data for the 
front end user experience part of a web transaction. This data is correlated 
together with other transactional event data from the TransactionVision 
Agents to form an end to end picture of the transaction.

For more information about monitored APIs, see "APIs Monitored by 
Agents" on page 409.

Data Collection Filters
Data collection filters assigned to a communication link determine the 
amount and type of information collected by each agent. Data collection 
filters specify criteria such as the following:

➤ About which technologies, hosts, programs, or APIs is information 
collected.

➤ About which CICS regions, transactions, and job names is information 
collected.

➤ About which queues or queue managers is information collected.

➤ About which servlets, WebSphere applications, WebSphere servers and 
URIs is information collected.

➤ For which time range is information collected.
27
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➤ What is the level of detail to be collected, such as API name only, API 
name and call arguments, or API name, call arguments, and data buffer 
segment. For the Servlet agent, the default data buffer size is 1K. 

See "Data Collection Filters" on page 173 for more information.

What TransactionVision Can Tell You About Your 
Business Transactions
Transaction Management reports and topologies can tell users the following: 

➤ The state of the transaction. For example, a stock buy transaction would 
fail if the account balance was less than $10,000, which is required to do 
the purchase, or a margin buy would fail if the account ratio is below a 
minimum balance threshold.

➤ A business value associated with the transaction

➤ Whether the transaction has exceeded its threshold

➤ For more information about the questions TransactionVision can answer, 
see "Reports and Topologies Workflows" on page 494.

Managing User Permissions

User permissions determine what operations a user can perform in the 
Transaction Management application and administration pages. User 
permissions are initially defined during deployment of the 
TransactionVision components. See the "Security" chapter in the 
HP TransactionVision Deployment Guide PDF for information about user 
permissions. 
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Tips for Using Browsers

The following information provides useful tips when using browsers to view 
your reports. See the HP TransactionVision Deployment Guide PDF for 
supported browsers.

➤ Users who have browser pop-up blockers must disable them for the 
TransactionVision user interface. Otherwise, certain reports may open 
windows with Session Expired error messages, and help pages are 
inaccessible. See the documentation for your pop-up blocker to determine 
how to add TransactionVision to the list of web applications for which 
pop-ups are enabled.

➤ Many TransactionVision reports and topologies contain session 
information and are temporary. Therefore, creating browser bookmarks to 
return to these pages at a later time may not work.

➤ If you set up the TransactionVision host and port setting in BSM to be 
https://, then you must login to BSM with https://.
29
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The TransactionVision Demo

To help you become familiar with TransactionVision's features and 
capabilities, TransactionVision provides a sampling of trade events that can 
be processed by the Analyzer and viewed on the reports and topologies. The 
Trade sample contains simulated transaction data spanning over one 
month. This simulated data is for demonstration purposes only. 

Files Installed with the Trade Demo Sample Events
The following Trade Demo Sample Events files are in the 
<TVISION_HOME>/samples/trade directory.

File Description

tvision_trade_events_900.zip Zip file jar file containing the Trade Demo 
Sample Events.

TradeTransaction.xdm Trade demo XML database mapper transaction 
definition file defining trade-specific business 
transaction attributes.

TransactionDefinition.xml The classification rule file.
30
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Tasks

How to Administer TransactionVision

The user acting in the role of TransactionVision Administrator performs the 
following tasks:

➤ Deploys and maintains one or more TransactionVision Processing Servers 
in the deployment environment. See Chapter 2, "Processing Servers."

➤ Deploys and maintains one or more TransactionVision Analyzers on the 
Processing Servers in the Deployment Environment. See Chapter 3, 
"Analyzers."

➤ Deploys and maintains a primary and backup Job Manager in the 
Deployment Environment. See "How to Create a Processing Server" on 
page 44.

➤ Deploys and maintains a primary and backup Query Manager in the 
Deployment Environment. See "How to Create a Processing Server" on 
page 44.

➤ For each Agent in the deployment environment, defines a 
communication link between it and an Analyzer. See Chapter 4, 
"Communication Links."

➤ Defines transaction classification rules and data to include with each 
transaction. See Chapter 15, "Business Transaction Tracing."

➤ Defines data collection filters. See Chapter 5, "Data Collection Filters."

➤ Monitors the built-in jobs and creates and maintains custom jobs. See 
Chapter 7, "Jobs."

➤ Keeps the TransactionVision appropriately secured, including controlling 
which users can access the Administration tab or the Application tab. See 
"Security" in the HP TransactionVision Deployment Guide PDF. 
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These tasks correspond to the items in the Configuration tab of the 
Transaction Management application. Only users with administrative 
privileges have access to this tab. These tab shows the full set of 
TransactionVision components currently defined in your deployment 
environment, for example:

These tasks are dependent on the TransactionVision components being 
installed. See the HP TransactionVision Deployment Guide PDF for installation 
information.
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How to Set Up the TransactionVision Demo

This task describes how to prepopulate an Analyzer schema with the TRADE 
demo set of events.

➤ "Import the Transaction Definitions" on page 33

➤ "Import the Transaction Tracing Rules" on page 34

➤ "Import the Trade Demo Sample Events" on page 35

➤ "View the Demo Data in Reports and Topologies" on page 36

Import the Transaction Definitions

 1 In Admin > Transaction Management > Configuration, select the 
TransactionVision root node.

 2 (right pane) Navigate to Configuration > XDM.

 3 Create a new XDM file as follows. 

 a In the XDM properties area, click  Create a custom XDM file. 

 b Enter TradeTransaction for Name, and choose Transaction for 
Document Type. 

 c Click OK.

 4 Update the new TradeTransaction XDM file as follows:

 a Delete the Mapping definition that has been pre-populated into the 
file, and copy the contents of <TVISION_HOME>/samples/trade/
TradeTransaction.xdm into the Text window. 

 b Click Apply and choose Yes to the next dialog.
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 5 (left pane) Access the Analyzer wizard to create a new Analyzer with both 
a name and schema name of Trade. Specify Assign default 
communication links option and do not enable this analyzer for RUM 
events processing:

You can create the Analyzer on an existing Processing Server or on a new 
one. See "How to Create a Processing Server" on page 44.

For information about accessing the Analyzer wizard, see "How to Add an 
Analyzer to the Deployment Environment" on page 82.

Import the Transaction Tracing Rules

 1 Navigate to Admin > Transaction Management > Monitoring.

 2 (left pane) In the Monitoring tab, click the Transaction Configuration 
button.

 3 From the drop-down list, choose Business Transactions.

 4 Click the  New Application button and create a new application CI 
named Trade App.

 5 Under Trade App, create three new Business Transaction CIs: Equity, 
Bond, and Fund Transfer.
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 6 Click the Transaction Tracing Rules button.

 7 Click  Import Transaction Rule Definition XML from a file. Select the 
file <TVISION_HOME>/samples/trade/TransactionDefinition.xml' and 
import it.

 8 Click  Refresh. Several Rules appear under Transaction Rules.

 9 In the Monitoring tab, click the Transaction Configuration button.

 10 Select Bond.

 11 (right pane) Click the Tracing tab. 

 12 Select Trace this transaction using an existing Rule Definition and click 
Configure Transaction Tracing.

 13 From the drop-down list, choose Bond. (Note: be sure you do not choose 
Bond Page instead.)

 14 Set Threshold value to 5000 and assign the Trade analyzer. Click Apply

 15 Repeat the above steps for Equity and Fund Transfer. Chose a threshold 
value of 10000 for Equity, and 4000 for Fund Transfer.

Import the Trade Demo Sample Events

 1 Copy and unzip the tvision_trade_events_900.zip file to the file system of 
the host that contains the Processing Server with the Trade Analyzer.

 2 Copy the file trade_raw_events.jar to <TVISION_HOME>/logs.

 3 Navigate to and select Admin > Transaction Management > Configuration 
> ProcessingServers > <processing server> > Trade.

 4 (right pane) On the Configuration > Events > General area, set Read From 
Jar.

 5 With the Analyzer still selected, click the Status tab, then click the  
Start button in the Analyzer status area.

The jar file contains around 78155 events, after which the Analyzer 
processing can be stopped by clicking the  Stop button. 
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View the Demo Data in Reports and Topologies

 1 To view the imported data, run any report or topology specifying the 
Bond, Equity or Fund Transfer business transaction CIs on the Transaction 
Filter dialog. See Chapter 19, "Reports Overview."

The sample data spans from 12/17/2008 - 1/17/2009, so adjust the date 
range in the report settings accordingly before running the reports.
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Processing Servers

This chapter includes:

Concepts

➤ Processing Servers Overview on page 38

➤ Key Configuration Settings for Processing Servers on page 40

Tasks

➤ How to Create a Processing Server on page 44

➤ How to Remove a Processing Server on page 45

➤ How to Modify a Processing Server on page 46

➤ How to Synchronize a Processing Server’s Configuration on page 46

➤ How to Recover a Processing Server on page 47

Reference

➤ Processing Server User Interface on page 48

Troubleshooting and Limitations on page 69
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Concepts

Processing Servers Overview

A TransactionVision Processing Server is a container for the 
TransactionVision components that deliver the core functionality of 
business transaction tracing to BSM. A Processing Server typically runs on its 
own host, separate from other BSM components. 

The deployment environment can contain multiple Processing Servers. Each 
Processing Server can contain any of the following TransactionVision 
components:

➤ Job Manager. Manages the built-in and custom jobs that are used by 
TransactionVision.

Job Managers are designated as either primary or backup. At least one 
Processing Server in the deployment environment must contain the 
primary Job Manager. 

➤ Query Engine. Manages the queries that are used to populate some of the 
Transaction Management reports and topologies. 

Like Job Managers, Query Engines are designated as either primary or 
backup. At least one Processing Server in the deployment environment 
must contain the primary Query Engine. 

➤ Analyzers. The Analyzers communicate with TransactionVision agents 
and process event data collected by the agents into transactions. At least 
one Processing Server in the deployment environment must contain an 
Analyzer.

Database for the TransactionVision Data
Event and transaction level data is stored in a database. Each Processing 
Server is assigned a particular database to which it writes the data. The 
reports and topologies of Transaction Management use data from all of the 
databases in the deployment environment. 
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You choose which type of database the deployment environment uses. In a 
production environment, the database is one of these third-party databases: 
Oracle, Microsoft SQL Sever, or IBM DB2. In a test environment where the 
volume of event collection is low, the embedded database can be used 
instead of third-party database. The embedded database is also used to store 
configuration information for the Processing Servers. 

For more information about setting up the database, see the 
HP TransactionVision Deployment Guide PDF. 
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Processing Servers in the Deployment Environment
The following diagram shows a sample deployment environment with two 
Processing Servers writing to the same third-party database. Each Processing 
Server has two Analyzers running. One Processing Server is dedicated to 
running the primary Job Manager and the Query Engine; the other 
Processing Servers is running the backup Job Manager and Query Engine.

Key Configuration Settings for Processing Servers

Processing Servers are configurable. This section describes some of the 
common configuration areas: 

➤ "Communication with the BSM Gateway Server" on page 41

➤ "Time Skew Information" on page 41

➤ "Database Connection Settings" on page 42

➤ "Configuration Message Expiry Setting" on page 43

TransactionVision 
Processing Server B

Job Manager 
(backup)

Query Engine 
(backup)

Embedded 
Database

TransactionVision 
Processing Server A

Analyzer A

Analyzer C

Database
Schema AA
Schema AB
Schema BC
Schema BD

Agent 1

Agent 2

Agent 3

Agent 4

Comm 
Link

Analyzer B

Analyzer D

Comm 
Link

Comm 
Link

Comm 
Link

Comm 
Link

Job Manager

Query Engine
Embedded 
Database

= host

Transaction 
Management 
Reports and 

Topologies in 
BSM

BSM 
Gateway 
Server
40



Chapter 2 • Processing Servers
Communication with the BSM Gateway Server
See "Configuration Tab, BSM Settings Tab" on page 296. 

Time Skew Information
Because of the time sensitivity of the collected event data, it is critical that 
all hosts in the deployment environment are synchronized with respect to 
time. There are two areas where differences in time, known as time skews, 
occur: 

➤ Time Skew 1

Time differences between the agent hosts and the Processing Server host 
are managed by the following configuration settings on the Processing 
Server:

time skew check interval
time skew history size
time skew latency threshold
time skew message priority
time skew reply wait interval
time skew retry threshold

Time Skew 2
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➤ Time Skew 2

Time differences between the BSM Gateway Server and the Processing 
Server are managed by the BSM time server. You set the Time skew Web 
URL property to identify the location of the time server. 

For information about setting time skew settings, see "Processing Server 
Page, Configuration Tab" on page 62.

Some time skew settings can also be specified at the Analyzer level. See 
"Configuration Tab, General Tab" on page 101.

Database Connection Settings
The Processing Server requires constant access to the database. The 
Processing Server connects to the database via JDBC. When you create a 
Processing Server, you are prompted for the database type, host name, 
database name, database port, user name, and password which are used for 
establishing the JDBC connection to the database. 

Processing Servers use third-party JDBC drivers from DataDirect for 
accessing the database. If there is a need to use the original vendor JDBC 
drivers instead, specify the JDBC driver in the JDBC property field as 
described in "Database Connection Parameters Page" on page 52. 

If the database becomes unavailable to a Processing Server, the Processing 
Server logs all exceptions to the logs directory and does not process any 
more events. You can configure persistence for the event transport which 
saves the events and process them later when the processing server is 
connected to the database. Event persistence is specified as a 
communication link option. 

The following properties control the Processing Server in the event the 
database connection is lost: 

Reconnect interval, Reconnect timeout, Query timeout

For more information about these settings, see "Database Connection 
Parameters Page" on page 52.

For more information about setting event persistence, see "Event Options 
Page" on page 162.
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Configuration Message Expiry Setting
One of the configuration options for a Processing Server is Configuration 
Message Expiry. This setting controls when event collection stops in the 
event the Analyzers cannot send a configuration message. This happens if 
an Analyzer cannot connect to the queue manager, or if the Processing 
Server on which the Analyzer is running unexpectedly stops. For more 
information about configuration messages, see "Message Queues in 
Communication Links" on page 127.

By default, the setting is 60 minutes. In this case, if an agent does not 
receive a configuration message after 60 minutes the last configuration 
message no longer applies and event collection stops. 

Depending on your environment, you may need to adjust the setting to be 
lower or higher. The following table summaries the reasons for high and low 
configuration message expiry values: 

These settings are on the "Processing Server Page, Configuration Tab" on 
page 62.

Reasons for a high 
Configuration 
Message Expiry 
setting

If it is critical that your agents do not miss collecting 
any events, set the configuration expiry to -1. The 
configuration messages will not expire. 

You can also set the configuration expiry to a value 
higher than the default, such as 120 minutes. This 
means that agents will continue to collect events and 
place messages on the queues until the time is reached. 

Make sure you have the necessary system resources to 
handle the backed up events in the event queue. See 
the documentation for the event transport provider for 
details. 

Reasons for a low 
Configuration 
Message Expiry

If keeping all events is not important or you cannot 
accommodate a growing event queue, set your 
configuration expiry to a lower value. Agents stop 
collecting when the time is reached and do not collect 
again until they reconnect and the Analyzers sends out 
new messages. This prevents events from filling up the 
event queues. 
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Tasks

How to Create a Processing Server

This task describes how to create a new Processing Server in the deployment 
environment. 

This task includes the following steps:

➤ "Prerequisites" on page 44

➤ "Launch the Processing Server Wizard" on page 44

➤ "Results" on page 45

 1 Prerequisites

A Processing Server must be installed on a host accessible by BSM.

You will need to know the following about the host on which the 
Processing Server is installed: 

➤ host name

If you are not using the embedded database, you will need to know the 
following about the third-party database to be used: 

➤ database name and connection information, including login 
credentials

For information about installing a Processing Server, see the 
HP TransactionVision Deployment Guide PDF.

 2 Launch the Processing Server Wizard

 a Select Admin > Transaction Management.

 b (left pane) Click the Configuration tab.

 c Click  and then select New Processing Server.
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 d The Processing Server Wizard appears. Use it to define the new 
Processing Server. For details about this interface, see "Processing 
Server Wizard" on page 48.

 3 Results

The new Processing Server name appears in the Configuration tab.

To assign an Analyzer to the new Processing Server, see "How to Add an 
Analyzer to the Deployment Environment" on page 82.

How to Remove a Processing Server

This task describes how to remove a Processing Server from the deployment 
environment. 

 1 Make sure any Analyzers created on the Processing Server are not needed. 
They will be deleted. 

 2 Select Admin > Transaction Management.

 3 (left pane) Click the Configuration tab.

 4 Select Processing Servers > <processing server>

 5 Right-click <processing server> and select Delete. 

 6 If you want to permanently remove the Processing Server, uninstall it. See 
the HP TransactionVision Deployment Guide PDF. 
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How to Modify a Processing Server

This task describes how to modify the properties of a Processing Server. 

Most properties of a processing server can be changed without stopping the 
Processing Server. The Processing Server processes will stop and restart 
automatically upon configuration as needed. In rare cases, you may need to 
stop and restart the Processing Server processes manually. To do this, use the 
nanny utility. See "Administration Utilities" on page 319.

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Select Processing Servers > <processing server>.

The processing server properties appear on the right. For details about this 
interface, see "Processing Server Page, Configuration Tab" on page 62.

 4 (right pane) Click the Configuration tab.

How to Synchronize a Processing Server’s Configuration

The configuration information you specify on the Administration > 
Transaction Management > Configuration tab is stored both locally in the 
Processing Server and in the BSM Management database. 

The data in the two locations is synchronized automatically as needed. In 
rare cases, such as after Analyzer recovery, you may need to force the 
Analyzer to retrieve the current configuration from the BSM database. 

To synchronize the Analyzer configuration with the BSM database:

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Expand Processing Servers 

 4 Select <processing_server> 

 5 Right-click <analyzer> and select Synchronize Configuration. 
46



Chapter 2 • Processing Servers
How to Recover a Processing Server

If the host on which a Processing Server is running shuts down, the 
Processing Server services (Windows) and daemons (UNIX) are stopped. 
When the host starts again, the Processing Server services and daemons 
automatically restart. For information about the service and daemon names, 
see the HP TransactionVision Deployment Guide PDF.

The Analyzers that were running on the Processing Server will need to be 
recovered. See "How to Recover an Analyzer" on page 87.
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Reference

Processing Server User Interface

This section describes:

 ➤ Processing Server Wizard on page 48

 ➤ Processing Servers Summary Page, Status Tab on page 57

 ➤ Processing Servers Summary Page, Job Manager Tab on page 60

 ➤ Processing Servers Summary Page, Query Engine Tab on page 61

 ➤ Processing Server Page, Status Tab on page 61

 ➤ Processing Server Page, Configuration Tab on page 62

 ➤ Processing Server Page, Log Files Tab on page 68

Processing Server Wizard 

This wizard enables you to add a new Processing Server to the deployment 
environment.

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Click the New button and select Processing Server. 

Important 
information

➤ A Processing Server must be installed before it can be 
added through this wizard. See the 
HP TransactionVision Deployment Guide PDF.

➤ After a Processing Server is created from this wizard its 
properties can be modified. 

Relevant tasks "How to Create a Processing Server" on page 44
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General Information Page
This wizard page enables you to name the Processing Server and assign Job 
Managers and Query Engines to it. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map This wizard contains:

General Information Page> Database Selection Page > 
Database Connection Parameters Page > Database 
Advanced Parameters Page > Summary Page

See also "Processing Server Page, Configuration Tab" on page 62

Important 
information

General information about this wizard is available here: 
"Processing Server Wizard" on page 48.

Wizard map The Processing Server Wizard contains:

General Information Page> Database Selection Page > 
Database Connection Parameters Page > Database 
Advanced Parameters Page > Summary Page

UI Elements Description

Processing Server 
Name

A name for the Processing Server that is unique to the 
deployment environment. You may want to choose a 
name that represents the host on which the Processing 
Server is running or the database it is using. 

Processing Server 
Host

The name of the host on which the Processing Server is 
installed. 

Processing Server 
Port

The port on which the Processing Server listens. Default 
value: 21100
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Job Manager Create Job Manager. Runs a Job Manager in this 
Processing Server. One and only one Processing Server in 
the deployment environment must host the primary Job 
Manager. 

Job Manager Port. The port of the Job Manager. Default 
value: 21010

Job Manager SSL Port. The SSL port of the Job Manager. 
Specify this value if you are enabling SSL in the 
deployment environment. Default value: 21011

Make this the primary Job Manager. Designates this Job 
Manager as the primary Job Manager. If another Job 
Manager was designated as the primary Job Manager, it 
now becomes a backup Job Manager. 

Make this a backup Job Manager. Designates this Job 
Manager as the backup Job Manager. If the primary Job 
Manager needs to be shut down, you can promote this to 
be a primary Job Manager.

Query Engine Create Query Engine. Runs a Query Engine in this 
Processing Server. One and only one Processing Server in 
the deployment environment must host the primary 
Query Engine. 

Query Engine Port. The port of the Query Engine. 
Default value: 21000

Query Engine SSL Port. The SSL port of the Query 
Engine. Default value: 21001

Make this the primary Query Engine. Designates this 
Query Engine as the primary Query Engine. If another 
Query Engine was designated as the primary Query 
Engine, it will become a backup Query Engine.

Make this a backup Query Engine. Designates this Query 
Engine as the backup Query Engine. If the primary Query 
Engine needs to be shut down, you can promote this to 
be the primary Query Engine.

UI Elements Description
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Database Selection Page
This page enables you to choose the database type of the database in which 
the Processing Server stores transaction and event data.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ General information about this wizard is available 
here: "Processing Server Wizard" on page 48.

➤ In production environments, TransactionVision 
requires a 3rd-party database. In test or demonstration 
environments where event collection volumes are low, 
the embedded database can be used. 

Wizard map The Processing Server Wizard contains:

General Information Page> Database Selection Page > 
Database Connection Parameters Page > Database 
Advanced Parameters Page > Summary Page

See also For information about which database versions are 
supported, see chapter 2 in the HP TransactionVision 
Deployment Guide PDF.

UI Element Description

Select the database 
type in which the 
Processing Server 
will store transaction 
and event data

Embedded Database (Derby)

Oracle

IBM DB2

Microsoft SQL
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Database Connection Parameters Page
This page enables you to specify the database connection information. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ General information about this wizard is available 
here: "Processing Server Wizard" on page 48.

➤ Some of the UI elements below are database specific. 
See the description. 

Wizard map The Processing Server Wizard contains:

General Information Page> Database Selection Page > 
Database Connection Parameters Page > Database 
Advanced Parameters Page > Summary Page

UI Elements Description

Database host Fully-qualified domain name of the host on which the 
database is installed. Applies to: IBM DB2, Microsoft SQL, 
Oracle

Database name Name of the database. Applies to: IBM DB2

Database sid Name of the database. Applies to: Oracle

Database instance Name of the database instance. Applies to: Microsoft SQL

Use Custom JDBC 
URL

A custom JDBC URL to use with the JDBC driver 
manager. Some environments, such as Oracle 10g RAC, 
require a custom URL to access the database.
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Database port The port number where the Processing Server listens for 
RMI calls. Applies to: IBM DB2, Microsoft SQL, Oracle as 
follows. 

IBM DB2

This is the TCP/IP port the database server is listening on. 
To identify the correct value, select the following menu 
items from the DB2 Control Center while the DB2 
administration server is running:

All Systems > system_name > Instances > instance_name 

Right-click and select Setup Communications from the 
context menu. Click Properties to get the port number 
your database instance is using. Default value: 50000

Microsoft SQL

The port number to connect to on the SQL Server. 
Default value: 1433

Oracle

This is the TCP/IP port the database server is listening on. 
To identify the correct value, run the lsnrctl command on 
the server side. Use the status command to find out the 
port number. Default value: 1521

UI Elements Description
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Database user The user name that is used to connect to the database. 
Applies to: IBM DB2, Oracle. The user must have these 
privileges for database access:

IBM DB2 

GRANT CREATETAB,CONNECT ON DATABASE TO USER 
<user>;

Oracle

grant resouce,connect to <user>;
grant create user to <user>;
grant create any table to <user>;
grant create any index to <user>;
grant select any table to <user>;
grant insert any table to <user>;
grant update any table to <user>;

Default value: the currently logged in user is used to 
make the database connection

Database password/
Confirm password

The password associated with the user name above. 
Applies to: IBM DB2, Oracle

User as Schema Creates a TVISION schema based on a user instead of a 
role. Applies to: Microsoft SQL

Test Connection Tests the connection to the database. 

If the connection fails, check the database connection 
information: host, port, user name, and password and try 
again.

UI Elements Description
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Database Advanced Parameters Page
This page enables you to specify some advanced configuration information 
for the database access. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

General information about this wizard is available here: 
"Processing Server Wizard" on page 48.

Wizard map The Processing Server Wizard contains:

General Information Page> Database Selection Page > 
Database Connection Parameters Page > Database 
Advanced Parameters Page > Summary Page

UI Elements Description

Reconnect interval 
(sec)

The number of seconds the Processing Server waits before 
attempting to connect to the database in the event the 
database connection is lost. Default value: 10

Reconnect timeout 
(sec)

The total number of seconds after which the Processing 
Server stops attempting to connect to the database in the 
event the database connection is lost. Default value: 600

Query timeout (sec) The number of seconds after which the Processing Server 
should abort a query that has not returned any data. 
Default value: 600

Excluded object 
types

If you have determined an object type that does not need 
to be specified in the query or data collection filter 
configuration pages, you can specify that object type 
here. 

Unicode bytes per 
character

Character-based XDM columns with the attribute 
unicode=true are generated with a size using this value as 
a multiplier of the base value. This option takes effect 
only if Unicode database is also selected on this page.

Default Value: 2 

Note: Values larger than 3 may cause database creation 
problems. 
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Use encryption for 
passwords

Encrypts the entered Database Password field value 
before storing it. All configuration data including this is 
stored both locally in the embedded database and the 
BSM Management database. 

Unicode database Indicates whether the database has Unicode data. If set, 
all character-based XDM columns with the attribute 
unicode=true set are generated with double the byte size 
to allow the specified number of characters to be stored 
in the database. For character sets requiring more than 
two bytes per character, set Unicode bytes per character 
to the required number of bytes per character. 

Default value: Off

SQL trace Logs detailed information about SQL queries issued by 
the Processing Server to the database. For more 
information, see "Processing Server Page, Log Files Tab" 
on page 68.

Default Value: Off

Enable TIBCO EMS If TIBCO is the messaging middleware provider used in 
the TransactionVision deployment environment, specify 
the installation location. 

Enable WebSphere If WebSphere MQ is the messaging middleware provider 
used in the TransactionVision deployment environment, 
specify the installation location. 

UI Elements Description
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Processing Servers Summary Page, Status Tab

This tab enables you to view summary information about all Processing 
Servers in the deployment environment.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Processing Servers. 

4  (right pane) Click the Status tab.

Important 
Information

The Processing Server status is not updated 
automatically; click Refresh to update the status. 

See also "How to Synchronize a Processing Server’s Configuration" 
on page 46

UI Elements Description

Refresh the list and statuses of the Processing Servers. 

Job Manager Status The Processing Server name, status, and host on which 
the primary Job Manager is running and the Job Manager 
status: Running or Not Running. 

Query Engine Status The Processing Server name and host on which the 
primary Query Engine is running and the Job Manager 
status: Running or Not running.

<for each Processing Server> 

Processing Server 
Status

The Name, Host, and Port of the Processing Server. For a 
description of these values, see "Database Connection 
Parameters Page" on page 52. 

The Status of the Processing Server: 

 The Processing Server is running. 

 The Processing Server is not running. 
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Analyzer 
Communication Link 
Summary

For each Analyzer on the Processing Server: 

Name. The name of the Analyzer. 

Status. The status of the Analyzer:

 The Analyzer status is COLLECTING EVENTS. Hover 
over the status to see details. 

 Status information cannot be obtained. This 
typically indicates the Analyzer is not running. 

Events. The number of events collected through the 
communication links since the Analyzer was last started. 
Config Msgs. The number of configuration messages sent 
through the communication links since the Analyzer was 
last started. 

Analyzer 
Performance 
Summary

For each Analyzer on the Processing Server: 

Name. The name of the Analyzer. 

Events in Database. The number of events processed and 
stored in the database since the Analyzer was last started.

Events Per Second (Current/Average). The current and 
average rate of event collection since the Analyzer was 
started. 

Analyzer Transaction 
Summary

For each Analyzer on the Processing Server: 

Transaction Tracing Rules. The transaction tracing rule 
assigned to the Analyzer. 

UI Elements Description
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Processing Servers Summary Page, Job Manager Tab 

This tab enables you to view summary information about the Job Manager 
in the deployment environment.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Processing Servers.

4  (right pane) Click the Job Manager tab.

See also Chapter 7, "Jobs"

UI Elements Description

Job Manager Status See "Processing Servers Summary Page, Status Tab" on 
page 57. 

Job Manager 
Configuration

 Create a new Job Manager. 

 Edit properties of the selected Job Manager.

 Deleted the selected Job Manager.

For each Processing Server in the deployment 
environment:

Processing Server Name and Host. The Processing Server 
name and host. 

Job Manager Port. Click to change the Job Manager port. 
Default value: 21010

SSL Enabled. Click to enable or disable SSL on the Job 
Manager. Default value: false

Enable Primary Job Manager. Check to enable the 
primary Job Manager on this Processing Server. 
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Processing Servers Summary Page, Query Engine Tab

This tab enables you to view summary information about the Query Engine 
in the deployment environment.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Processing Server Page, Status Tab

This tab contains the same information that appears on the Processing 
Servers Summary page Status tab. See "Processing Servers Summary Page, 
Status Tab" on page 57.

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Processing Servers.

4  (right pane) Click the Query Engine tab.

UI Elements (A-Z) Description

Query Engine 
Configuration

 Create a new Query Engine. 

 Edit properties of the selected Query Engine.

 Deleted the selection Query Engine.

For each Processing Server in the deployment 
environment:

Processing Server Name and Host. The Processing Server 
name and host. 

Query Engine Port. Click to change the Query Engine 
port. Default value: 21000

SSL Enabled. Click to enable or disable SSL on the Query 
Engine. Default value: false

Enable Primary Query Engine. Check to enable the 
primary Query Engine on this Processing Server. 

Query Engine Status See "Processing Servers Summary Page, Status Tab" on 
page 57. 
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Processing Server Page, Configuration Tab

This tab enables you to change the settings of the Processing Server. 

General Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Processing Servers > <processing_server>. 

4  (right pane) Click the Configuration tab.

See also "Key Configuration Settings for Processing Servers" on 
page 40

UI Elements (A-Z) Description

See Initialization Status below.

Configuration 
message expiry (min)

The expiration time in minutes of configuration 
messages received by agents. When the configuration 
messages expire, agents stop collecting events. 

See "Key Configuration Settings for Processing Servers" 
on page 40 for more information. 

Specify -1 if you do not want configuration messages to 
expire.

This setting affects all Analyzers on the Processing Server. 

Default value: 60

Configuration sync 
interval

Interval in minutes at which existing configuration 
messages are resent to the agents, so that they do not 
unintentionally expire. Default value: 15 

This setting affects all Analyzers on the Processing Server. 
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Connection retry 
delay (sec)

The number of seconds to wait between attempts to 
connect to the event queue’s queue manager. This setting 
affects all Analyzers running on this Processing Server.

Default value: 10

Database exception 
threshold

The number of exceptions from the database to accept in 
the event collection threads before attempting to 
reconnect to the database. Default value: 3

Database reconnect 
interval (sec)

See the description of this property on the "Database 
Advanced Parameters Page" on page 55

Debug Enables Debug logging for all Analyzers on this 
Processing Server. This option is intended for 
troubleshooting and should not be turned on in 
production environments. See "Processing Server Page, 
Log Files Tab" on page 68.

Event get wait 
interval (sec)

The number of seconds to wait for an event message. 
Increasing this number slows down the Analyzer 
response to commands. This setting affects all Analyzers 
running on this Processing Server.

Default value: 5

Host The host of the Processing Server. 

Initialization Status Indicates whether the Processing Server component on 
the specified host is synchronized with the Processing 
Server configuration settings specified on this tab. 

Click Init Processing Server to synchronize the 
Processing Server. You typically only need to do this if 
the Processing Server has been reinstalled since it was 
first configured, or the BSM LW-SSO settings have 
changed since the Processing Server was first configured.

Name The name of the Processing Server. 

UI Elements (A-Z) Description
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PII Objects Cache size for PII objects. If you have a large system 
model that contains a lot of ProgramInstance objects, 
some reports such as the Instance Topology may render 
more quickly by increasing the cache size. See 
"Configuring the Cache" in "Key Configuration Concepts 
for Analyzers" on page 73.

Default value: 1000

Port The port of the Processing Server. Default value: 21100

SSL Port The port of the Processing Server when enabled for SSL. 
Default value: 21101

Time skew check 
interval (sec)

The number of seconds between sending messages to 
determine the time skew across communication links. At 
each specified interval, the Analyzer takes time skew 
samplings across the communication links. The time 
skew is reported per Analyzer. See "Analyzer Page, 
Configuration Tab" on page 101. 

Default value: 3600 (one hour)

Time skew history 
size

The number of previous time skew samplings to consider 
for the best time skew to use. 

Having a larger history size improves the chance of 
finding a time skew with smaller latency, but it also 
increases the chance of picking a time skew that may 
have occurred long ago to represent a time skew that may 
be more off due to clock drifting. 

A value of 0 causes the time skew that was taken with the 
smallest latency to be used. This time skew is not 
discarded until a new time skew with equal or less 
latency is taken. Using this value disregards clock drift, 
which occurs frequently.

Default value: 24

UI Elements (A-Z) Description
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Time skew latency 
threshold (msec)

The number of milliseconds to accept when sampling 
time skews. 

If more than the specified time passes when waiting for a 
time skew reply, another time skew sampling is taken in 
hopes it has a lower latency. Any time skew samples that 
surpass the threshold are still kept in the time skew 
history because it is possible no samplings are under the 
suggested latency threshold. This threshold affects time 
skew sampling across communication links.

Default value: 100 

Time skew message 
priority

The WebSphere MQ Message Priority on the 
Confirmation of Arrival (COA) time skew messages. The 
default value causes the default priority to be used. Since 
configuration and event messages use the default 
priority, it is a good idea to set this value at a value higher 
than the default. Setting a higher value ensures that time 
skew messages travel through channels faster than other 
messages that may be backed up on transmission queues. 
Therefore, latency times when sampling time skews is 
reduced and results are more accurate. This value must 
not exceed the MaxPriority attributes of the queue 
managers. Default value: -1

Time skew reply wait 
interval (sec)

The number of seconds to wait for the message sent to 
determine the time skew across a communication link. If 
no response is received in this time, the time skew is 
disregarded. Default value: 30 

Time skew retry 
threshold

The maximum number of time skew samples to take at a 
single time skew check interval. At each time skew check 
interval, the Processing Server continues to retry up to 
this number of times if the sampling surpasses the time 
skew latency threshold. Default value: 8

UI Elements (A-Z) Description
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Database Area

These elements are described with the Processing Server Wizard. See the 
description on the "Database Selection Page" on page 51, "Database 
Connection Parameters Page" on page 52 and "Database Advanced 
Parameters Page" on page 55.

Note: Any changes to Database configuration settings for a Processing Server 
cause all Analyzers assigned to the Processing Server to be restarted.

Time skew Web URL The URL of the servlet used to determine the time skew 
between the Processing Server host and the BSM Gateway 
Server. 

Default value: the time server servlet in the BSM 
installation which is http://
<bsm_gateway_server_host>:80/topaz/services/
technical/time?alt=text/plain.

Trace Enables Trace logging for all Analyzers on this Processing 
Server. See "Processing Server Page, Log Files Tab" on 
page 68.

Use the Time Server 
Running in the 
Processing Server

Use the time server within the Processing Server hosting 
the Analyzer to calculate all time skews. Otherwise, 
specify the name of the host running the Time Server 
and its port number. 

Default value: Checked

Time Server Host. The host name on which the Time 
server is running.

Time Server Port. The port number for the Time Server. 

UI Elements (A-Z) Description
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Advanced Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Enable SSL Enables SSL communication for this Processing Server. 
Enabling SSL here requires that all components in the 
TransactionVision deployment environment are enabled 
for SSL, including the BSM Gateway Server. 

The workflow for enabling SSL is described in "Using SSL 
with TransactionVision" in the the HP Business Service 
Management Hardening Guide PDF.

IF SSL is enabled, specify the following values as 
described in the above chapter:

Key Password. Password for the private key located in the 
keystore file.

Keystore Location. The full path and file name of the 
keystore file containing the private keys and client 
certificate. The keystore file must be a java keystore file 
(JKS).

Note: Configure this field only if you want to use client 
certificates.

Keystore Password. The password for the keystore file.

Enable TIBCO EMS See "Database Advanced Parameters Page" on page 55.

Enable WebSphere See "Database Advanced Parameters Page" on page 55.

Synchronize 
transaction class 
properties for SQL 
Alert jobs

Enables the use of the SQL Alert job, which is a custom 
job you can add to the TransactionVision deployment 
environment. See "How to Add a Custom Job" on 
page 275.
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Processing Server Page, Log Files Tab

This tab enables you to view the log files of a Processing Server. 

Processing Server Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Query Engine Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Processing Servers > <processing_server>.

4  (right pane) Click the Log Files tab.

Important 
information

The <TVISION>/logs directory contains all log files. Only 
the log files related to the Processing Server, Job Manager, 
and Query Engine are shown here. 

See also "Analyzer Page, Configuration Tab" on page 101

UI Elements (A-Z) Description

Log files The log file names and sizes of the Processing Server logs.

Contents of <log file 
name>

The log file entries. 

UI Elements (A-Z) Description

Log files The log file names and sizes of the Query Engine logs.

Contents of <log file 
name>

The log file entries. 
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Job Manager Area

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Troubleshooting and Limitations

Port Conflicts
The Processing Server can fail to initialize a Job Manager, Query Engine, 
SonicMQ Broker or Analyzer due to a port conflict. That is, the port number 
that TransactionVision attempts to use is already in use by another 
application. If a port conflict occurs, the component cannot be created.

Review the following table to help you resolve port conflicts.

UI Elements (A-Z) Description

Log files The log file names and sizes of the Job Manager logs.

Contents of <log file 
name>

The log file entries. 

Component Default Port To change, access: 

The port on which 
the BSM Gateway 
Server listens for 
Processing Server 
calls.

80 Administration > Configuration 
> TransactionVision > 
Configuration > BSM Settings 

The port on which 
the Processing Server 
listens for BSM

21100 Processing Server page, 
Configuration tab, General area

The SSL port on 
which the Processing 
Server listens for BSM

21101 Processing Server page, 
Configuration tab, General area

Job Manager Port 21010 Processing Servers Summary 
page, Job Manager tab
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Job Manager SSL Port 21011 Not needed; the Job Manager 
runs in SSL if the associated 
Processing Server is SSL enabled.

Query Engine Port 21000 Processing Servers Summary 
page, Query Engine tab

Query Engine SSL 
Port

21001 Not needed; the Query Engine 
runs in SSL if the associated 
Processing Server is SSL enabled.

The port on which 
the Processing Server 
listens for JDBC calls 
to the database

IBM DB2: 50000
Microsoft SQL: 1433
Oracle: 1521

Processing Server Configuration 
tab, Database area

SonicMQ Domain 
Manager (bundled)

21110

SonicMQ Broker 
(bundled)

21111 Communication Link page, 
SonicMQ Connection Info area

Analyzers 1-5 21120
21130
21140
21150
21160

Analyzer page, Configuration tab

Component Default Port To change, access: 
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Analyzers

This chapter includes:

Concepts

➤ Analyzers Overview on page 72

➤ Key Configuration Concepts for Analyzers on page 73

Tasks

➤ How to Add an Analyzer to the Deployment Environment on page 82

➤ How to Assign a Communication Link to an Analyzer on page 83

➤ How to View Analyzer Status on page 84

➤ How to Stop and Restart Event Collection on page 85

➤ How to Stop and Restart an Analyzer on page 86

➤ How to Remove an Analyzer from the Deployment Environment 
on page 86

➤ How to Recover an Analyzer on page 87

➤ How to Enable Failure Mode on an Analyzer on page 88

Reference

➤ Analyzers User Interface on page 94

➤ Troubleshooting and Limitations on page 114
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Concepts

Analyzers Overview

The TransactionVision Analyzers process collected event data into business 
transactions. The Analyzer runs in the context (container) of a 
TransactionVision Processing Server. 

The TransactionVision deployment environment can have multiple 
Analyzers. For more information about the TransactionVision deployment 
environment, see "Processing Servers Overview" on page 38.

The processing of events by an Analyzer occurs in the phases below:

Phase 1: Event collection. Raw events arrive in the event queues, and the 
Analyzer pulls them off and forms an in-memory Event.xml document to 
store and process them. 

Phase 2: Correlation. The Analyzer process the events into one-to-one 
relationships indicating they are in the same transaction. The Analyzer then 
correlates events that are part of the same local transaction (an application 
unit of work). 

Note: A local transaction is known only to the Analyzer on which 
correlation occurs. It is different from the business transaction which is 
created in Phase 3. 

Phase 3: Transaction Classification. The Analyzer executes the rules assigned 
to it to classify the transaction into a business transaction. It also assigns 
transaction attributes to the transaction.
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Throughout these phases, there are several points at which the Analyzer 
writes its data to the associated database schema:

The writing of user data, event XML, and raw events to the database can be 
enabled or disabled. See the "Miscellaneous Information Page" on page 165 
in Chapter 4, "Communication Links".

Key Configuration Concepts for Analyzers

Analyzers are highly configurable. 

This section includes the main configuration concepts:

➤ "About Data Purging" on page 74

➤ "About Time Skews" on page 74

➤ "Configuring the Caches" on page 75

➤ "About Logging" on page 76

Analyzer memory and caches

Associated Schema for this Analyzer      

TransactionVision
Database

Raw Events

Event Processing Event Analysis

Processing Server 
 host

System Model Event Storage Event-To-Event

Relation

Local and Business 

Transaction

Aggregated 

Topology Statistics

Aggregated Transaction Statistics

 Event XML 

Static 
Objects

Events 
(XML, cols)

Dynamic 
Objects Relation, Lookup Key Local and Business Txns

Read/Write Cache

All communication links 
assigned to this Analzyer

Low volume High volume

Statistics
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➤ "Choosing Standard Mode or Failure Mode" on page 76

➤ "Enabling an Analyzer for RUM" on page 80

➤ "Enabling an Analyzer for BPI" on page 81

About Data Purging
In the TransactionVision deployment environment, the data storage tables 
which contain the event and transaction data can grow to a very large size. 
You need to determine how long the data be retained to support the needs 
of the Transaction Management users and schedule data purging 
accordingly. A full database causes the Analyzers writing to it to stop event 
collection and also generates database exceptions. 

By default, no data is purged. You can schedule the purging based on event 
age or other factors. See the Data Purge tab in "Configuration Tab, Data 
Purge Tab" on page 111. 

About Time Skews
The time difference between an agent host and the Analyzer host to which 
the agent is sending events is a time skew. Time skews are calculated by the 
Processing Servers and automatically applied to the relevant event data, 
such as event start time or stop time. That way, differences in the time on 
the different hosts don’t affect the event data. 

Time skews rely on the time servers that are run by the Processing Server. If 
an agent cannot access the Processing Server host, it uses another time 
server as designated in the communication link definition.

Time skews are reported on the Communication Links Summary page. See 
"Communication Links Summary Page" on page 168.

Time skews also exist between a Processing Server and the BSM Gateway 
Server. See "Key Configuration Settings for Processing Servers" on page 40.
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Configuring the Caches
The Analyzer uses several caches to hold data it is processing for event 
analysis. A bigger cache size minimizes database access and increases 
performance, but also increases the amount of memory used by the 
Analyzer. 

Each analyzer has its own set of caches, since each Analyzer runs in its own 
JVM.

The cache is configurable as follows: 

➤ PII objects

Specifies the number of PII system model objects cached.

➤ events

Specifies the size per each event’s cache.

➤ transactions

Specifies the size of each transaction correlation cache.

Typically, you do not need to modify the default cache sizes. However, if 
you are running the Analyzer in Failure mode, you do need to increase the 
caches sizes. See "Memory Cache Changes Needed for Failure Mode" on 
page 79.

The statistics cache is a special cache that is used to hold the data shown in 
the Component Topology. The statistic cache is structured based on a 
configurable timeslice. 

The timeslice is used to partition data into different pieces so that 
depending on what timeframe one is interested in looking at this data can 
be quickly retrieved. A timeslice represents a period of time during which all 
events belonging to the same program and MQ object are condensed into a 
single statistic. For example, if you had a program putting messages to a 
particular queue, all the statistics data relating to the program and the queue 
(latency times, success counts, etc.) during a particular timeslice are stored 
in the same database row. By changing the values of the time slice interval 
you can control how big and how efficient access to the statistics table is. 
The larger the timeslice, the more efficient the storage of results will be; the 
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trade-off you lose is that your time slice interval is the smallest increment of 
time that you can view your data in for the Component Topology in Static 
mode. For example, if you were to set a time slice of one day, you would not 
be able to view these statistics on an hourly basis. By default it is 60 minutes. 
For information about setting the time slice, see "Configuration Tab, Cache 
Tab" on page 103.

About Logging
These special types of logging can be enabled: 

➤ Performance Logging. Analyzer event processing rate and other 
associated metrics are logged. The log provides metrics for average events 
per second overall and over the last event sampling period.

Log location: Navigate to Admin > Transaction Management > 
TransactionVision > Processing Servers > <processing server> > <analyzer> 
> Configuration > Log Files > PerfLog.

➤ Trace Logging. Verbose and detailed information about what an Analyzer 
is doing internally. This logging is used mainly to troubleshoot problems 
and should not be turned on in a production environment.

Log location: Navigate to Admin > Transaction Management > 
TransactionVision > Processing Servers > <processing server> > <analyzer> 
> Configuration > Log Files > Trace.

➤ Debug Logging. Highly detailed information about what an Analyzer is 
doing internally. This logging is used to troubleshoot problems and 
should not be turned on in a production environment.

Log location: Navigate to Admin > Transaction Management > 
TransactionVision > Processing Servers > <processing server> > <analyzer> 
> Configuration > Log Files > DebugLog.

Logging also occurs at the Processing Server level. See "Processing Server 
Page, Log Files Tab" on page 68.

Choosing Standard Mode or Failure Mode
By default, Analyzers run in standard mode. In standard mode, all event, 
correlation, and local transaction data is flushed continuously to the 
database. 
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The Analyzer can be configured to run in failure mode. In this mode, the 
Analyzer flushes only the event, correlation, and local transaction data of 
failed transactions or transactions that have violated their defined threshold 
to the database. Event data for successful transactions is not stored.

Business transaction-level data is always written to the database, regardless 
of the mode. 

Failure mode is useful because it significantly reduces the data storage 
requirement for the Analyzer. This reduction in database access also 
increases the performance of the Analyzer. 

However, an Analyzer running in failure mode cannot recover from a system 
crash or processing error because event data is kept only in memory.

Failure mode can be enabled on a per-Analyzer basis, allowing you to run 
certain Analyzers in failure mode while running others in standard mode.

A typical use case for the failure mode is for high-volume systems with 
short-lived transactions where statistics collection and failure alerting is the 
primary requirement.

When Data is Flushed to the Database in Failure Mode

In failure mode, the business transaction data is always flushed to the 
database. The remaining data (event XML, user data, correlation and local 
transaction data) is stored in memory caches until either:

➤ The transaction result attribute is set to SUCCESS by matching 
classification rules, in which case all data for this transaction kept in 
memory is discarded. Further events for this transaction are discarded as 
well.

➤ The transaction result is set to FAILED by the classification rule engine, in 
which case all data of this transaction is flushed to the database. Further 
events for this transaction are stored as well.

➤ The transaction violates its threshold. The response time of a transaction 
is continuously monitored and transaction data is flushed to the database 
if this response times exceeds the Threshold value specified in the 
business transaction tracing properties.
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➤ The transaction result has still not been set even after a certain 
configurable time has passed, in which case the transaction is also 
considered to be “aged out”, and all data is flushed to the database. The 
SLA status column of the transaction is set to Aged Out. In case an event 
is processed later which marks the transaction as successful, the SLA 
status is reset and the transaction is treated in the same way as a 
successful transaction - all further events are discarded.

The time after which a transaction is considered to “age out” is dynamically 
computed from the sum of the transaction threshold plus Process delay 
time specified in the Analyzer configuration. This value specifies the 
maximum time the processing of any event can be ‘delayed’ within the 
Analyzer in respect to other events of the same transaction. There is a 
certain amount of lag between the time events in a transaction are 
generated at the agent and the time events for a transaction are completely 
processed by the Analyzer. This lag is due to the effects of queuing in the 
WebSphere MQ infrastructure, event batching, multithreading, and context 
switches by the OS. So if for example, the transaction threshold is defined as 
5 seconds, and the Process delay setting is 10 seconds, any transaction 
whose result has not been determined 15 seconds after the first event has 
been processed are aged out.

Successful transactions still appear together with their attribute values on 
the Transaction Tracking Report, but it is not possible any more to navigate 
to any other views or drill down to the event level, since all this data has not 
been written to the database. But for failed and aged out transactions all 
data is available, and the report offers the same functionality as if those 
transactions had been processed in Standard Mode.
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Memory Cache Changes Needed for Failure Mode

A high system load, too small cache sizes, or keeping event data too long in 
the caches can all lead to cache overflows (indicated by a 
FailureModeCacheOverflow warning in the AppLog file). When this 
happens, the entire cache contents are written to the database slowing 
down the Analyzer event processing rate.

As mentioned previously, failure mode only works efficiently if the Analyzer 
is able to clear out the memory caches as quickly as new data is coming in. If 
a cache overflow occurs, the system slows down considerably since all the 
data has to be written to the database. A system with frequent cache 
overflows does not perform as expected.

The ability of the Analyzer to keep the caches from overflowing is 
determined by the multiple factors:

➤ Rate of which new events are coming into the system

➤ Database performance

➤ Configured size of the caches

➤ Time an open transaction is kept in the system (determined by threshold 
+ process delay)

The Analyzer Failure Mode is intended for systems with short lived 
transactions, with threshold values in the range of seconds. As the threshold 
values get bigger, the transactions need to be kept in the caches much 
longer, and more data can accumulate in the caches. Such a system can still 
work properly if the cache sizes are large enough, or if the load on the 
system is small enough. 

Failure Mode Considerations

There are certain issues with the Failure Mode about which you need to be 
aware. First, since all event data is initially only kept in memory, this mode 
does not offer any recoverability. If an Analyzer crash, database error, or 
general system failure occurs, the data in the caches is lost. In standard 
processing mode, the XML event is always written to the database, so that in 
case of such a failure the missing analysis data can be recovered. In Failure 
Mode, the XML event data might not have been written to the database, so 
there is nothing to recover from.
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Another issue arises when events for a successful transaction are being 
processed (or even entering the system) after the data for the transaction has 
been discarded from the caches. If these events contain an event which 
increases the response time of the transaction beyond the threshold value, 
and if writing of threshold violations is enabled, then this transaction only 
has partial data stored in the database, because previous event data has 
already been discarded. Note that this issue does not occur if the transaction 
classification contains time rules, since successful transaction are not 
removed from the cache until the time rules have fired.

The second case in which late events can cause a problem occurs when the 
event is being processed so late that the correlation data for the 
corresponding transaction has already been pushed out of the lookup caches 
(which are, like the write caches, also limited in size). In this case, an event 
might not get correlated into the existing transaction, and a new transaction 
is created instead. Increasing the size of the caches (event_based) could 
remedy the problem, but it might also be an indicator that the Failure Mode 
is not well suited for this kind of transaction.

Enabling an Analyzer for RUM 
Transaction Management reports and topologies can be configured to 
include RUM data by integrating TransactionVision components with RUM 
components in the same deployment environment. 
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At least one Analyzer in the deployment environment must be enabled to 
collect the RUM events. That Analyzer uses the built-in RUM 
communication link to communicate with the RUM Engine. In this 
example deployment environment, Analyzer B is dedicated to processing 
RUM events: 

To enable an Analyzer for RUM, set the corresponding checkbox on the 
General page of the Analyzer wizard. See "Analyzer Wizard" on page 94.

The Analyzer cache size for RUM objects is configurable. See "Configuration 
Tab, General Tab" on page 101.

Enabling an Analyzer for BPI 
One or more Analyzers can be configured to send events to BPI, where they 
are used as input for Business Process modeling.

To enable an Analyzer for BPI, see the BPI settings group in "Configuration 
Tab, Events Tab" on page 105.

For more information about the communication between BPI and 
TransactionVision, see "Business Process Insight" on page 309.

TransactionVision 
Processing Server A

TransactionVision 
Processing Server B

Analyzer A

Analyzer C

Database
Schema AA
Schema AB
Schema BC
Schema BD

Agent 1

Agent 2

Agent 3

Built-In 
RUM 

Comm Link
BSM Gateway 

Server

Analyzer B

Analyzer D

Comm 
Link

Comm 
Link

Comm 
Link

Comm 
Link

RUM Engine
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Tasks

How to Add an Analyzer to the Deployment Environment

This task describes how to add a new instance of an Analyzer to the 
deployment environment.

This task includes the following steps:

➤ "Prerequisites" on page 82

➤ "Launch the Analyzer Wizard" on page 83

➤ "Results" on page 83

➤ "Assign a Communication Link to the Analyzer" on page 83

 1 Prerequisites

Determine the Processing Server on which to add the Analyzer. A 
Processing Server can have up to 5 Analyzers. 

If a new Processing Server is needed to host the Analyzer, see "How to 
Create a Processing Server" on page 44.

Note that correlation cannot happen across Analyzers. Events for a single 
transaction must all be collected and sent to the same Analyzer so that 
correlation can occur. 

An agent, on behalf of a single application, can send events to more than 
one Analyzer however. This can be a desirable configuration for 
partitioning the traffic into different Analyzers/transaction classes. For 
example, if the application is some sort of general purpose hub (like IBM 
WMB), different events coming from the same broker may have different 
business meanings and belong in different business transactions. 
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 2 Launch the Analyzer Wizard

 a Select Admin > Transaction Management.

 b (left pane) Click the Configuration tab.

 c Navigate to the Processing Server to which to add the new Analyzer, 
then right-click and select New Analyzer. 

 d The Analyzer Wizard appears. For details about this interface, see 
"Analyzer Wizard" on page 94.

 3 Results

The new Analyzer appears in the Configuration tab. 

 4 Assign a Communication Link to the Analyzer

The way that an Analyzer gets events is by one or more communication 
links assigned to it. See "How to Assign a Communication Link to an 
Analyzer" on page 83. 

How to Assign a Communication Link to an Analyzer 

This task describes how to assign a communication link to an Analyzer. The 
Analyzer processes events from its assigned communication links only. 

 1 Select Admin > Transaction Management.

 2 (left pane) Select the Configuration tab.

 3 Navigate to and select the target Analyzer. You may have to expand the 
Processing Servers folder. 

 4 (right pane) Click the Configuration tab. 
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 5 In the Communication Link and Data Collector Filter Assignment area, 
click the Assign communication link  button. 

 6 In the Communication Link and Data Collector Filter Assignment group, 
choose the communication link to assign to the Analyzer and click OK.

 7 Click Apply.

By default, the Collect All data collection filter is assigned to the 
communication link. To assign a different data collection filter, see "How 
to Assign a Data Collection Filter to a Communication Link" on page 146.

How to View Analyzer Status

This task describes how to view the status for an Analyzer.

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Navigate to the Analyzer for which you want to view the status and select 
it. You may have to expand the Processing Server folder. 

 4 The Analyzer status is displayed on the Status tab. For details about this 
interface, see "Analyzer Page, Status Tab" on page 96.
84



Chapter 3 • Analyzers
How to Stop and Restart Event Collection

For some maintenance tasks in the TransactionVision deployment 
environment, you need to temporarily start or stop event collection of an 
Analyzer. These tasks include:

➤ Database imports or exports involving the database tables directly (not 
through the Transaction Management Administration pages).

➤ Analyzer configuration involving changing schema definition

To stop event collection for an Analyzer:

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Select Processing Servers > <processing_server> > <analyzer>.

 4 (right pane) Click the Status tab and then click Stop Analyzer button. For 
more information about this user interface, see "Analyzer Page, Status 
Tab" on page 96.

The Analyzer shuts down all collection threads without waiting for them 
to clean out events in the event queue. While the Analyzer is shutting 
down all the threads, its status is set to QUIESCING. Once all collection 
threads are shut down, the status changes to STOPPED.

To start event collection for an Analyzer:

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Select Processing Servers > <processing_server> > <analyzer>.

 4 (right pane) Click the Status tab and choose the Start Analyzer button. 

The Analyzer status becomes COLLECTING and details about event 
collection are displayed for each communication link associated with the 
Analyzer in the Analyzer and Communication Link Status area. 

For more information about this user interface, see "Analyzer Page, Status 
Tab" on page 96.
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How to Stop and Restart an Analyzer

Some database maintenance tasks require that the Analyzer service or 
process be shut down.

A Processing Server can host up to 5 Analyzers. Each Analyzer is has a 
unique service name as follows:

tv_analyzer1
tv_analyzer2
tv_analyzer3
tv_analyzer4
tv_analyzer5

To completely stop the Analyzer process, use the nanny command on the 
host on which the Processing Server is running, and specify the analyzer 
service name:

If you stop the analyzer by using the nanny utility, you need to use the same 
utility to restart the Analyzer. To restart the Analyzer, use the following 
nanny command:

For more information about the nanny command, see "nanny" on page 347.

How to Remove an Analyzer from the Deployment 
Environment

There are two ways of removing an Analyzer from the deployment 
environment.

Delete an Analyzer Permanently

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

nanny stopService tv_analyzer1

nanny startService tv_analyzer1
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 3 Expand Processing Servers 

 4 Navigate to the Analyzer, then right-click and select Delete. 

Archive an Analyzer 

You can set an Analyzer to Archive mode to deactivate it. A deactivated 
Analyzer cannot be started or stopped by the nanny and does not collect 
events, however its configuration is retained. 

You may want to use Archive mode to retain the analyzer configuration, 
either for documentation purposes or if you want to make the Analyzer 
active again at some other time.

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Expand Processing Servers 

 4 Navigate to the Analyzer.

 5 (right pane) Click the Configuration tab. 

 6 On the General tab, set Archived.

 7 Click Apply.

How to Recover an Analyzer

Errors in Analyzer processing can happen in two different stages:

➤ Event processing - where events are unmarshalled and the event.xml is 
created. 

In this case the events will be put on the exception queues defined for the 
communication links and remain there. You use the ManageQueue utility 
to process them. For more information about this utility, see 
"ManageQueue" on page 339.
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➤ Event analysis - processing that results in the local transaction being 
defined.

In this case, the events are pulled of the queues and not available 
anymore. Next time the Analyzer starts it scans the associated database 
schema for unprocessed events and automatically recovers the statistics 
cache and resumes processing. 

How to Enable Failure Mode on an Analyzer

This task describes how to run an Analyzer in Failure mode. 

This task includes the following steps:

➤ "Prerequisites" on page 82

➤ "Enable Threshold Violation Tracking - Optional" on page 89

➤ "Set the Enable failure mode setting to ON." on page 90

➤ "Adjust Caches" on page 90

➤ "Set Other Related Properties" on page 90

➤ "Tune the Settings - Optional" on page 91

 1 Prerequisites

Using failure mode requires that the Result attribute of the transaction be 
defined accurately. See "Data Rules" in "Transaction Tracing Rules Page, 
Rules Definition Tab" on page 467.
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 2 Enable Threshold Violation Tracking - Optional 

By default, failure mode captures data for transactions that have a FAILED 
result or have timed out.

Failure mode can also capture data for transactions that have violated 
their threshold setting. To enable threshold violation tracking, enable the 
LogSLAViiolationBean section in the Analyzer’s Beans.xml:

The Beans.xml file is accessed through the Analyzer > Configuration > 
XML tab.

When this section is enabled, the response time of each transaction is 
continuously monitored against the threshold setting that is defined for 
this transaction class, and the status is stored in the sla_status for the 
transaction. If the response time exceeds the threshold, a value of 1 
(=Violated) is stored, otherwise a value of 0 (=None). For transactions 
which age out during the analysis process (as mentioned above), a value 
of 2 (=AgedOut) is stored into the column. When the WriteTxn attribute 
is set to true, transactions violating the threshold are treated like failed 
transactions.

The LogLevel attribute specifies the severity level of the log message and 
can be adjusted to the level of the corresponding log appender. Valid 
values are Info, Warning, and Error. The default is Warning. 

Note: If you are using the SMTP log appender to send SLA alerts via email, 
the LogLevel attribute has to be set to Error.

<Module name="LogSLAViolationCtx" type="Context">
   <Module   
class="com.bristol.tvision.services.analysis.eventanalysis.LogSLAViolationBean" 
type="Bean">
      <Attribute name="WriteTxn" value="true"/>
      <Attribute name="LogLevel" value="Warning"/>
   </Module>
</Module>
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 3 Set the Enable failure mode setting to ON. 

To enable failure mode processing in the Analyzer, set the Failure mode 
checkbox on the Analyzer > Configuration > Cache tab. By default, failure 
mode is disabled. 

The Analyzer does not need to be stopped to enable or disable failure 
mode. Once the mode is set and the Analyzer starts processing new 
events, those events are processed using the new processing mode.

 4 Adjust Caches

Failure Mode requires increases to the default settings of the cache sizes. 
In general; you need to increase the sizes to at least twice the sizes used in 
the standard processing mode. See "Key Configuration Concepts for 
Analyzers" on page 73.

 5 Set Other Related Properties

The following other configuration parameters should also be changed:

➤ Thread count. Defines the number of flushing threads to use for Failure 
Mode. This number should be set high enough so that the cache data can 
be flushed fast enough, but low enough to not waste too many system 
resources. The default value is 2.

➤ Process delay time. Defines the amount of time, in milliseconds, which 
gets added to the threshold value for determining the age out timeout 
and is a crucial value for the Failure Mode. If this value is set too low, a lot 
of successful transaction data unnecessarily ages out and is written to the 
database, which results in poorer performance, and wasted database disk 
space. If this value is set too high, too much data is held in the memory 
caches. If the cache sizes are not large enough for the system load, cache 
overflows occur frequently and lead to very poor performance. The 
default value is 5 seconds.
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➤ Discard overflow. In case of a cache overflow all the data in the caches is 
normally written to the database. If the overflow was caused, for 
whichever reason, by a longer lasting system slowdown, the constant 
flushing of the cache could further worsen the situation and slow down 
the Analyzer even more. If the main concern is to avoid any chance of 
filling up the event queue in such situations, you can set the above 
parameter to true and force the discarding of all cache data in case of an 
overflow. The default value is false.

 6 Tune the Settings - Optional

The diagnostic status output of the Analyzer can assist in finding 
appropriate configuration values for the Failure Mode. The following 
steps show how to get a meaningful status.

 a In the Analyzer configuration page, enable Events > Performance 
Logging> Log Details.

 b Enable Failure Mode.

 c Run the Analyzer in Failure Mode for a sufficient amount of time on 
typical data.

 d Run AnalyzerManager –n <analyzer_id> –diagstatus.

 e Look for the section beginning with FailureMode Cache Manager 
statistics for schema.
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Sample output

The values of interest are:

➤ Number of forced flushes. This is the number of times the Analyzer 
processing had to wait for the caches to be flushed to disk. If there are 
no forced flushes, the event processing and data flush happen mostly 
asynchronously with maximum performance. If the number of forced 
flushes is high, the processing threads have to suspend the analysis 
process until the flushing threads have emptied the caches often, 
which results in poor Analyzer performance. To minimize forced 
flushes, increase the number of flushing threads, or the size of the 
caches.

FailureMode Cache Manager statistics for schema TEST

[…]

Number of forced flushes:           0

FailureMode FlushThread#0: last flush: 4 rows 0 ms
   current flush time = 0 ms
   total flush cycles: 213
   cycles skipped: 3
   max scan depth: 0

FailureMode FlushThread#1: last flush: 0 rows 0 ms
   current flush time = 0 ms
   total flush cycles: 309
   cycles skipped: 309
   max scan depth: 0

Max txn processing time in schema TEST: 16188 ms (business txn 858)
Avg txn processing time in schema TEST: 4842 ms
Number of txns (success/failed/agedOut) :  0/129/6
Number of overflow cache writes in schema TEST: 0
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➤ total flush cycles / cycles skipped. The ratio of both numbers gives an 
indication of how well the flushing threads are used. If the number of 
cycles skipped is very close to the total number of flush cycles, the 
threads are idle most of the time and the number of flushing threads 
can be reduced to save some system resources. If all flushing threads 
show a very low number of skipped cycles, it indicates that all threads 
are fully utilized, and additional flush threads might be necessary.

➤ Maximum txn processing time. This is the longest time a transaction 
has been processing inside the Analyzer (from first to last event). The 
Failure Mode process_delay value should be chosen at least so big that 
the maximum processing time is still less than the sum of transaction 
class threshold and process_delay value to avoid unnecessary aging out 
of transaction data. If the value is set too high or too low, it can lead to 
performance issues as described earlier.

➤ Number of overflow cache writes. The number of times the complete 
cache contents had to be flushed to the database because a cache 
overflow occurred. Since overflow cache writes have a severe impact 
on the performance, it should always be tried to keep this value at zero 
by configuring the parameters explained above as required. If this still 
won’t succeed it might indicate that the system load or transaction 
structure may not be well suited to be processed in Failure Mode.
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Reference

Analyzers User Interface

This section describes:

 ➤ Analyzer Wizard on page 94

 ➤ Analyzer Page, Status Tab on page 96

 ➤ Analyzer Page, Configuration Tab on page 101

Analyzer Wizard

This wizard enables you to define an instance of the Analyzer.

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand Processing Servers.

4  Right-click the Processing Server on which you want 
to deploy the Analyzer and select New Analyzer.

Important 
information

➤ This wizard collects only some of the Analyzer 
configuration parameters and uses defaults for the 
remaining ones. 

➤ The full set of properties is available on the 
Configuration tab. See "Analyzer Page, Configuration 
Tab" on page 101.

Wizard map This wizard contains:

General Info Page > Summary Page

See also ➤ "Analyzer Page, Configuration Tab" on page 101

➤ "Key Configuration Concepts for Analyzers" on 
page 73
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General Info Page
This page enables you to configure the Analyzer. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

General information about this wizard is available here: 
"Analyzer Wizard" on page 94.

Wizard map The Analyzer Wizard contains:

General Info Page > Summary Page

UI Elements Description

Additional Classpaths Specify the classpaths to Jar files if your event transport 
provider requires custom path settings or any custom 
bean/code.

Additional Native 
Paths

Specify the native paths to Jar files if your event transport 
provider requires custom path settings or any custom 
bean/code.

Name The name of the Analyzer. The name must be unique to 
the deployment environment.

Schema The schema name to be created in the database that will 
store the Analyzer’s event data. The name must be 
unique to the deployment environment. 

Assign default 
communication links

Assign the built-in communication links to this Analyzer. 
See "Default Communication Links" on page 141.

Port The port number where the Analyzer listens for 
administrative and status requests. Default value: 21120, 
21130, 21140, 21150, 21160

Do you want to 
enable this Analyzer 
for RUM Events 
processing?

Choose Yes to have the Analyzer process RUM events as 
well as those captured by any TransactionVision Agents. 

If you want to include RUM event data in the Transaction 
Management reports, one Analyzer in the deployment 
environment must be enabled to process RUM events. 
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Analyzer Page, Status Tab

The Status tab of the Analyzer page provides the current status of the 
selected Analyzer. The following is an example of the Status tab of the 
Analyzer page.
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General Tab

User interface elements are described below. 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Navigate to Processing Servers > <processing_server> > 
<analyzer>

4  (right pane) Click the Status tab. 

See also ➤ "Processing Server Page, Status Tab" on page 61. 

➤ "Configuration Tab, Data Purge Tab" on page 111.

UI Elements (A-Z) Description

Analyzer Status Start event collection for the Analyzer.

Stop event collection for the Analyzer, 
allowing time for the event queue to be emptied. 

Stop the Analyzer, not allowing time for the 
event queue to be emptied. When the Analyzer 
restarts it will clean out the event queue. 

Refresh Analyzer status.

Average Events Processed per Second. The rate 
of event processing. 

Collection State. Indicates whether the Analyzer 
is currently collecting events. ACTIVE indicates 
that the Analyzer is collecting events. INACTIVE 
indicates that the Analyzer is not currently 
collecting events.

Current Events Processed per Second. The 
current rate of event processing. 

Events in Database. The number of events stored 
in the database schema for this Analyzer. Click 
Update Events to refresh the value. 

Schema. The database schema in which the 
Analyzer data is stored.
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Analyzer Status, continued Status. The current status of the Analyzer:

➤ COLLECTING. The Analyzer is started and 
collecting events.

➤ COMMAND PENDING. The Analyzer is 
switching between statuses.

➤ FAILED. BSM cannot connect to the Analyzer; 
an error message is provided, and the 
exception and stack trace are listed. 

➤ RECOVERY. The Analyzer is performing event 
analysis and statistics data recovery. See 
"Analyzer Recovery Mode" on page 115.

➤ QUIESCING. The Analyzer is shutting down 
all collection threads in response to a stop 
command. Once all collection threads are 
down, the status changes to STOPPED.

➤ STOPPED. The Analyzer has been stopped and 
is not collecting events.

Logs. The log messages of the Analyzer. 

UI Elements (A-Z) Description
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Analyzer Commlink Status For each communication link assigned to the 
Analyzer, the following details display: 

Communication link name

Log Errors. The number of error messages

Threads. Number of event collection threads. 
This is controlled by the Number of Event 
Collection Threads value specified in the 
communication link. 

Configs. Number of configuration messages sent 
through this communication link since the 
Analyzer was last started. 

Events. Number of events processed since the 
Analyzer was last started. 

Event Pkgs. Number of event packages sent to the 
event queue since the Analyzer was last started. 

Unprocessed. Number of unpracticed events on 
the event queue. 

Time skew. Time skew across the communication 
link. 

UI Elements (A-Z) Description
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Data Purge Tab

User interface elements are described below. 

UI Elements (A-Z) Description

Start the data purge operation on this Analyzer. If 
the next scheduled time for the purge operation 
has already passed, it runs immediately; 
otherwise, it is placed in a waiting state until its 
scheduled time arrives. 

To set up the schedule for purging, see 
"Configuration Tab, Data Purge Tab" on page 111.

Stop the data purge operation on this Analyzer. If 
the data purge operation is currently running, a 
cancel command is first issued, followed by 
commands to stop and shut it down.

Force stop the data purge operation. This button 
is only enabled if the data purge operation is in 
Quiescing mode.

Cancel the current data purge operation without 
stopping the data purge operation scheduled. 
The job changes to a waiting state until the next 
scheduled run time.

Next Run The next scheduled run of the data purge 
operation. 

Job Logs Any log or warning messages. 

Status The status of the data purge operation. 
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Analyzer Page, Configuration Tab

Note: Some changes require the Analyzer to be automatically restarted. 
These changes include modifying the native path, classpath, ports and 
schema/xdm (which is handled elsewhere) changes.

The Configuration tab has these tabs:

➤ "Configuration Tab, General Tab" on page 101

➤ "Configuration Tab, Cache Tab" on page 103

➤ "Configuration Tab, Events Tab" on page 105

➤ "Configuration Tab, Data Purge Tab" on page 111

➤ "Configuration Tab, XML Tab" on page 113

Configuration Tab, General Tab
The General tab of the Configuration tab enables you to view and modify 
Analyzer properties. 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand Processing Servers 

4  Select <processing_server> > <analyzer> 

5  (right pane) Click the Configuration > General tab.

Important 
information

Some configuration changes require the Analyzer to be 
automatically restarted. 

See also ➤ "Analyzer Wizard" on page 94

➤ "Key Configuration Concepts for Analyzers" on 
page 73
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Analyzer General ApplyTimeSkew. Disable if all the hosts in the 
deployment environment (Processing Servers, Queue 
Managers, agents) are already time synchronized, thereby 
guaranteeing that the time on all of the hosts is always 
the same. Default value: On

Archived. Enable to stop the Analyzer and place it in 
archive mode. See "How to Remove an Analyzer from the 
Deployment Environment" on page 86. Default value: 
Off

Classpath. Classpaths to Jar files needed by your event 
transport provider. See the Additional Classpath 
description in "Analyzer Wizard" on page 94

Debug. Enables debug logging. See "About Logging" on 
page 76. Default value: Off

Description. Description of the Analyzer. 

Name. Name of the Analyzer.

Native path. Native paths to Jar files needed by your 
event transport provider. See the Additional Native Path 
description in "Analyzer Wizard" on page 94.

Port. The port number on which the Analyzer runs. See 
the Port description in "Analyzer Wizard" on page 94.

Schema. Schema name to contain the Analyzer data. See 
the Schema description in "About Logging" on page 76.

Trace. Enables trace logging. See "About Logging" on 
page 76. Default value: Off

Communication Link 
and Data Collection 
Filter Assignment

 Assign a communication link to the Analyzer.

 Assign a data collection filter to a communication 
link. 

 Delete the selected communication link. 

Name. The communication link assigned to this 
Analyzer, and the data collection filter assigned to it. 
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Configuration Tab, Cache Tab
The Cache tab of the Configuration tab enables you to view and modify 
Analyzer properties related to the caches.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand Processing Servers 

4  Select <processing_server> > <analyzer> 

5  (right pane) Click the Configuration > Cache tab.

Important 
information

Some configuration changes require the Analyzer to be 
automatically restarted. 

See also "Key Configuration Concepts for Analyzers" on page 73

UI Elements (A-Z) Description

General Event Objects. The cache size for data cached per event. 
Default value: 1000

Flush Interval(min). How often the statistics cache is 
written out to the database. Until the data is written to 
the database, it won't be visible in reports or topologies.

Depending on the volume of incoming requests, it might 
be useful to either flush more often, or less often. A 
longer flush time means fewer database writes, but will 
result in a larger cache size. Default value: 10

RUM Objects. The cache size for RUM data processing. 
Default value: 1000

TimeSlice interval(min). The minutes for which event 
statistics should be calculated. This affects the level of 
graunularity that displays in the Component Topology. 
Set this to the same value on all Analyzers. Default value: 
60

Transaction Objects. The cache size for data cached per 
correlation/transaction. Defeat value: 1000
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Database Discard Overflow. In case of a cache overflow all the data 
in the caches will normally be written to the database. If 
the overflow was caused, for whatever reason, by a longer 
lasting system slowdown, the constant flushing of the 
cache could further worsen the situation and slow down 
the Analyzer even more. If the main concern is to avoid 
any chance of filling up the event queue in such 
situations, you can set this option to On and force the 
discarding of all cache data in case of an overflow. 
Default value: Off

Failure Mode. Enables failure mode on the Analyzer. In 
failure mode, the Analyzer stores only event data of failed 
transactions or transactions violating their threshold. 
Failure mode is a significant change to the 
TransactionVision data flows and requires several 
configuration changes. See "How to Enable Failure Mode 
on an Analyzer" on page 88. Default value: off

Number of Threads. The number of threads to use for 
writing the cached analysis data to the database.

The best value is dependent on the hardware the 
Analyzer is running on and can only be determined by 
performance measuring with different values, but a good 
starting point would be to set this number to half the 
number of collection threads used for a particular 
schema. Default value: 2

Process Delay Time. The amount of time, in 
milli-seconds, which gets added to the threshold value 
for determining the age out timeout and is a crucial value 
for the Failure Mode. If this value is set too low, a lot of 
successful transaction data will unnecessarily age out and 
be written to the database, which will result in poorer 
performance, and wasted database disk space. If this 
value is set too high, too much data will be held in the 
memory caches. If the cache sizes are not large enough 
for the system load, cache overflows will occur frequently 
and lead to very poor performance. Default value: 5 
seconds

UI Elements (A-Z) Description
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Configuration Tab, Events Tab
The Events tab of the Configuration tab enables you to view and modify 
Analyzer properties related to event handling. 

Database 
(continued)

Standard Mode. Enables standard mode on the Analyzer. 
Default value: on

Skip Threshold (Idle Threads). Skip threshold for idle 
flush threads for flushing the caches to the database. 
Default value: 50 ms

Thread Wait Time (msec). Wait time for idle flush 
threads. Default value: 100 

Wait Time until Overflow (msec). Wait time until cache 
overflow is reported. Default value: 60 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand Processing Servers 

4  Select <processing_server> > <analyzer> 

5  (right pane) Click the Configuration > Events tab.

Important 
information

Some configuration changes require the Analyzer to be 
automatically restarted. 

See also "Key Configuration Concepts for Analyzers" on page 73

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

General FailSafe Collection Shutdown. Stop sending 
configuration messages to agents if a serious failure 
occurs in event collection and processing. Default value: 
on

Garbage Collection Sleep (sec). Interval for forced 
garbage collection. Default value: 120

No Events Processing. Disables event processing. If you 
want to only measure the incoming rate of events to the 
event queue, you can enable this option. No event or 
transaction-level data is written to the database schema 
or therefore available for the reports and topologies. 
Default value: off

Read from Jar. Reads raw events from a JAR file 
<TVISION_HOME>/logs/<SCHEMA>_raw_events.jar. See 
"Storing and Using Raw Events" on page 118. Default 
value: off

Write to Jar. Stores raw events into a JAR file 
<TVISION_HOME>/logs/<SCHEMA>_raw_events.jar. See 
"Storing and Using Raw Events" on page 118. Default 
value: off
106



Chapter 3 • Analyzers
Database Batch Commit Count. The number of processed events to 
batch before a commit is issued. Default value: 50

Commit Bytes Threshold. The number of bytes (of 
processed events) after which a commit is forced. Default 
value: 1,000,000

Commit time threshold. The number of seconds after 
which a commit (of processed events) is forced. Default 
value: 1

JDBC Batch Count. If Use JDBC Batching is specified, the 
number of SQL operations to batch in JDBC batching 
mode. This value should be equal to or a multiple of the 
Batch Commit Count value. Default value: 50

Keep raw events. Once a raw event has been processed, it 
is no longer needed. However if you want to process the 
events again (for example, with a custom Java bean for a 
different type of analysis), you can retain them by 
enabling this setting. Default value: off

Read from buffer table. Read raw events from the 
database in addition to reading from the queue. Use this 
property to test custom beans or troubleshoot issues. It 
should always be set to Off in a production environment. 
Default value: off

Use JDBC Batching. Executes database statements in 
batch mode. Default value: on

Use Oracle batching. Use Oracle specific update batching 
instead of JDBC batching. TransactionVision must be 
manually configured to use the Oracle JDBC driver. See 
the Use Custom JDBC URL property on "Database 
Connection Parameters Page" on page 52. Default value: 
off

UI Elements (A-Z) Description
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Analysis Correlation Limit. Limit the number of event relations 
being created for the same correlation key. Default value: 
-1 (no limit)

Event Matching Interval. The time in seconds to wait 
between every invocation of event matching. Default 
value: 600.

Generate API only transactions. By default the Analyzer 
does not perform any transaction analysis on events that 
have been collected with a Data Collection Filter setting 
of User Data Range = API Names Only. Set this property 
to On to change this behavior. Default value: off.

Latency Resolution (1/sec). The resolution used to 
calculate latency between events. Possible values are: 

➤ 1 to specify seconds

➤ 10 to specify 1/10 seconds

➤ 100 to specify 1/100 seconds

➤ 1000 to specify milliseconds

Default value: 100

Partial Event Lifetime(min). The maximum time in 
minutes a partial event entry can exist in the 
partial_event table. When this time limit is reached, the 
partial event is flushed. Default value: 10 minutes.

Separate Child Thread Transactions. By default, if a 
servlet spins off a thread to make some JMS calls, the 
servlet passes tracking information to the child thread. 
The result is that both the servlet and JMS events belong 
to the same transaction. However, there may be some 
cases in which you want to separate these events into 
different transactions. For example, a servlet may spin off 
a long-running thread that you do not want to be part of 
the same transaction as the servlet. If you do not want 
threads spun off by a servlet to be included in the same 
transaction as the servlet, list the servlet program name 
as the value for this property. Separate multiple program 
names with a comma, as in the following example:

program1, program2 

UI Elements (A-Z) Description
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Performance Count Interval. The number of events after which 
performance data is logged. Default value: 500

Enable Performance. Enables performance logging. 
Default value: off

Event Queue Depth Retrieval. Retrieves the current event 
queue depth for each log interval. Default value: off

Log Details. Generates detailed performance and 
statistics logs. Default value: off

Start at Event Count. The number of events to be 
processed before performance logging starts. Default 
value: 500

UI Elements (A-Z) Description
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BPI Enable BPI Integration. Enables BPI for this Analyzer. 
Default value: off

Event Expiry Time(sec). Time that delayed (events that 
could not be delivered) events are kept before being 
purged. 

Event Thread Retry Interval(sec). Time the Analyzers 
checks to clean up expired events and retry any events 
that failed to send. 

Initial Context Factory. The classname of the JNDI 
context factory. This value depend on which JMS vendor 
you use (see their documentation for details). Some 
examples are: 
com.sun.jndi.fscontext.RefFSContextFactory
com.tibco.tibjms.naming.TibjmsInitialContextFactory.

Password. Optional setting if authentication to the JMS 
provider is required.

Provider URL. The URL to the JNDI repository, format is 
dependent on the JMS vendor. A RefFSContextFactory 
has a URL similar to file:/C:/jndi. For TIBCO, you might 
use something like tibjmsnaming:// host:7222.

Queue Connection Factory. The name of the Queue 
Connection Factory JNDI object.

If using the built-in Sonic MQ to send events to BPI, the 
queue and corresponding JNDI mapping 
(TV2BPI.EVENT.QUEUE) are created automatically. 

Queue Name. The name of the JNDI object (if JNDI is 
used), or the actual name of the queue (in the case of 
WMQ JMS).

Username. Optional setting if authentication to the JMS 
provider is required.

UI Elements (A-Z) Description
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Configuration Tab, Data Purge Tab
The Data Purge tab of the Configuration tab enables you to control when 
event data is deleted from the database. 

The user interface elements are grouped into three categories:

Purge Options

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand Processing Servers 

4  Select <processing_server> > <analyzer> 

5  (right pane) Click the Configuration > Data Purge tab.

Important 
information

➤ By default, no event data is purged.

➤ You can monitor the data purging operation on the 
Analyzer Status tab. 

➤ Data purging can also be done through the 
deleteEvents command line utility. See "DeleteEvents" 
on page 331.

See also "About Data Purging" on page 74

UI Elements Description

Time Time Range. Stop sending data collection configuration 
messages if a serious failure occurs in event collection 
and processing. 

New Than. Interval for forced garbage collection. 

Older Than. Disables event processing. 

Default value: Older Than 48 hours. 
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Common Options

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Advanced Options

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Event Count Limit Event Count Limit. The number of events processed after 
which deletion occurs. The oldest events are deleted first. 
Default value: none

Query Name Query. The query used to select the events to be deleted. 
Default value: none

UI Elements (A-Z) Description

Interval Maximum number of events to process before cleaning 
out the system model and transaction tables. Default 
value: 1000 

Disable Purge Job Disables the purging operation. Default value: off

Topology Graph 
Stats

Delete statistics data as well as event data. Statistics data 
is the topology and business transaction statistics table. 
Default value: off

Force Option Additional options that allow you to control which data 
is deleted. Specify the options in the Advanced Options 
area below. Default value: none

UI Elements (A-Z) Description

Create a new option. 

Edit an existing option.

UI Elements Description
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Configuration Tab, XML Tab
The XML tab of the Configuration tab enables you to view and modify 
Analyzer XML files. 

Deleted the selected option.

Commit Count Commit database transactions after the specified 
COUNT. Default value: 1000 

Disable Multi 
Threaded Delete

No deletion threads are used. By default 4 deletion 
threads are used for the deletion operation.

Default value: false 

Keep Local 
Transactions

Do not delete local transactions from the transaction 
tables. Business transactions are candidates for deletion. 
Default value: false

Timeout Force deletion to end after the specified time. 

Default value: 60 minutes

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand Processing Servers 

4  Select <processing_server> > <analyzer> 

5  (right pane) Click the Configuration > XML tab.

Important 
information

Be sure that you maintain valid XML when making any 
modifications to the files. 

Some configuration changes require the Analyzer to be 
automatically restarted. 

See also See the the HP TransactionVision Advanced Customization 
Guide PDF.

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Troubleshooting and Limitations

This section provides the following troubleshooting and limitation 
information:

➤ "Common Log Entries" on page 114

➤ "Retrieving Events From the Exception Message Queue" on page 115

➤ "Analyzer Recovery Mode" on page 115

➤ "Memory Resource Problems" on page 117

➤ "Storing and Using Raw Events" on page 118

➤ "Event and Transaction Correlation Problems" on page 121

➤ "Batching Multiple Listener Events in a Transaction" on page 122

➤ "JDBC Batch Error Due to Incorrect Database Version" on page 124

Common Log Entries
TransactionVision Error(ErrorGettingSkewFromWebAppServer): Error 
getting time skew from web application server (http://
OVRNTT44.ovrtest.adapps.hp.com:80/topaz/services/technical/
time?alt=text/plain): Unexpected end of file from server

Check the time skew settings for the Processing Server. See "Key 
Configuration Settings for Processing Servers" on page 40.

UI Elements (A-Z) Description

Name The name of the XML file to be customized.

Text The content of the file. Enter CTRL-F to launch a Find 
dialog. Click Accept to apply your changes, or Cancel to 
discard them. 
114



Chapter 3 • Analyzers
Retrieving Events From the Exception Message Queue
Event messages that could not be placed on the event queue for any reason, 
are placed on the exception message queue defined in the communication 
link. See "Communication Links" on page 125, for more information.

Once the cause of the failure is resolved, use the ManageQueue utility to 
replay the events on the exception message queue to the event queue, as in 
the following example:

For more information about this utility, see "ManageQueue" on page 339.

If the exception message queue contains events that have failed after the 
XML data of the event has been written to the database (in the event 
analysis stage), those events cause a “Duplicate XML event” warning when 
they are replayed to the event queue. You can safely ignore this warning.

Analyzer Recovery Mode
The Analyzer uses in-memory caches to accumulate and store event analysis 
data as well as the statistics data for the Static Component Topology. This 
data is flushed and written to disk frequently by separate flush threads. 

While the Analyzer is running, it keeps track of which events the analysis 
and statistics data has been flushed. If the writing of the cache data fails for 
any reason, the transaction and statistics data is incomplete, and the 
Analyzer schema is marked for RECOVERY mode. Failures that can lead to 
RECOVERY mode include database errors, event processing errors, and 
abnormal termination of the Analyzer process.

When an Analyzer whose schema has been marked for RECOVERY is 
started, the Analyzer goes into RECOVERY mode to regenerate the analysis 
and statistics data from the stored XML event. The time needed for the 
recovery process is proportional to the number of events that need to 
re-analyzed, and is usually slower than the normal event processing rate. 

ManageQueue.bat -iq TVISION.EXCEPTION.QUEUE -oq TVISION.EVENT.QUEUE 
-qm YOUR_QUEUE_ MANAGER
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When the Analyzer is in RECOVERY mode, the Analyzer status displays the 
number of events processed and the total number of events to process (for 
example, “230 of 2140 events processed”). Click Refresh to update the 
number of events processed. A log entry in the AppLog file also shows how 
many events need to be recovered:

If Trace logging is enabled for the Analyzer, the progress of the recover 
process is also logged. To enable trace logging for the Analyzer, set the value 
of the Trace property to On on the Analyzer Configuration page.

Once the data has been flushed to disk successfully, the recovery mode of 
the schema is reset, and the Analyzer starts up normally the next time. 

Note: If the data is not flushed because of a processing error which cannot 
be resolved, the Analyzer is not able to re-analyze the corresponding events 
and continue to start up in RECOVERY mode. In such a case, the recovery 
state can be cleaned out with the FlushStatusUtil utility. After the state has 
been cleaned, the Analyzer does not attempt to recover those events again. 
For more information about this utility, see "FlushStatusUtil" on page 338.
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Memory Resource Problems
The amount of memory the Analyzer can use for event processing is bound 
by the JVM parameter “-Xmx” which defines the maximum JVM heap size. 
The default value is 256 Megabytes, but this value can be changed via the 
JVMOPTS parameter in the <TVISION_HOME>\bin\start_analyzer.bat or 
start_analyzer.sh script.

If the in-memory caches in the Analyzer are configured too large, the 
Analyzer tries to keep more data in memory than the JVM is capable of and 
at some point throws an OutOfMemory exception such as: 

This error can indicate two different issues: a) the DB caches are too small 
for the event volume (solution is to increase the cache sizes on the Analyzer 
Cache tab), or b) the event data cannot be written fast enough to the 
database (solution is to increase the throughput of the database).

In this case the Analyzer stops processing, and the error is logged to the 
AppLog file. To resolve this problem either reduce the cache sizes on the 
Analyzer Configuration > Cache tab or increase the JVM heap size in the 
<TVISION_HOME>\bin\start_analyzer.bat or start_analyzer.sh script.

Another possible memory related error is the overflow of the analysis 
caches. When this error occurs, the following error is logged to the AppLog 
file:

A cache overflow means that the amount of data for one or more 
transactions that the Analyzer is trying to store in memory exceeds the 
configured capacity of the caches. The caches most likely to overflow are 
“LocalTransaction” (the size of which may be configured by the Transaction 
Objects setting), “RelationLookup”, and “EventRelation” (both of which 
may be configured by the Event Objects setting). 

TransactionVision Fatal(OutOfMemoryError) : Please check your TVision cache size 
settings in file <TVISION_HOME>/config/services/CacheSize.properties and the JVM 
heap size setting.

TransactionVision Error(EventAnalyzeFailed): Failed to analyze events from ('CSQ1' 
'TVISION.EVENT.QUEUE') in database ('TVISION'): TransactionVision 
Error(CacheOverflow): Overflow of DB cache RelationLookup in schema MQIMS
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The follow table summarizes possible causes of a cache overflow and 
includes instructions regarding how the problem may be corrected:  

Storing and Using Raw Events
The TransactionVision agents generate event messages and put them on the 
event queue. The Analyzer collects these event messages, processes them, 
and stores them in the database. The unprocessed event messages are called 
raw events.

TransactionVision provides two ways to store and re-process raw events in a 
JAR file: either using the ManageQueue utility or configuring the Analyzer 
during processing. 

Using the ManageQueue Utility

➤ ManageQueue can get raw events from a queue (such as the event queue 
or exception queue) to a JAR file. This can be used to obtain events that 
the Analyzer failed to process (if those events are still available on the 
exception queue) for initial investigation.

➤ ManageQueue can read a JAR file and put the events back to a queue 
(such as the event queue).

For more information about using the ManageQueue utility, see 
"ManageQueue" on page 339. Specifically, see the following examples:

➤ Archive all messages on the event queue into a jar file while leaving them 
on the queue.

➤ Replay all events stored in a jar file for the TVISION schema to the 
TVision–tv.qmgr communication link.

Cause of cache overflow Corrective action required

The monitored transaction data is very 
complex and requires larger cache sizes.

Increase the appropriate cache size 
parameter in CacheSize.properties.

An erroneous custom correlation or 
transaction bean generates a huge 
amount of incorrect relational or 
transactional data for one event.

Check the logic of any custom beans, 
especially the generation of custom 
relation lookup keys (see "Event and 
Transaction Correlation Problems" on 
page 121 for details).
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Configuring the Analyzer

The Analyzer can be configured to:

➤ Automatically store raw events that are collected during Analyzer 
processing into a JAR file. This should be used after a problem in the 
Analyzer has occurred to obtain all events that were collected. 

Note: Since writing the JAR file has a performance penalty it should never 
be enabled during production.

➤ Read raw events from the JAR file and process them as if they originated 
from the event queue.

➤ Enable JAR reading and writing during the Analyzer run time.

To configure a JAR file for storing raw events:

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Expand Processing Servers 

 4 Select <processing_server> > <analyzer>.

 5 (right pane) Click the Configuration > General tab.

 6 Set the Write to jar checkbox. 

 7 Stop and Start the Analyzer.

Once you start an Analyzer and collect events, a JAR file with the name 
SCHEMA_raw_events.jar is created in <TVISION_HOME>/logs. 

Any events for this Analyzer are stored in the JAR file. 

 8 Stop the Analyzer to use the JAR file. 

To configure a JAR file for processing raw events:

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Expand Processing Servers 
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 4 Select <processing_server> > <analyzer> 

 5 (right pane) Click the Configuration > General tab.

 6 Set the Read from jar checkbox. 

 7 Stop and Start the Analyzer. 

 8 Copy the JAR file with the name <SCHEMA>_raw_events.jar into 
$TVISION_HOME/logs. Replace <SCHEMA> with the actual schema name 
for the Analyzer. 

The Analyzer gets the JAR file, processes all events in the file, and then 
renames the JAR file to 
<SCHEMA>_raw_events.jar.processed.TIMESTAMP. This avoids the 
Analyzer from processing the JAR file again the next time the Analyzer is 
started. Also, this allows multiple JARs to be processed (after each one has 
finished processing) for one Analyzer.

To enable JAR writing, execute:

AnalyzerManager -debugcmd write_jar on

To disable JAR writing, execute:

AnalyzerManager -debugcmd write_jar off

To enable JAR reading, execute:

AnalyzerManager -debugcmd read_jar on

To disable JAR reading, execute:

AnalyzerManager -debugcmd read_jar off
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Event and Transaction Correlation Problems
The Analyzer issues the following warnings when it detects potential 
problems correlating events into local transactions or correlating local 
transactions into transactions.

Event Correlation

The event with the specified ID has been correlated into a message path 
together with an unusually large number of related events. If you are using 
custom correlation beans, this warning could indicate that the logic in the 
custom beans does not work correctly. 

If no custom correlation logic is in place, this warning could indicate that 
the message data in the events used for correlation are not well-suited for 
the standard correlation, and custom correlation may be necessary. For 
example, applications may re-use WebSphere MQ message IDs.

Transaction Correlation

The transaction with the specified ID consists of an unusually large number 
of local transactions. If you are using custom analysis beans, this warning 
could indicate that the logic in the custom beans does not work correctly. 

If no custom analysis logic is in place, this warning could indicate that the 
nature of the message data might not be well-suited for the standard 
analysis algorithms, and custom correlation/transaction logic may be 
necessary.

TransactionVision Warning(): Number of correlated events exceeds threshold: event 
ID=’(1245,23)’, count=30.

TransactionVision Warning(): Number of local transactions in one business transaction 
exceeds threshold: business txn ID=’32’, count=1000.
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Batching Multiple Listener Events in a Transaction
In environments where the WebSphere MQ channels have a non-zero 
BATCHINT (batch interval) parameter, events are batched up by the 
WebSphere MQ listener process and committed after n events. This causes 
TransactionVision to group together transactions that would normally be 
separate. 

To work around this issue, a local transaction definition file can be defined 
that splits up listener messages into separate local transactions or unit of 
works (UOW), regardless of their actual commit point. 
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The following is a sample definition file. Refer to the the 
HP TransactionVision Advanced Customization Guide PDF for more 
information about this file. The following rules may be further customized 
to include specific queues, queue managers or event brokers.

<LocalTransactionDefinition>

  <LocalTransactionType dbschema="*" hasMultiTracking= "false" >
    <Match xpath="/Event/StdHeader/TechName" operator= "EQUAL" 
value="MQSERIES"/>
    <Match xpath="/Event/StdHeader/ProgramName" operator= "EQUAL" 
value="AMQRMPPA"/>

    <LocalTransactionAttributes>

         <Attribute name="LookupKey">
             <Path>/LocalTransaction/LookupKey</Path>

             <ValueRule name="SetLookupKey">

                 <Value type="XPath">/Event/EventID/ @programInstID</Value>

                 <Value type="Constant">-</Value>
                 <Value type="XPath">/Event/EventID/ @sequenceNum</Value> 

        </ValueRule>

        </Attribute>

        </LocalTransactionAttributes>

  </LocalTransactionType>

</LocalTransactionDefinition>
123



Chapter 3 • Analyzers
JDBC Batch Error Due to Incorrect Database Version
The following exception in the Analyzer logs indicates that DB2 8.1 FixPack 
11 (also known as DB2 8.2 FixPack 4) is not installed:

2006-07-05 15:15:28,562 [MQJava0-July05-11] ERROR AppLog - TransactionVision 
Error(DBFailedEventStore): Failed to store events from ('chenhpc.tv1.manager' 
'TVISION.EVENT.QUEUE') in database ('tv'): Non-atomic batch failure. The batch was 
submitted, but at least one exception occurred on an individual member of the batch. 
Use getNextException() to retrieve the exceptions for specific batched elements.

2006-07-05 15:15:28,562 [MQJava0-July05-11] ERROR AppLog - TransactionVision 
Error(ProcessEventError): Error while processing event.

2006-07-05 15:15:28,562 [MQJava0-July05-11] ERROR AppLog - TransactionVision 
Error(JDBCBatchError): Error while executing JDBC batch operation 'INSERT INTO 
JULY05.USER_DATA (proginst_id, sequence_no, data_num, type, ccsid, event_time, 
user_data) VALUES (?,?,?,?,?,?,?)' - SQL Error : com.ibm.db2.jcc.b.vd: Non-atomic 
batch failure. The batch was submitted, but at least one exception occurred on an 
individual member of the batch. Use getNextException() to retrieve the exceptions for 
specific batched elements.
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Communication Links

This chapter includes:

Concepts

➤ Communication Links Overview on page 126

➤ Message Queues in Communication Links on page 127

➤ Message Queue Configurations on page 129

➤ Message Queue Requirements on page 132

➤ Default Communication Links on page 141

Tasks

➤ How to Create a Communication Link on page 143

➤ How to Assign a Communication Link to an Analyzer on page 144

➤ How to Test a Communication Link on page 144

➤ How to Modify a Communication Link on page 145

➤ How to Assign a Data Collection Filter to a Communication Link 
on page 146

➤ How to Monitor a Communication Link on page 146

➤ How to Remove a Communication Link on page 147

Reference

➤ Communication Links User Interface on page 148

Troubleshooting and Limitations on page 171
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Concepts

Communication Links Overview

A communication link defines the message queues used to pass 
configuration and event messages between an agent and an Analyzer. 
Communication links are created and managed through TransactionVision. 
Message queues are created and directly managed by a messaging 
middleware product. TransactionVision works with any of four messaging 
middleware products, including SonicMQ which is bundled and installed 
with the TransactionVision Processing Server. For more information about 
supported messaging middleware providers, see the HP TransactionVision 
Deployment Guide PDF.

Each agent has a communication link between it and the Analyzer to which 
it is sending events. For example, the following deployment scenario has 5 
communication links: 

TransactionVision 
Processing Server A

TransactionVision 
Processing Server B

Analyzer A

Analyzer C

Agent 1

Agent 2

Agent 3

Agent 4

Comm 
Link

Analyzer B

Analyzer D

Comm 
Link

Comm 
Link

Comm 
Link

Comm 
Link
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Message Queues in Communication Links 

Each communication link uses three message queues:

➤ Configuration queue. Agents monitor this queue for configuration 
messages from the Analyzer.

➤ Event queue. The Analyzer monitors this queue for event messages from 
agents. 

➤ Exception message queue. Contains events that fail to be processed by 
the Analyzer. These events are removed from the event queue and put on 
the exception message queue.

The following diagram shows the way events flow to and from the message 
queues:

This section describes the following queues:

➤ "Configuration Queues" on page 128

➤ "Event Queues" on page 129

➤ "Exception Message Queues" on page 129

Agent 1

TransactionVision 
Processing Server A

Analyzer A

Comm Link

Event Queue

Configuration Queue

Exception Message Queue
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Configuration Queues
The Analyzer sends configuration messages to the configuration queues. 
This configuration message defines the data collection filter conditions, the 
name of the event queue that event messages should be sent to, and when 
event collection should stop.

The Analyzer sends configuration messages at these times:

➤ A communication link setting is changed, such as specifying a new Time 
Server location. 

➤ A data collection filter assigned to the communication link is changed, 
such as new criteria was added or some criteria removed.

➤ A new data collection filter is assigned to the communication link. 

➤ The Analyzer state changes from INACTIVE to ACTIVE.

➤ The Analyzer is started.

When the Analyzer stops collecting events, it sends a new configuration 
message to the configuration queue indicating that no more events should 
be collected. The Analyzer can stop collecting events for any of the 
following reasons:

➤ Event collection is stopped for the Analyzer. 

➤ Events stop being sent by the agent because the end time specified in the 
data collection filter is reached.
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Event Queues
The agent evaluates each event in the monitored application against the 
data collection filter conditions specified in the configuration message. If 
the filter conditions are met, the agent creates an event entry message about 
the API call. The agent then delegates control to the user application to 
finish the work. When the work finishes, the agent creates an event exit 
message, and then passes the return on to the calling application. Entry and 
exit events are grouped into a single message to be put on the specified 
event queue. There may be more than one configuration message, so event 
messages may be put on more than one event queue. 

After the first successfully monitored event, the agent continues to check 
the configuration queue periodically for new configuration messages.

Exception Message Queues
If an event fails to be processed by the Analyzer, either because of an invalid 
event or an unexpected error or exception, the event is removed from the 
event queue and put on the exception message queue. 

Any fatal Java errors (such as OutOfMemoryError) causes the event to be put 
on the exception message queue and events are no longer pulled off the 
event queue until the Analyzer is restarted. If the exception message queue 
name is not specified, the failed events are discarded. 

You can use the ManageQueue utility to transfer messages from the 
specified exception message queue to an Analyzer for reprocessing. For more 
information, see See "ManageQueue" on page 339.

Message Queue Configurations

This section describes configuration requirements for the following 
communication link types:

➤ "WebSphere MQ Configurations" on page 130

➤ "TIBCO EMS Configurations" on page 130

➤ "SonicMQ Configurations" on page 131
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➤ "WebLogic JMS Configurations" on page 131

➤ "HTTP Based Queues" on page 131

WebSphere MQ Configurations
The following are possible configurations for agents that use WebSphere 
MQ:

➤ Both the agent and the Analyzer communicate directly with the same 
queue manager.

➤ The agent uses one queue manager and the Analyzer uses a different one.

➤ The agent uses one queue manager, and the Analyzer sends configuration 
messages to a second queue manager and monitors an event queue on a 
third queue manager.

➤ The agent uses one queue manager to monitor for configuration messages 
and a second queue manager to send event messages to; the Analyzer uses 
a third queue manager.

Most agent types can use WebSphere MQ, but not all can. See "Supported 
Messaging Middleware Providers" in chapter 3 of the HP TransactionVision 
Deployment Guide PDF for more information.

TIBCO EMS Configurations
The following are possible configurations for agents that use TIBCO EMS:

➤ Both the agent and the Analyzer communicate directly with the TIBCO 
EMS server.

➤ The agent uses one TIBCO EMS server, and the Analyzer uses a different 
one. The configuration queue and/or event queue on one TIBCO EMS 
server is defined as a route to the TIBCO route home queue of the same 
name on the other TIBCO EMS server. 

➤ The agent uses one TIBCO EMS server, and the Analyzer sends 
configuration messages to one TIBCO EMS server but use another TIBCO 
EMS server to retrieve events.
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Only some agent types can use Tibco EMS. See "Supported Messaging 
Middleware Providers" in chapter 3 of the HP TransactionVision Deployment 
Guide PDF for more information.

SonicMQ Configurations
The following are possible configurations for agents that use SonicMQ:

➤ Both the agent and the Analyzer communicate directly with the same 
SonicMQ broker.

➤ The agent uses one SonicMQ broker, and the Analyzer uses a different 
one. The configuration queue and/or event queue on one SonicMQ 
broker is listed as a routing definition to the queue on the other SonicMQ 
broker. 

➤ The agent uses one SonicMQ broker, and the Analyzer sends 
configuration messages to one SonicMQ broker but uses another 
SonicMQ broker to retrieve events.

Only some agent types can use SonicMQ. See "Supported Messaging 
Middleware Providers" in chapter 3 of the HP TransactionVision Deployment 
Guide PDF for more information.

For information about SonicMQ's Dynamic Routing Architecture, see the 
Progress SonicMQ Deployment Guide.

WebLogic JMS Configurations
The configuration queue and event queue must use the same WebLogic JMS 
server to make a connection.

Only some agent types can use WebLogic JMS. See "Supported Messaging 
Middleware Providers" in chapter 3 of the HP TransactionVision Deployment 
Guide PDF for more information.

HTTP Based Queues
If the agents in your deployment environment are not supported by one of 
the above messaging middleware providers, you can use HTTP-based 
message queues. 
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This type of message queue is used by the BEA Tuxedo and NonStop TMF 
agents. This type of queue can also be used by custom User Event Agents.

For more information about the HTTP acceptor, see the Sonic MQ product’s 
Deployment Guide (mq_deploy.pdf).

Only some agent types can use HTTP based queues. See "Supported 
Messaging Middleware Providers" in chapter 3 of the HP TransactionVision 
Deployment Guide PDF for more information.

Message Queue Requirements

If you are not using the SonicMQ messaging middleware product bundled 
with TransactionVision, you need to create and manage queues using the 
messaging middleware provider’s tools.

Note: TIBCO EMS and WebLogic JMS are supported only for release 8.0x 
agents. 

The queues to be used by TransactionVision have requirements as described 
below for each event transport provider type:

➤ "WebSphere MQ" on page 132

➤ "SonicMQ" on page 137

➤ "TIBCO EMS" on page 138

➤ "WebLogic JMS" on page 140

WebSphere MQ
The following sections describe the queue requirements for WebSphere MQ:

➤ "Message Length" on page 133

➤ "Queue Depth" on page 133

➤ "Event Queue Manager" on page 134
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➤ "Event Queue Storage" on page 134

➤ "Event Queue Message Persistency" on page 134

➤ "Queue Parameters" on page 135

➤ "Agent Security Permissions" on page 135

➤ "Analyzer Security Permissions" on page 135

Message Length

The message length requirements for configuration queues are small. A 
default configuration message uses approximately 500 bytes. However, 
specifying data collection filter conditions increases the size of 
configuration messages. A minimum message length of 10,000 bytes is 
required.

The length of event messages can vary greatly, depending on the parameters 
passed to the API, the user data passed through the calls, and data collection 
filter conditions. For event queues, it is recommended to use the default 
maximum message length of 4194304 bytes; a minimum message length of 
10,000 bytes is required. To restrict the message length based on your 
applications, consider the length of messages sent by your application and 
allow an additional 4000 bytes for event information.

Queue Depth

For configuration queues, the default queue depth should be sufficient. 
Analyzers send configuration messages to start data collection, to change 
data collection filter conditions, to end data collections, and to determine 
time skews across hosts. The number of configuration messages sent to a 
configuration queue depends on the number of Analyzers sending messages 
to the queue.

Event queue depth should be set to a value that matches the queue manager 
storage space based on the average event package message size. It should be 
adequate to handle the peak volume. It is recommended to use the largest 
queue depth possible for the event queue and, in the case of remote 
communication link configurations, all queues in between. 
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In some cases, agents put event messages on the event queues faster than 
Analyzers retrieve them. If event delay retry is enabled on the 
communication link, insufficient queue depth may result in event queues 
filling up and agents slowing down waiting for the Analyzer to catch up. 
Increasing the event queue depth helps prevent this situation.

Event Queue Manager

It is best to have the actual event queue hosted on a queue manager other 
than the production queue manager, so that issues related to event queues 
(such as running out of disk storage due to event backlog) does not affect 
normal operations. 

Note: The channel on which the TransactionVision event queue is located 
should have the channel property CONVERT set to NO. If this property is set 
to YES, event messages are discarded to the exception message queue. If the 
channel is being shared by queues that have messages that require the 
property to be set to YES, please create a separate channel specifically for the 
event queue.

Event Queue Storage

Event queue storage should match the event queue depth based on the 
event message size. It should not exceed the storage capability of the queue 
manager host system. This is especially important when the event queue 
and exception message queue are hosted by the production queue manager 
because running out of storage space may stop the queue manager 
completely.

Event Queue Message Persistency

The event queue message persistency property should match the event 
collecting policy.
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Queue Parameters

Queue parameters require the following:

➤ Configuration and event queues must:

➤ have the Default Share Option (DEFSOPT) set to SHARED.

➤ allow Shared Access (SHARED).

➤ allow Get (GET(ENABLED)) and Put (PUT(ENABLED)) operations.

➤ TransactionVision configuration queues must allow messages of at least 
10,000 bytes in length (MAXMSGL).

➤ TransactionVision event queues must allow messages of at least 10,000 
bytes in length (MAXMSGL).

➤ All channels (including client channels) must have MAXMSGL of at least 
10,000 bytes.

Agent Security Permissions

Userids of programs using the agent require the following:

➤ GET and BROWSE authority to the configuration queue.

➤ PUT authority to the event queue.

Analyzer Security Permissions

Users of the Analyzer require the following:

➤ PUT, GET, BROWSE, and INQ authority to all configuration and event 
queues. 

➤ Passid permission to test communication links.

Note that Analyzer users can be given authority to only subsets of the 
configuration/event queues if you want to limit access to certain agents.
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If a user does not have the required access permission on the configuration 
queue (TVISION.CONFIGURATION.QUEUE by default), the following 
message is found in the agent logs:

To set access permission of TVISION.CONFIGURATION.QUEUE for a user 
(tester in this example), run the following command:

It returns a message that the command completed successfully.

To display the access permission of TVISION.CONFIGURATION.QUEUE for a 
user (tester in this example), run the following command:

It returns output similar to the following example:

TransactionVision agent: cannot open event queue 
TVISION.CONFIGURATION.QUEUE on queue manager merce.es1.manager: Not 
authorized for access.

setmqaut -m queuemanager -n TVISION.CONFIGURATION.QUEUE -t queue -p tester. 
+get +browse +put +inq

dspmqaut -m queuemanager -n TVISION.CONFIGURATION.QUEUE -t queue -p tester

Entity tester has the following authorizations for object 
TVISION.CONFIGURATION.QUEUE:
   get
   browse
   put
   inq
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SonicMQ
SonicMQ is included with each TransactionVision Processing Server. The 
messaging queues are created automatically and you do not need to 
configure them as described here. See "Default Communication Links" on 
page 141. 

However you can use a standalone version of SonicMQ if necessary for your 
deployment environment. The following sections describe the queue 
requirements for SonicMQ:

➤ "Event Queue SonicMQ Broker" on page 137

➤ "Event Queue Storage" on page 137

➤ "Queue Parameters" on page 138

➤ "Agent Security Permissions" on page 138

Event Queue SonicMQ Broker

It is best to have the actual event queue hosted on a SonicMQ broker other 
than the production broker, so that issues related to event queues (such as 
running out of disk storage due to event backlog) do not affect normal 
operations.

Event Queue Storage

Event queue storage should not exceed the storage capability of the 
SonicMQ broker host system. This is especially important when the event 
queue and TransactionVision exception message queue are hosted by the 
production SonicMQ broker. The behavior of the production SonicMQ 
broker may be unpredictable if you run out of storage space.
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Queue Parameters

Queue parameters require the following:

➤ TransactionVision configuration and event queues must allow receive, 
send, and browse operations that are defined at TransactionVision setup, 
to be granted to the user.

➤ TransactionVision configuration queues must allow messages of at least 
10,000 bytes in length (maxbytes).

➤ TransactionVision event queues must allow messages of at least 10,000 
bytes in length (maxbytes).

Agent Security Permissions

The user name that is used by the agent must have the following 
permissions to use the configuration and event queues:

➤ receive and browse permission to the TransactionVision configuration 
queue

➤ send permission to the TransactionVision event queue

Furthermore, to allow the SonicMQ Agent to resolve route and bridge 
information correctly, the user name provided in SonicMQ broker setup 
must have administrative permission.

TIBCO EMS
The following sections describe the queue requirements for TIBCO EMS:

➤ "Event Queue TIBCO EMS Server" on page 139

➤ "Event Queue Storage" on page 139

➤ "Event Queue Message Persistency" on page 139

➤ "Queue Parameters" on page 139

➤ "Agent Security Permissions" on page 140

➤ "Analyzer Security Permissions" on page 140
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Event Queue TIBCO EMS Server

It is best to have the actual event queue hosted on a TIBCO EMS server other 
than the production EMS server, so that issues related to event queues (such 
as running out of disk storage due to event backlog) do not affect normal 
operations.

Event Queue Storage

Event queue storage should not exceed the storage capability of the TIBCO 
EMS server host system. This is especially important when the event queue 
and TransactionVision exception message queue are hosted by the 
production TIBCO EMS server because running out of storage space may 
cause unpredictable behavior of the production EMS server.

Event Queue Message Persistency

The event queue message persistency property should match the event 
collecting policy.

Queue Parameters

Queue parameters require the following:

➤ Configuration and event queues must allow receive, send, browse 
operations are granted to the user that are defined at TransactionVision 
setup.

➤ Configuration queues must allow messages of at least 10,000 bytes in 
length (maxbytes).

➤ Event queues must allow messages of at least 10,000 bytes in length 
(maxbytes).
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Agent Security Permissions

The user used by the agent to connect to configuration and event queues 
must have the following permissions:

➤ receive and browse permission to the configuration queue

➤ send permission to the event queue

Furthermore, to allow the TIBCO EMS Agent to resolve route and bridge 
information correctly, the user name provided in TIBCO EMS server setup 
must have administrative permission

Analyzer Security Permissions

The user used by the Analyzer to connect to configuration and event queues 
must have the following permissions:

➤ send, receive, browse permission to all configuration and event queues

➤ view-destination permission on event queues to check the pending 
unprocessed event count

WebLogic JMS

Queues
Point-to-point queues should be used for all TransactionVision queues.

JMS Server Configuration
If possible, create a separate JMS Server to host the queues needed for 
TransactionVision.

Configure the JMS Server to use "File Persistent Store".
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Default Communication Links

TransactionVision includes the following default communication links: 

SonicMQ
This commlink includes a SonicMQ broker installed and started 
automatically on the host on which the Analyzer is running. 

The communication link is configured to have both the Analyzer and agent 
connect to the same broker. 

SonicMQ RUM
This communication link is used only for RUM to send events to 
TransactionVision.

If this communication link is assigned to an Analyzer, the configuration 
information is automatically filled in for your deployment environment. See 
"Enabling an Analyzer for RUM" in "Key Configuration Concepts for 
Analyzers" on page 73.

No data collection filter can be assigned to this communication link. 

SonicMQ HTTP
This communication uses a SonicMQ broker configured with an HTTP 
listener and installed on the host on which the Analyzer is running.

This commlink is used if the standard technology agents are not used to 
monitor the application. The HTTP protocol must be used by the user agent 
to send events to the analyzer.

The event queue is called HTTP.EVENT.QUEUE, and the exception queue is 
called HTTP.EXCEPTION.QUEUE.
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Agents post HTTP messages to the HTTP acceptor URL 
http://<hostname>:21113/tv_http and SonicMQ broker receives the 
messages and forwards them to HTTP.EVENT.QUEUE as JMS messages, which 
are then read by the Analyzer.

To configure the HTTP communication link to use SSL, you would change 
the URL to be https://<hostname>:21114/tv_http.
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Tasks

How to Create a Communication Link

This task describes how to create a new communication link.

This task includes the following steps:

➤ "Prerequisites" on page 143

➤ "Step Through the Communication Link Wizard" on page 143

➤ "How to Assign a Communication Link to an Analyzer" on page 144

 1 Prerequisites

You should first determine if one of the built-in communication links 
meets your requirements. If it does, you do not need to create a new 
communication link. For information about the default communication 
links, see "Default Communication Links" on page 141. 

The Communication Link Wizard will collect information from you 
about the agent’s environment and the Analyzer’s environment. The 
information that you will need to specify is described in "Message Queue 
Requirements" on page 132. You will also need to know the names of the 
event queue, configuration queue, and the exception queue.

Except for SonicMQ, these queues are created by using 3rd-party 
messaging middleware provider tools. 

 2 Step Through the Communication Link Wizard 

 a Select Admin > Transaction Management.

 b (left pane) Select the Configuration tab.

 c Click the New button and select New Communication Link.

The Communication Link Wizard appears. For details about this 
interface, see "Communication Link Wizard" on page 149.
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How to Assign a Communication Link to an Analyzer

This task describes how to assign a communication link to an Analyzer.

 1 Prerequisites

Determine which Analyzer should handle the incoming events. See the 
HP TransactionVision Planning Guide PDF for more information.

 2 Assign the Communication Link to the Analyzer

See "How to Assign a Communication Link to an Analyzer" on page 83.

 3 Verify the Communication Link is working

To test the communication link; see "How to Test a Communication Link" 
on page 144. 

If the test shows the communication link is working successfully, the 
communication link is effective immediately. Events should appear on 
the Event Analysis report.

How to Test a Communication Link

This task describes how to test a communication link.

 1 Select Admin > Transaction Management.

 2 (left pane) Select the Configuration tab.

 3 Select Communication Links. 

 4 (right pane) Select the communication link to test.

 5 Choose the Analyzer with which to test from the drop-down list. 
Typically you would select the Analyzer that are going to assign the 
communication link to. 

 6 Click Test. 
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If the selected communication link uses WebSphere MQ queues, the 
selected Analyzer sends a request message to the configuration queue 
requesting a confirmation on arrival (COA). The COA report message is 
sent to the event queue by the configuration queue that the 
communication link is configured to monitor. The end result is much like 
the behavior of typical communication between the Analyzer and agents. 
The communication link entry in the list of communication links is 
updated to show the Analyzer and test status. 

If the selected communication link uses SonicMQ, WebLogic JMS, or 
TIBCO EMS, the test only checks whether the selected Analyzer can 
successfully make a connection to the given configuration queue and 
event queue.

If the test fails, the error message is displayed in the Test Status column. 
The following are the most common reasons for a communication link 
test to fail:

➤ Timeout waiting for a reply message

This error is typically caused by channel problems with remote 
configurations. The request message may not make it to the final 
queue manager that is to report, or the report message may not make it 
to the queue manager to which the Communication Link Editor is 
connected. If the link test fails for this reason, see "Troubleshooting 
and Limitations" on page 171.

➤ WebSphere MQ errors

WebSphere MQ problems within the communication link are reported 
with the WebSphere MQ error reason, which usually provides enough 
information to isolate the problem.

How to Modify a Communication Link

This task describes how to modify a communication link:

 1 Select Admin > Transaction Management.

 2 (left pane) Select the Configuration tab.

 3 Expand Communication Links. 
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 4 Select the communication link to modify.

 5 (right pane) Modify the desired settings. See "Communication Link Page" 
on page 170. 

 6 Retest the communication link if desired. 

How to Assign a Data Collection Filter to a 
Communication Link

Data collection files can be assigned only to communication links that are 
assigned to an Analyzer. 

This task describes how to assign a data collection filter to a communication 
link. 

 1 Select Admin > Transaction Management.

 2 (left pane) Select the Configuration tab.

 3 Expand Processing Servers. 

 4 Navigate to and select the Analyzer that has the target communication 
link. 

 5 (right pane) In the Communication Link and Data Collector Filter 
Assignment area, right-click the target communication link and select 
Assign a Data Collection Filter. 

 6 Choose the target data collection filter from the Available data collection 
filters dialog and click OK.

 7 Click Apply.

How to Monitor a Communication Link

The Processing Server Summary page displays the status and activity of each 
communication link in the deployment environment. See "Processing 
Servers Summary Page, Status Tab" on page 57.
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How to Remove a Communication Link

 1 Select Admin > Transaction Management.

 2 (left pane) Select the Configuration tab.

 3 Expand Communication Links. 

 4 Right-click the communication link name and select Delete.
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Reference

Communication Links User Interface

This section describes:

 ➤ Communication Link Wizard on page 149

 ➤ Communication Links Summary Page on page 168

 ➤ Communication Link Page on page 170
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Communication Link Wizard

This wizard enables you to create a communication link. 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  From the New menu, select New Communication Link. 

Important 
information

➤ Queues must be created before the communication 
link can be used, but do not need to exist to define the 
communication links with this wizard. See "Message 
Queue Requirements" on page 132 for details.

➤ You can also create a communication link by copying 
an existing one and modifying its properties. See "How 
to Modify a Communication Link" on page 145 for 
details. 

Relevant tasks ➤ "How to Create a Communication Link" on page 143

Wizard map The Communication Link wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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General Page
This wizard page enables you to name the new communication link and 
specify the type of event transport provider it requires.

Important 
information

➤ General information about this wizard is available 
here: "Communication Link Wizard" on page 149.

➤ TransactionVision includes one event transport 
provider product: SonicMQ. Other event transport 
providers are supported but must be obtained, 
installed and configured using the product vendor’s 
tools. 

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Agent Connection Page
This wizard page enables you to specify the queue details for the Agent-
specific queues.

UI Elements Description

Communication link 
name:

Enter a name for the communication link, which must 
be unique to the deployment environment. 

Select an event 
transport provider

Specify the event transport provider that the agents and 
Analyzer for this communication link use. Options are: 

IBM WebSphere MQ
TIBCO EMS
Progress SonicMQ
BEA WebLogic JMS
Other JMS Provider

Default: IBM WebSphere MQ

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

IBM WebSphere MQ

UI Elements Description

Queue manager the 
Agent will connect 
to:

The name of the queue manager that the agents connects 
to. This queue manager must be used by applications to 
be monitored. 

Queue the Agent will 
receive configuration 
messages from:

The name of the queue that agents check for 
configuration messages. This queue must be a local 
queue on the specified queue manager. 

The configuration queue used by a WebSphere MQ Agent 
must be on the same queue manager used by the 
application being monitored.

Default value: TVISION.CONFIGURATION.QUEUE

Queue the Agent will 
send event messages 
to:

The name of the queue to which agents send event 
messages. This queue should only be used by 
TransactionVision. 

Default value: TVISION.CONFIGURATION.QUEUE

Is event queue in a 
cluster?

Select Yes if the queue is in a cluster.

If it is not a local queue, select No and specify either the 
name of the transmission queue that has the same name 
as the remote queue manager or a queue manager alias 
that resolves to the remote queue manager. This method 
of sending messages is described in the WebSphere MQ 
Application Programming Guide. 

Default value: No

Should Agent use the above Queue as Transmission 
Queue/Queue Manager alias to open event queue? 
Select No to enter a different transmission queue or 
queue manager alias name below.

Transmission Queue/Queue Manager alias name. The 
transmission queue or queue manager alias name.
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TIBCO EMS

Progress Sonic MQ

UI Elements Description

EMS Server 
hostname and port 
the Agent will 
connect to:

The EMS Server host and port to which the agent 
connects. Choose the protocol.

User Name: The user name the agent uses to connect to the EMS 
Server. 

Password: The password associated with the user name above. 

Queue the Agent will 
receive configuration 
messages from:

The name of the queue that agents check for 
configuration messages.

Queue the Agent will 
send event messages 
to:

The name of the queue to which agents send event 
messages. This queue should only be used by 
TransactionVision.

UI Elements Description

Broker hostname and 
port the Agent will 
connect to:

The broker host and port to which the agent connects. 

User Name: The user name the agent uses to connect to the broker.

Password: The password associated with the user name above. 

Queue the Agent will 
receive configuration 
messages from:

The name of the queue that agents check for 
configuration messages.

Default value: TVISION.CONFIGURATION.QUEUE

Queue the Agent will 
send event messages 
to:

The name of the queue to which agents send event 
messages. This queue should only be used by 
TransactionVision.

Default value: TVISION.EVENT.QUEUE
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BEA WebLogic

Other JMS Providers

UI Elements Description

Broker hostname and 
port the Agent will 
connect to:

The broker host and port to which the agent connects. 
Default value: 7001

Queue Connection 
Factory JNDI Name:

The JNDI name of the queue connection factory.

User Name: The user name the agent uses to connect to the broker. 

Password: The password associated with the user name above. 

Queue the Agent will 
receive configuration 
messages from:

The name of the queue that agents check for 
configuration messages. 

Default value: TVISION.CONFIGURATION.QUEUE

Queue the Agent will 
send event messages 
to:

The name of the queue to which agents send event 
messages. This queue should only be used by 
TransactionVision.

Default value: TVISION.EVENT.QUEUE

UI Elements Description

JNDI Provider 
Context Factory:

The initial context factory of the JMS provider. 

JNDI Provider URL 
Agent will connect 
to:

The URL that the agent uses to connect to the JNDI 
naming service. 

Queue Connection 
Factory JNDI Name:

The JNDI name of the queue connection factory. 

User Name: The user name the agent uses to connect to the JNDI 
provider. 

Password: The password associated with the user name above. 
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Analyzer Connection Page
This wizard page enables you to specify which queues the Analyzer connects 
to.

Queue the Agent will 
receive configuration 
messages from:

The name of the queue that agents check for 
configuration messages.

Default value: TVISION.CONFIGURATION.QUEUE

Queue the Agent will 
send event messages 
to:

The name of the queue to which agents send event 
messages. This queue should only be used by 
TransactionVision.

Default value: TVISION.EVENT.QUEUE

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132

UI Elements Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Queue Settings Page
This wizard page enables you to specify the queue information for the 
Analyzer. This page appears only if No was specified on the previous page 
(Analyzer Connection page). 

UI Element Description

Should the Analyzer 
connect to the same 
queues and queue 
manager used by the 
Agent? 

Select Yes if the Analyzer should connect to the same 
queues that the Agent connects to. This requires that the 
Analyzer is running on the same host on which the 
queue manager, SonicMQ Broker, JMS Server or TIBCO is 
installed. 

Select No if the Analyzer should connect to different 
queues than the agent connects to. You will specify the 
queue details on the next page of the wizard. 

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Is the Analyzer going 
to use the same 
queue manager for 
configuration and 
event messages? 

Select Yes if the Analyzer should use the same queue 
manager for both configuration and event messages. 

Select No if the Analyzer should use different queue 
managers for configuration and event messages.

Queue Manager to 
which the Analyzer 
will connect for 
sending 
configuration 
messages

The name of the queue manager the Analyzer uses.

Queue the Analyzer 
will send 
configuration 
messages to

The name of the queue that the Analyzer should send 
configuration messages to. This queue must be a remote 
queue for the configuration queue on the agent queue 
manager.

Default value: TVISION.CONFIGURATION.QUEUE

Queue Manager to 
which the Analyzer 
will connect for 
receiving event 
messages 

The name of the transmission queue or queue manager 
alias. 

This option is used only if No is selected above. 

Queue the Analyzer 
will receive event 
messages from:

The name of the queue the Analyzer checks for event 
messages. 

Default value: TVISION.EVENT.QUEUE
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Connection Settings Page
This wizard page enables you to specify the connection information for the 
Analyzer. 

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Will the Analyzer use 
client connection 
mode to 
communicate with 
the Queue Manager? 

Yes if the Analyzer will connect in client mode.

No if the Analyzer will connect in server mode. Specify 
specific options below. 

Default Value: No

Channel for 
<configuration 
queue manager>

The channel for the configuration queue manager. 

Host for 
<configuration 
queue manager>

The host name or IP address for the configuration queue 
manager.

Port for 
<configuration 
queue manager>

The port for the configuration queue manager. 

CCSID for 
<configuration 
queue manager>

Choose the CCSID for the event queue manager. 

Required only if the queue manager uses double-byte. 

Channel for <event 
queue manager>

The channel for the event queue manager. 

Host for <event 
queue manager>

The host name or IP address for the event queue 
manager. 

Port for <event 
queue manager>

The port for the event queue manager. 

CCSID for <event 
queue manager>

Choose the CCSID for the event queue manager. 

Required only if the queue manager uses double-byte. 
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Domain Manager Page
This wizard page enables you to specify SonicMQ domain information if 
you are not using the default domain. 

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Domain Name: The SonicMQ Domain Name to which the brokers 
belong. Default value: Domain1.

Domain Manager 
hostname and port 
Analyzer will connect 
to

The host and port of the SonicMQ Domain Manager 
listener to which the Analyzer connects. This allows you 
to query for the event queue depth. Specify in the form 
of hostname:port. Default value(port): 21111

User Name: A user name to connect to the SonicMQ Domain 
Manager. Default value: none

Password: The password associated with the user name above. 
Default value: none

Name of broker with 
event queue to be 
queried via the 
Domain Manager: 

The name of the broker to which the Analyzer connects 
to collect events. This name is used to query the event 
queue depth through the Domain Manager.

If not specified, the unprocessed event count that 
normally appears on the Analyzer Status page is not 
available. 
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Event Options Page
This wizard page enables you to configure the event queue maximum size 
and the behavior to follow when an event message cannot be delivered. 

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Event Queue 
Maximum Message 
Length (10000 - 
2147483647)

The maximum event message length in bytes.

A minimum message length of 10,000 bytes is required; 
to calculate the size needed for the monitored 
application see "Message Queue Requirements" on 
page 132.

Default value: 4194304

Event Retry on 
Failure

(Does not apply to WebSphere Agents)

If the agent cannot connect to the Queue Manager, EMS 
Server, JMS Server or SonicMQ broker, specifies how 
often reconnection is attempted:

Retry forever every <interval> at every TransactionVision 
event. Continues to retry at the specified interval as long 
as event collection is in progress. Note that this option 
can cause every application API call to slow down in the 
event of a connection failure, reducing application 
performance significantly. This option is recommended 
for an audit environment where all events must be 
logged.

Retry every <interval> across TransactionVision events. 
Continues to retry at the specified interval as long as 
event collection is in progress. However, the 
reconnection time delay is not incurred for each API call, 
but at a given frequency. 

Retry once per TransactionVision event. Retries once for 
each event. This option reduces the impact on 
application performance if a connection is lost, but 
Transaction Management events are lost if the retry 
attempt is not successful.

Retry every <interval> for <duration> at every 
TransactionVision event. Continues to retry at the 
specified interval until the timeout is reached. 

Default value: Retry forever every 10 seconds.
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Time Server Page
This wizard page enables you to specify the time server to calculate the time 
skew information for the Analyzer and agents.

Enable retry event 
upon failure

Retry if the agent fails to put an event on the event 
queue. Not recommended for a production environment.

The Event Delivery Retry on Failure elements are enabled 
if this option is specified:

Retry timeout. The number of seconds, minutes, or hours 
to continue to retry. Default: retry forever.

Retry interval. The number of milliseconds or seconds 
that the Agent waits between failed retry attempts.

Default value: retry forever every 10 seconds.

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Key Configuration Concepts for Analyzers" on 
page 73

UI Elements Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Miscellaneous Information Page
This wizard page enables you to specify miscellaneous information for the 
Analyzer and agents. 

UI Elements Description

Use the Time Server 
Running in the 
Processing Server

Use the time server within the Processing Server hosting 
the Analyzer to calculate all time skews. Otherwise, 
specify the name of the host running the Time Server 
and its port number. 

Default value: Checked

Time Server Host: The host name on which the Time server is running.

Time Server Port: The port number for the Time Server. 

Important 
information

General information about this wizard is available here: 
"Communication Link Wizard" on page 149

Wizard map The Communication Link Wizard contains:

General Page > Agent Connection Page > Analyzer 
Connection Page > Queue Settings Page > Connection 
Settings Page > Domain Manager Page> Event Options 
Page > Time Server Page > Miscellaneous Information 
Page

See also ➤ "Message Queue Requirements" on page 132
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Exception message 
queue name

The name of the exception message queue. This queue is 
always managed by the same queue manager, broker, or 
Server that manages the event queue.

Default value: TVISION.EXCEPTION.QUEUE. 

Number of event 
collection threads (1-
100)

The number of event collection threads, from 1 to 100. 
This value should match the results from the DBMS 
insert test: DB2Test, OracleTest, SQLServerTest. For 
information about these utilities, see the 
HP TransactionVision Deployment Guide PDF.

Default Value: 1

Enable Agent trace 
logging

Enables verbose logging information of 
TransactionVision agent operation. This option is 
intended for troubleshooting and should not be turned 
on in production environments. For information about 
the agent log file locations, see the HP TransactionVision 
Deployment Guide PDF.

Default: Off

Enable event 
persistence

Enables event persistence. Default: Off

Event persistence guarantees that an event message is 
physically stored on a queue.  For instance, the event 
messages are no lost if the queue manager/broker/server 
is restarted. Event persistence is a feature of the 
messaging middleware provider. 

Enable support for 
processing user 
defined events

Enables user-defined events processing. User events are 
events created by user applications beyond those 
originating from the standard TransactionVision agents. 
For information about implementing user events in 
applications, see the the HP TransactionVision Advanced 
Customization Guide PDF. 

Default Value: Off. The communication link is 
configured to process standard agent events only. 
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Store user data: Causes the Analyzer to store the user data portion of the 
event message in the database and the data is therefore 
available in the Event Detail page. Storing user data 
increases the Analyzer size requirements and may 
degrade Analyzer performance. Default Value: On

Store event 
document:

Causes the Analyzer to store the event XML data in the 
database and the data is therefore available in the Event 
Detail page. Storing event XML data increases the 
Analyzer size requirements and may degrade Analyzer 
performance.

If set to Off, the Analyzer is not able to recover event 
analysis data if the database. 

Default Value: On

Store raw events: Causes the Analyzer to store a copy of the raw events in 
the database. Raw events are those pulled directly from 
the event queue and not yet processed by the Analyzer. 
This option is intended for troubleshooting and should 
not be turned on in production environments.

For information about using raw events, see "Storing and 
Using Raw Events" on page 118.

Default Value: Off

UI Elements Description
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Communication Links Summary Page

This page enables you to view the status of all communication links in the 
deployment environment. The following is an example of the 
Communication Links Summary page.

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Communication Links.

Important 
information

The diagram represents the queue names and 
configuration for the selected communication link. 

See also ➤ "How to Test a Communication Link" on page 144

➤ "How to Create a Communication Link" on page 143

➤ "How to Remove a Communication Link" on page 147
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Analyzer The Analyzer with which to test the communication link. 

Analyzer Tested On The time at which the communication link was last 
tested. 

Name The communication link name. 

Queue Manager/JMS 
Server

The queue manager or JMS server that the Agent 
connects to. 

Tests the selected communication link. 

Time Skew At the time the communication link was last tested, the 
time skew between the Analyzer host and the host on 
which the configuration queue’s queue manager/JMS 
server/SonicMQ broker host is running. 

Test Status Test results. If the communication link test fails, the error 
message should indicate which queue, queue manager or 
event broker failed — make sure the specified queue, 
queue manager or event broker has been created.
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Communication Link Page

This page enables you to edit the communication link settings.

General Settings Area

The settings in this area are described as part of the Communication Link 
Wizard, where they are originally set. See "General Page" on page 150, "Time 
Server Page" on page 164 and "Miscellaneous Information Page" on 
page 165.

 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Expand the Communication Links folder. 

4  Select <communication link>.

Important 
information

Depending on your changes, the following message may 
be displayed:

This significant change to the communication link could 
leave unprocessed events intended for the previous 
communication link definition on the event queue. It is 
recommended to only make this change while the event 
queue is empty. Proceed with this change?

[Yes] [No]

 Then click Yes to confirm your changes. 

Note that due to event packaging, the agent may have 
events buffered but not yet sent to the event queue. To 
force buffered events to be sent to the event queue restart 
the Analyzer.

See also ➤ "Communication Links Overview" on page 126

➤ "Message Queues in Communication Links" on 
page 127

➤ "Message Queue Configurations" on page 129

➤ "Message Queue Requirements" on page 132
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<event transport provider> Connection Area

The settings in this area are described as part of the Communication Link 
Wizard, where they are originally set. See "Connection Settings Page" on 
page 158.

 

Event Retry on Failure

The settings in this area are described as part of the Communication Link 
Wizard, where they are originally set. See "Event Options Page" on page 162.

Troubleshooting and Limitations

If the communication link does not appear to be collecting the expected 
events, there may be a problem with the communication link. 

To diagnose the problem, perform the following steps:

 1 Ensure that the communication link is assigned to at least one Analyzer 
and the results of testing the communication link are successful.

 2 Ensure that data collection filters are not filtering out the events you 
expect to see. 

 3 If you are viewing the collected events based on a query, ensure that the 
query is getting the right event data from the database.

 4 Ensure that an agent is intercepting WebSphere MQ API calls from the 
monitored application. On UNIX and Windows platforms, set the 
TVISION_BANNER environment variable, then start the application. A 
banner indicating that the application is loading the agent should appear. 
To disable this behavior, unset TVISION_BANNER. This environment 
variable can be set to any value. On Windows, it must be set to a value 
other than an empty string. On i5/OS, TVISION_BANNER does not display 
the library path as it does on UNIX.

If not, set the environment variable for your platform to cause the 
application to load the agent library instead of the standard WebSphere 
MQ library. 
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The following table shows the appropriate environment variables:  

On z/OS, the CICS region prints a message when it connects to the queue 
manager or event broker, indicating that the WebSphere MQ crossing exit 
was found and used. If the WebSphere MQ crossing exit was not found or 
loaded, a message indicating the error appears. 

 5 If the agent library is being loaded by the application, check the 
monitored application host’s system log for any error messages. 

 6 If there are no error messages in the system log, enable trace logging for 
the active communication links. 

Look at the trace messages in the application host’s UNIX system log, 
Windows event log, z/OS operator console log, or i5/OS user’s job log for 
any WebSphere MQ-related errors or messages that indicate that the data 
collection criteria such as collection time or collection entities were too 
restrictive.

On UNIX platforms, you can specify the log facility by setting the 
TVISION_SYSLOG environment variable to one of the following values: 
user, local0, local1, local2, local3, local4, local5, local6, or local7. If 
TVISION_SYSLOG is not set or is set to a value other than those listed, 
TransactionVision uses local0. The target log file must already exist.

To view the job log on i5/OS, use the DSPJOBLOG command.

Platform Environment Variable

Windows PATH

Sun Solaris LD_LIBRARY_PATH

HP-UX SHLIB_PATH

Linux LD_LIBRARY_PATH

IBM AIX LIBPATH
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Data Collection Filters

This chapter includes:

Concepts

➤ Data Collection Filters Overview on page 174

➤ Categories of Filter Criteria on page 175

➤ About Building the Data Collection Filter on page 176

➤ Guidelines for Good Data Collection Filtering on page 178

Tasks

➤ How to Create a Data Collection Filter on page 179

➤ How to Assign a Data Collection Filter to a Communication Link 
on page 181

➤ How to Modify a Data Collection Filter on page 181

➤ How to Remove a Data Collection Filter on page 182

Reference

➤ Data Collection Filters User Interface on page 183
173



Chapter 5 • Data Collection Filters
Concepts

Data Collection Filters Overview

Collecting all possible event information about all API calls can cause the 
TransactionVision database to grow quite large. It also adds to your 
communication link overhead — the more events that are collected, the 
more event messages are sent back to the Analyzer for processing. 

You typically do not need to collect all information about every event that 
occurs in the monitored application to successfully obtain business 
transaction information. For example, you may only need to collect events 
that occur on a specific host, events for a specific API, events with a specific 
MQI reason code, or events with a specific value in the user data. 
Additionally, you may require only a subset of the user data for each event.

Data collection filters limit the number of events and the amount of data for 
each event that agents collect and forward to the Analyzer. The Analyzer 
communicates data collection filter criteria to agents through configuration 
messages. The agent only collects events that match the filter criteria 
specified in the configuration message:

Data collection filters 
filter out events that 
get put on the Event 

queue 

Agent 1

TransactionVision 
Processing Server A

Analyzer A

Comm Link

Event Queue

Configuration Queue

Exception Message Queue
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A data collection filter is assigned to a particular communication link. A 
communication link can have more than one data collection filter assigned 
to it, and a specific data collection filter can be assigned to more than one 
communication links. 

Categories of Filter Criteria 

A data collection filter has many criteria that can be specified as part of the 
filter. The criteria are grouped into the following categories:

➤ Common Options

Criteria that can be specified for any type of agent such as the hose on 
which the event occurred, or the program name that generated the event. 

➤ Technology-specific options

CICS: criteria for the CICS Agent
EJB: criteria for EJB-related messages of the Java Agent
JDBC: criteria for JDBC-related messages of the Java Agent
JMS: criteria for JMS-related messages of the Java Agent
Servlet: criteria for servlet-related messages of the Java Agent
WebSphere MQ: criteria for WebSphere MQ Agent
User Event: criteria for the Tuxedo, .NET, and NonStop TMF Agents
175



Chapter 5 • Data Collection Filters
All filter criteria in the Common Options category can be overridden in the 
technology-specific category. For example, you can specify All Hosts as a 
common option that applies to all technologies. Then for the JMS specific 
technology, you can specify host Host1. Then only JMS events originating 
on Host1 match the filter criteria.

About Building the Data Collection Filter

When creating a data collection filter, you typically supply multiple criteria. 
The criteria work together as follows:

➤ Selections within the same criteria and data collection filter are ORed 
together.

➤ Include/Exclude is applied to the overall criteria. For example: !(a OR b 
OR c)). An event only meets filter criteria if it matches all criteria specified 
for the filter. The AND operation is used within each filter.

➤ Different criteria selections within the same data collection filter are 
ANDed together.

➤ You may need to define more than one filter to meet your specific 
requirements.

➤ Multiple Data Collection Filters are ORed. For example: (Filter1) OR 
(Filter2)). The agent collects events that meet the criteria for any assigned 
filter. The OR operation is used between filters.

For example, suppose you want to collect all events from applications 
TradeServlet and TradeSession, except MQCMIT events. You also don't want 
to collect any event with the MQRC_NO_MSQ_AVAILABLE reason code.
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You would use a single data collection filter with the three criterion settings. 
The Summary pane in the Data Collection Filter page displays the filter as 
follows:

Only events that meet all three criteria are collected; the criteria are AND'd.

If you have another application on the monitored system for which you do 
want to collect MQCMIT events, you would create a second data collection 
filter for this and apply both data collection filters to the communication 
link. 

The Default Filter

If no data collection filter is specified, then the default filter is used. This 
filter can be customized, but has the following initial settings:

➤ For WebSphere MQ:

➤ Only MQGET, MQPUT, and MQPUT1 API names are included.

➤ Do not send browsing MQGET is set.

➤ For JMS, send, receive, and onMessage methods are included.

➤ For all technologies, event packaging is enabled and the number of events 
to package is set to 10 events.

➤ The EJB and JDBC technologies are off.
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Guidelines for Good Data Collection Filtering

The primary goal of a data collection filter is to avoid unneeded events. 
Some common examples of things to exclude: 

➤ Programs and/or Queues that are not part of “in scope” transactions 
(customer specific)

➤ Steps that are not of any interest (and aren’t needed for correlation)

➤ MQ APIs others than MQGET, MQPUT, MQPUT1

➤ amqrmppa channel program

➤ MQ explorer or MQ monitoring tools

The secondary goal of the data collection filter is to limit the data collected 
per event. This is typically done by specifying the Data Range criterion to 
avoid unlimited data ranges when necessary. Typically, the following 
guidelines are good starting points: 

➤ Limit MQ message sizes collected to the first 1-10K.

➤ Limit HTTP request/response data collected to the first 1-5K.
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Tasks

How to Create a Data Collection Filter

This task describes how to create a new data collection filter. 

 1 Prerequisites

Determine the technology that applies to the application being 
monitored. Then, determine which events you want to include or 
exclude. 

Review the list of technologies on "Categories of Filter Criteria" on 
page 175. Review the list of event categories on "Data Collection Filter 
Page, Filter Criteria Tab" on page 186.

 2 Select Admin > Transaction Management.

 3 (left pane) Click the Configuration tab.

 4 Right-click Data Collection Filters select New Data Collection Filter.

The New Data Collection Filter dialog appears. 

 5 Enter a name and click OK.
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 6 (right pane) Use the Filter Criteria tab to manage and set the criteria for 
the data collection filter. On this tab, you perform these general steps:

1. (left pane) Choose 
the category of 
criteria that you 
want to set. 

2. (left pane) Choose 
the criterion that you 
want to set. 

3. (right pane) Set the 
criteria.

4. (right pane) Review 
the settings in the 
Summary panel and 
then click Apply. 
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For more details about this interface, see "Data Collection Filter Page, 
Filter Criteria Tab" on page 186.

How to Assign a Data Collection Filter to a 
Communication Link

You need to assign the data collection filter to a communication link before 
it can have any effect. See "How to Assign a Data Collection Filter to a 
Communication Link" on page 146.

Note: Multiple data collection filters are not supported by the BEA Tuxedo 
Agent. The BEA Tuxedo Agent applies the first data collection filter it finds 
that matches the Technology and Program/Servlet/EJB criteria. Therefore 
you should enable only one data collection filter for this type of agent on 
each Analyzer.

How to Modify a Data Collection Filter

This task describes how to modify a data collection filter. 

 1 Prerequisites

Determine which events you want to include or exclude. 

 2 Select Admin > Transaction Management.

 3 (left pane) Click the Configuration tab.

 4 Select Data Collection Filters > <data collection filter>.

 5 (right pane) Use the Filter Criteria page to change the criteria for the data 
collection filter. For details about this interface, see "Data Collection Filter 
Page, Filter Criteria Tab" on page 186.
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After you click Apply, the filter becomes effective. Any associated agents 
are notified about the filter change through a new configuration message. 
For more information about configuration messages, see "Message Queues 
in Communication Links" on page 127.

 6 Use the General Settings tab to rename the data collection filter if desired. 
For details about this interface, see "Data Collection Filter Page, General 
Settings Tab" on page 223.

Note: Renaming a data collection filter unassigns it from any 
communication links that it was assigned to before renaming. 

How to Remove a Data Collection Filter

This task describes how to remove a data collection filter. 

 1 Prerequisites

Make sure no communication links are using the data collection filter. 

 2 Select Admin > Transaction Management.

 3 (left pane) Click the Configuration tab.

 4 Select Data Collection Filters > <data collection filter>.

 5 Right-click and select Delete. 
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Reference

Data Collection Filters User Interface

This section describes:

 ➤ Data Collection Filters Summary Page on page 184

 ➤ Data Collection Filter Page, Filter Criteria Tab on page 186

 ➤ Data Collection Filter Page, General Settings Tab on page 223
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Data Collection Filters Summary Page

This page enables you to view all data collection filters and the technologies 
to which a selected filter apply. 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Data Collection Filters 

Important 
information

You can click on an entry in the Summary pane to go to 
the criterion setting area for that data collection filter. 

Relevant tasks ➤ "How to Create a Data Collection Filter" on page 179

➤ "How to Modify a Data Collection Filter" on page 181
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Available Filters The data collection filters currently defined in the 
deployment environment. 

Summary For a selected data collection filter, the non-default 
settings are shown. 
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Data Collection Filter Page, Filter Criteria Tab

This page enables you to specify data collection filter criteria. 
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To access For an existing data collection filter:

1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Data Collection Filters > <filter name>

4  (right pane) Select the Filter Criteria tab. 

Important 
information

➤ View the Summary pane in the lower right-hand side 
of the page to see the combined effect of all criteria set 
for the filter. The Apply button updates the Summary 
pane.

➤ Any Common Options settings specified at the All 
Technologies level are inherited, and can be 
overridden at a specific technology level. 

➤ For the WebSphere MQ and CICS Agents, a blank field 
is treated as a match when a data collection filter 
criteria is specified. For example, if you create a filter 
that collects events with the user name J_SMITH, 
events with an empty user name are also collected by 
the WebSphere MQ and CICS Agents.

➤ User-created entries for a filter are specific to that filter. 
For instance, if you add a new host named "Server1" to 
a particular data collection filter, that entry does not 
appear in the Host list of any other data collection 
filter. 

Relevant tasks ➤ "How to Create a Data Collection Filter" on page 179

➤ "How to Modify a Data Collection Filter" on page 181
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Common Options Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

User Data Range (WebSphere MQ Agents only.)

Include qualified events in the filter criteria. 

For CICS and WebSphere MQ technologies, limit the data by choosing one 
of the following from the drop-down list:

➤ API Names + Call Arguments + User Buffer. All possible event details 
are returned. 

➤ API Names + Call Arguments. The user buffer and call arguments of 
the event is not returned. 

➤ API Names Only. The user buffer and call arguments of the event is 
not returned. Queries against the event data cannot include API 
parameter values.

For EJB, JDBC, JMS, Servlet, User Event technologies, limit the data by 
choosing one of the following from the drop-down list:

➤ Collect User Data. User buffer data is included; you can select a range to 
specify how many bytes of the user data buffer to collect. Check the box 
next to All Data (no data ranges applied) to collect the entire user data 
buffer. 

To manually add a new range, click  and then enter the starting 
byte number (0 based index) in the Start Value field and the ending 
byte number in the End Value field. Specify a * in the End Value field to 
collect to the end of the user data buffer.

Agents collect data in all selected data range definitions, so remove any 
data ranges you do not want to collect. To remove an existing range, 
clear the data range checkbox.

Example. If you know that the event data you are interested in is at the 
beginning of the event payload, for example in a meta data header, you 
can collect the first 1KB of the payload by specify a Start Value of 0 and 
an End Value of 1023. 

➤ Do not Collect User Data. All buffer data is included.

For the BEA Tuxedo, NonStop TMF, JMS, Servlet, EJB, and JMS Agents this 
criterion is not evaluated.
188



Chapter 5 • Data Collection Filters
Event Packaging Use Event Packaging. Enables agents to buffer events until the event 
packaging criteria (below) is met or other conditions within the agent 
force it to flush the package. At that point, the packaged events are sent to 
the Event queue. 

Event Packaging directly improves the performance of the agent. However, 
if the monitored application crashes, event packaging may result in some 
collected events not being sent to the Analyzer. 

Specify the following options if Event Packaging is enabled: 

Maximum Package Size. The limit on the amount of memory an agent can 
set aside for storing events to be packaged. When the agent reaches or 
exceeds this limit while packaging events together, it sends the package to 
the event queue. Leave this field blank or specify a value of zero to use the 
Number of Events for the agent to package together field to determine 
when the package is sent.

Note that if the Maximum Package Size is smaller than the event size, each 
event is sent immediately. In this case, Event Packaging is effectively 
turned off. The minimum event size is approximately 4000 bytes.

Number of Events for the agent to package together. The number of 
events stored in the agent before sending a package to the Event Queue. As 
soon as the agent reaches this number of events while packaging events 
together, it sends the package to the Event queue.

The number of events should be set to a value suitable to the 
environment, usually 10 events per message.

Leave this field blank or specify a value of zero to use the Maximum 
Package Size field to determine when the package is sent.

If you specify a value for both the number of events and the maximum 
package size, agents combine messages into packages based on which limit 
is reached first. If both are zero or blank, the default behavior of no event 
packaging is used.

For the NonStop TMF Agent this criterion is not evaluated.

UI Elements (A-Z) Description
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Host Include or Exclude selected hosts in the filter criteria. The host list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all hosts in the filter criteria, check All.

To include a specific host in the filter criteria, select the host name 
checkbox. 

To remove a host name from the filter criteria, clear the host name 
checkbox. 

To manually add a host to the list, click  and then enter the host 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of host names, click .

Program/Servlet/EJB Include or Exclude selected programs, servlets, and/or EJBs in the filter 
criteria. The program list is generated from events collected and stored in 
the database. 

To include all programs, servlets, and EJBs in the filter criteria, check All.

To include a specific program, servlet, or EJB in the filter criteria, select the 
program, servlet, or EJB name checkbox. 

To remove a program, servlet, or EJB name from the filter criteria, clear the 
program, servlet, or EJB name checkbox. 

To manually add a program, servlet, or EJB to the list, click  and then 
enter the program, servlet, or EJB name. An asterisk can be used at the 
beginning or the end as a wildcard.

To refresh the list of program, servlet, or EJB names, click .

For the BEA Tuxedo Agent, the program, servlet, or EJB name must be the 
executable process that made the Tuxedo call. This can be done by either 
including the name explicitly or by specify All.

For the NonStop TMF Agent, this criterion is not evaluated.

UI Elements (A-Z) Description
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Time Specify the time mode:

Any Time. Events are collected with no time restrictions.

From a set start to end time. Specify a time range (based on the clock of 
the host running the agent) to collect events. To select the date from a 
calendar, click the drop-down button in the field and then click the 
desired date. The events are collected from the specified start time until 
the specified end time.

From a set start time. Specify a time range (based on the clock of the host 
running the Agent) to collect events. To select the date from a calendar, 
click the drop-down button in the field and then click the desired date. 
The events are collected from a specific start time until event collection is 
stopped.

Even if you specify a start time, you must initialize event recording before 
that start time. Initializing event recording causes the Analyzer to send a 
configuration message with filter information to all assigned 
communication links.

For the .NET Agent, BEA Tuxedo Agent, NonStop TMF Agent, and Java 
User Event technology this criterion is not evaluated.

UI Elements (A-Z) Description
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User Data Matching Include or Exclude selected strings of data in the filter criteria. 

To add a new string to the list, click  and then enter the prefix 
characters, suffix characters, and the matching value. An asterisk can be 
used at the beginning or the end as a wildcard. The suffix is optional. If it 
is not specified, the end of the user data buffer acts as the end of the 
string. Text within binary user data can be searched as null characters are 
ignored.

A prefix/suffix pair can be applied to multiple matching values. Right click 
an existing entry and select Add New Item to build the list:

Check Ignore white space to ignore any whitespace characters in the 
prefix, suffix, and matching value. 

Check Case sensitive search to consider case in the matching value.

Examples. Assume the user data payload contains account and 
transactional information as follows: 

<BankTransaction>
<Name>Stewie Gatesman</Name>
<Account>123456789</Account>
<Action>Deposit</Action>
<Amount>1000000.00</Amount>

</BankTransaction>

Perhaps the user is classifying transactions based on the Action and they 
want to route all Deposits to a dedicated Analyzer. The following User 
Data Matching criteria for the XML element value could be specified: 

Prefix: <Action>
Suffix: </Action>
Matching String(s): Deposit

To match on a particular element tag, regardless of value, the following 
criteria could be specified: 

Prefix: <Deposit>
Suffix: 
Matching String(s): *

For the CICS, .NET Agent, BEA Tuxedo Agent, NonStop TMF Agent, and 
Java User Event technology this criterion is not evaluated. 

UI Elements (A-Z) Description
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CICS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

User Name Include or Exclude selected users in the filter criteria. The user name list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all user names in the filter criteria, check All.

To include a specific user name in the filter criteria, select the user name 
checkbox. 

To remove a user name from the filter criteria, clear the user name 
checkbox. 

To manually add a user name to the list, click  and then enter the user 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of user names, click .

For the .NET Agent, BEA Tuxedo Agent, and NonStop TMF Agent, and Java 
User Event technology this criterion is not evaluated.

UI Elements (A-Z) Description

API Name Include or Exclude events for selected APIs. 

To include all APIs in the filter criteria, check All.

To specifically include an API, select the API name checkbox. The APIs are 
grouped by API type.

To remove an API from the list, clear the API checkbox. 

UI Elements (A-Z) Description
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File Name Include or Exclude events for selected file names. The file name list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all file names in the filter criteria, check All.

To include a specific file name in the filter criteria, select the file name 
checkbox. 

To remove a host name from the filter criteria, clear the file name 
checkbox. 

To manually add a file name to the list, click  and then enter the file 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of file names, click .

Response Code Include or Exclude events for selected response codes.

To include all response codes in the filter criteria, check All.

To specifically include a response code, select the response code name 
checkbox.

To remove a response code from the list, clear the response code checkbox. 

SYSID Include or Exclude events for selected CICS SYSIDs. The SYSID list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all SYSIDs in the filter criteria, check All.

To include a specific SYSID in the filter criteria, select the SYSID checkbox. 

To remove a SYSID from the filter criteria, clear the SYSID checkbox. 

To manually add a SYSID to the list, click  and then enter the file 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of SYSIDs, click .

UI Elements (A-Z) Description
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TD Queue Name Include or Exclude events for selected TD (transient data) queue names. 
The TD queue name list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all TD queue names in the filter criteria, check All.

To include a specific TD queue names in the filter criteria, select the TD 
queue names checkbox. 

To remove a TD queue names from the filter criteria, clear the TD queue 
names checkbox. 

To manually add a TD queue names to the list, click  and then enter 
the TD queue names. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of TD queue names, click .

Terminal ID Include or Exclude events for selected terminal IDs. The terminal ID list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all terminal IDs in the filter criteria, check All.

To include a specific terminal ID in the filter criteria, select the terminal ID 
checkbox. 

To remove a terminal ID from the filter criteria, clear the terminal ID 
checkbox. 

To manually add a terminal ID to the list, click  and then enter the 
terminal ID. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of terminal IDs, click .

UI Elements (A-Z) Description
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Transaction ID Include or Exclude events for selected CICS transaction IDs. The 
transaction ID list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all transaction IDs in the filter criteria, check All.

To include a specific transaction ID in the filter criteria, select the 
transaction ID checkbox. 

To remove a transaction ID from the filter criteria, clear the transaction ID 
checkbox. 

To manually add a transaction ID to the list, click  and then enter the 
transaction ID. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of transaction IDs, click .

TS Queue ID Include or Exclude events for selected TS (transient data) queue IDs. The TS 
queue ID list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all TS queue IDs in the filter criteria, check All.

To include a specific TS queue IDs in the filter criteria, select the TS queue 
ID checkbox. 

To remove a TS queue name from the filter criteria, clear the TS queue ID 
checkbox. 

To manually add a TS queue ID to the list, click  and then enter the TS 
queue ID. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of TS queue IDs, click .

UI Elements (A-Z) Description
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User ID Include or Exclude events for selected user IDs. The user ID list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all user IDs in the filter criteria, check All.

To include a specific user ID in the filter criteria, select the user ID 
checkbox. 

To remove a user ID from the filter criteria, clear the user ID checkbox. 

To manually add a user ID to the list, click  and then enter the user ID. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of user IDs, click .

UI Elements (A-Z) Description
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EJB Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Application Server Include or Exclude events for selected application servers. The application 
server list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all application servers in the filter criteria, check All.

To include a specific application server in the filter criteria, select the 
application server name checkbox. 

To remove a application server name from the filter criteria, clear the 
application server name checkbox. 

To manually add a application server to the list, click  and then enter 
the application server name. An asterisk can be used at the beginning or 
the end as a wildcard.

To refresh the list of application server names, click .

EJB Name Include or Exclude events for selected EJB names. The EJB name list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all EJB names in the filter criteria, check All.

To include a specific EJB name in the filter criteria, select the EJB name 
checkbox.

To remove an EJB name from the filter criteria, clear the EJB name 
checkbox.

To manually add an EJB name to the list, click  and then enter the EJB 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of EJB names, click .

Exception Setting Include both normal and exception events, normal events only, or 
exception events only.
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Method Include or Exclude events for selected EJB methods. The EJB method list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all EJB methods in the filter criteria, check All.

To include a specific EJB method in the filter criteria, select the EJB 
method name checkbox. 

To remove a EJB method name from the filter criteria, clear the EJB 
method name checkbox. 

To manually add a EJB method to the list, click  and then enter the EJB 
method name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of EJB method names, click .

Web Application Include or Exclude events for selected Web application names. The Web 
application list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all Web applications in the filter criteria, check All.

To include a specific Web application in the filter criteria, select the Web 
application name checkbox. 

To remove a Web application name from the filter criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

UI Elements (A-Z) Description
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JDBC Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Class Include or Exclude events for selected JDBC classes. The list of JDBC class 
names is generated from events collected and stored in the database.

To include all JDBC class names in the filter criteria, check All.

To specifically include a JDBC class names, select the JDBC class name 
checkbox.

To remove JDBC class name from the list, clear the JDBC class name 
checkbox. 

Database Include or Exclude events for selected JDBC databases. The database list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all databases in the filter criteria, check All.

To include a specific database in the filter criteria, select the database name 
checkbox. 

To remove a database name from the filter criteria, clear the database 
name checkbox. 

To manually add a database to the list, click  and then enter the 
database name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of database names, click .
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Database Object Include or Exclude events that make use of certain database objects. The 
object list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all objects of all schemas in the filter criteria, check All.

To include all objects in a specific schema in the filter criteria, select the 
schema name checkbox in the Database Schemas pane. 

To include specific objects in a specific schema in the filter criteria, clear 
the schema name checkbox but keep the database schema name selected. 
Then identify the objects to add to the filter criteria as follows: 

To remove a schema from the filter criteria, clear the schema name 
checkbox. 

To manually add a new schema and object to the list, click  and then 
enter the names. An asterisk can be used at the beginning or the end as a 
wildcard. An object filter can be applied. 

To refresh the list of schema and object names, click .

To edit the filter for a selected schema name, click . 

UI Elements (A-Z) Description

The current object 
filter. 

Choose to include 
or exclude objects 

The object name. 
An asterisk can be 
used at the 
beginning or end as 
a wild card. 
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Method Include or Exclude events for selected JDBC methods. 

To include all JDBC method names in the filter criteria, check All.

To specifically include a JDBC method names, select the JDBC method 
name checkbox.

To remove a JDBC method name from the list, clear the JDBC method 
name checkbox. 

Result Code Include or Exclude events that have a particular result code. The list of 
result codes is generated from events collected and stored in the database. 

To include all result codes in the filter criteria, check All.

To specifically include a result code, select the result code name checkbox.

To remove a result code from the filter criteria, clear the result code 
checkbox. 

SQL Code Include or Exclude events that have a particular SQL Code. The SQL code 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all SQL codes in the filter criteria, check All.

To include a specific SQL code in the filter criteria, select the SQL code 
checkbox. 

To remove an SQL code from the filter criteria, clear the SQL code 
checkbox. 

To manually add an SQL code to the list, click  and then enter the SQL 
code name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of SQL code names, click .

SQL codes used by the JDBC application vary based on the underlying 
database vendor. 

UI Elements (A-Z) Description
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SQL State Include or Exclude events that have a particular SQL state. The SQL state 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all SQL states in the filter criteria, check All.

To include a specific SQL state in the filter criteria, select the SQL state 
checkbox. 

To remove an SQL state from the filter criteria, clear the SQL state 
checkbox. 

To manually add an SQL code to the list, click  and then enter the SQL 
stated name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of SQL states, click .

Similar to SQL Code, SQL state values used by the JDBC application vary 
based on the underlying database vendor.

SQL Statement Include or Exclude events for a particular SQL statement type. 

To include all SQL statement types in the filter criteria, check All.

To specifically include an SQL statement type, select the SQL statement 
stype checkbox.

To remove an SQL statement type from the list, clear the SQL statement 
type name checkbox. 

Web Application Include or Exclude events for selected Web applications. The Web 
application list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all Web applications in the filter criteria, check All.

To include a specific Web application in the filter criteria, select the Web 
application name checkbox. 

To remove a Web application name from the filter criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

UI Elements (A-Z) Description
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JMS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Class Include or Exclude events for selected JMS classes. 

To include all JMS class names in the filter criteria, check All.

To specifically include a JMS class, select the JMS class name checkbox.

To remove a JMS class from the filter criteria, clear the JMS class name 
checkbox. 

Connection Name Include or Exclude events for selected connection names. The connection 
name list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all connection names in the filter criteria, check All.

To include a specific connection name in the filter criteria, select the 
connection name checkbox. 

To remove a connection name from the filter criteria, clear the connection 
name checkbox. 

To manually add a connection name to the list, click  and then enter 
the connection name. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of connection names, click .

Exception Setting Select whether to include both normal and exception events, normal 
events only, or exception events only.

Method Include or Exclude events for selected JMS methods.The method list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all methods in the filter criteria, check All.

To include a specific method in the filter criteria, select the method name 
checkbox. 

To remove a method name from the filter criteria, clear the method name 
checkbox. 

Check Do not collect events when no message is available to avoid 
collecting JMS Consumer events with no message.
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Queue Include or Exclude events for selected queues.

To include all JMS queue names in the filter criteria, check All.

To specifically include a JMS queue, select the JMS queue name checkbox.

To remove a JMS queue from the filter criteria, clear the JMS queue name 
check

To manually add a connection name to the list, click  and then enter 
the connection name. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of queue names, click .

Topic Include or Exclude events for selected topics. The topic list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all topics in the filter criteria, check All.

To include a specific topic in the filter criteria, select the topic name 
checkbox. 

To remove a topic name from the filter criteria, clear the topic name 
checkbox. 

To manually add a topic to the list, click  and then enter the topic 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of topic names, click .

Web Application Include or Exclude events for selected Web applications. The Web 
application list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all Web application names in the filter criteria, check All.

To include a specific Web application in the filter criteria, select the Web 
application name checkbox. 

To remove a Web application name from the filter criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

UI Elements (A-Z) Description
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Servlet Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Application Server Include or Exclude events for selected application servers. The application 
server list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all application servers in the filter criteria, check All.

To include a specific application server in the filter criteria, select the 
application server name checkbox. 

To remove a application server name from the filter criteria, clear the 
application server name checkbox. 

To manually add a application server to the list, click  and then enter 
the application server name. An asterisk can be used at the beginning or 
the end as a wildcard.

To refresh the list of application server names, click .

Client Host/IP Include or Exclude events for selected client host/IPs. The host/IP list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all host/IPs in the filter criteria, check All.

To include a specific host/IP in the filter criteria, select the host/IP name 
checkbox. 

To remove a host/IP name from the filter criteria, clear the host/IP name 
checkbox. 

To manually add a host/IP to the list, click  and then enter the host/IP 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of host/IP names, click .

Exception Setting Determine whether to include both normal and exception events, normal 
events only, or exception events only.
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Servlet Method Include or Exclude events for selected servlet methods. 

To include all servlet method names in the filter criteria, check All.

To specifically include a servlet method, select the servlet method name 
checkbox.

To remove a servlet method from the list, clear the servlet method name 
check

Status Code Include or Exclude events for selected status codes.

To include all status code names in the filter criteria, check All.

To specifically include a status code, select the status code name checkbox.

To remove a status code from the list, clear the status code name check

URI Include or Exclude events for selected URIs. The URI list is generated from 
events collected and stored in the database; you can add custom entries to 
the list.

To include all URIs in the filter criteria, check All.

To include a specific URI in the filter criteria, select the URI name 
checkbox. 

To remove a URI name from the filter criteria, clear the URI name 
checkbox. 

To manually add a URI to the list, click  and then enter the URI name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of URI names, click .

UI Elements (A-Z) Description
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User Event Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Web Application Include or Exclude events for selected Web applications. The Web 
application list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all Web applications in the filter criteria, check All.

To include a specific Web application in the filter criteria, select the Web 
application name checkbox. 

To remove a Web application name from the filter criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

UI Elements (A-Z) Description

Class Include or Exclude events for selected classes. The class list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all classes in the filter criteria, check All.

To include a specific class in the filter criteria, select the class name 
checkbox. 

To remove a class name from the filter criteria, clear the class name 
checkbox. 

To manually add a class to the list, click  and then enter the class 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of class names, click .

UI Elements (A-Z) Description
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Completion Code Include or Exclude events for selected User Event method completion 
codes. 

To include all completion code in the filter criteria, check All.

To specifically include a completion code, select the completion code 
checkbox.

To remove a completion code from the list, clear the completion code 
name checkbox.

Not available for BEA Tuxedo, .NET, NonStop TMF, or Java User Event 
Agents.

Method Include or Exclude events for selected methods. The method list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all methods in the filter criteria, check All.

To include a specific method in the filter criteria, select the method name 
checkbox. 

To remove a method name from the filter criteria, clear the method name 
checkbox. 

To manually add a method to the list, click  and then enter the 
method name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of method names, click .

Queue Include or Exclude events for selected User Event queue strings. The queue 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all queues in the filter criteria, check All.

To include a specific queue in the filter criteria, select the queue name 
checkbox. 

To remove a queue name from the filter criteria, clear the queue name 
checkbox. 

To manually add a queue to the list, click  and then enter the queue 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of queue names, click .

UI Elements (A-Z) Description
209



Chapter 5 • Data Collection Filters
Queue Space Include or Exclude events for selected User Event queue space strings. The 
string list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all queue space strings in the filter criteria, check All.

To include a specific queue space string in the filter criteria, select the 
queue space string name checkbox. 

To remove a queue space string from the filter criteria, clear the queue 
space string checkbox. 

To manually add a queue space string to the list, click  and then enter 
the string. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of queue space string names, click .

For the BEA Tuxedo Agent, Queue Space must match the queue space for 
which the tpenqueue/tpdequeue operation is intended.

Not available for .NET, NonStop TMF, or Java User Event Agents.

Service Include or Exclude events for selected User Event service strings. The 
service strings list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all service strings in the filter criteria, check All.

To include a specific service string in the filter criteria, select the service 
string name checkbox. 

To remove a service string name from the filter criteria, clear the service 
string name checkbox. 

To manually add a service string to the list, click  and then enter the 
service string name. An asterisk can be used at the beginning or the end as 
a wildcard.

To refresh the list of service string names, click .

UI Elements (A-Z) Description
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Status Include or Exclude events for selected User Event status strings. The status 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all status strings in the filter criteria, check All.

To include a specific status in the filter criteria, select the status string 
name checkbox. 

To remove a status name from the filter criteria, clear the status name 
checkbox. 

To manually add a status to the list, click  and then enter the status 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of status names, click .

Not available for .NET, BEA Tuxedo, or NonStop TMF Agents.

Technology The type of User Event Agent. Enter: .NET, BEA Tuxedo, NonStop-TMF, or 
Java.

UI Elements (A-Z) Description
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WebSphere MQ Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

API Name Include or Exclude selected WebSphere MQ APIs in the filter criteria. The 
list of class names is generated from events collected and stored in the 
database. Click Refresh to obtain the current set of class names.

To include all MQ API names in the filter criteria, check All.

To specifically include an MQ API, select the MQ API name checkbox.

To remove an MQ API from the filter criteria, clear the MQ API name 
checkbox.

Check Discard MQCMIT in empty transactions to avoid collecting empty 
transactions. Empty transactions occur in applications that pool a queue 
by making MQGET calls in a loop. When there are no inputs, the MQGET 
calls fail with a MQRC_NO_MSG_AVAILABLE and are typically filtered out 
by customers in TransactionVision. However, the MQGET may be 
followed by an MQCMIT. This option provides an easy way to filter out 
these MQCMIT events.

Check Do not send MQDISC exit event to report only the entry 
information of each MQDISC call. This improves performance and reduces 
overhead for the agent. Otherwise, the agent must reconnect and reopen 
the event queue in order to send MQDISC exit information, and this 
information is typically not necessary.

Check Do not send browsing MQGET if you do not want to collect 
MQGET calls used to browse messages on the queue.

 Completion Code Include or Exclude events for selected WebSphere MQ API completion 
codes.

To include all MQ API completion codes in the filter criteria, check All.

To specifically include an MQ API completion code, select the MQ API 
completion code checkbox.

To remove an MQ API completion code from the filter criteria, clear the 
MQ API completion code name checkbox.
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Object Include or Exclude queue managers and objects. The list is generated from 
events collected and stored in the database; you can add custom entries to 
the list.

To include all objects of all queue managers in the filter criteria, check All.

To include all objects in a specific queue manager in the filter criteria, 
select the queue manager name checkbox in the Queue Managers pane. 

To include specific objects in a specific schema in the filter criteria, clear 
the queue manager name checkbox but keep the queue manager name 
selected. Then identify the objects to add to the filter criteria by using the 
Object pane as described for Database Objects in the JDBC Criteria section. 

To remove a queue manger and all of its objects from the filter criteria, 
clear the queue manager name checkbox. 

To manually add a new queue manager and object to the list, click  
and then enter the names. An asterisk can be used at the beginning or the 
end as a wildcard. An object filter can be applied. 

To refresh the list of queue manager and object names, click .

To edit the filter for a selected queue manager name, click . 

Selecting objects not listed under a queue manager is useful if the same 
object name is present on multiple queue managers (for example, as in 
clustered queues). The object list is generated from events collected and 
stored in the database. 

To prevent the WMQ Agent from attempting to resolve remote cluster 
queues or queues which are opened remotely through a transmission 
queue, set the Do not attempt to resolve cluster or remotely opened 
queues checkbox. 

This option is relevant only if MQ Event Messaging is enabled in your 
environment, and need to reduce LOCALEV messages being sent to the 
SYSTEM.ADMIN.QMGR.EVENT queue because of failed MQOPEN 
operations during WMQ Agent queue resolution. By default, this option is 
not specified.

Note: All active data collection filters must have this option checked in 
order for this resolution to be stopped in the WMQ Agent. By stopping 
this resolution, cluster queues cannot be resolved. 

UI Elements (A-Z) Description
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Reason Code Include or Exclude events for selected WebSphere MQ API reason codes. 

To include all reason codes in the filter criteria, check All.

To specifically include a reason code, select the reason code checkbox.

To remove a reason code from the filter criteria, clear the reason code 
checkbox.

Note: MQGET calls with a MQRC_NO_MSG_AVAILABLE reason code are 
filtered out by default. When monitoring WebSphere MQ Brokers, make 
sure to filter out MQGET calls to WebSphere MQ Broker system queues 
with a reason code of MQRC_NO_MSG_AVAILABLE.

ReplyTo Object Include or Exclude queue managers and objects. The list is generated from 
events collected and stored in the database; you can add custom entries to 
the list.

To include all objects of all queue managers in the filter criteria, check All.

To include all objects in a specific queue manager in the filter criteria, 
select the queue manager name checkbox in the Queue Managers pane. 

To include specific objects in a specific schema in the filter criteria, clear 
the queue manager name checkbox but keep the queue manager name 
selected. Then identify the objects to add to the filter criteria by using the 
Object pane as described for Database Objects in the JDBC Criteria section. 

To remove a queue manger and all of its objects from the filter criteria, 
clear the queue manager name checkbox. 

To manually add a new queue manager and object to the list, click  
and then enter the names. An asterisk can be used at the beginning or the 
end as a wildcard. An object filter can be applied. 

To refresh the list of queue manager and object names, click .

To edit the filter for a selected queue manager name, click . 

Selecting objects not listed under a queue manager is useful if the same 
object name is present on multiple queue managers (for example, as in 
clustered queues). The object list is generated from events collected and 
stored in the database. 

To collect events that do not have the MQMD ReplyTo fields, select Collect 
MQPUT, MQPUT1, and MQGET events if both “ReplyTo” fields are not set.

UI Elements (A-Z) Description
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WebSphere MQ IMS Bridge Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

WebSphere MQ z/OS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

MQIMS Bridge API Include or Exclude events for selected MQIMS bridge APIs.

To include all MQIMS bridge APIs in the filter criteria, check All.

To specifically include a MQIMS bridge API, select the MQIMS bridge API 
checkbox.

For more information about the MQSeries-IMS Bridge Agent, see the 
HP TransactionVision Deployment Guide PDF.

UI Elements (A-Z) Description

CICS SYSID Include or Exclude events for selected CICS SYSIDs. The SYSID list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all SYSIDs in the filter criteria, check All.

To include a specific SYSID in the filter criteria, select the SYSID checkbox. 

To remove a SYSID name from the filter criteria, clear the SYSID name 
checkbox. 

To manually add a SYSID to the list, click  and then enter the SYSID 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of host names, click .

Only events generated on the z/OS CICS platform have a CICS SYSID. To 
collect events that do not have a CICS SYSID (non-z/OS CICS events), 
choose Collect events regardless of whether the field "CICS SYSID" is 
available.

Choose Collect events if and only if the field "CICS SYSID" is available to 
collect events that only have CICS SYSIDs.
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CICS Task Include or Exclude events for selected CICS tasks. The task list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all tasks in the filter criteria, check All.

To include a specific task in the filter criteria, select the task checkbox. 

To remove a task name from the filter criteria, clear the task name 
checkbox. 

To manually add a task to the list, click  and then enter the task name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of task names, click .

Only events generated on the z/OS CICS platform have a CICS task. To 
collect events that do not have a CICS task (non-z/OS CICS events), 
choose Collect events regardless of whether the field "CICS Task" is 
available.

Choose Collect events if and only if the field "CICS Task" is available to 
collect events that only have CICS tasks.

CICS Transaction Include or Exclude events for selected z/OS CICS transactions. The 
transaction list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all transactions in the filter criteria, check All.

To include a specific transaction in the filter criteria, select the transaction 
checkbox. 

To remove a transaction name from the filter criteria, clear the transaction 
name checkbox. 

To manually add a transaction to the list, click  and then enter the 
transaction name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of transaction names, click .

Only events generated on the z/OS CICS platform have a CICS 
transaction. To collect events that do not have a CICS transaction (non-z/
OS CICS events), choose Collect events regardless of whether the field 
"CICS Transaction" is available.

Choose Collect events if and only if the field "CICS Transaction" is 
available to collect events that only have CICS transactions.

UI Elements (A-Z) Description
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IMS Identifier Include or Exclude events for selected IMS identifiers. The identifier list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all identifiers in the filter criteria, check All.

To include a specific identifier in the filter criteria, select the identifier 
checkbox. 

To remove an identifier name from the filter criteria, clear the identifier 
name checkbox. 

To manually add an identifier to the list, click  and then enter the 
identifier name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of identifier names, click .

Only events generated on the z/OS IMS platform have an IMS identifier. 
To collect events that do not have an IMS identifier (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS 
Identifier" is available.

Choose Collect events if and only if the field "IMS Identifier" is available to 
collect events that only have IMS identifiers.

IMS PSB Include or Exclude events for selected IMS PSBs. The PSB list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all PSBs in the filter criteria, check All.

To include a specific PSB in the filter criteria, select the PSB name 
checkbox. 

To remove a PSB from the filter criteria, clear the PSB name checkbox. 

To manually add a PSB to the list, click  and then enter the PSB name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of PSB names, click .

Only events generated on the z/OS IMS platform have an IMS PSB. To 
collect events that do not have an IMS PSB (non-z/OS IMS events), choose 
Collect events regardless of whether the field "IMS PSB" is available.

Choose Collect events if and only if the field "IMS PSB" is available to 
collect events that only have IMS PSBs.

UI Elements (A-Z) Description
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IMS Region Identifier Include or Exclude events for selected IMS region identifiers. The IMS 
region identifier list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all IMS region identifiers in the filter criteria, check All.

To include a specific IMS region identifier in the filter criteria, select the 
IMS region identifier name checkbox. 

To remove a IMS region identifier from the filter criteria, clear the IMS 
region identifier name checkbox. 

To manually add an IMS region identifier to the list, click  and then 
enter the IMS region identifier name. An asterisk can be used at the 
beginning or the end as a wildcard.

To refresh the list of IMS region identifiers, click .

Only events generated on the z/OS IMS platform have an IMS region 
identifier. To collect events that do not have an IMS region identifier 
(non-z/OS IMS events), choose Collect events regardless of whether the 
field "IMS Region Identifier" is available.

Choose Collect events if and only if the field "IMS Region Identifier" is 
available to collect events that only have IMS region identifiers.

UI Elements (A-Z) Description
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IMS Region Type Include or Exclude events for selected IMS region types. The IMS region 
type list is generated from events collected and stored in the database; you 
can add custom entries to the list.

To include all IMS region types in the filter criteria, check All.

To include a specific IMS region type in the filter criteria, select the IMS 
region type name checkbox. 

To remove a IMS region type name from the filter criteria, clear the IMS 
region type name checkbox. 

To manually add a IMS region type to the list, click  and then enter the 
IMS region type name. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of IMS region type names, click .

Only events generated on the z/OS IMS platform have an IMS region type. 
To collect events that do not have an IMS region type (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS Region 
Type" is available.

Choose Collect events if and only if the field "IMS Region Type" is 
available to collect events that only have IMS region types.

UI Elements (A-Z) Description
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IMS Transaction Include or Exclude events for selected IMS transactions. The IMS 
transaction list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all transactions in the filter criteria, check All.

To include a specific transaction in the filter criteria, select the transaction 
name checkbox. 

To remove a transaction from the filter criteria, clear the transaction name 
checkbox. 

To manually add a transaction to the list, click  and then enter the 
transaction name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of transactions, click .

Only events generated on the z/OS IMS platform have an IMS transaction. 
To collect events that do not have an IMS transaction (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS 
transaction" is available.

Choose Collect events if and only if the field "IMS Transaction" is available 
to collect events that only have IMS transactions.

Jobs and Steps Include or Exclude selected z/OS job steps in the filter criteria. The job step 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all job steps in the filter criteria, check All.

To include a specific job and step in the filter criteria, select the job step 
name checkbox. 

To remove a job step from the filter criteria, clear the job step name 
checkbox. 

To manually add a job step to the list, click  and then enter the job 
and step name. An asterisk can be used at the beginning or the end as a 
wildcard.

Only events generated on the z/OS platform have job names and job steps. 
To collect events that do not have a CICS job and step (non-z/OS events), 
choose Collect events regardless of whether the field "Jobs and Steps" is 
available.

Choose Collect events if and only if the field "Jobs and Steps" is available 
to collect events that only have the CICS job names and steps.

UI Elements (A-Z) Description
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WebSphere MQ i5/OS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Job Name Include or Exclude events for selected job names. The job name list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all job names in the filter criteria, check All.

To include a specific job name in the filter criteria, select the job name 
checkbox. 

To remove a job from the filter criteria, clear the job name checkbox. 

To manually add a job to the list, click  and then enter the job name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of job names, click .
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WebSphere MQ BTTRACE Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

BTTRACE API Include or Exclude events for selected BTTRACE APIs. Applications can use 
the BTTRACE function provided by the agent library to send user-defined 
trace messages to TransactionVision.

To include all BTTRACE APIs in the filter criteria, check All.

To include a specific BTTRACE API, select the BTTRACE API checkbox.

To remove a BTTRACE API from the filter criteria, clear the BTTRACE API 
checkbox. 

BTTRACE Severity Include or Exclude events for selected BTTRACE severity levels. 
Applications can use the BTTRACE function provided by the agent library 
to send user-defined trace messages to TransactionVision.

To include all BTTRACE severity levels in the filter criteria, check All.

To include a specific BTTRACE severity level, select the BTTRACE severity 
level checkbox.

To remove a BTTRACE severity level from the filter criteria, clear the 
BTTRACE severity level checkbox. 
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Data Collection Filter Page, General Settings Tab

This page enables you to specify data collection filter names and 
descriptions. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Select Data Collection Filters > <filter name>.

4  (right pane) Select the General Settings tab.

Important 
information

Click the criteria category name on the left side for the 
condition that you want to change and make desired 
changes on the right side of the page. 

Relevant tasks ➤ "How to Create a Data Collection Filter" on page 179

➤ "How to Modify a Data Collection Filter" on page 181

UI Elements (A-Z) Description

Filter Description Enter text that helps administrators know the purpose of 
the filter. 

Filter Name Enter a name for the data collection filter. The name 
must be unique to the TransactionVision deployment 
environment. 
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6
Queries

This chapter includes:

Concepts

➤ Queries Overview on page 226

➤ Optimizing Query Performance on page 226

Tasks

➤ How to Add a Query on page 229

➤ How to Modify a Query on page 231

➤ How to Test a Query on page 231

Reference

➤ Queries User Interface on page 232
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Concepts

Queries Overview

Queries control which events in the database are displayed in the Event 
Analysis report or used for analysis in the Component Topology. You can 
specify to use a built-in query or a custom query. The built-in queries are: 

➤ All Events: Includes all events in all schemas in the database. 

➤ Last 24 hours: Includes only the events collected in the last 24 hours.

A custom query includes events based on any number of criteria. For 
instance, specific hosts, Queue Managers, programs, time frames and APIs 
can all be used to exclude or include events. This allows you to choose only 
the event data you need for analysis or to resolve a specific problem.

Optimizing Query Performance

To improve the time it takes to render the Event Analysis report or the 
Component Topology, define queries that meet the following guidelines:

➤ Include only those technologies that you need. By default, all 
technologies are specified.
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For example, if your query need only include WebSphere MQ events, 
disable the remaining technologies on the Technology drop-down list so 
that only WebSphere MQ remains selected:

➤ Specify User Buffer Data criteria in its own query. 

For most criteria, TransactionVision uses a database lookup table, which 
stores a set of predefined key values along with event IDs. However, it 
uses a linear search for the User Buffer Data criteria. Although linear 
searching enhances query capabilities, it reduces query performance. If 
you include these criteria in your query, query performance is degraded. 
To minimize the impact on query performance, avoid specifying these 
criteria together in the same query when possible.
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Another drawback of linear searches is that the resulting reports have 
limited page navigation capabilities since the total number of events and 
result pages is unknown. For example, after running a query that contains 
a query condition for event User Buffer data, the Event Analysis report 
would show page forward and backward options, but would not provide 
the number of events, the number of event pages, or controls to navigate 
to a particular page.
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Tasks

How to Add a Query

This task describes how to create a new query. 

 1 Prerequisites

Determine the technology that applies to the events you want to extract 
from the database. Then, determine which events you want to include or 
exclude. 

Review the list of technologies in "Categories of Filter Criteria" on 
page 175. The technologies used for data collection filters are the same 
that apply to queries with one exception: queries have the additional 
Transaction Attributes category in Common Options. 

Review the list of event categories on "Query Page, Query Criteria Tab" on 
page 233.

 2 Select Admin > Transaction Management.

 3 (left pane) Click the Configuration tab.

 4 Right-click Queries and select New Query.

The New Query dialog appears. 

 5 Enter a name and click OK.
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 6 (right pane) Use the Query Criteria tab to manage and set the criteria for 
the query. On this tab, you perform these general steps:

For more details about this interface, see "Query Page, Query Criteria Tab" 
on page 233.

1. (left pane) Choose 
the category of 
criteria that you 
want to set. 

2. (left pane) Choose 
the criterion that you 
want to set. 

3. (right pane) Set the 
criterion.

4. (right pane) Review 
the settings in the 
Summary panel and 
then click Apply. 
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How to Modify a Query

To modify a query, change the criteria settings as follows: 

 1 Select Admin > Transaction Management.

 2 (left pane) Click the Configuration tab.

 3 Select Queries > <query name>.

 4 (right pane) On the Query Criteria tab, update the query criteria.

 5 Click Apply. 

How to Test a Query

After you define a query, use the Preview button to test it. 

You should see the expected events on the Event Analysis report. See "Event 
Analysis Report" on page 535.
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Reference

Queries User Interface

This section describes:

 ➤ Queries Summary Page on page 232

 ➤ Query Page, Query Criteria Tab on page 233

 ➤ Query Page, General Settings Tab on page 272

Queries Summary Page

The Queries Summary page enables you to view and manage all queries in 
the deployment environment.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin> Transaction Management > 
Configuration. 

2  (left pane) Select Queries 

3  (right pane) From the Available Queries list, choose 
the query for which you want to view a summary.

UI Element Description

Available Queries Lists all queries in the deployment environment. Select a 
criteria to view its summary information. 

Summary Lists the query criteria, grouped by technology. Click the 
technology name to go that area in the query criteria.
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Query Page, Query Criteria Tab

This page enables you to specify query criteria. 
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To access 1  Select Admin> Transaction Management > 
Configuration. 

2  (left pane) Select Queries > <query name>

3  (right pane) Select the Query Criteria tab. 

Important 
information

➤ View the Summary pane in the lower right-hand side 
of the page to see the combined effect of all criteria set 
for the query. The Apply button updates the Summary 
pane.

➤ Any Common Options settings specified at the All 
Technologies level are inherited, and can be 
overridden at a specific technology level. 

➤ For the WebSphere MQ and CICS Agents, a blank field 
is treated as a match when a query criteria is specified. 
For example, if you create a query that collects events 
with the user name J_SMITH, events with an empty 
user name are also collected by the WebSphere MQ 
and CICS Agents.

➤ User-created entries for a query are specific to that 
query. For instance, if you add a new host named 
"Server1" to a particular query, that entry does not 
appear in the Host list of any other query. 

Relevant tasks "How to Add a Query" on page 229

"How to Modify a Query" on page 231
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Query Criteria Tab, Common Options

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Event Time When you create a new query, the default event time is events from the 
last 24 hours, relative to the last collected event. For example, if the time 
and date of last event in the schmea is 07:56 on 7-22-2005, the query 
includes events collected since 07:56 on 7-21-2005.

➤ Select the time mode. 

➤ Any Time: Events are collected with no time restrictions.

➤ From a set start to end time: Specify a time range (based on the clock 
of the host running the agent) to collect events. To select the date from 
a calendar, click the drop-down button in the field and then click the 
desired date. The events are collected from the specified start time until 
the specified end time.

➤ From a set start time: Specify a time range (based on the clock of the 
host running the Agent) to collect events. To select the date from a 
calendar, click the drop-down button in the field and then click the 
desired date. The events are collected from a specific start time until 
event collection is stopped.

Even if you specify a start time, you must initialize event recording 
before that start time. Initializing event recording causes the Analyzer 
to send a configuration message with query information to all assigned 
communication links.

For the .NET Agent, BEA Tuxedo Agent, NonStop TMF Agent, and Java 
User Event technology this criterion is not evaluated.
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Host Include or Exclude selected hosts in the query criteria. The host list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all hosts in the query criteria, check All.

To include a specific host in the query criteria, select the host name 
checkbox. 

To remove a host name from the query criteria, clear the host name 
checkbox. 

To manually add a host to the list, click  and then enter the host 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of host names, click .

Program/Servlet/EJB Include or Exclude selected programs, servlets, and/or EJBs in the query 
criteria. The program list is generated from events collected and stored in 
the database. 

To include all programs, servlets, and EJBs in the query criteria, check All.

To include a specific program, servlet, or EJB in the query criteria, select 
the program, servlet, or EJB name checkbox. 

To remove a program, servlet, or EJB name from the query criteria, clear 
the program, servlet, or EJB name checkbox. 

To manually add a program, servlet, or EJB to the list, click  and then 
enter the program, servlet, or EJB name. An asterisk can be used at the 
beginning or the end as a wildcard.

To refresh the list of program, servlet, or EJB names, click .

For the BEA Tuxedo Agent, the program, servlet, or EJB name must be the 
executable process that made the Tuxedo call. This can be done by either 
including the name explicitly or by specify All.

For the NonStop TMF Agent, this criterion is not evaluated.

UI Elements (A-Z) Description
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User Name Include or Exclude selected users in the query criteria. The user name list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all user names in the query criteria, check All.

To include a specific user name in the query criteria, select the user name 
checkbox. 

To remove a user name from the query criteria, clear the user name 
checkbox. 

To manually add a user name to the list, click  and then enter the user 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of user names, click .

For the .NET Agent, BEA Tuxedo Agent, and NonStop TMF Agent, and Java 
User Event technology this criterion is not evaluated.

User Buffer Data Note: The TransactionVision Analyzer can be configured to use an XML 
Event Compression bean, which can reduce the size of the resulting event 
database. However, if this bean is in use by the Analyzer, it is not possible 
to query on the user buffer data.

Specify where to search. If you have non-XML based user data in events, 
select Search in user data. If you have XML user data and have enabled the 
DefaultModifierBean in the Analyzer, select Search in event XML to search 
for strings in that XML data.

Click the appropriate radio button to indicate whether the specified user 
data is in binary string or normal string format and enter the buffer data. 
For normal string format, select the correct code page. To query on a 
double-byte character set (DBCS) string, you may either type in the DBCS 
text string or enter the binary representation of the text.

Select the appropriate Code Page for the desired character coding.

User Buffer Data is not supported for SQL Server.

TransactionVision uses linear searching for this criteria. Although linear 
searching enhances query capabilities, it reduces query performance. If 
you include this criteria in your query, query performance is degraded. 

UI Elements (A-Z) Description
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Query Criteria Tab, Transaction Attributes

The transaction related query criteria follow the same basic rules as other 
query criteria, allowing you to add criteria based on the transaction in 
which the event was a part.

For example, you can combine these two criteria:

➤ Ask for all events that have a certain program name.

➤ Ask only for events that are part of transactions that have been marked as 
failed.

User interface elements are described below:

These elements are populated based on transaction data rules. See "Business 
Transaction Tracing" on page 445.

UI Elements Description

Transaction Class The Business Transaction CI name. 

Transaction Start 
Time

The start time of the transaction.

Transaction End Time The end time of the transaction.

Transaction Response 
Time

The end-to-end response time of the transaction. See "Key Information 
Reported For a Transaction" on page 491.

Transaction State The completion state of the transaction. 

Transaction Result The result state of the transaction. 

Transaction Label The transaction label. 

Transaction SLA 
State

The SLA state of the transaction. 
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Query Criteria Tab, BTTRACE Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Query Criteria Tab, CICS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets): 

UI Elements (A-Z) Description

BTTRACE API Include or Exclude events for selected BTTRACE APIs. Applications can use 
the BTTRACE function provided by the agent library to send user-defined 
trace messages to TransactionVision.

To include all BTTRACE APIs in the query criteria, check All.

To include a specific BTTRACE API, select the BTTRACE API checkbox.

To remove a BTTRACE API from the query criteria, clear the BTTRACE API 
checkbox. 

BTTRACE Severity Include or Exclude events for selected BTTRACE severity levels. 
Applications can use the BTTRACE function provided by the agent library 
to send user-defined trace messages to TransactionVision.

To include all BTTRACE severity levels in the query criteria, check All.

To include a specific BTTRACE severity level, select the BTTRACE severity 
level checkbox.

To remove a BTTRACE severity level from the query criteria, clear the 
BTTRACE severity level checkbox. 

UI Elements (A-Z) Description

API Name Select whether to Include or Exclude events for selected APIs. 

To include all APIs in the query criteria, check All.

To specifically include an API, select the API name checkbox. The APIs are 
grouped by API type.

To remove an API from the list, clear the API checkbox. 
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API Type Select whether to Include or Exclude events for selected API types.

To include all APIs in the query criteria, check All.

To specifically include an API, select the API name checkbox. The APIs are 
grouped by API type.

CICS Task Include qualified events where the CICS Task is equal to a specific 
value. 

File Name Select whether to Include or Exclude events for selected file names. The file 
name list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all file names in the query criteria, check All.

To include a specific file name in the query criteria, select the file name 
checkbox. 

To remove a host name from the query criteria, clear the file name 
checkbox. 

To manually add a file name to the list, click  and then enter the file 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of file names, click .

Response Code Select whether to Include or Exclude events for selected response codes.

To include all response codes in the query criteria, check All.

To specifically include a response code, select the response code name 
checkbox.

To remove a response code from the list, clear the response code checkbox. 

UI Elements (A-Z) Description
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TD Queue Name Include or Exclude events for selected TD (transient data) queue names. 
The TD queue name list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all TD queue names in the query criteria, check All.

To include a specific TD queue names in the query criteria, select the TD 
queue names checkbox. 

To remove a TD queue names from the query criteria, clear the TD queue 
names checkbox. 

To manually add a TD queue names to the list, click  and then enter 
the TD queue names. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of TD queue names, click .

TS Queue ID Include or Exclude events for selected TS (transient data) queue IDs. The TS 
queue ID list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all TS queue IDs in the query criteria, check All.

To include a specific TS queue IDs in the query criteria, select the TS queue 
ID checkbox. 

To remove a TS queue name from the query criteria, clear the TS queue ID 
checkbox. 

To manually add a TS queue ID to the list, click  and then enter the TS 
queue ID. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of TS queue IDs, click .

UI Elements (A-Z) Description
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Terminal ID Include or Exclude events for selected terminal IDs. The terminal ID list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all terminal IDs in the query criteria, check All.

To include a specific terminal ID in the query criteria, select the terminal 
ID checkbox. 

To remove a terminal ID from the query criteria, clear the terminal ID 
checkbox. 

To manually add a terminal ID to the list, click  and then enter the 
terminal ID. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of terminal IDs, click .

Transaction ID Include or Exclude events for selected CICS transaction IDs. The 
transaction ID list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all transaction IDs in the query criteria, check All.

To include a specific transaction ID in the query criteria, select the 
transaction ID checkbox. 

To remove a transaction ID from the query criteria, clear the transaction 
ID checkbox. 

To manually add a transaction ID to the list, click  and then enter the 
transaction ID. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of transaction IDs, click .

UI Elements (A-Z) Description
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Query Criteria Tab, EJB Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Application Server Include or Exclude events for selected application servers. The application 
server list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all application servers in the query criteria, check All.

To include a specific application server in the query criteria, select the 
application server name checkbox. 

To remove a application server name from the query criteria, clear the 
application server name checkbox. 

To manually add a application server to the list, click  and then enter 
the application server name. An asterisk can be used at the beginning or 
the end as a wildcard.

To refresh the list of application server names, click .

EJB Application Select whether to Include or Exclude events for selected EJB names. The 
EJB name list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all EJB names in the query criteria, check All.

To include a specific EJB name in the query criteria, select the EJB name 
checkbox.

To remove an EJB name from the query criteria, clear the EJB name 
checkbox.

To manually add an EJB name to the list, click  and then enter the EJB 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of EJB names, click .
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Query Criteria Tab, JDBC Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

EJB Method Include or Exclude events for selected EJB methods. The EJB method list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all EJB methods in the query criteria, check All.

To include a specific EJB method in the query criteria, select the EJB 
method name checkbox. 

To remove a EJB method name from the query criteria, clear the EJB 
method name checkbox. 

To manually add a EJB method to the list, click  and then enter the EJB 
method name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of EJB method names, click .

EJB Status Select whether to Include or Exclude events for the selected EJB status.

Check Failure to include only failed EJB events, or check Success to include 
only successful EJB events. Check Select All EJB Status to include successful 
and failed EJB events in the query criteria.

UI Elements (A-Z) Description

Application Server Select whether to Include or Exclude events for selected application 
servers. The application server list is generated from events collected and 
stored in the database; you can add custom entries to the list.

To include all application servers in the query criteria, check All.

To include a specific application server in the query criteria, select the 
application server name checkbox. 

To remove a application server name from the query criteria, clear the 
application server name checkbox. 

To manually add a application server to the list, click  and then enter 
the application server name. An asterisk can be used at the beginning or 
the end as a wildcard.

To refresh the list of application server names, click .

UI Elements (A-Z) Description
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Class Select whether to Include or Exclude events for selected JDBC classes. The 
list of JDBC class names is generated from events collected and stored in 
the database.

To include all JDBC class names in the query criteria, check All.

To specifically include a JDBC class names, select the JDBC class name 
checkbox.

To remove JDBC class name from the list, clear the JDBC class name 
checkbox. 

Database Select whether to Include or Exclude events for selected JDBC databases. 
The database list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all databases in the query criteria, check All.

To include a specific database in the query criteria, select the database 
name checkbox. 

To remove a database name from the query criteria, clear the database 
name checkbox. 

To manually add a database to the list, click  and then enter the 
database name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of database names, click .

UI Elements (A-Z) Description
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Database Object Select whether to Include or Exclude events that make use of certain 
database objects. The object list is generated from events collected and 
stored in the database; you can add custom entries to the list.

To include all objects of all schemas in the query criteria, check All.

To include all objects in a specific schema in the query criteria, select the 
schema name checkbox in the Database Schemas pane. 

To include specific objects in a specific schema in the query criteria, clear 
the schema name checkbox but keep the database schema name selected. 
Then identify the objects to add to the query criteria as follows: 

To remove a schema from the query criteria, clear the schema name 
checkbox. 

To manually add a new schema and object to the list, click  and then 
enter the names. An asterisk can be used at the beginning or the end as a 
wildcard. An object filter can be applied. 

To refresh the list of schema and object names, click .

To edit the filter for a selected schema name, click . 

UI Elements (A-Z) Description

The current object 
filter. 

Choose to include 
or exclude objects 

The object name. 
An asterisk can be 
used at the 
beginning or end as 
a wild card. 
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Method Select whether to Include or Exclude events for selected JDBC methods. 

To include all JDBC method names in the query criteria, check All.

To specifically include a JDBC method names, select the JDBC method 
name checkbox.

To remove a JDBC method name from the list, clear the JDBC method 
name checkbox.

Result Code Select whether to Include or Exclude events that have a particular result 
code. The list of result codes is generated from events collected and stored 
in the database. 

To include all result codes in the query criteria, check All.

To specifically include a result code, select the result code name checkbox.

To remove a result code from the query criteria, clear the result code 
checkbox. 

SQL Code Select whether to Include or Exclude events that have a particular SQL 
Code. The SQL code list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all SQL codes in the query criteria, check All.

To include a specific SQL code in the query criteria, select the SQL code 
checkbox. 

To remove an SQL code from the query criteria, clear the SQL code 
checkbox. 

To manually add an SQL code to the list, click  and then enter the SQL 
code name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of SQL code names, click .

SQL codes used by the JDBC application vary based on the underlying 
database vendor. 

UI Elements (A-Z) Description
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SQL State Select whether to Include or Exclude events that have a particular SQL 
state. The SQL state list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all SQL states in the query criteria, check All.

To include a specific SQL state in the query criteria, select the SQL state 
checkbox. 

To remove an SQL state from the query criteria, clear the SQL state 
checkbox. 

To manually add an SQL code to the list, click  and then enter the SQL 
stated name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of SQL states, click .

Similar to SQL Code, SQL state values used by the JDBC application vary 
based on the underlying database vendor.

SQL Statement Select whether to Include or Exclude events for a particular SQL statement 
type. 

To include all SQL statement types in the query criteria, check All.

To specifically include an SQL statement type, select the SQL statement 
stype checkbox.

To remove an SQL statement type from the list, clear the SQL statement 
type name checkbox. 

SQL Statement Type Select whether to Include or Exclude events for a particular SQL statement 
type.

To include all SQL statement types in the query criteria, check All.

Check the box next to the statement type (such as Select, Merge, Insert, 
and Update) you want to include specifically in the query criteria, or check 
the box next to Select All SQL Statement Type to include all statement 
types in the query criteria.

UI Elements (A-Z) Description
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Query Criteria Tab, JMS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Web Application Select whether to Include or Exclude events for selected Web applications. 
The Web application list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all Web applications in the query criteria, check All.

To include a specific Web application in the query criteria, select the Web 
application name checkbox. 

To remove a Web application name from the query criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

UI Elements (A-Z) Description

Class Select whether to Include or Exclude events for selected JMS classes. 

To include all JMS class names in the query criteria, check All.

To specifically include a JMS class, select the JMS class name checkbox.

To remove a JMS class from the query criteria, clear the JMS class name 
checkbox. 

UI Elements (A-Z) Description
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Connection Name Select whether to Include or Exclude events for selected connection 
names. The connection name list is generated from events collected and 
stored in the database; you can add custom entries to the list.

To include all connection names in the query criteria, check All.

To include a specific connection name in the query criteria, select the 
connection name checkbox. 

To remove a connection name from the query criteria, clear the 
connection name checkbox. 

To manually add a connection name to the list, click  and then enter 
the connection name. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of connection names, click .

Data Size Select whether to Include or Exclude events for the selected data size.

Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

Enter the desired data size in bytes.

Exception Code Select whether to Include or Exclude events for selected exception codes.

Check the box next to each exception code you want to include 
specifically in the query criteria, or check the box next to Select All 
Exception Code to include all exception codes in the query criteria. The 
list of exception codes is generated from events collected in the database 
schema.

Exception Class 
Name

Select whether to Include or Exclude events for selected exception class 
names.

Check the box next to each exception class name you want to include 
specifically in the query criteria, or check the box next to Select All 
Exception Class Name to include all exception class names in the query 
criteria. The list of exception class names is generated from events 
collected in the database schema.

UI Elements (A-Z) Description
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Method Select whether to Include or Exclude events for selected JMS methods.The 
method list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all methods in the query criteria, check All.

To include a specific method in the query criteria, select the method name 
checkbox. 

To remove a method name from the query criteria, clear the method name 
checkbox. 

Check Do not collect events when no message is available to avoid 
collecting JMS Consumer events with no message.

Queue Select whether to Include or Exclude events for selected queues.

To include all JMS queue names in the query criteria, check All.

To specifically include a JMS queue, select the JMS queue name checkbox.

To remove a JMS queue from the query criteria, clear the JMS queue name 
check

To manually add a connection name to the list, click  and then enter 
the connection name. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of queue names, click .

Topic Select whether to Include or Exclude events for selected topics. The topic 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all topics in the query criteria, check All.

To include a specific topic in the query criteria, select the topic name 
checkbox. 

To remove a topic name from the query criteria, clear the topic name 
checkbox. 

To manually add a topic to the list, click  and then enter the topic 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of topic names, click .

UI Elements (A-Z) Description
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Web Application Select whether to Include or Exclude events for selected Web applications. 
The Web application list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all Web application names in the query criteria, check All.

To include a specific Web application in the query criteria, select the Web 
application name checkbox. 

To remove a Web application name from the query criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

Websphere MQ 
Queue Manager and 
Queue

Select whether to Include or Exclude events for selected WebSphere MQ 
queue and queue managers.

Check the box next to each queue you want to include specifically in the 
query criteria, or check the box next to Select Any WebSphere MQ Queue 
Manager to include all queue managers in the query criteria. The list of 
queue managers is generated from events collected in the database 
schema.

In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter 
it in the Customize WebSphere MQ Queue Manager list field and click 
Add. To remove a queue manager from the list, check the box next to the 
queue manager and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

UI Elements (A-Z) Description
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Query Criteria Tab, Servlet Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Application Server Select whether to Include or Exclude events for selected application 
servers. The application server list is generated from events collected and 
stored in the database; you can add custom entries to the list.

To include all application servers in the query criteria, check All.

To include a specific application server in the query criteria, select the 
application server name checkbox. 

To remove a application server name from the query criteria, clear the 
application server name checkbox. 

To manually add a application server to the list, click  and then enter 
the application server name. An asterisk can be used at the beginning or 
the end as a wildcard.

To refresh the list of application server names, click .

Data Size Select whether to Include or Exclude events for the selected data size.

Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

Enter the desired data size in bytes.

Servlet Method Select whether to Include or Exclude events for selected servlet methods. 

To include all servlet method names in the query criteria, check All.

To specifically include a servlet method, select the servlet method name 
checkbox.

To remove a servlet method from the list, clear the servlet method name 
check.

Status Code Select whether to Include or Exclude events for selected status codes.

To include all status code names in the query criteria, check All.

To specifically include a status code, select the status code name checkbox.

To remove a status code from the list, clear the status code name check.
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URI Select whether to Include or Exclude events for selected URIs. The URI list 
is generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all URIs in the query criteria, check All.

To include a specific URI in the query criteria, select the URI name 
checkbox. 

To remove a URI name from the query criteria, clear the URI name 
checkbox. 

To manually add a URI to the list, click  and then enter the URI name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of URI names, click .

Web Application Select whether to Include or Exclude events for selected Web applications. 
The Web application list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all Web applications in the query criteria, check All.

To include a specific Web application in the query criteria, select the Web 
application name checkbox. 

To remove a Web application name from the query criteria, clear the Web 
application name checkbox. 

To manually add a Web application to the list, click  and then enter 
the Web application name. An asterisk can be used at the beginning or the 
end as a wildcard.

To refresh the list of Web application names, click .

UI Elements (A-Z) Description
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Query Criteria Tab, User Event Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Class Select whether to Include or Exclude events for selected classes. The class 
list is generated from events collected and stored in the database; you can 
add custom entries to the list.

To include all classes in the query criteria, check All.

To include a specific class in the query criteria, select the class name 
checkbox. 

To remove a class name from the query criteria, clear the class name 
checkbox. 

To manually add a class to the list, click  and then enter the class 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of class names, click .

Completion Code Select whether to Include or Exclude events for selected User Event 
method completion codes. 

To include all completion code in the query criteria, check All.

To specifically include a completion code, select the completion code 
checkbox.

To remove a completion code from the list, clear the completion code 
name checkbox.

Not available for BEA Tuxedo, .NET, NonStop TMF, or Java User Event 
Agents.

Data Size Select whether to Include or Exclude events for the selected data size.

Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

Enter the desired data size in bytes. 
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Method Select whether to Include or Exclude events for selected methods. The 
method list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all methods in the query criteria, check All.

To include a specific method in the query criteria, select the method name 
checkbox. 

To remove a method name from the query criteria, clear the method name 
checkbox. 

To manually add a method to the list, click  and then enter the 
method name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of method names, click .

Queue Select whether to Include or Exclude events for selected User Event queue 
strings. The queue list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all queues in the query criteria, check All.

To include a specific queue in the query criteria, select the queue name 
checkbox. 

To remove a queue name from the query criteria, clear the queue name 
checkbox. 

To manually add a queue to the list, click  and then enter the queue 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of queue names, click .

UI Elements (A-Z) Description
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Queue Space Select whether to Include or Exclude events for selected User Event queue 
space strings. The string list is generated from events collected and stored 
in the database; you can add custom entries to the list.

To include all queue space strings in the query criteria, check All.

To include a specific queue space string in the query criteria, select the 
queue space string name checkbox. 

To remove a queue space string from the query criteria, clear the queue 
space string checkbox. 

To manually add a queue space string to the list, click  and then enter 
the string. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of queue space string names, click .

For the BEA Tuxedo Agent, Queue Space must match the queue space for 
which the tpenqueue/tpdequeue operation is intended.

Not available for .NET, NonStop TMF, or Java User Event Agents.

Service Select whether to Include or Exclude events for selected User Event service 
strings. The service strings list is generated from events collected and 
stored in the database; you can add custom entries to the list.

To include all service strings in the query criteria, check All.

To include a specific service string in the query criteria, select the service 
string name checkbox. 

To remove a service string name from the query criteria, clear the service 
string name checkbox. 

To manually add a service string to the list, click  and then enter the 
service string name. An asterisk can be used at the beginning or the end as 
a wildcard.

To refresh the list of service string names, click .

UI Elements (A-Z) Description
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Status Select whether to Include or Exclude events for selected User Event status 
strings. The status list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all status strings in the query criteria, check All.

To include a specific status in the query criteria, select the status string 
name checkbox. 

To remove a status name from the query criteria, clear the status name 
checkbox. 

To manually add a status to the list, click  and then enter the status 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of status names, click .

Not available for .NET, BEA Tuxedo, or NonStop TMF Agents.

Technology The type of User Event Agent. Enter: .NET, BEA Tuxedo, NonStop-TMF, or 
Java.

UI Elements (A-Z) Description
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Query Criteria Tab, WebSphere MQ Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

API Name Select whether to Include or Exclude selected WebSphere MQ APIs in the 
query criteria. The list of class names is generated from events collected 
and stored in the database. Click Refresh to obtain the current set of class 
names.

To include all MQ API names in the query criteria, check All.

To specifically include an MQ API, select the MQ API name checkbox.

To remove an MQ API from the query criteria, clear the MQ API name 
checkbox.

Check Discard MQCMIT in empty transactions to avoid collecting empty 
transactions. Empty transactions occur in applications that pool a queue 
by making MQGET calls in a loop. When there are no inputs, the MQGET 
calls fail with a MQRC_NO_MSG_AVAILABLE and are typically filtered out 
by customers in TransactionVision. However, the MQGET may be 
followed by an MQCMIT. This option provides an easy way to query out 
these MQCMIT events.

Check Do not send MQDISC exit event to report only the entry 
information of each MQDISC call. This improves performance and reduces 
overhead for the agent. Otherwise, the agent must reconnect and reopen 
the event queue in order to send MQDISC exit information, and this 
information is typically not necessary.

Check Do not send browsing MQGET if you do not want to collect 
MQGET calls used to browse messages on the queue.
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Connection Name The connection name and queue manager are typically the same, except 
in the case where a queue on one queue manager is opened using a 
connection (specified with the hConn parameter) to a different queue 
manager. For example, suppose a program opens queue QM1.Q using a 
connection to queue manager QM1, then later opens QM1.Q using a 
connection to queue manager QM2. This event shows QM1.Q as the 
object name, QM1 as the queue manager, and QM2 as the connection 
name.

Select whether to Include or Exclude events for the selected WebSphere 
MQ connections. 

Check the box next to each connection you want to include specifically in 
the query criteria, or check the box next to Select All Connection Name to 
include all connections in the query criteria. The list of connection names 
is generated from events collected in the database schema.

In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter 
it in the Customize Connection Name list field and click Add. To remove a 
connection name from the list, check the box next to the connection 
name and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

 Completion Code Select whether to Include or Exclude events for selected WebSphere MQ 
API completion codes.

To include all MQ API completion codes in the query criteria, check All.

To specifically include an MQ API completion code, select the MQ API 
completion code checkbox.

To remove an MQ API completion code from the query criteria, clear the 
MQ API completion code name checkbox.

Correlation ID Select whether the Correlation ID contains or does not contain either a 
binary string or normal string.

Click the appropriate radio button to indicate whether the specified 
correlation ID is in string or binary format and enter the correlation ID. 
For string format, select the correct code page.

UI Elements (A-Z) Description
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Data Size Select whether to Include or Exclude events for the selected data size.

Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

Enter the desired data size in bytes.

Message ID Select whether the Message ID contains or does not contain either a binary 
string or normal string.

Click the appropriate radio button to indicate whether the specified 
message ID is in string or binary format and enter the message ID. For 
string format, select the correct code page.

UI Elements (A-Z) Description
261



Chapter 6 • Queries
Queue Manager and 
Object

Select whether to Include or Exclude queue managers and objects. The list 
is generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all objects of all queue managers in the query criteria, check All.

To include all objects in a specific queue manager in the query criteria, 
select the queue manager name checkbox in the Queue Managers pane. 

To include specific objects in a specific schema in the query criteria, clear 
the queue manager name checkbox but keep the queue manager name 
selected. Then identify the objects to add to the query criteria by using the 
Object pane as described for Database Objects in the JDBC Criteria section. 

To remove a queue manager and all of its objects from the query criteria, 
clear the queue manager name checkbox. 

To manually add a new queue manager and object to the list, click  
and then enter the names. An asterisk can be used at the beginning or the 
end as a wildcard. An object filter can be applied. 

To refresh the list of queue manager and object names, click .

To edit the filer for a selected queue manager name, click . 

Selecting objects not listed under a queue manager is useful if the same 
object name is present on multiple queue managers (for example, as in 
clustered queues). The object list is generated from events collected and 
stored in the database. 

To prevent the WMQ Agent from attempting to resolve remote cluster 
queues or queues which are opened remotely through a transmission 
queue, set the Do not attempt to resolve cluster or remotely opened 
queues checkbox. 

This option is relevant only if MQ Event Messaging is enabled in your 
environment, and need to reduce LOCALEV messages being sent to the 
SYSTEM.ADMIN.QMGR.EVENT queue because of failed MQOPEN 
operations during WMQ Agent queue resolution. By default, this option is 
not specified.

Note: All active queries must have this option checked in order for this 
resolution to be stopped in the WMQ Agent. By stopping this resolution, 
cluster queues cannot be resolved. 

UI Elements (A-Z) Description
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Reason Code Select whether to Include or Exclude events for selected WebSphere MQ 
API reason codes. 

To include all reason codes in the query criteria, check All.

To specifically include a reason code, select the reason code checkbox.

To remove a reason code from the query criteria, clear the reason code 
checkbox.

Note: MQGET calls with a MQRC_NO_MSG_AVAILABLE reason code are 
filtered out by default. When monitoring WebSphere MQ Brokers, make 
sure to filter out MQGET calls to WebSphere MQ Broker system queues 
with a reason code of MQRC_NO_MSG_AVAILABLE.

ReplyTo Queue 
Manager and Object

Select whether to Include or Exclude queue managers and objects. The list 
is generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all objects of all queue managers in the query criteria, check All.

To include all objects in a specific queue manager in the query criteria, 
select the queue manager name checkbox in the Queue Managers pane. 

To include specific objects in a specific schema in the query criteria, clear 
the queue manager name checkbox but keep the queue manager name 
selected. Then identify the objects to add to the query criteria by using the 
Object pane as described for Database Objects in the JDBC Criteria section. 

To remove a queue manger and all of its objects from the query criteria, 
clear the queue manager name checkbox. 

To manually add a new queue manager and object to the list, click  
and then enter the names. An asterisk can be used at the beginning or the 
end as a wildcard. An object filter can be applied. 

To refresh the list of queue manager and object names, click .

To edit the filter for a selected queue manager name, click . 

Selecting objects not listed under a queue manager is useful if the same 
object name is present on multiple queue managers (for example, as in 
clustered queues). The object list is generated from events collected and 
stored in the database. 

To collect events that do not have the MQMD ReplyTo fields, select Collect 
MQPUT, MQPUT1, and MQGET events if both “ReplyTo” fields are not set.

UI Elements (A-Z) Description
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Query Criteria Tab, WebSphere MQ z/OS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

CICS SYSID Include or Exclude events for selected CICS SYSIDs. The SYSID list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all SYSIDs in the query criteria, check All.

To include a specific SYSID in the query criteria, select the SYSID 
checkbox. 

To remove a SYSID name from the query criteria, clear the SYSID name 
checkbox. 

To manually add a SYSID to the list, click  and then enter the SYSID 
name. An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of host names, click .

Only events generated on the z/OS CICS platform have a CICS SYSID. To 
collect events that do not have a CICS SYSID (non-z/OS CICS events), 
choose Collect events regardless of whether the field "CICS SYSID" is 
available.

Choose Collect events if and only if the field "CICS SYSID" is available to 
collect events that only have CICS SYSIDs.
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CICS Task Include or Exclude events for selected CICS tasks. The task list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all tasks in the query criteria, check All.

To include a specific task in the query criteria, select the task checkbox. 

To remove a task name from the query criteria, clear the task name 
checkbox. 

To manually add a task to the list, click  and then enter the task name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of task names, click .

Only events generated on the z/OS CICS platform have a CICS task. To 
collect events that do not have a CICS task (non-z/OS CICS events), 
choose Collect events regardless of whether the field "CICS Task" is 
available.

Choose Collect events if and only if the field "CICS Task" is available to 
collect events that only have CICS tasks.

CICS Transaction Include or Exclude events for selected z/OS CICS transactions. The 
transaction list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all transactions in the query criteria, check All.

To include a specific transaction in the query criteria, select the 
transaction checkbox. 

To remove a transaction name from the query criteria, clear the 
transaction name checkbox. 

To manually add a transaction to the list, click  and then enter the 
transaction name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of transaction names, click .

Only events generated on the z/OS CICS platform have a CICS 
transaction. To collect events that do not have a CICS transaction (non-z/
OS CICS events), choose Collect events regardless of whether the field 
"CICS Transaction" is available.

Choose Collect events if and only if the field "CICS Transaction" is 
available to collect events that only have CICS transactions.

UI Elements (A-Z) Description
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IMS Identifier Include or Exclude events for selected IMS identifiers. The identifier list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all identifiers in the query criteria, check All.

To include a specific identifier in the query criteria, select the identifier 
checkbox. 

To remove an identifier name from the query criteria, clear the identifier 
name checkbox. 

To manually add an identifier to the list, click  and then enter the 
identifier name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of identifier names, click .

Only events generated on the z/OS IMS platform have an IMS identifier. 
To collect events that do not have an IMS identifier (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS 
Identifier" is available.

Choose Collect events if and only if the field "IMS Identifier" is available to 
collect events that only have IMS identifiers.

IMS PSB Include or Exclude events for selected IMS PSBs. The PSB list is generated 
from events collected and stored in the database; you can add custom 
entries to the list.

To include all PSBs in the query criteria, check All.

To include a specific PSB in the query criteria, select the PSB name 
checkbox. 

To remove a PSB from the query criteria, clear the PSB name checkbox. 

To manually add a PSB to the list, click  and then enter the PSB name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of PSB names, click .

Only events generated on the z/OS IMS platform have an IMS PSB. To 
collect events that do not have an IMS PSB (non-z/OS IMS events), choose 
Collect events regardless of whether the field "IMS PSB" is available.

Choose Collect events if and only if the field "IMS PSB" is available to 
collect events that only have IMS PSBs.

UI Elements (A-Z) Description
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IMS Region Identifier Include or Exclude events for selected IMS region identifiers. The IMS 
region identifier list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all IMS region identifiers in the query criteria, check All.

To include a specific IMS region identifier in the query criteria, select the 
IMS region identifier name checkbox. 

To remove a IMS region identifier from the query criteria, clear the IMS 
region identifier name checkbox. 

To manually add an IMS region identifier to the list, click  and then 
enter the IMS region identifier name. An asterisk can be used at the 
beginning or the end as a wildcard.

To refresh the list of IMS region identifiers, click .

Only events generated on the z/OS IMS platform have an IMS region 
identifier. To collect events that do not have an IMS region identifier 
(non-z/OS IMS events), choose Collect events regardless of whether the 
field "IMS Region Identifier" is available.

Choose Collect events if and only if the field "IMS Region Identifier" is 
available to collect events that only have IMS region identifiers.

UI Elements (A-Z) Description
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IMS Region Type Include or Exclude events for selected IMS region types. The IMS region 
type list is generated from events collected and stored in the database; you 
can add custom entries to the list.

To include all IMS region types in the query criteria, check All.

To include a specific IMS region type in the query criteria, select the IMS 
region type name checkbox. 

To remove a IMS region type name from the query criteria, clear the IMS 
region type name checkbox. 

To manually add a IMS region type to the list, click  and then enter the 
IMS region type name. An asterisk can be used at the beginning or the end 
as a wildcard.

To refresh the list of IMS region type names, click .

Only events generated on the z/OS IMS platform have an IMS region type. 
To collect events that do not have an IMS region type (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS Region 
Type" is available.

Choose Collect events if and only if the field "IMS Region Type" is 
available to collect events that only have IMS region types.

UI Elements (A-Z) Description
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IMS Transaction Include or Exclude events for selected IMS transactions. The IMS 
transaction list is generated from events collected and stored in the 
database; you can add custom entries to the list.

To include all transactions in the query criteria, check All.

To include a specific transaction in the query criteria, select the 
transaction name checkbox. 

To remove a transaction from the query criteria, clear the transaction 
name checkbox. 

To manually add a transaction to the list, click  and then enter the 
transaction name. An asterisk can be used at the beginning or the end as a 
wildcard.

To refresh the list of transactions, click .

Only events generated on the z/OS IMS platform have an IMS transaction. 
To collect events that do not have an IMS transaction (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS 
transaction" is available.

Choose Collect events if and only if the field "IMS Transaction" is available 
to collect events that only have IMS transactions.

Job Name Select whether to Include or Exclude events for selected job names. The job 
name list is generated from events collected and stored in the database; 
you can add custom entries to the list.

To include all job names in the query criteria, check All.

To include a specific job name in the query criteria, select the job name 
checkbox. 

To remove a job from the query criteria, clear the job name checkbox. 

To manually add a job to the list, click  and then enter the job name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of job names, click .

UI Elements (A-Z) Description
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Job Steps Select whether to Include or Exclude selected z/OS job steps in the query 
criteria. The job step list is generated from events collected and stored in 
the database; you can add custom entries to the list.

To include all job steps in the query criteria, check All.

To include a specific job and step in the query criteria, select the job step 
name checkbox. 

To remove a job step from the query criteria, clear the job step name 
checkbox. 

To manually add a job step to the list, click  and then enter the 
job and step name. An asterisk can be used at the beginning or the 
end as a wildcard.

UI Elements (A-Z) Description
270



Chapter 6 • Queries
Query Criteria Tab, WebSphere MQ i5/OS Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Query Criteria Tab, WebSphere MQ IMS Bridge Agent Criteria

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Job Name Include or Exclude events for selected job names. The job name list is 
generated from events collected and stored in the database; you can add 
custom entries to the list.

To include all job names in the query criteria, check All.

To include a specific job name in the query criteria, select the job name 
checkbox. 

To remove a job from the query criteria, clear the job name checkbox. 

To manually add a job to the list, click  and then enter the job name. 
An asterisk can be used at the beginning or the end as a wildcard.

To refresh the list of job names, click .

UI Elements (A-Z) Description

MQIMS Bridge API Include or Exclude events for selected MQIMS bridge APIs.

To include all MQIMS bridge APIs in the query criteria, check All.

To specifically include a MQIMS bridge API, select the MQIMS bridge API 
checkbox.

For more information about the MQSeries-IMS Bridge Agent, see the 
HP TransactionVision Deployment Guide PDF.
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Query Page, General Settings Tab

The General Settings tab enables you to view the query name and 
description.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin> Transaction Management > 
Configuration. 

2  (left pane) Select Queries > <query name>

3  (right pane) Select the General Settings tab. 

Relevant tasks "How to Add a Query" on page 229

UI Element Description

Query Description Enter text that helps administrators know the purpose of 
the query. 

Query Name Enter a name for the query. The name must be unique to 
the TransactionVision deployment environment. 
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Jobs

This chapter includes:

Concepts

➤ Built-in Jobs on page 274

➤ Custom Jobs on page 274

Tasks

➤ How to Modify the Built-in Jobs on page 275

➤ How to Add a Custom Job on page 275

Reference

➤ Jobs User Interface on page 277
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Concepts

Built-in Jobs 

Transaction Management uses these built-in jobs to manage data 
synchronization between various data repositories. TransactionVision 
provides the following built-in jobs:

Custom Jobs

Transaction Management can also run custom jobs. Custom jobs are created 
by writing Java classes that use the JobBean basic class and implement the 
IJob interface. 

Job Name Purpose

ODB Population Publishes the following to the ODB:

➤ new business transaction CIs

➤ CIs corresponding to the infrastructure elements 
discovered by TransactionVision agents

➤ any dependency relationship between business 
transactions CIs and corresponding infrastructure 
elements 

ODB Update Updates infrastructure CIs corresponding to current 
business transactions, to prevent the aging out of these 
CIs. 

BSM Aggregate TV 
Data Sample

Creates and delivers aggregate business transaction data 
to the BSM Profile database. By default, the sample is 
resent every 5 minutes.
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Tasks

How to Modify the Built-in Jobs

To modify the BSM Aggregate TV Data Sample Job: 

 1 Select Admin > Transaction Management.

 2 (left pane) Select Configuration > Transaction Vision > Jobs.

 3 Right-click BSM Aggregate TV Data Sample and select Edit Job.

 4 The Edit Job dialog appears. For details about this interface, see "Edit Job 
Dialog" on page 283.

To modify the ODB Population or Update Job: 

 1 Select Admin > Transaction Management.

 2 (left pane) Select Configuration > Transaction Vision > Jobs.

 3 Right-click ODBPopJob or ODBUpdateJob selectEdit Job.

 4 The Edit Job dialog appears. For details about this interface, see "Edit Job 
Dialog" on page 283.

How to Add a Custom Job

This task describes how to create a new custom job for the 
TransactionVision deployment environment.

This task includes the following steps:

➤ "Prerequisite" on page 276

➤ "Fill out the Add Job dialog" on page 276

➤ "Start the Job if necessary" on page 276
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 1 Prerequisite

Write and test the Java class that represents the task you want the job to 
do. For an example of a custom job Java class, see the HP TransactionVision 
Advanced Customization Guide PDF.

 2 Fill out the Add Job dialog 

Note: If class files are part of a package, they must be placed in that 
corresponding directory. For example, a Java class named 
com.mycompany.TestClass would need to be placed in the com/
mycompany directory within WEB-INF/classes.

 a Select Admin > Transaction Management.

 b (left pane) Select Configuration.

 c Click New  and then select New Job.

 d The Add Job dialog appears. For details about this interface, see "Add 
Job Dialog" on page 282.

 3 Start the Job if necessary

The job name and description appear on the Job Status page.
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Reference

Jobs User Interface

This section describes:

 ➤ Job Summary Page, Job Manager Status tab on page 278

 ➤ Job Status Page on page 279

 ➤ Add Job Dialog on page 282

 ➤ Edit Job Dialog on page 283
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Job Summary Page, Job Manager Status tab

The Job Manager Status page enables you to view the status of built-in and 
custom jobs. The following is an example of the Job Manager Status tab.

 

To access 1  Admin > Transaction Management > Configuration

2  (left pane) Click the Jobs folder.

3  (right pane) Click the Job Manager Status tab.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Job Status Page

The Job Status page enables you to view the status of the selected job, as well 
as start and stop it.

UI Elements Description

Job Manager Status Primary Job Manager Processing Server Name. The 
Processing Server on which the Job Manager is running. 

Primary Job Manager Host Name. The host name 
associated with the Processing Server specified above. 

Primary Job Manager Status. The status of the primary 
Job Manager: 

 Running. 

 Not running. 

Click  Refresh to refresh the Job Manager status.

Jobs Status For each job: 

Job Name. Name of the job. 

Job Status. Status of the job. 

Job Next Run. Next time the job is scheduled to run. 

Job Interval. Frequency with which the job runs. 

Job Startup Mode. How the job is started. 

Click  Refresh to refresh the job list.

Click  Refresh to change the job configuration for the 
selected job. 

To access 1  Admin > Transaction Management > Configuration

2  (left pane) Expand the Jobs folder.

3  (left pane) Click the <job name> tab.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Modify the Built-in Jobs" on page 275

See also "How TransactionVision Data is Exported to BSM" on 
page 314

UI Elements (A-Z) Description

Start the job. Starting a job initializes and activates it. If 
it’s next scheduled time has already passed, it runs 
immediately; otherwise, it is placed in a waiting state 
until its scheduled time arrives.

Stop the job. If the job is currently running, a cancel 
command is first issued, followed by commands to stop 
and shut it down.

Force stop the job. This button is only enabled if the 
selected job is in Quiescing mode.

Cancel the current job run without stopping the job. The 
job changes to a waiting state until the next scheduled 
run time.

Run job now rather than continuing to wait for the 
scheduled time. 

Refresh job list.
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Job Status The status and next run time for the job. Possible status 
values are:

Running. The job is in the process of executing the task it 
is programmed to do.

Waiting. The job is active and waiting for its scheduled 
run time to arrive.

Quiescing. The job is in the process of shutting down, 
performing any specific cleanup or shutdown processes 
applicable. A job initially transfers to this state when it is 
stopped, then automatically moves from this state to 
Stopped when the shutdown or cleanup process is 
complete. When in Quiescing mode, use the Force Stop 
button to end a job immediately without completing 
pending tasks.

Stopped. The job is not active, is not loaded into 
memory, and does not perform any tasks until started 
with the Start button, 

Job Logs History information showing when the job has been 
initialized, run, and completed.

Next Run The next scheduled run of the job. 

UI Elements (A-Z) Description
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Add Job Dialog

The Add Job dialog box enables you to create a new custom job.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management > 
Configuration 

2  (left pane) Right-click Jobs, and select Add Job.

Relevant tasks "How to Add a Custom Job" on page 275.

UI Element (A-Z) Description

Class name The name of the Java class. 

Description Description for the new job.

Name Name for the new job.

Interval Enter the frequency with which the job should be 
repeated. The interval may be in minutes, hours, days, or 
months.

Parameters Any startup parameters needed for this job. 

Startup mode The startup mode for the job. Options are:

Automatic: the job is automatically initialized and started 
when the web server starts, or when a user clicks Start All.

Manual: the job is only started when the job is selected 
and started.

Disabled: the job cannot be run until its startup mode is 
changed to Automatic or Manual. Disabling a job is 
useful if you have an automatically starting job that you 
want to temporarily turn off so it doesn’t start when the 
system comes up or when starting all jobs.
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Edit Job Dialog

The Edit Job dialog box enables you to modify a job’s configuration.

The Edit Job Dialog for the BSM Aggregate TV Data Sample Job

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management > 
Configuration 

2  (left pane) Right-click TransactionVision > Jobs, and 
select Edit Job.

Relevant tasks "How to Modify the Built-in Jobs" on page 275

UI Element Description

Name Name of the job. Do not change this name.

Description Description of the job.

Class name The predefined job name. 

Parameters The startup parameters for this job. You cannot change 
these parameters. 

Startup Mode The startup mode for the job. Options are:

Automatic. The job is automatically initialized and 
started when the Job Manager starts, or when the Start 
All button is clicked.

Manual. The job is only started when the job is selected 
and started.

Disabled. The job cannot be run until its startup mode is 
changed to Automatic or Manual. Disabling a job is 
useful if you have an automatically starting job that you 
want to temporarily turn off so it doesn’t start when the 
system comes up or when starting all jobs.

Interval Enter the frequency with which the job should be 
repeated. The interval may be in minutes, hours, days, or 
months.
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The Edit Job Dialog for the ODB Population and Update Job

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Time Slice Delta (sec) Interval at which the sample is collected. Default value: 
300

For instance, every 300 seconds the sampling period 
starts and continues for the time specified by the Sample 
Delta value (default is 360 seconds). 

In-Process Aging 
(sec)

Affects the Time Slice Delta. By default, all of the 
in-process transactions are processed for the sample. This 
option, if set, allows only transactions that are still 
in-process at this adjusted time to be processed for the 
sample: 

Endtime is after (Current Time - In Process Aging value)

Sample Aging Period 
(sec)

Affects the Sample Delta. By default, all completed 
transactions that end in the sample period are processed. 
However, if this option is set, the sample period is 
adjusted as follows: 

CurrentTime - Sample Aging Period value

Sample Update 
Aging Period (min)

Determines which sample records are deleted from the 
database. For example, a value of 1440 means any sample 
records which are 2 days old are deleted.

Default value: 300 

Sample Delta (sec) Time duration for which samples are gathered. Default 
value: 360 

Debug Logging Enable debug logging for jobs. 

UI Element (A-Z) Description

Class name The predefined job name. 

Description Description of the job.

UI Element Description
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Interval Enter the frequency with which the job should be 
repeated. The interval may be in minutes, hours, days, or 
months.

Name Name of the job. Do not change this name. 

Parameters The startup parameters for this job:

-debug. Set this parameter to true to enable debug 
statements.

-domain <domain>. Set this parameter to set the 
corresponding value as the probe_domain attribute for 
populating hosts in ODB (default value is 
DefaultDomain).

Note: If the  -domain parameter is used, it should be set to 
the same value as the ODB Update job.

Startup mode The startup mode for the job. Options are:

Automatic. The job is automatically initialized and 
started when the Job Manager starts, or when a user 
clicks Start All.

Manual. The job is only started when the job is selected 
and started

Disabled. The job cannot be run until its startup mode is 
changed to Automatic or Manual. Disabling a job is 
useful if you have an automatically starting job that you 
want to temporarily turn off so it doesn’t start when the 
system comes up or when starting all jobs.

UI Element (A-Z) Description
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Advanced Configuration

This chapter includes:

Concepts

➤ About Advanced Configuration on page 288

Tasks

➤ How to Modify the XDM Files on page 290

➤ How to Modify the SonicMQ OOB Settings on page 291

➤ How to Enable Session Tracking on page 291

Reference

➤ Advanced Configuration User Interface on page 294
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Concepts

About Advanced Configuration

Advanced configuration refers to modifications you typically do not need to 
make as an administrator of the TransactionVision deployment 
environment. Advanced configuration can be divided into two categories: 

Customizing the TransactionVision Database Schema
In some cases information in the message data that is needed for analysis is 
not captured by default. In these cases, you can extract fields from the 
message data and map them to database columns where they can be stored. 
Once they are stored in the database, they are available for analysis and use 
in the Transaction Management reports they are visible in any reports 
dealing with instance level detail, for example the Transaction Tracking or 
Transaction Detail report.

Before these fields can be written to a database column by the Analyzer, they 
need to be extracted from the message and converted to XML (if not already 
in the XML format). For information about how to extract data from a 
message, see chapter 3 in the HP TransactionVision Advanced Customization 
Guide PDF.

The TransactionVision database schema also must be customized to accept 
the new data. The schema is made extensible through the XML to Database 
Mapping (XDM) files. As message data specific columns are added to the 
database, the XDM files can be updated to describe the new schema. Hence 
XML to Database mapping serves multiple purposes:

➤ To describe the layout of the database schema tables. Each Analyzer has 
its own unique schema in the database, but all schemas must have the 
same table layout.

➤ To describe to the Analyzer the fields that are to be extracted from the 
XML event data and stored in event lookup tables for fast searching and 
retrieval.
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➤ To describe to the Analyzer the fields that are to be extracted from the 
transaction XML document and stored in the transaction lookup tables.

➤ To describe the database schema to the query services for use in 
Transaction Management reports and topologies.

Customizing System Information
Some properties can require customization. These properties affect the 
entire deployment.

The properties are in the following groups:

➤ DataCollectionFilter

➤ DefaultUserColumnData

➤ FixedXPaths

➤ Initial.Logging

➤ JobManager.Logging

➤ Migrate.Logging

➤ OOBSonic

➤ PresentationQuery

➤ QueryEngine.Logging

➤ Setup.Logging

➤ SystemModelDefinition

➤ UIBeans

➤ UIProperties
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Tasks

How to Modify the XDM Files

This task describes how to modify the default XDM files. Modifying these 
files changes the table structure used to store data of the corresponding type. 
Therefore, once you modify a default or existing XDM file, previous versions 
of the XDM file cannot be used. 

Important: Changing the table structure requires that the tables be recreated 
(this occurs automatically). Existing data in the tables will be lost. 

 1 Prerequisites

Determine which XDM file you need to modify.

 2 Modify the XDM File

 a Select Admin > Transaction Management.

 b (left pane) Click the TransactionVision node.

 c (right pane) Select Configuration > XDM tab.

Make the needed changes and click Apply. 

For information about this tab, see "Configuration Tab, XDM Tab" on 
page 295.
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How to Modify the SonicMQ OOB Settings

This task describes how to modify the configuration of the built-in SonicMQ 
broker. For example, to change the size of the RecoveryLog maxFileSize or 
the port used by the SonicMQ Broker.

 1 Select Admin > Transaction Management.

 2 (left pane) Click the TransactionVision node.

 3 (right pane) Select Configuration > General tab.

 4 Choose SonicOOB. 

Make the needed changes and click Apply.

Note: Changes to the recovery log size or location need also be made to 
the SonicMQ Broker itself through the SonicMQ Management Console. 

 5 Restart the TransactionVision Processing Servers by using 
<TVISION_HOME>\bin\SupervisorStop and SupervisorStart on each one.

How to Enable Session Tracking

This task describes how to enable analysis and classification of Session ID 
with a servlet’s transaction, to allow classifying and analyzing Session ID 
data for the Web Session report.

To enable session tracking:

 1 Navigate to the transaction.xdm file as described in "Configuration Tab, 
XDM Tab" on page 295.

 2 To the bottom of the file, add the following lines: 

<Column name="sessionid" type="VARCHAR" size="32" 
description="SessionId">
<Path>/Transaction/SessionId</Path>
</Column>
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After saving the file changes, a warning displays indicating that the 
transaction model will be changed. Transaction data in the previous 
model will no longer be available. 

 3 Create a data rule in your transaction tracing rule that populates the 
HTTP Session ID from your event data (/Event/Technology/Servlet/
Session/ID).
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 4 Start collecting events.

The transaction class using this rule should now be setting the Session ID. 
This can be verified by going to the Transaction Tracking report and 
seeing transactions listed in the Session ID column or by running the Web 
Session report.
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Reference

Advanced Configuration User Interface

This section describes:

 ➤ Configuration Tab, General Tab on page 294

 ➤ Configuration Tab, XDM Tab on page 295

 ➤ Configuration Tab, BSM Settings Tab on page 296

Configuration Tab, General Tab 

This tab enables you to customize various system-wide property settings. 

User interface elements are described below:

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Click the TransactionVision node.

4  (right pane) Click the Configuration tab.

5  Click the General tab.

Relevant tasks "How to Enable Session Tracking" on page 291

See also "About Advanced Configuration" on page 288

UI Elements Description

Name Property file. 

Text The content of the file. 

Apply Applies the changes.

Cancel Cancels any changes to the file. 
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Configuration Tab, XDM Tab

This tab enables you to customize the XDM files that represent the 
TransactionVision database tables. 

You can add a new table but you cannot remove one forth built-in tables.

 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Click the TransactionVision node.

4  (right pane) Click the Configuration tab.

5  Click the XDM tab.

Important 
information

Editing the XDM changes the database table and 
therefore it becomes incompatible with any previous 
version. 
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User interface elements are described below:

Configuration Tab, BSM Settings Tab

This tab enables you to configure access to the BSM Gateway Server, the 
ODB and the RUM engine. 

Relevant tasks "How to Modify the XDM Files" on page 290

See also "About Advanced Configuration" on page 288

For information about how to modify the built-in XDM 
files, see the HP TransactionVision Advanced Customization 
Guide PDF.

UI Elements (A-Z) Description

Add a new custom XDM entry.

Delete the selected XDM entry. Only custom XDM 
entries can be deleted.

Name The XDM file name. This is the XML to Database 
Mapping (XDM) files. 

Text The content of the XDM file in XML format. 

To access 1  Select Admin > Transaction Management.

2  (left pane) Click the Configuration tab.

3  Click the TransactionVision node.

4  (right pane) Click the Configuration tab.

5  Click the BSM Settings tab.

Important 
information

➤ The settings on this tab are initialized when the 
TransactionVision application is deployed through the 
Admin > Transaction Management > Platform > Setup 
and Maintenance pages. 

➤ To restore the default settings, click Reset to Default.
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User interface elements are described below:

UI Elements (A-Z) Description

Customer Name Always Default Client.

Enable Basic 
Authentication

Use basic authentication (in addition to your current 
LW-SSO configuration) for communication between the 
BSM Gateway server and all TransactionVision Processing 
Servers. Default value: off

If checked, also enter:

Basic Authentication User Name. The user name to access 
the BSM Gateway server with basic authentication. 

Basic Authentication Password. The password associated 
with the user name above.

Host Enter the fully-qualified domain name of the BSM 
Gateway Server. This setting is automatically set based on 
a typical deployment and setup. In special deployments 
or where you have changed BSM settings you need to 
specify this field.

ODB User Name You can specify access credentials through which all ODB 
access from TransactionVision occurs. Default value: 
TVISION. 

ODB Password

Confirm ODB 
Password

The password associated with the user name above. 
Default value: TVISION

Port Enter the listening port on the BSM Gateway server for all 
TransactionVision Processing Servers. Default value: 80

Protocol Choose the protocol used for communication between 
the BSM Gateway server and all TransactionVision 
Processing Servers. Options are: HTTP or HTTPS. Default 
value: HTTP

A value of HTTPS requires that components be enabled 
for SSL communication. See "Using SSL with 
TransactionVision" in the HP Business Service Management 
Hardening Guide PDF
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RUM Publish Port Enter the RUM publish port. Default value: 21113

RUM Publish 
Protocol 

Choose the protocol used for communication between a 
RUM Engine and a TransactionVision Analyzer. Default 
value: HTTP

A value of HTTPS requires components be enabled for SSL 
communication. See "Using SSL with TransactionVision" 
in the HP Business Service Management Hardening Guide 
PDF

UI Elements (A-Z) Description
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Working with Other Applications in BSM

This chapter includes:

Concepts

➤ Service Health on page 300

➤ MyBSM on page 306

➤ Service Level Management and Alerts on page 306

➤ End User Management on page 307

➤ HP Diagnostics on page 309

➤ Business Process Insight on page 309

➤ TransactionVision Data in the BSM Profile Database on page 312

➤ TransactionVision Data in the ODB on page 314

➤ How TransactionVision Data is Exported to BSM on page 314

Tasks

➤ How to Verify or Modify Communication Between BSM and 
TransactionVision on page 315

➤ How to Enable Communication Between RUM and TransactionVision 
on page 315

➤ How to Enable Communication Between BPI and TransactionVision 
on page 316

Troubleshooting and Limitations on page 316
299



Chapter 9 • Working with Other Applications in BSM
Concepts

Service Health

This section includes: 

➤ "Data Sent From TransactionVision For Use With Service Health" on 
page 300

➤ "The Transaction States Relevant to Service Health" on page 305

➤ "Drilldowns From Service Health to the Transaction Management Reports 
and Topologies" on page 306

Data Sent From TransactionVision For Use With Service 
Health
The TransactionVision Processing Servers automatically send their business 
transaction CI data to BSM. This data is used to calculate some Health 
Indicators and KPIs for use with the Service Health application. 

For example, the KPIs for a business transaction display on the 360 View: 

Each Business Transaction CI has default KPIs and HIs (health indicators) 
that define what is monitored for the transaction. 
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The following table shows the relationship among the default KPIs, Health 
Indicators and TransactionVision data.

KPI Contributing Health Indicator
Supporting TransactionVision Data in the 
Sample

Application 
Performance

TransactionVision End-to-end 
Transaction Average duration
or

The average end-to-end Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

TransactionVision End-to-end 
Transaction Minimum 
duration
or

The minimum end-to-end Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

TransactionVision End-to-end 
Transaction Maximum 
duration
or

The maximum end-to-end Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

TransactionVision End User 
Transaction Average duration
or

The average end user Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

TransactionVision End User 
Transaction Minimum 
duration
or

The minimum end user Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

TransactionVision End User 
Transaction Maximum 
duration
or

The maximum end user Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state
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Application 
Performance

(continued)

Backend Transaction 
Maximum duration
or

The maximum backend Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

Backend Transaction 
Minimum duration
or

The minimum backend Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

Backend Transaction Average 
duration
or

The average backend Response Time of all 
instances of the specified Business Transaction 
CI type that have:

➤ completed in the specified time range

➤ any transaction state

Backlog TransactionVision In-process 
Transaction Count

The total Transaction Count (or Volume) of all 
instances of the specified Business Transaction 
CI type that have:

➤ been started in the specified time range but 
not completed 

➤ any transaction state

KPI Contributing Health Indicator
Supporting TransactionVision Data in the 
Sample
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Delays TransactionVision In-process 
Transaction Delayed Value

or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ been started in the specified time range but 
not completed 

➤ a transaction state of Delayed

TransactionVision In-process 
Transaction Delayed Rate

or

In-process transactions with a state of Delayed 
divided by total in-process transactions.

TransactionVision Completed 
Transaction Delayed Value

or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ completed in the specified time range

➤ a transaction state of Delayed

TransactionVision Completed 
Transaction Delayed Rate

Completed transactions with a state of Delayed 
divided by total completed transactions.

Exceptions TransactionVision In-process 
Transaction Exception Value
or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ been started in the specified time range but 
not completed 

➤ a transaction state of Exception

TransactionVision In-process 
Transaction Exception Rate
or

In-process transactions with a state of Exception 
divided by total in-process transactions.

TransactionVision Completed 
Transaction Exception Value
or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ completed in the specified time range

➤ a transaction state of Exception

TransactionVision Completed 
Transaction Exception Rate

Completed transactions with a state of 
Exception divided by total completed 
transactions.

KPI Contributing Health Indicator
Supporting TransactionVision Data in the 
Sample
303



Chapter 9 • Working with Other Applications in BSM
Failure TransactionVision In-process 
Transaction Failure Value
or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ been started in the specified time range but 
not completed 

➤ a transaction state of Failure

TransactionVision In-process 
Transaction Failure Rate
or

In-process transactions with a state of Failure 
divided by total in-process transactions.

TransactionVision Completed 
Transaction Failure Value
or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ completed in the specified time range but not 
completed 

➤ a transaction state of Failure

TransactionVision Completed 
Transaction Failure Rate

Completed transactions with a state of Failure 
divided by total completed transactions with a 
state of Failure.

Value TransactionVision In-process 
Transaction Value
or

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ been started in the specified time range but 
not completed 

➤ any transaction state

TransactionVision Completed 
Transaction Value

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ completed in the specified time range

➤ any transaction state

Volume TransactionVision Completed 
Transaction Count

The total Value of all instances of the specified 
Business Transaction CI type that have:

➤ completed in the specified time range

➤ a transaction state of Completed

KPI Contributing Health Indicator
Supporting TransactionVision Data in the 
Sample
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You can view the Indicators that exist in the BSM deployment environment 
by selecting Admin > Service Health > Repositories > Indicators > CI Types > 
Business Element > Business Transaction. For more details about the 
Indicators, see "HI Repository" in Using Service Health.

You can view the KPIs that exist in the BSM deployment environment by 
selecting Admin > Service Health > Repositories > KPIs. For more details 
about the KPIs, see "KPI Repository" in Using Service Health.

The Transaction States Relevant to Service Health
The transaction state is the current state of the transaction and can be one 
or more of the following:

Transactions can be classified in more than one state category, for example, 
as both late and as successful.

State Description

Successful The total count of transaction instances, minus the 
failed count. See Failed below.

Late Transaction instances with a response time that 
exceeded the threshold value specified in the 
transaction tracing properties. Also referred to as 
delayed. 

Failed Transaction instances that did not meet a success 
threshold defined by the Failures rule. For example, 
a stock buy transaction would fail if the account 
balance was less than $10,000, which is required to 
do the purchase, or a margin buy would fail if the 
account ratio is below a minimum balance 
threshold.

For information about the Failure data rule, see 
"Transaction Tracing Overview" on page 446.

Transaction Exceptions Transaction instances that did not follow the 
expected flow path, as defined by the Exception 
data rule, see "Transaction Tracing Overview" on 
page 446.
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Drilldowns From Service Health to the Transaction 
Management Reports and Topologies
There are some drilldowns from Service Health to Transaction Management. 
See Using Service Health.

MyBSM

In MyBSM you can create your own workspace based on built-in or custom 
pages. To those pages, the following components based on Transaction 
Management reports can be added:

➤ Transaction Summary report.

➤ The Volume/Response graph of the Transaction Over Time Report.

➤ The Volume Analysis graph of the Transaction Over Time Report.

➤ The Transaction State graph from the Transaction Over Time Report" in 
Using Transaction Management.

➤ The Transaction Capacity Planning Graph of the Transaction Over Time 
Report.

➤ The Transaction Measurement Correlation Graph of the Transaction Over 
Time Report.

For more information about MyBSM, see Using MyBSM.

Service Level Management and Alerts

Similar to the way that TransactionVision data is used in Service Health, it is 
used in Service Level Management. 

See Using Service Level Management.
306



Chapter 9 • Working with Other Applications in BSM
End User Management

This section includes: 

➤ "Data Sent From RUM to TransactionVision" on page 307

➤ "Drilldowns From RUM Reports to the Transaction Management Reports 
and Topologies" on page 308

➤ "Drilldowns From BPM Reports to the Transaction Management Reports 
and Topologies" on page 308

Data Sent From RUM to TransactionVision
RUM data can be sent to TransactionVision. This allows the end user 
perspective data to be added to the business transaction data collected by 
TransactionVision.

This integration has the following requirements:

➤ The application must be monitored by both RUM and either 
TransactionVision or HP Diagnostics.

➤ Only J2EE Web transactions are eligible.

➤ The TransactionVision deployment environment must have an Analyzer 
enabled for RUM. See "How to Enable Communication Between RUM and 
TransactionVision" on page 315.
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Drilldowns From RUM Reports to the Transaction 
Management Reports and Topologies
The integration between End User Management and TransactionVision 
helps isolate problems occurring on the server side. In TransactionVision 
you can identify which parts of a server call are causing long server response 
times, and see all the events that participate in a server call plus the time 
taken for each sub-step of the server call.

The following RUM reports provide drilldown links to Transaction 
Management reports:

Drilldowns From BPM Reports to the Transaction 
Management Reports and Topologies
The following BPM reports provide drilldown links to Transaction 
Management reports:

The drilldown is based on Business Process Monitor’s BPM Profile, BPM 
Location, and BPM Transaction.

Drill From this EUM Report
To this Transaction Management 
Report:

Action Summary Transaction Tracking report

Action Over Time Transaction Tracking report

End Users by Action Transaction Tracking report

Application Infrastructure by Action Transaction Tracking report

Action Raw Data Transaction Tracking report

Triage Transaction Tracking report

Triage Raw Data Transaction Tracking report

Drill From this BPM Report
To this Transaction Management 
Report:

Triage Raw Data Transaction Tracking report
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HP Diagnostics

If HP Diagnostics is deployed in the BSM environment, you can drill down 
to Diagnostics data from some of the Transaction Management reports and 
topologies. TransactionVision automatically detects when Diagnostics has 
data on a component, shows it with a special Diagnostics drilldown icon 
where relevant.

The drilldowns have the following requirements:

➤ Applies only to Servlet/JSP components and hosts.

➤ The Agent monitoring the applications is configured to act as both a 
Diagnostics probe and a TransactionVision Agent.

➤ Both tracing and monitoring are enabled on the transaction. 

For more information about the drilldowns, see "Reports Overview" on 
page 498.

Business Process Insight

This section includes: 

➤ "Data Sent by TransactionVision to Business Process Insight" on page 309

➤ "Drilldowns Between Business Process Insight and the Transaction 
Management Reports and Topologies" on page 310

➤ "Design-Time Integration with Business Process Insight" on page 310

➤ "Run-Time Integration with Business Process Insight" on page 311

Data Sent by TransactionVision to Business Process 
Insight
You can define rules that define which business transaction events to make 
available to Business Process Insight. TransactionVision then collects these 
events and aggregates the data related to the events. 

The events and the aggregated data are placed on a JMS queue and are 
available for Business Process Insight to import into the Model Repository. 
See the task "How to Send Events to BPI" on page 454.
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Drilldowns Between Business Process Insight and the 
Transaction Management Reports and Topologies

➤ Progress to Business Process Insight business processes with data received 
from TransactionVision business transaction events.

➤ Link from details of TransactionVision instances, to the process instance 
details page within the Business Process Insight Business Process 
Dashboard.

Design-Time Integration with Business Process Insight
Event and transaction rules are defined to filter the incoming transactions 
according to your requirements. The required transaction events are placed 
on the configured Business Process Insight JMS queue.

The event importer component reads the transaction events from the JMS 
queue and imports them into the Model Repository, where they are 
available to the Modeler.

You define your processes as usual and create Data definitions, which can 
then subscribe to the imported Event definitions.
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Run-Time Integration with Business Process Insight
When TransactionVision and Business Process Insight are both deployed in 
the BSM deployment environment, event data flows from each 
TransactionVision Processing Server to the BPI Server as follows: 

The numbered labels in the diagram have the following meaning: 

1 Using the BPI rules defined for the business transactions, the 
TransactionVision Processing Server places the appropriate events on a 
JMS queue that you have defined. See "Events tab" in "Analyzer Page, 
Configuration Tab" on page 101.

For information about creating BPI rules for business transactions, see 
"How to Send Events to BPI" on page 454.

2 The JMS Business Event Handler is listening for new events that are 
arriving on the queue.

3 The JMS Business Event Handler processes the events and sends them to 
the Business Impact Engine for processing.
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TransactionVision Data in the BSM Profile Database

The TransactionVision Sample is frequently uploaded to the BSM Profile 
database where it used for other BSM applications such as Service Health. 
This data can also be extracted into custom reports by using the BSM API. 
See Reports.

The Sample contains information for each Business Transaction CI, 
including: 

➤ Transaction name

The Business Transaction CI name. This name is specified when the CI 
was created. For information about creating Business Transaction CIs, see 
"How to Create a Business Transaction CI" on page 452.

➤ Transaction instance response times for completed transactions

Sum of end-to-end response time of transactions instances that 
completed in the reporting interval and did not have a state of Failed.

The maximum response time of any transactions instance that completed 
in the reporting interval (failed transaction instances are not eligible) is 
also included. 

The minimum response time of any transactions instance that completed 
in the reporting interval (failed transaction instances are not eligible) is 
also included. 

For more information about response times, see "Key Information 
Reported For a Transaction" on page 491.

4 Details of the process and its progression are stored in the Business Process 
Insight database as usual.

5 The Business Process Insight application presents the results of the process 
progression, providing drilldown to the appropriate business transaction 
events within the Transaction Management reports and topologies. 
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➤ Transaction instance end user response times for completed transactions

If RUM is also providing data about the monitored application:

➤ Total end user response time of transactions instances that completed 
in the reporting interval and did not have a state of Failed. 

➤ The maximum end user response time of any transactions instance 
that completed in the reporting interval (failed transaction instances 
are not eligible) is also included. 

➤ The minimum response time of any transactions instance that 
completed in the reporting interval (failed transaction instances are 
not eligible) is also included. 

➤ Transaction instance counts for completed transactions

Total numbers of transaction instances that completed in the reporting 
interval, including subtotals for failed, late, and exception transaction 
instances.

➤ Transaction instance counts for in-process transactions

Total numbers of transaction instances that exist but have not yet 
completed in the reporting interval, including subtotals for failed, late, 
and exception transaction instances.

➤ Transaction instance values for completed transactions

Total value of transaction instances that completed in the reporting 
interval, including subtotals for failed, late, and exception transaction 
instances.

➤ Transaction instance values for in-process transactions

Total value of transaction instances that exist but have not yet completed 
in the reporting interval, including subtotals for failed, late, and 
exception transaction instances.

➤ Customer name

Customer name to which the sample belongs. This is only applicable for 
HP Software-as-a-Service deployments. For all others it is Default client.
313



Chapter 9 • Working with Other Applications in BSM
➤ TV id

The ID for the transaction in TransactionVision.

For details about the fields in the data sample structure, see “Data Sample for 
TransactionVision” in Reference Information.

TransactionVision Data in the ODB 

TransactionVision publishes CIs other than Business Transaction CIs. 

It publishes information corresponding to the infrastructure elements 
discovered by TransactionVision agents. These dependencies can then be 
viewed from the Business Transactions view in System Health.

How TransactionVision Data is Exported to BSM

The TransactionVision Data Samples are sent to BSM through the built-in 
BSM Aggregate TV Data Sample job. Along with other built-in jobs, this job 
is run by the TransactionVision Job Manager. 

The job creates and then delivers aggregate Business Transaction CI data to 
the BSM Profile database. It queries the TransactionVision database, and 
every 5 minutes (300 seconds) delivers it to BSM via HTTP Post. 

The TransactionVision infrastructure CIs are sent to BSM through the ODB 
Population and ODB Update job. These jobs publish and refresh, 
respectively, the following information about the infrastructure:

➤ J2EE applications

➤ J2EE servers on which the J2EE applications reside

➤ and any machines on which J2EE servers are hosted

This job also creates and reports each dependency relationship between 
business transactions and corresponding J2EE applications. 

For more information about these job, see "Built-in Jobs" on page 274.
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Tasks

How to Verify or Modify Communication Between BSM 
and TransactionVision

 1 Select Admin > Transaction Management.

 2 (left pane) Click the TransactionVision node.

 3 (right pane) Select Configuration > BSM Settings tab.

For information about this tab, see "Configuration Tab, BSM Settings Tab" 
on page 296.

How to Enable Communication Between RUM and 
TransactionVision

In the Transaction Management Administration pages:

 1 Designate one (and only one) Analyzer in the TransactionVision 
deployment environment to process RUM events. This involves setting 
the Do you want to enable this Analyzer for RUM events? checkbox in the 
Analyzer wizard. See "Key Configuration Concepts for Analyzers" on 
page 73.

The built-in RUM Commlink is automatically assigned to the Analyzer. 
See "Default Communication Links" on page 141.

In the RUM Administration user interface:

 1 Designate one and only one RUM Engine to connect to the 
TransactionVision Analyzer from step 1 above. 

This involves using the Configuration drop-down menu on the RUM 
Engine Web console to access the TV Connection Settings. See the Real 
User Monitor Administration PDF.
315



Chapter 9 • Working with Other Applications in BSM
How to Enable Communication Between BPI and 
TransactionVision

In the Transaction Management Administration pages:

 1 Designate a single Analyzer in the TransactionVision deployment 
environment to process BPI events. This involves setting options in the 
BPI group in the Analyzer’s Configuration Page, Events tab. See 
"Configuration Tab, Events Tab" on page 105.

 2 Designate which events you want to export to BPI. See "How to Send 
Events to BPI" on page 454.

In the BPI Server Administration user interface:

 1 Specify the JMS Service Provider configuration that matches the values 
specified on the BPI group in the Analyzer’s Configuration Page, Events 
tab. 

If you are using the built-in SonicMQ as the messaging middleware 
product, the default settings in the JMS Service Provider configuration 
should apply. 

This makes the events automatically available within process definitions. 

 2 In the BPI Modeler, add the events. 

For complete details on importing events into Business Process Insight, 
see Using Business Process Insight.
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Troubleshooting and Limitations

This section includes the following topics:

"Time Zone On Target Applications Must Be Set Correctly" on page 317

"Samples Not Delivered to BSM" on page 317

Time Zone On Target Applications Must Be Set Correctly
Make sure all components (for example TransactionVision, Real User 
Monitor, Business Process Monitor) are time synched with BSM, or the data 
might not be consistent across the different components.

Samples Not Delivered to BSM
When TransactionVision samples are not delivered to BSM check the 
settings desribed on the "Configuration Tab, BSM Settings Tab" on page 296. 

If you still do not see TransactionVision samples in the BSM applications 
such as Service Health, you can debug further by turning on tracing. See 
"How to Modify the Built-in Jobs" on page 275.
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Administration Utilities

This chapter includes:

Reference

➤ AnalyzerManager on page 320

➤ ConfigurationTool on page 321

➤ CreateSqlScript on page 324

➤ DataUtil on page 328

➤ DB2Test on page 330

➤ DeleteEvents on page 331

➤ FlushStatusUtil on page 338

➤ ManageQueue on page 339

➤ MigrateDB on page 347

➤ nanny on page 347

➤ OracleTest on page 350

➤ PartitionUtil on page 353

➤ PassGen on page 354

➤ rebind_agent on page 355

➤ rebind_tux_sensor on page 356

➤ runSupportSnapshot on page 357

➤ SetupModule on page 361

➤ SQLServerTest  on page 362

➤ TimeServer on page 363

➤ ValidateXml on page 365
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Reference

AnalyzerManager

Location:

<TVISION_HOME>/bin/AnalyzerManager.[sh|bat]

Purpose: 

Manage the TransactionVision Analyzer service. 

Syntax:

Options:
 

AnalyzerManager -status -processinfo | -reconfig | -version | -exit [keepcollect] | -debug 
on|off | 
-trace on|off) | -perf on|off [-host HOST] [-index INDEX]

Option Description

-status Reports the current Analyzer status. 

-processinfo Reports the process status of all Analyzers on this host. This 
also returns Analyzer index which is needed for other 
options of this utilty and for the nanny utility.

-reconfig Reloads Analyzer configuration settings (classification/
logging/all settings) without stopping event collection. 

-version Returns Analyzer version information.

-exit

-exit [keepcollect]

The Analyzer stops collecting event data, then the process 
exits. 

Use keepcollect to specify that stop messages are not sent to 
agents and event collection continues.

-debug Enable or disalbe the Analyzer in debug mode.

-trace Enable or disable analyzer trace logging.

- perf Enable or disable analyzer performance logging.
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Examples:

To exit the Analyzer without sending a stop collection message to the agent 
(so that the agent continues to collect events), use the following command:

AnalyzerManager -exit -keepcollect

Note that the agent only continues to collect events until the last 
configuration message has expired, since there will not be any new 
configuration messages sent by the Analyzer. You can change the 
configuration message expiry on the Analyzer configuration.

ConfigurationTool

Location:

<TVISION_HOME>/bin/ConfigurationTool.[sh|bat]

Purpose:

Use this utility to manually send Stop configuration messages to 
TransactionVision agents. This tool can be used as an emergency means of 
stopping TransactionVision agents from sending events. 

This utility works with WebSphere MQ and SonicMQ event transport 
providers only. 

The database name, database host IP, database schema id, and 
communication link id are specified to construct the Stop Configuration 
message. ManageQueue -show_event_ids can be used to examine the events 
on the event queue to determine what to use for these values.

- host HOST Name of the host where the Analyzer runs. Can be either 
name or IP address. Local host is used if not specified. 

-index Index number of the Analyzer to perform the operation 
against. 

If no index is specified, then the analyzer with index 1 is 
used by default.

Option Description
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Syntax:

Options:
  

ConfigurationTool [Queue Connection Options] [Configuration Options] <Action>
[Input/Output Options] [Miscellaneous Options] 

Option Description

 <Action> -stop  Sends a Stop configuration message to the 
specified queue. 

 [Queue Connection Options] 

-qm QUEUEMANAGER WebSphere MQ queue manager to connect to. 

-sonicmq (-s) SonicMQ server to connect to. 

-host (-h) HOST Host name for client connection to queue manager. 

-port (-p) PORT Listener port for client connection to queue 
manager. 

 -channel (-c) CHANNEL Client connection channel to queue manager.

 -username USERNAME Username to connect with. 

 -password PASSWORD Password to connect with. 

[Input/Output Options] 

-outputqueue (-oq) 
QUEUE 

Output queue. 

 [Configuration Options] 

-schema ID|NAME Specifies the schema ID or name to use in the 
configuration message. 

-db_name NAME Specifies the database name to use in the 
configuration message. If not specified, the currently 
defined database name is used. 

-db_host IP|HOST Specifies the database host IP or name to use in the 
configuration message. If not specified, the currently 
defined database host IP is used. 

-commlink ID|NAME Specifies the communication link ID or name to use 
in the configuration message 
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Usage Notes: 

In some cases, events continue to be collected from the WMQ Agent despite 
the fact that collection has been stopped from the TransactionVision user 
interface. This may be due to orphaned configuration messages on the 
config queues that had infinite timeout, which would cause them to stay 
enabled indefinitely. Shutting down the queue managers would resolve the 
problem, but this is not possible in a production environment. 

To clear out the orphaned messages from the configuration queue, and 
thereby stop event collection use the ConfigurationTool utility to issue an 
emergency stop message. 

[Miscellaneous Options] 

-verbose (-v) Print verbose output. 

-trace (-t) Enable agent trace logging. 

Option Description
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CreateSqlScript

Location:

<TVISION_HOME>/bin/CreateSqlScript.[sh|bat]

Purpose: 

To create and optionally execute an SQL script to create, drop, import or 
export a TransactionVision system table or schema table. 

Syntax:

Options:
  

CreateSqlScript 
{-create(-c) | -drop(-d) | -import(-i) | -export(-ex) | -grant(-g) | -dbstats(-ds)}

  {-system(-sys) | -schema(-s) SCHEMA | -table(-t) TABLE SCHEMA}
  [[-noscript(-n)] -execute(-e)] [-noprompt(-np)]
  [-noinsert(-ni)] 
  [-tablespace(-ts) TABLESPACE] [-dbMove(-m)] 
  [-fileType(-f) IXF|DEL] [-lobPath(-lp) PATH]
  [-noLob(nl)] [-dbproperties(-db) FILE]

Option Description

-drop (-d) Drop tables

-create (-c) Create tables

-execute (-e) Execute script

-noscript (-n) No script generation

-noinsert (-ni) Do not insert initial table rows

-system (-sys) Create script for system tables

-schema (-s) SCHEMA Create/drop tables in schema SCHEMA

-table (-t) TABLE SCHEMA Create/drop table TABLE in schema SCHEMA

-dbMove (-m) Use db2move to import/export data

-tablespace (-ts) 
TABLESPACE

Use tablespace TABLESPACE. See "Usage Notes: " on 
page 326 for information about using this option 
with an Oracle database.
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-dbproperties (-db) FILE Use Database.properties file FILE.

-dbstats (-ds) Generates a script for generating the database 
statistics used by the database optimizer. 

-import (-i) Generates a database import script. To run database 
scripts, use the command db2 -n -t -f <sql script 
filename>. For a DB2 database, you can combine this 
option with the -fileType and -lobPath options to 
customize the data format and the location of LOB. 
You may NOT combine this option with the 
-noscript or -execute options.

-export (-ex) Generates a database export script. To run database 
scripts, use the command db2 -n -t -f <sql script 
filename>. For a DB2 database, you can combine this 
option with the -fileType and -lobPath options to 
customize the data format and the location of LOB. 
You may NOT combine this option with the 
-noscript or -execute options.

-fileType (-f) IXF|DEL Specify the DB2 data output file format used for 
importing/exporting data. The default type is IXF. 
For the IXF file type, the import/export script uses 
the LOBFILE option for rows that contain greater 
than 32K data. For the DEL type, the import/export 
script exports LOBFILEs into a single file (requires 
FixPack 8).

-lobPath (-lp) PATH Specifies the directory for DB2 LOBFILEs. The default 
value is the current directory.

-grant (-g) Generates a script for granting all database privileges 
required for accessing the tables of the schema to the 
database user specified in Database.properties 
(Oracle and DB2 only)

-noLob (-nl) Do not generate DB2 export/import SQL with 
LOBINFILE option. This option truncates LOB data 
to the first 32K bytes.

-noprompt (-np) Do not prompt for confirmation when dropping 
tables

Option Description
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Usage Notes: 

Note: The TransactionVision Analyzer and UI/Job Server need to be stopped 
before performing any database imports or exports. This is to avoid causing 
the database import/exports to fail because of database locks held by the 
Analyzer or Web application. If a schema is dropped, make sure that there 
are no users logged in that are using that schema.

When the -dbstats option is specified, the generated SQL script updates 
statistics about the physical characteristics of a table and the associated 
indexes. These characteristics include metrics like number of records, 
number of pages, average record length, and so forth. The optimizer uses 
these statistics when determining access paths to the data.

This SQL script should get executed when a table has had many updates, 
such as when data is continuously collected into the database by the 
TransactionVision Analyzer.

It could result in large performance gains in queries made by 
TransactionVision views and reports, as well as queries made internally by 
the TransactionVision Analyzer to correlate events.

Alternatively, you can use the database vendor tools (Oracle Enterprise 
Manager, DB2 Control Center) to regenerate the database statistics.

Note: While the database statistics are being generated the 
TransactionVision Analyzer processing slows down.

SQL Server does not have the concept of “table spaces,” but the “file group” 
is a similar concept. Though tables can be distributed to different file groups 
by using custom DDL scripts, the creation of tables in specific file groups 
through the Analyzers or CreateSqlScript is not supported.
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Examples:

Create system tables with schema as TVISION and execute the procedure 
without generating SQL script:

CreateSqlScript –e –n –c –sys

Drop table EVENT in schema PROJECT and execute the procedure without 
generating SQL script:

CreateSqlScript –e –n –d –t EVENT PROJECT
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DataUtil

Location:

<TVISION_HOME>/bin/DataUtil.[sh|bat]

Purpose:

Offers various functionality to display and manipulate TransactionVision 
data stored in the database, and is mainly used for diagnostics purposes. 
This utility obtains database connection information from the 
TransactionVision Database.properties file.

Syntax: 

Options: 

DataUtil -schema(-s) schema [options]

Option Description

-schema The database schema.

-localtxn_list(-ltl) pii,seq | btxnid Prints data for all local transactions of a 
business transaction.

-localtxn_ids(-ltids) pii,seq | btxnid Prints the ids of all local transactions for a 
business transaction.

-businesstxn_ids(-btids) pii,seq | 
ltxnid

Prints the business transaction id for a 
local transaction.

-localtxn_events(-ltev) pii,seq | 
ltxnid

Prints data for all events of a local 
transaction.

-businesstxn_events(-btev) pii,seq | 
btxnid

Prints data for all events of a business 
transaction.

-localtxn_data(-ltd) pii,seq | ltxnid Prints data for a local transaction.

-businesstxn_data(-btd) pii,seq | 
btxnid

Prints data for a business transaction.

-correlated_events(-ce) pii,seq | 
seqid 

Prints out all correlated events for an 
event.
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-eventdetail(-ed) pii,seq | seqid 
{-conv}

Prints out the event XML document for 
an event (-conv translates object ids into 
object names).

-userdata(-ud) pii,seq | seqid Prints out the user data for an event.

-sysmodel_object(-smo) objid Prints the data for a system model object.

-eventid(-eid) seqid Prints proginst_id and sequence_no for a 
given seq_id.

-seqid(-sid) pii,seq Prints seq_id for a given proginst_id and 
sequence_no.

-counts(-c) Prints transaction counts.

-row_counts(-rc) Prints the row count for all schema tables.

-list_schemas(-ls) Prints out all schema names registered 
within TransactionVision.

-show_ids(-si) Prints schema and commlink IDs.

-sql QUERYFILE Prints out the generated SQL for an XML 
query document.

-query QUERYFILE Executes the query specified by the XML 
query document and returns the resulting 
<EventList> document.

-clear_txndef Clears all transaction class and 
classification data in the database.

-import_txndef INFILE 
[CLASS_XDM_DIR]

Imports the classes and classification rules 
contained in the legacy classification rule 
file INFILE. If an optional XDMDIR is 
specified, the class attribute values from 
the XDM files are also imported.

-export_txndef [OUTFILE] Exports the transaction classes and 
classification rules to a legacy 
classification rule file (all schemas).

Option Description
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DB2Test

Location:

com.bristol.tvision.admin.DB2Test 

Description:

Measures DB2 database INSERT performance. 

The utility inserts sample event data into the RAW_EVENT table of the 
specified schema. Before running the test, create a new schema schema with 
CreateSqlScript (which can be deleted after running the test). See the 
TransactionVision Planning Guide for details on how to set up the required 
test environment

-export_schema_txndef SCHEMA 
[OUTFILE] 

Exports the transaction classes and 
classification rules for a specific schema to 
a legacy classification rule file.

-import_classxdm XDM_DIR Imports all class attribute values from the 
transaction class XDM files located in 
XDM_DIR.

-export_classxdm SCHEMA Exports all class attribute values for a 
specific schema to a legacy 
TransactionClass.xdm file.

-pii Proginst_id a of an event.

-seq Sequence_no (primary key) of an event. 

-ltxnid Local_trans_id of a local transaction.

-btxnid Business_trans_id of a business 
transaction.

Option Description
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Syntax: 

Options: 

DeleteEvents

Location:

<TVISION_HOME>/bin/DeleteEvents.[sh|bat]

Purpose:

Allow the user to delete events in EVENT tables and clean up contents in 
other tables related to deleted events.

The utility (by default) does only delete the event data. In order to clean up 
other related table data like system model objects and transaction data, use 
the options -deletePiis and -deleteTxns described below. If you have deleted 
event data without these options, you can clean up the remaining data by 
running the DeleteEvents utility again with the option -cleanup.

java com.bristol.tvision.admin.DB2Test databaseName user passwd schema 
eventCount eventSize threadCount {-commit n}{-jdbcBatch} 

Option Description

-databaseName Name of the DB2 Database that contains the schema to be 
used for the test

-user DB2 user name

-passwd DB2 password

-schema TransactionVision schema in which sample event data will 
be saved

-eventCount Number of events to generate

-threadCount Number of threads to use to generate events

-commit n Executes every n insert statements as part of a single batch 
operation. Default is to commit each insert individually.

-jdbcBatch Use JDBC standard batching
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Syntax:

Options:
 

DeleteEvents
-from(-f) TIME -to(-t) TIME | -older(-o) TIME | -newer(-n) TIME
    [-timezone(-tz) TZID] [-businesstxns(-bt) [-state STATE] [-result RESULT]]
    [-keepPiis(-kp)] [-keepTxns(-kt)] [-keepLocalTxns(-klt)]
    [-deleteStats(-ds) [topology(t)] [business(b)]]
    [-threadcount(-tc) THREADS] [-nosplit]

-eventCountLimit(-ecl) MAXCOUNT
    [-businesstxns(-bt) [-state STATE] [-result RESULT]]
    [-keepPiis(-kp)] [-keepTxns(-kt)] [-keepLocalTxns(-klt)]
    [-deleteStats(-ds) [topology(t)] [business(b)]]
    [-threadcount(-tc) THREADS] [-nosplit]

-query(-q) QUERY
    [-keepPiis(-kp)] [-keepTxns(-kt)]

-cleanup(-cl)
    [-sysmodel(-sys)] [-transactions(-txns)]

-event PII SEQNO
-btxn BTXNID

common options:
    -schema(-s) SCHEMA
    [-commit(-c) COUNT] [-timeout(-ti) MINUTES] [-force(-fc)]
    [-loglevel(-log) LOGLEVEL]

Option Description

-keepLocalTxns(-klt) Do not delete local transactions from the 
transaction tables. (DEFAULT: keep only 
business transactions, only applicable if using 
-keepTxns).

-event PII SEQNO Delete a single event.

-btxn TXNID Delete a single business transaction.

-query (-q) QUERY Specifies the name of the query.
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-commit(-c) COUNT Commit database transactions after the 
specified COUNT. The default interval is 1000.

-from(-f) STARTTIME Specifies the start time (Time format = mm/dd/
yyyy hh:mm:ss.SSS, event time in the time 
zone you set (your local time zone by default) 
or, for relative time, n[hr|min])

-to(-t) ENDTIME Specifies the end time (Time format = mm/dd/
yyyy hh:mm:ss.SSS, event time (your local time 
zone by default) or, for relative time, n[hr|min])

-older (-o) TIME Deletes events older than the specified time.

-newer (-n) TIME Deletes events newer than the specified time.

-eventCountLimit (-ecl) 
MAXCOUNT

Deletes all but the latest MAXCOUNT events.

-minage (-m) HOURS By default, the DeleteEvents utility does not 
allow deleting events from the last 48 hours. 
Use this option to override the default. No 
events from the last number of hours specified 
by the HOURS value is to be deleted.

-schema(-s) SCHEMA Database schema for where events are stored.

-businesstxns (-bt) 
[-state STATE]
[-result RESULT]

Deletes only events of transactions with the 
specified transaction state or result. 
State values:
  -1=UNKNOWN
  0=PROCESSING
  1=COMPLETED
Result values:
  -1=UNKNOWN
  0=FAILED
  1=SUCCESS

-deleteStats (-ds) [topology(t)] 
[business(b)]

Deletes statistics data from the topology or 
business transaction statistics table. This is 
optional. The time period specifies the time 
slices for which statistics are deleted.

-timezone (-z) TZID Timezone ID (for example, GMT, EST, etc.)

Option Description
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-help(-h) Displays the usage message.

-keepPiis (-kp) Do not delete program instance or CICS task 
objects from the system model table (DEFAULT: 
off; objects are deleted).

-keepTxns (-kt) Do not delete transactions from the transaction 
tables (DEFAULT: off; transactions are deleted).

-cleanup (-cl)
-sysmodel (-sys)
-transactions (-txns)

Cleans up the system model tables (removes all 
program instance objects which are no longer 
referenced) or transaction tables (removes all 
transaction objects which are no longer 
referenced). You must specify either system 
model tables or transactions.

-iterationcount 
(-it) EVENTS

Maximum number of events to process before 
cleaning out the system model and transaction 
tables. The default is 1000.

-timeout (-ti) MINUTES Force deletion to end after the specified time. 
The default is 60 minutes.

-force (-fc) Force deletion to stop immediately after a 
cancel or timeout. This option is always is effect 
in timestamp deletion mode (for example, with 
the -older option).

-loglevel (-log) LOGLEVEL Log output level. The default is 0.

-threadcount (-tc) THREADS Number of deletion threads (only applicable if 
using -older). The default is 4.

-nosplit Disables deletion of the same table by multiple 
concurrent threads.

-schema(-s) SCHEMA Database schema where events are stored.

-commit(-c) COUNT  Number of database operations to execute 
before committing, default = 1000.

Option Description
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Usage Notes:

This utility operates in three modes: deleting by query mode, deleting by 
time mode, and cleaning up tables. Therefore, the options are grouped into 
three sets.

➤ Deleting by time options include: -from, -to, -older, -newer, -timezone, 
-keepPiis, -keepTxns, -deleteStats, -businesstxns, -state, -result (and 
-threadcount, -nosplit if using -older). The -force option is always in effect 
when deleting by time.

➤ Deleting by query options include: -query, -keepPiis, -keepTxns

➤ The cleanup mode options include: -cleanup, -sysmodel,  -transactions

Options that can be used in all three modes include: -c, -ti, -fc, -log. 
Otherwise, these sets of options may not be mixed. For example, the 
following commands are INVALID and result in errors:

DeleteEvents -schema MYPROJECT -query MYQUERY -business
DeleteEvents -schema MYPROJECT -query MYQUERY -older 05/15/2003 
03:00:00.000

Execution of the DeleteEvents utility or setting the Purging options on the 
Analyzer configuration is processing events is only allowed for the -older 
and -eventCountLimit modes in which the Analyzer executes specific code 
to safeguard against accidental deletion of data in process. But due to the 
negative impact of deletion on the Analyzer performance it is still not 
recommended to delete data while the Analyzer is processing. However, 
sometimes it may not be feasible to shut down the Analyzer while 
DeleteEvents is running. In that case, make sure that you do not delete 
transactions for which events are likely to come in. 

On many systems, deleting events from 2 days to a week in the past can 
ensure this scenario does not occur. However, you need to consider the 
duration of your business transactions to determine a period beyond which 
events can be deleted. For example, if your business transactions can span a 
day, do not delete events in the last day, if your business transactions can 
span a week, do not delete events in the last week while the Analyzer is 
running. The utility (by default) does not delete any events that are younger 
than 48 hours. If you are sure that no transaction duration ever exceeds a 
certain value, you can override this behavior by specifying the option 
-minage n, where n is the time buffer to exclude in hours.
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Deleting by time mode provides better performance results than deleting by 
query. The performance of the deletion options can be ordered in the 
following way:

 1 Deletion by query (low performance)

 2 Deletion by time with options -from/to or -newer (medium performance)

 3 Deletion based on event count (medium-high performance)

 4 Deletion by time with option -older (high performance)

The deletion by time with option -older is able to take advantage of 
timestamp columns present in the tables and achieves much higher 
performance than the other methods. Also, it can execute the deletion 
process with multiple threads (option -threadcount), where each thread 
deletes different portions of the tables at the same time. The default number 
of threads is 4. You should adjust this option to the number of CPUs (or 
higher) in your system.

The deletion based on event count (-eventCountLimit) has similar 
performance characteristics as the deletion by time. Internally, the deletion 
module determines the date from which to delete based on the event count 
parameter, and then performs a -older deletion.

The following conditions may also affect the performance of the 
DeleteEvents utility:

➤ Make sure your database log space is sufficient, and adjust the number of 
uncommitted database operations (option -commit) accordingly; 
otherwise, the deletion process fails running out of logspace. Usually a 
larger commit count yields better deletion performance.

➤ On DB2, you could encounter deadlocks if the deletion is using multiple 
threads and your database lock storage is low. In that case, please adjust 
the value of LOCKLIST and MAXLOCKS accordingly. On Oracle this is of 
no concern because Oracle never escalates row locks to table locks. 
Alternately, use the option -nosplit to DeleteEvents. This disables the 
concurrent deletion of a single table by multiple threads.
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Time formats may be absolute format or relative format. Absolute times are 
specified as mm/dd/yyyy hh:mm:ss.SSS. Relative times are specified as 
n[hr|min]. Relative time is offset to the time you run the script. For example 
“12 hr” means “12 hours before the current time.” You can specify the time 
in any of the following ways. The descriptions assume that the script was 
run at 9:00 a.m.  

Examples:

 1 Delete everything (event and related data) from schema PROJECT which 
is older than 72 hours using 2 threads and commit database transactions 
after 10000 operations:

DeleteEvents -schema PROJECT -older 72 hr -kp -kt 
-ds b t -tc 2 -c 10000

 2 Delete events from schema PROJECT using query QUERY and commit the 
database transaction after deletion of every 10 events:

DeleteEvents –schema PROJECT –query QUERY –c 10

 3 Delete events from GMT time 11:00AM, July 10, 2003 to GMT time 
8:00PM, July 11, 2003:

DeleteEvents –from 07/10/2003 11:00:00.000 –to 07/11/2003 20:00:00.000 –z 
GMT

 4 Delete events collected before 10 minutes together with statistic data 
from topology table:

DeleteEvents –older 1 hr -minage 1 –statistics t

 5 Delete all but the latest 500,000 events in the schema:

DeleteEvents -schema PROJECT -eventCountLimit 500000

Example Description

-f 2 hr -t 1 hr Deletes events from 7:00 a.m. to 8:00 a.m.

-o 1 hr Deletes events that came into the system before 8:00 a.m.

-n 1 hr Deletes events within the last hour.
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FlushStatusUtil

Location:

<TVISION_HOME>/bin/FlushStatusUtil.[sh|bat]

Purpose:

Shows and cleans the flush status of transaction analysis data and cached 
statistics for the Static Component Topology. The status is stored in the 
database and determines whether recovery is needed when the Analyzer 
starts. This utility can be used to force Analyzer startup without performing 
recovery by cleaning the flush status before starting the Analyzer.

Syntax:

Options:

Usage Notes:

Shows and cleans the flush status of transaction analysis data and cached 
statistics for the Static Component Topology. The status is stored in the 
database and determines whether recovery is needed when the Analyzer 
starts.

For cached statistics, the status contains the IDs of the events for which 
statistics and analysis data are missing in the database.

This utility obtains database connection information from the 
TransactionVision Database.properties file.

FlushStatusUtil –schema SCHEMA [-clean]

Option Description

-schema The name of the database schema to show or clean the flush 
status for.

-clean Clean the current flush status of the analysis data and 
statistics (default action is ‘show’). The Analyzer starts up in 
a “clean” state without recovery, even though data might be 
missing in the database. Use this option with extreme 
caution.
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Example Output:

The following output indicates that IDs 7916-8084 and the set of additional 
IDs are missing statistics and analysis data and need to be recovered at the 
next startup time:

Last written sequential_id in EVENT_LOOKUP: 8084

DBCACHE flush status:
Last flushed sequential_id: 7915
Additional ids not flushed: 7912,7911,7901,7892,7870,7872

STATISTICS flush status:
Last flushed sequential_id:7915
Additional ids not flushed: 7912,7911,7901,7892,7870,7872
The following output indicates that all statistics and analysis data has been 
flushed; no recovery is needed:
Last written sequential_id in EVENT_LOOKUP: 9640

DBCACHE flush status:
Last flushed sequential_id: 9640
STATISTICS flush status:
Last flushed sequential_id: 9640

ManageQueue

Location:

<TVISION_HOME>/bin/ManageQueue.[sh|bat]

Purpose:

This utility works with SonicMQ and WebsphereMQ only.

Use this multipurpose tool to manipulate and maintain TransactionVision 
event queues. This utility allows you to copy, move, and delete messages 
(usually TransactionVision related, but not limited to) from a queue. The 
messages can be transferred from the queue to another queue or archived 
into a jar file that can later be extracted and copied into a queue.
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This utility also provides a means to query Analyzer (schema) related 
database IDs and summarize the contents of an event queue (or other 
queues). 

Syntax:

Options:
 

ManageQueue <Action Options> [Queue Connection Options] [Input/Output Options] 
[Message Selection Options] [Miscellaneous Options]

Options Description

Action Options

-show_db_ids Display all schema and communication link IDs from 
the database defined in Database.properties

-show_event_ids Display all TransactionVision event IDs from a given 
Input

-copy [SCHEMA 
COMMLINK]

Copy messages from Input to Output using Message 
Selection Options. Optionally targets the messages to a 
new SCHEMA and COMMLINK. If no SCHEMA and 
COMMLINK are specified, all messages are copied 
using their original message IDs.

-move [SCHEMA 
COMMLINK]

Move messages from Input to Output using Message 
Selection Options. Optionally targets the messages to a 
new SCHEMA and COMMLINK. If no SCHEMA and 
COMMLINK are specified, all messages are moved 
using their original message IDs.

-delete Deletes messages from Input using Message Selection 
Options.

Queue Connection Options

-qm QUEUEMANAGER Queue manager to connect to

-host (-h) HOST Host name for client connection to queue manager

-port (-p) PORT Listener port for client connection to queue manager

-channel (-c) CHANNEL Client connection channel to queue manager
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-username USERNAME Username to connect with

-password PASSWORD Password to connect with

Input/Output Options

-input_file (-if) FILE1 
[FILE2…]

Input files

-input_queue (-iq) 
QUEUE1 [QUEUE2…]

Input queues

-output_file (-of) FILE Output file

-output_queue (-oq) 
QUEUE

Output queue

Message Selection Options

-commlink ID|NAME All TransactionVision events targeted to a given link 
ID or name

-schema ID|NAME All TransactionVision events targeted to a given 
schema ID or name

-db_name NAME All TransactionVision events targeted to a given 
database name

-db_host IP|HOST All TransactionVision events targeted to a given 
database host (IP or name)

-erroneous All messages not recognized as TransactionVision 
events

-userevents All messages recognized as TransactionVision User 
events

-alltv All messages recognized as TransactionVision events

-otherdbs All TransactionVision events targeted to databases 
other than the one defined in Database.properties

-orphaned All TransactionVision events targeted to schema and/
or communication link IDs which no longer exist

Options Description
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Usage Notes:

The utility takes five different types of options, most of which are optional 
with the exception to the Action. In addition to the Actions, there are 
Queue Connection Options which provide information needed to connect 
to a given queue manager or broker if needed.

Input and Output options are used to copy, move, or delete from a queue or 
jar file. An output option is only needed if there is a copy or move action 
performed.

Input Message Selection Options are special options only used in 
conjunction with the -input_queue option. This provides a means for 
processing the Action on only a subset of the messages on the queue.

Miscellaneous Options provide additional functionality. The -verbose 
option shows additional information during message processing to show 
progress status, and displays a summary of what was processed at the end of 
execution. The –count option allows you to process only the first given 
number of events from the Input.

With the use of –show_event_ids, you can display a summary listing of all 
TransactionVision events on a given Input Queue. ManageQueue 
summarizes them by showing a count of each message and which database, 
schema, and communication link they are targeted for.

-valid All TransactionVision events targeted to valid schema 
and communication link IDs

Miscellaneous Option

-count COUNT Process a specified limited number of messages.

-verbose (-v) Print verbose output.

-help Print usage.

Options Description
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The –show_event_ids option also determines whether the messages are 
TransactionVision events with a valid destination (valid target schema and 
communication link on the defined database) and reports them as “Valid.” 
Events which are targeted to a schema and/or communication link which 
no longer exist are shown as “Orphaned.” And events targeted to another 
database which may or may not be valid are shown as “Other DB.”

The –show_event_ids option also shows a count of events not recognized as 
TransactionVision events as “Erroneous Messages.”

Input and Output can be combinations of queues and/or jar files. The 
following limitations apply to Input Files:

➤ You cannot use –show_event_ids with Input Files.

➤ You cannot use –move with Input Files. Use –copy instead.

➤ You cannot use –delete with Input Files.

When using an Input Queue and/or Output Queue, you must provide 
Queue Connection Options. For WebSphere MQ, if only a queue manager is 
specified (-qm), server binding is used. For client connections, use –host, 
-port, and -channel. The –port option is optional as the default port is 1414 
when using the –host and –channel options. For SonicMQ, specify the 
-sonicmq option along with -host and -port to the SonicMQ broker.

ManageQueue only supports connection to one queue manager or broker. If 
there is a need you transfer messages from a queue on one queue manager or 
broker to a queue on a different queue manager, use a remote queue or 
cluster for the destination queue or broker, or transfer the messages to an 
Output File. Then transfer them from the file to the destination queue.

When using an Input Queue, you can specify Message Selection Options to 
process only a subset of the messages on the specified Input Queue. There 
are two types of message selection:

➤ Discrete Selectors

-commlink
-schema
-db_name
-db_host
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➤ Validity Selectors

-erroneous
-alltv
-otherdbs
-orphaned
-valid

In you use any Discrete Selectors, all Validity Selectors are ignored, with the 
exception of –erroneous because it does not apply to TransactionVision 
events. Discrete Selectors are ANDed so all Discrete Selectors specified must 
match in order for the message to be processed.

If no Discrete Selectors are used, the specified Validity Selectors are ORed. All 
messages matching any of the specified Validity Selectors are processed.

If no selectors are used, all messages are processed.

Any option that requires the user to specify a schema and/or 
communication link can take either the database ID or name. Surround 
names containing spaces with quotation marks.

When copying or moving messages to a queue, it may be necessary to 
specify new targeted schema and communication link IDs or names. This is 
especially useful when the messages have been orphaned (the targeted 
schema and/or communication link does not exist anymore). If no schema 
and communication link is specified, each message’s original event 
information is used.

When copying or moving messages to a jar file, new schema and 
communication link IDs or names are not required. If they are specified, 
they are ignored by ManageQueue.

Examples:

➤ Remove all messages on the event queue which are not being processed. 
This includes non-TransactionVision (erroneous) messages and events 
that are targeted to a schema and/or communication link which no 
longer exists (orphaned):

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –delete 
–erroneous –orphaned –verbose
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➤ Show all messages on the event queue:

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
show_event_ids

This command results in output similar to the following:

➤ Show all Database IDs:

ManageQueue.sh –show_db_ids

This command results in output similar to the following:

➤ Connection to WebSphere MQ:

ManageQueue.sh -qm tv.qmgr -input_queue TVISION.EVENT.QUEUE -delete 
-erroneous -orphaned -verbose

➤ Connection to TransactionVision SonicMQ:

ManageQueue.sh -sonicmq -host win2003 -port 21111 -input_queue 
TVISION.EVENT.QUEUE -delete -erroneous -orphaned -verbose

➤ Move all TransactionVision events from the TransactionVision Exception 
Queue to the event queue. Target them to the TVISION schema and the 
TVision – TransactionVision.qmgr communication link.

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVSISION.EVENT.QUEUE –move “TVISION” “TVISION – 
tv.qmgr” -alltv
or

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVISION.EVENT.QUEUE –move 1 1 –alltv
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➤ Retarget all events not being collected because they are currently targeted 
to a schema and/or communication link which no longer exists 
(orphaned):

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
output_queue TVISION.EVENT.QUEUE –move 1 1 -verbose
or

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
output_queue TVSION.EVENT.QUEUE –move “TVISION” “TVision – tv.qmgr” –
verbose

➤ Move all TransactionVision events from the TransactionVision Exception 
Queue to their respective event queue. This example assumes that the 
schema TVISION uses the communication link “TVision – tv.qmgr” 
which in turn uses TVISION.EVENT.QUEUE, and schema TVISION2 uses 
communication link “Test – tv.qmgr” which in turn uses 
TVISION.TEST.QUEUE.

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVISION.EVENT.QUEUE  -move –schema “TVISION” –commlink 
“TVision – tv.qmgr”
ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVISION.TEST.QUEUE –move –schema “TEST” –commlink “Test 
– tv.qmgr”

➤ Archive all messages on the event queue into a jar file while leaving them 
on the queue:

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
output_file events.jar –copy –verbose

➤ Replay all events stored in a jar file for the TVISION schema to the TVision 
– tv.qmgr communication link:

ManageQueue.sh –qm tv.qmgr –input_file events.jar -output_queue 
TVISION.EVENT.QUEUE –copy “TVISION’ “TVision – tv.qmgr” -verbose
or
ManageQueue.sh –qm tv.qmgr –input_file events.jar –output_queue 
TVISION.EVENT.QUEUE –copy 1 1 -verbose
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MigrateDB

Location:

<TVISION_HOME>/bin/MigrateDB.[sh|bat] 

Description:

Migrates database files from an older version of TransactionVision to the 
current version. This script has to be run after an upgrade installation 
process. It must be run in a configured TransactionVision environment; the 
Database.properties must be set correctly for communication with the 
database.

Syntax:

nanny

Location:

<TVISION_HOME>/bin/nanny.[sh|bat] 

Description:

Manages the services controlled by the Nanny Manager. TransactionVision 
components such as SonicMQ Domain Manager, SonicMQ Broker, the 
Analyzer and the UI/Job Server are services which are managed (started/
stopped/monitored) by the Nanny Manager. 

The Nanny Manager is a service (named HP Business Availability Center) on 
Windows and a process on UNIX (nannyManager). This nanny utility can 
be used to find out which components are being managed by the 
NannyManager.

MigrateDB 
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Syntax: 

Options: 

nanny -s <hostname> -p <port> <cmd> 

Option Description

-s <hostname> Hostname of the host where the Analyzer is 
installed. It defaults to localhost.

-p <port> Port of the nanny server. It defaults to 11020.
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Examples:

To list all services being managed by the Nanny Manager, enter:

nanny.bat listAllServiceNames 

<cmd> One of the following commands: 
-disableService <servicename> 

-enableService <servicename>

-getServiceInfo <servicename> 

-isServiceRunning <servicename> 

-listAllDisabledServicesNames

-listAllServicesNames 

-listDeadServicesNames

-listLiveServicesNames

-listServiceInfo

-listStartingServicesNames

-restartService <servicename>

-retrieveNannyManagerHTMLAdapterPort 

-showStackTrace <servicename>

-startAllServices

-startService <servicename>

-stopAllServices

-stopService <servicename> 

where <servicename> is one of the following:

tv_as - TransactionVision UI/Job Server 
Tomcat Web Service
tv_message_broker - TransactionVision 
SonicMQ Message Broker
tv_domain_manager - TransactionVision 
SonicMQ Domain Managerv_analyzer - 
TransactionVision Analyzer 

Option Description
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The command generates the following output:

Executing: listAllServicesNames Service:  on (localhost,11020)
Result = [tv_as, tv_message_broker, tv_domain_manager, tv_analyzer]

The nanny utility can enable or disable a component. Once a component is 
disabled, it is not managed by the NannyManager until it is enabled.

To disable the Analyzer, run the following command: 

nanny.bat disableService tv_analyzer

To enable the Analyzer, run the following command: 

nanny.bat enableService tv_analyzer

The nanny utility can also be used to start a component after it has been 
enabled. 

To start the Analyzer component, run the following command: 

nanny.bat startService tv_analyzer

OracleTest

Location:

com.bristol.tvision.admin.OracleTest 

Description:

Measures Oracle database INSERT performance. 

The utility inserts sample event data into the RAW_EVENT table of the 
specified schema. Before running the test, create a new schema with 
CreateSqlScript (which can be deleted after running the test). See the 
TransactionVision Planning Guide for details on how to set up the required 
test environment
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Syntax: 

Options: 

java com.bristol.tvision.admin.OracleTest databaseName host port user passwd 
schema eventCount eventSize threadCount [-VARCHAR | -BLOB | 
-LONGRAW] {-commit n} {-jdbcBatch} {-OracleBatch} {-thin} {-parallel} {-url URL}

Option Description

-databaseName Name of the Oracle database that contains the schema to 
be used for the test.

-host Name of host system on which the Oracle server exists

-user Oracle user name

-passwd Oracle password

-schema TransactionVision schema in which sample event data will 
be saved

-eventCount Number of events to generate

-eventSize Size of event user data buffer (default is 1024 bytes)

-threadCount Number of threads to use to generate events

-VARCHAR Use this option if the RAW_EVENT table has been created 
with a VARCHAR column definition.

-BLOB Use this option if the RAW_EVENT table has been created 
with a BLOB column definition.

-LONGRAW Use this option if the RAW_EVENT table has been created 
with a LONGRAW column definition.

-commit n Executes every n insert statements as part of a single batch 
operation. Default is to commit each insert individually.

-jdbcBatch Use JDBC standard batching.

-oracleBatch Use Oracle update batching

-thin User thin client driver. Default is to use oci client driver.
351



Chapter 10 • Administration Utilities
-parallel Use the Oracle INSERT PARALLEL option instead of the 
standard INSERT INTO.

-url URL By default, OracleTest will use an appropriate JDBC URL for 
thin or oci client drivers. However the default may be 
overwritten by specifying the JDBC URL here.

Option Description
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PartitionUtil

Location:

<TVISION_HOME>/bin/PartitionUtil.[sh|bat]

Description:

Creates an SQL script for adding and dropping table partitions of 
TransactionVision tables database tables.

This utility only works on tables that were created with the table 
partitioning options of CreateSqlScript. 

Syntax:

Options: 

PartitionUtil -db DBTYPE [-add OPTIONS | -drop OPTIONS]

        add OPTIONS (date format: mm/dd/yyyy h:mm [am|pm]):
                -startNo PARTITION_NO -count COUNT -startDate DATE [-localTime]
                -length LENGTH -interval {hours | days | months} -schema SCHEMA

        drop OPTIONS:
                -startNo PARTITION_NO -count COUNT -schema SCHEMA

Option Description

-db The database type: 'oracle' or 'db2'

-startNo The start number of the partition to add or drop. Partitions are 
named PARTn, n = 1,2,… when created via CreateSqlScript

-count The number of partitions to add or drop

-startDate The start date for the first partition to add. The format for this 
date is: mm/dd/yyy h:mm [am|pm]. This time has to be in 
GMT, unless the option -localTime is used.

-localTime Allows to specify the start date in local time.

-length The length for each newly added partition.
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Example:

Generate SQL script for dropping the first two table partitions of schema 
TRADE:

PartitionUtil.bat -db oracle -drop -s TRADE -startNo 1 -count 2 

Generate SQL script for adding two new partitions spanning one day in 
tablespace TS1 to schema TRADE. Assumption: five partitions (PART1 - 
PART5) have already been defined with CreateSqlScript, and the last 
partition reaches up to 04/01/2010 4:00 pm:

PartitionUtil.bat -db oracle -add -s TRADE -startNo 6 -count 2 -length 1 -interval 
days -startDate "04/01/2010 4:00 pm" -ts TS1

PassGen

Location:

TVISON_HOME/bin/PassGen

Description:

A password can be obfuscated by using the PassGen utility.

Syntax: 

Options: 

-interval The length unit for each added partition, valid values are 
'hours', 'days', 'months'.

-schema The database schema.

PassGen /system <password>

Option Description

-password A string of alpha-numeric characters with a maximum length 
of 128 characters. 

Option Description
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Example:

cd <installdir>/bin
$ PassGen /system TheLazyFoxJumpedHigh

password: 
OBF:3q6r3xxz3y3r3xjs3wx03yc63n0r3lbr3vc03wd745893wre44u0413j3kn93zw
y40vi432i44fr3m453m894493439040pc40303kjd419r44na3wx0451h3wir3v6m3
lfr3mwj3yi03wre3xpi3xxz3y3r3q23

rebind_agent

Location:

TVISON_HOME/bin/rebind_agent.sh

Description:

This script rebinds the TransactionVision WebSphere MQ Agent on the AIX 
platform.

In WebSphere MQ support pacs, internal symbols exported from the 
TransactionVision WebSphere MQ Agent on the AIX platform may change. 
When an internal symbol that has been exported from the agent library is 
no longer available in the WebSphere MQ library, the application cannot 
start and fails with various symbol resolution errors.

Hence, the rebind_sensor script needs to be run whenever a WebSphere MQ 
support or fix pac is installed. 

It modifies the TransactionVision agent libraries in <TVISION_HOME>/lib.

On WebSphere MQ 6.0 and above, this utility needs to be run twice, to 
instrument the 32-bit libraries and the 64-bit libraries, as follows:

$TVISION_HOME/bin/rebind_sensor.sh 
$TVISION_HOME/bin/rebind_sensor.sh -64 
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Syntax: 

Options:  

rebind_tux_sensor

Location:

<TVISION_HOME/>bin/rebind_tux_sensor.sh

Description:

This script rebinds the TransactionVision BEA Tuxedo agent on the AIX, 
Solaris and HP-UX platforms.

On HP-UX PA-RISC systems using a 32-bit version of BEA Tuxedo, all Tuxedo 
applications should be shut down before running the rebind_tux_sensor.sh 
script. This will ensure the script does not encounter any conflicts due to 
another process using the BEA Tuxedo library.

rebind_sensor.sh [-v|-s|-h][-64] 

Option Description

-v Writes errors to the console. The default behavior is to write 
errors to <TVISION_HOME>/logs/mqsensorbind.log

-s Uses silent mode, which does not prompt before executing

-h Displays usage message

-64 Rebinds the 64-bit agent library. The default, when this option 
is not present, is to rebind the 32-bit library
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Syntax: 

Options:  

Usage Notes:

The BEA Tuxedo Agent library must be linked to the BEA Tuxedo library 
using its full path.  If this is not done, a BEA Tuxedo application monitored 
by the TransactionVision agent may fail with errors indicated unresolved 
library dependencies or unresolved symbols.

Hence, the rebind_tux_sensor.sh script needs to be run after 
TransactionVision agent installation and whenever BEA Tuxedo is upgraded 
or its installation location is changed.

The TVISION_HOME and TUXDIR environment variables must be set before 
running this script. TUXDIR should be set to the full absolute path of the 
BEA Tuxedo Agent installation directory. The script will modify the 
TransactionVision agent libraries in <TVISION_HOME>/lib or 
<TVISION_HOME>/lib64 as necessary. 

runSupportSnapshot

Location:

<Diagnostics_probe_install_dir>/contrib/JASMutilities/snapins/
runSupportSnapshot.[sh|cmd]

rebind_tux_sensor.sh [-v|-s|-h]

Option Description

-v Writes errors to the console. The default behavior is to write 
errors to <TVISION_HOME>/logs/tuxsensorbind.log

-s Uses silent mode, which does not prompt before executing

-h Displays usage message
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Description:

The runSupportSnapshot utility creates a .zip file containing the entire set 
of files relevant to troubleshooting one or more instances of the Java agent 
in a Diagnostics or TransactionVision deployment environment. This .zip 
file is intended for Customer Support. 

The .zip file contains the following:

➤ Files from the <Diagnostics_probe_install_dir>\etc directory

➤ Files from the <Diagnostics_probe_install_dir>\log directory

➤ Files from the <TransactionVision_sensor_install_dir>\config directory

➤ Files from the <TransactionVision_sensor_install_dir>\logs directory

➤ Property Scanner report, which compares a modified agent directory with 
the release version, and reports differences between the property files, 
points files, and for TransactionVision agents only, XML files.

➤ Probe or agent instance information, including property settings. For 
agents running in 1.5 JVMs, environment variables, stack dumps, and 
class loader information is also included.

Note: If a Diagnostics probe is configured so support SSL, this utility cannot 
collect the instance information.

Basic Syntax:

This utility uses defaults that apply to most agent environments. Therefore 
the typical syntax is simply: 

runSupportSnapshot.[sh|cmd] -console
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Full Syntax:

This utility also allows you specify options to override the defaults, allowing 
it to work in non-typical agent environments. This optional syntax is: 

runSupportSnapshot.[sh|cmd] -console [ -Zipfile ] [ -AddFiles ]
[ -JAUser ] [ -JAPass ] [ -JAPort ] [ -JACount ]
[ -FTPSite ] [ -User ] [ -Pass ] [ -RemoteFile ]
[ -Source1] [ -Source2 ] [ -DiffOnly ] [ -SubDirs ] [ -Sort ]
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Optional Syntax Options:

Option Description

-ZipFile The name of the .zip file that is to be created. Default: 
HPCustomerSupport.zip.

-AddFiles Any additional directories to include in the .zip. To include all 
subdirectories of a directory, append an "+" to the directory name.

-JAUser The user name to be used to access the host on which the Agent is 
running. Default: admin

-JAPass The corresponding password. Default: admin

-JAPort The port on which to start polling for Agent instances. Default: 
35000.

-JACount The maximum number of Java Agent instances on this host for 
which data will be included in the .zip file. Default: 20.

-FTPSite The name of the FTP site. 

-User The user name to be used to access the FTP site. 

-Pass The corresponding password.

-Remote File The remote file name. Prefix the filename with directory path if 
desired. For example, customer/diag/AgentSnapshot.zip.

-Source1 The etc directory of the current Agent installation. Default: 
<Java_probe_install_dir>\etc. 

-Source2 An archived copy of the out-of-the box etc directory in the 
directory. Default: An internal directory to the Agent installation. 

-DiffOnly Only display properties with differences (yes or no). Default: Yes

-SubDirs Specify whether subdirectories are also be compared (yes or 
no).Default: No.

-Sort Specify whether the output is sorted by property name (yes or no). 
Default: No.
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Example:

If desired, review the .zip file for any sensitive data before transmitting it to 
Customer Support. 

SetupModule

Location:

<java_agent_install_dir>\DiagnosticsAgent\lib

where <java_agent_install_dir> refers to the path of your Java Agent 
installation directory. The default path is C:\MercuryDiagnostics\JavaAgent 
on Windows and\opt\MercuryDiagnostics\JavaAgent on UNIX. 

Description:

This script starts the Java Agent Setup Module.

> cd C:\MercuryDiagnostics\JavaAgent\DiagnosticsAgent\contrib\JASMUtilties
\Snapins 
> java  -Dcom.hp.javaagent.diagnostics.home="..\..\.." -jar "..\..\..\lib\setupModule.jar" 
-launchClass com.mercury.opal.javaprobe.setupModule.SetupModule  -launchMethod 
launchSetupModule -importJarList 
probe.jar,org.mortbay.jetty-jdk1.2.jar,javax.servlet.jar,mail.jar,activation.jar 
-importJarsFrom "..\..\..\lib,lib" -customerSnapshot -console
INFORMATION-> [Looking for Java Agent Instances]: Looking for Java Agent 
Instances...please wait...
INFORMATION-> [Java Agent found at http://localhost:35000/inst/
customerSupportSnapshot]: Java Agent Discovery
INFORMATION-> [Creating Probe Information file]: Java Agent Information
INFORMATION-> [Creating Configuration Information file]: Java Agent Configuration 
Information
INFORMATION-> [Zip File Created]: Zip file 
C:\HPCode\diag_head\javaprobe\build\contrib\JASMUtilities\Snapins\HPCustomerSup
portFile.zip Created with length 159215
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Syntax: 

Options: 

SQLServerTest 

Location:

com.bristol.tvision.admin.SQLServerTest 

Description:

Measures SQL Server database INSERT performance. 

The utility inserts sample event data into the RAW_EVENT table of the 
specified schema. Before running the test, create a new schema with 
CreateSqlScript (which can be deleted after running the test).

SetupModule -recordFile name.rec -installFile name.rec -console

Option Description

-recordFile name.rec Records

-installFile name.rec Plays back recording or automates

-console Launches in console mode
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Syntax: 

Options: 

Example:

AnalyzerManager –stop –host HOST

TimeServer

Location:

<TVISION_HOME>/bin/TimeServer.[sh|bat]

Purpose: 

Run the time server stand-alone. 

java com.bristol.tvision.admin.SQLServerTest databaseName user passwd schema 
eventCount eventSize threadCount {-commit n}{-jdbcBatch}

Option Description

-databaseName Name of the SQL Server Database that contains the schema 
to be used for the test

-user SQL Server user name

-passwd SQL Server password

-schema TransactionVision schema in which sample event data will 
be saved

-eventCount Number of events to generate

-threadCount Number of threads to use to generate events

-commit n Executes every n insert statements as part of a single batch 
operation. Default is to commit each insert individually.

-jdbcBatch Use JDBC standard batching.
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Syntax: 

Options:
 

Usage Notes:

In TIBCO and generic JMS environments, TransactionVision is unable to 
determine time skew across a communication link using a COA as it can 
with WebSphere MQ JMS. Instead, a time server reports the current time on 
the host where it is running. Any TransactionVision component can 
connect to it via TCP/IP and get the time skew from the current host to the 
host running the time server.

The Analyzer itself can act as a time server, or it can be run on a different 
host. To run the time server within the Analyzer, modify the 
Analyzer.properties file as follows:

➤ Set the time_server property to on

➤ Optionally, set time_server_port to the listening port you would like it to 
use. The default port is 21104.

Use the TimeServer utility to run the time server stand-alone.

The time server is configured per communication link found on the Time 
Server page in the Communication Link Wizard and under the Time Server 
Definition in the Edit Communication Link page. This definition tells the 
Analyzer and agents where the tie server is in order to calculate time skew.

TimeServer[.sh|.bat] [PORT] 

Option Description

PORT Optionally, specify the listening port for the time server to 
use. The default is 21104.
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ValidateXml

Location:

<TVISION_HOME>/bin/ValidateXml.[sh|bat]

Purpose:

Validates TransactionVision XML configuration files. Currently only the 
files TransactionDefinition.xml, EventCorrelationDefinition.xml, and 
LocalTransactionDefinition.xml can be validated. It is necessary to edit the 
XML file and remove the comments around the DTD declaration.

Syntax: 

ValidateXML XML_filename 
365



Chapter 10 • Administration Utilities
366



11
Agent Error Messages

By default, the agents log informational, error, warning, and trace messages 
to the local0 facility in the UNIX system log (syslogd), the Windows event 
log, the z/OS system log (SYSLOG), or the i5/OS user job log.

In the messages below, %s and %1-n represent text strings that are filled in 
with appropriate information at run time. The message identifiers shown 
before each message, for example SLDS101E, apply only for agents running 
under z/OS and do not appear on other platforms.

Identifier Description

SLDS101E: TransactionVision Agent: failed to 
allocate space for %s

Out of memory error.

SLDS102E: TransactionVision Agent: failed to 
reallocate space for %s

Out of memory error.

SLDS103E: TransactionVision Agent: failed to 
create mutex lock

SLDS104E: TransactionVision Agent: failed to 
lock mutex

SLDS105E: TransactionVision Agent: failed to 
unlock mutex

SLDS106E: TransactionVision Agent: failed to 
destroy mutex lock

SLDS107E: TransactionVision Agent: error 
processing %s

SLDS108E: TransactionVision Agent: Cannot 
connect to configuration queue manager %s: %s

The specified WebSphere MQ error occurred. 
See WebSphere MQ documentation for 
explanation.
367



Chapter 11 • Agent Error Messages
SLDS109E: TransactionVision Agent: Cannot 
open configuration queue %s on queue 
manager %s: %s

The specified WebSphere MQ error occurred. 
See WebSphere MQ documentation for 
explanation.

SLDS10AE: TransactionVision Agent: Cannot 
reconnect to queue manager %s after user’s 
MQDISC call: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLDS10BE: TransactionVision Agent: Cannot 
reopen configuration queue %s on queue 
manager %s after user’s MQDISC call: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLDS10CE: TransactionVision Agent: Cannot 
connect event queue manager %s: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLDS10DE: TransactionVision Agent: Cannot 
open event queue %s on queue manager %s: 
%s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation

SLDS10EE: TransactionVision Agent: %d 
unsuccessful attempts were made to send an 
event message to queue (‘%s’ ‘%s’): %s 
Continuing to retry every %d ms...

Agent was unable to put an event message 
to the given event queue. Often, this is a 
result that occurs if the event queue 
becomes full if the agent is producing 
event messages faster than the Analyzer 
can pull them off the queue. The agent will 
continue to try to put to the event queue 
while the Analyzer is catches up. For 
information about configuring retry 
attempts, see "Event Options Page" on 
page 162.

SLDS10FE: TransactionVision Agent: Timed 
out (%d s) attempting %u times to put event 
message to queue (‘%s’ ‘%s’)

Agent was unable to put an event message 
to the given queue after the stated number 
of attempts. Often the is a result that 
occurs if the event queue is full. For 
information about configuring retry 
attempts, see "Event Options Page" on 
page 162.
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SLDS110I: TransactionVision Agent: 
successfully put an event message on queue 
(‘%s’ ‘%s’) after %d unsuccessful attempts

Informational message stating that the 
agent has successfully put an event 
message on the event queue after it had to 
retry multiple times. For information about 
configuring retry attempts, see "Event 
Options Page" on page 162.

SLDS111E: TransactionVision Agent: tried to 
use invalid handle for putting to event queue 
(‘%s’ ‘%s’)

An invalid handle was used to try to put to 
the event queue. This can occur if an 
application corrupts or passes a bad Hconn 
value to subsequent WebSphere MQ calls. 
The result is no event is sent to the 
Analyzer.

SLDS112E: TransactionVision Agent: Event 
message too big for queue (‘%s’ ‘%s’) max 
message length. This error is reported only 
once per event queue and could be occurring 
more than once. Please increase max 
message length setting on the event queue.

The event queue max message length size 
is too small for an event message.

SLDS113W: TransactionVision Agent: attempt 
to disable crossing exit agent failed

An internal error has occurred.

SLDS114W: TransactionVision Agent: crossing 
exit agent has been disabled since both are 
active

If the standard TransactionVision 
WebSphere MQ Agent library is active, the 
Crossing Exit Agent is automatically 
disabled. Only one type of WebSphere MQ 
Agent can be active at any time.

SLDS115W: TransactionVision Agent: 
unexpected internal error - Agent turned off.

An internal error has occurred. The 
WebSphere MQ application will continue 
to run, but events will no longer be 
reported.

SLDS116W: TransactionVision Agent: failed to 
close %s queue ‘%s’ ‘%s’
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SLDS116W: TransactionVision Agent: failed to 
close %s queue ‘%s’ ‘%s’

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLDS117W: TransactionVision Agent: failed to 
get %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLDS118W: TransactionVision Agent: error 
removing configuration message from queue 
(‘%s’ ‘%s’): %s

Failed to destructively get an expired or 
invalid configuration message from the 
configuration queue because of the 
specified WebSphere MQ error.

SLDS119W: TransactionVision Agent: cannot 
extract %s from configuration message

Failed to extract a given field from a 
configuration message. Possibly an invalid 
configuration message.

SLDS11AE: TransactionVision Agent: error in 
communication infrastructure %s: %s

An error occurred with the 
TransactionVision communication 
infrastructure. A WebSphere MQ error is 
included with the error.

SLDS11BI: TransactionVision Agent: errors on 
queue manager (‘%s’) will be supressed until 
successful communication resumes for this 
connection.

Informational message indicating that the 
agent will discontinue logging errors on 
the specified queue manager until it is able 
to communicate with the queue manager 
once again

SLDS11CI: TransactionVision Agent: 
Successful communication has been made to 
the queue manager (‘%s’).  Logging will 
resume.

Informational trace message indicating 
that the agent is able to communication 
with the specified queue manager. Error 
logging had been suppressed for the queue 
manager while the agent was unable to 
communicate with it, but will now resume.

SLDS11DI: TransactionVision Agent: errors on 
configuration queue (‘%s’ ‘%s’) will be 
suppressed until successful communication 
resumes.

Informational message indicating that the 
agent will discontinue logging errors on 
the specified configuration queue until it is 
able to communicate with the queue once 
again.
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SLDS11EI: TransactionVision Agent: 
Successful communication has been made to 
the configuration queue (‘%s’ ‘%s’). Logging 
will resume.

Informational trace message indicating 
that the agent is able to communication 
with the specified configuration queue. 
Error logging had been suppressed for the 
queue while the agent was unable to 
communicate with it, but will now resume.

SLDS11FW: TransactionVision Agent: failed to 
unmarshall configuration message.

The agent failed to unmarshall a 
configuration message. Possibly an invalid 
configuration message.

SLDS120W: TransactionVision Agent: invalid 
%s version.

An invalid version of a given WebSphere 
MQ structure has been encountered when 
constructing the event message.

SLDS121W: TransactionVision Agent: invalid 
message on configuration queue (‘%s’ ‘%s’) 
(not minimum configuration message size) 
(putting to dead letter queue).

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLMS122W:TransactionVision Agent: invalid 
message on configuration queue (‘%s’ ‘%s’) 
(configuration length does not match message 
length) (putting to dead letter queue).

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLDS123W:TransactionVision Agent: invalid 
message on configuration queue (‘%s’ ‘%s’) 
(product name incorrect in configuration 
message) (putting to dead letter queue)

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLDS124W: TransactionVision Agent: 
unsupported configuration message version 
found on (‘%s’ ‘%s’) (putting to dead letter 
queue)

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLDS125W:TransactionVision Agent: failed to 
remove configuration message from 
configuration queue (‘%s’ ‘%s’) and put to 
dead letter queue (‘%s’ ‘%s’): %s

The agent was unable to remove a 
configuration message from the 
configuration queue and place it on the 
exception message queue. A WebSphere 
MQ error accompanies this message.
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SLDS126W: TransactionVision Agent: invalid 
data range value in configuration message

SLDS127W: TransactionVision Agent: missing 
expected token separator in configuration 
message when parsing %s

SLDS128W: TransactionVision Agent: missing 
expected space separator in configuration 
message when parsing %s

SLDS129W: TransactionVision Agent: missing 
expected subsection separator in 
configuration message when parsing %s

SLDS12AW: TransactionVision Agent: missing 
expected section separator in configuration 
message when parsing %s

SLDS12BW: TransactionVision Agent: missing 
expected data range dash in configuration 
message

SLDS12CE: TransactionVision Agent: bad 
checksum for %s

SLDS12DI: TransactionVision Agent: opening 
configuration queue ‘%s’ ‘%s’

Informational trace message.

SLDS12EI: TransactionVision Agent: opening 
event queue ‘%s’ ‘%s’

Informational trace message.

SLDS12FI: TransactionVision Agent: got 
configuration message from ‘%s’ ‘%s’

Informational trace message.

SLDS130I: TransactionVision Agent: 
invalidating all previous configuration 
messages on ‘%s’ ‘%s’ from source analyzer

Informational trace message. Invalidating 
and removing all configurations from a 
given Analyzer previous to the 
configuration message currently being 
processed.
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SLDS131I: TransactionVision Agent: 
invalidating specified configuration message 
on ‘%s’ ‘%s’ from source analyzer

Informational trace message. Invalidating 
and removing a given configuration 
message from a given Analyzer specified by 
the configuration message currently being 
processed.

SLDS132I: TransactionVision Agent: removing 
invalidated configuration message from ‘%s’ 
‘%s’ MsgId: %s CorrelId: %s

Informational trace message.

SLDS133I: TransactionVision Agent: removing 
expired configuration message from ‘%s’ 
‘%s’ current GMT: %s expire time: %s MsgId: 
%s CorrelId: %s

Informational trace message.

SLDS134I: TransactionVision Agent: already 
have this configuration message from ‘%s’ 
‘%s’

Informational trace message. A duplicate 
configuration message has been found on 
the configuration queue.

SLDS135I: TransactionVision Agent: event 
message (%u bytes) too large for event 
queue. Removing user data to make event 
message smaller.

The event will be included in the project, 
but the user data buffer will not be 
available.

SLDS136I: TransactionVision Agent: this host 
(‘%s’) does not appear in filter rule

The host the agent is running on does not 
match the collection filter criteria for 
hosts.

SLDS137I: TransactionVision Agent: this user 
name (‘%s’) does not appear in filter rule

The user name associated with the message 
does not match the collection filter criteria 
for user names.

SLDS138I: TransactionVision Agent: this 
program (‘%s’) does not appear in filter rule

The program name of the program using 
the agent does not match the collection 
filter criteria.

SLDS139I: TransactionVision Agent: current 
time is out of filter start/stop time range: 
current GMT: %s start time: %s stop time: %s

The current time does not match the 
collection time specified in the collection 
filter.
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SLDS13AI: TransactionVision Agent: this CICS 
SYSID (‘%s’) does not appear in filter rule

The CICS SYSID does not match the 
collection filter criteria.

SLDS13BI: TransactionVision Agent: this CICS 
transaction id (‘%s’) does not appear in filter 
rule

The transaction id does not match the 
collection filter criteria.

SLDS13CI: TransactionVision Agent: this job 
name (‘%s’) and step (‘%s’) pair does not 
appear in filter rule

The z/OS Batch job name and step 
combination does not match the collection 
filter criteria.

SLDS13DI: TransactionVision Agent: the job 
name (‘%s’) does not appear in filter rule

The i5/OS job name does not match the 
collection filter criteria.

SLDS13EI: TransactionVision Agent: the IMS 
identifier (‘%s’) does not appear in filter rule

The IMS identifier does not match the 
collection filter criteria.

SLDS13FI: TransactionVision Agent: the IMS 
region type (‘%s’) does not appear in filter 
rule

The IMS region type does not match the 
collection filter criteria

SLDS140I: TransactionVision Agent: the IMS 
region identifier (‘%s’) does not appear in 
filter rule

The IMS region identifier does not match 
the collection filtering criteria

SLDS141I: TransactionVision Agent: the IMS 
transaction name (‘%s’) does not appear in 
filter rule

The IMS transaction name does not match 
the collection filtering criteria.

SLDS142I: TransactionVision Agent: the IMS 
PSB name (‘%s’) does not appear in filter rule

The IMS PSB name does not match the 
collection filtering criteria.

SLDS143I: TransactionVision Agent: API name 
(‘%s’) does not appear in filter rule

The API name does not match the 
collection filter criteria.

SLDS144I: TransactionVision Agent: 
completion code (%u) does not appear in 
filter rule

The WebSphere MQ API completion code 
does not match the collection filter criteria.

SLDS145I: TransactionVision Agent: reason 
code (%u) does not appear in filter rule

The WebSphere MQ API reason code does 
not match the collection filter criteria.
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SLDS146I: TransactionVision Agent: 
technology (‘%s’) in configuration does not 
match this technology (‘%s’)

The event technology does not match the 
collection filter criteria.

SLDS147I: TransactionVision Agent: queue 
manager does not appear in filter rule: ‘%s

The queue manager does not match the 
data collection filter criteria.

SLDS148I: TransactionVision Agent: queue 
manager and/or object name does not 
appear in filter rule: (Conn: ‘%s’) ‘%s’ ‘%s’

The queue manager or WebSphere MQ 
object name does match the collection 
filter criteria.

SLDS149I: TransactionVision Agent: ReplyTo 
queue manager and/or queue name does not 
appear in filter rule: ‘%s’ ‘%s’

The ReplyTo queue manager or queue 
name does not match the collection filter 
criteria.

SLDS14AI: TransactionVision Agent: severity 
(%d) does not appear in filter rule

The BTTRACE severity does not match the 
collection filter criteria.

SLDS14BI: TransactionVision Agent: collection 
mask does not match %s for %s

The specified entity does not match the 
collection filter criteria.

SLDS14EI: TransactionVision Agent: MQCMIT 
has been filtered out because all other events 
in the unit of work have been filtered out”

The MQCMIT was filtered out as specified 
in the collection filter criteria.

SLDS14FI: TransactionVision Agent: Exit part 
of MQDISC has been filtered out”

The MQDISC exit was filtered out as 
specified in the collection filter criteria.

SLDS150I: TransactionVision Agent: browsing 
MQGET has been filtered out

The “Do not send browsing MQGET” 
option is selected in the collection filter 
criteria.

SLDS151I: TransactionVision Agent: ignoring 
unmatched configuration message from ‘%s’ 
‘%s’

Ignoring a configuration message because a 
standard collection filter criteria did not 
match with the running agent.

SLDS152I: TransactionVision Agent: creating 
filter rule from matched configuration 
message from ‘%s’ ‘%s’ expire time: %s 
MsgID: %s CorrelId: %s

The agent matches the standard collection 
filter criteria of a given configuration 
message.
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SLDS153I: TransactionVision Agent: removing 
expired filter rule from memory current GMT: 
%s expire time: %s

A configuration message that has already 
been retrieved from the configuration 
queue has expired.

SLDS154I: putting event message on event 
queue (‘%s’ ‘%s’) MsgId: %s  CorrelId: %s

Informational trace message.

SLDS155I: Management Initiated for 
MQSeries API Crossing Exit

Informational trace message.

SLDS156I: TransactionVision Agent: Disabling 
MQSeries API Crossing Exit

Informational trace message.

SLDS157I: TransactionVision Agent: Enabling 
MQSeries API Crossing Exit

Informational trace message.

SLDS158I: TransactionVision Agent: SLMC 
Exiting

Informational trace message.

SLDS159I: TransactionVision Agent: The 
agent is being used with another 
TransactionVision component. Please remove 
the agent path from the library search path 
before starting the Analyzer or Java Agent.

The system library path environment 
variable has been set to load the agent 
instead of the real WebSphere MQ library. 
This library path should be set only for 
applications being monitored, but not for 
the Analyzer or the Servlet, JMS, or EJB 
Agents.

SLDS15AE: TransactionVision Agent: An 
unexpected error occured in an API exit.  The 
agent will be turned off.

An internal error has occurred.

SLDS15BE: TransactionVision Agent: An 
unexpected error occurred. The agent will be 
turned off.

An internal error has occurred.

SLDS15CE: TransactionVision Agent: An 
unexpected error occurred. The agent will be 
turned off. Please contact HP Technology 
with the stack trace that follows. %s

An internal error has occurred. Contact HP 
Support, providing the stack trace 
information that follows the error message.

Identifier Description
376



Chapter 11 • Agent Error Messages
SLDS15DE: TransactionVision Agent: An 
unexpected error occurred. The agent will be 
turned off. A failure occurred while trying to 
produce a stack trace: %s%u

An internal error has occurred.

SLDS15EE: TransactionVision Agent: An 
unexpected error occurred.  The agent will be 
turned off. A failure occurred while trying to 
produce a stack trace: %s

An internal error has occurred.

SLDS15FE: TransactionVision Agent: invalid 
pointer passed to API exit ('%s'): %s

An internal error has occurred.

SLDS160E: TransactionVision Agent: NULL 
parameter passed to API exit”

An internal error has occurred.

SLDS161E: TransactionVision Agent: NULL 
exit parameters passed to API exit

An internal error has occurred.

SLDS162E: TransactionVision Agent: NULL exit 
user area passed to API exit

An internal error has occurred.

SLDS163E: TransactionVision Agent: failed to 
register API exit: %d

An internal error has occurred.

SLDS164E: TransactionVision Agent: failed to 
allocate space for %s, package 
size=%d,package count=%d,max size=%d.

The agent was unable to allocate sufficient 
space for the event package because the 
package size exceeds the maximum size.

SLDS165E: TransactionVision Agent: Failed to 
connect to queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s

The Agent was unable to connect to the 
specified queue manager.

SLDS166E: TransactionVision Agent: Failed to 
disconnect from queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s

The agent was unable to disconnect from 
the specified queue manager.
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SLDS272E: TransactionVision Agent: wrong 
number of parameters.

The agent command contains an incorrect 
number of parameters. See the 
“Configuring the CICS agent,” chapter in 
the the HP TransactionVision Deployment 
Guide PDF for instructions on starting and 
stopping the CICS Agent.

SLDS273E: TransactionVision Agent: input 
queue manager name (%s) length is bigger 
than %d (MQ limit).

The specified queue manager name exceeds 
the allowed length.

SLDS274E: FailMemCDC: E: “%s%03XE 
%s:TransactionVision Agent: Failed to allocate 
memory for SLDI.

Out of memory error. The CICS Agent will 
fail to initialize and stop. Please try to 
restart the CICS Agent. If the same problem 
happens, contact HP Support.

SLDS275E: FailMemCCT: E: “%s%03XE 
%s:TransactionVision Agent: Failed to allocate 
memory for config table.

Out of memory error. The CICS Agent will 
fail to initialize and stop. Please try to 
restart the CICS Agent. If the same problem 
happens, contact HP Support.

SLDS276E: TransactionVision Agent: 
Unknown error occurred (type=%d), CICS 
Agent Driver is shutting down.

SLDS277I: TransactionVision Agent: The 
routine that generated abend in CICS Agent 
Driver is ‘%.80s’, and offset is %08X. Please 
contact HP Support with the dump 
information.

Please contact HP Support and report the 
diagnostic information included in the 
message.

SLDS278E: InitFailed: E: “%s%03XE %s: 
TransactionVision Agent: CICS %s Agent 
Driver startup failed. QMGR=%s, 
CONFIGQ=%s.

CICS Agent driver program failed to 
initialize due to error(s) previous shown.

SLDS279I: TransactionVision Agent: CICS %s 
Agent Driver startup completed. QMGR=%s, 
CONFIGQ=%s.

Informational message indicating the CICS 
Agent Driver startup completed 
successfully.
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SLDS27AE: WrongEventType: E: “%s%03XE 
%s: TransactionVision Agent: Unknown event 
type (type=%d), skip this event.

The event type is not collectable by the 
CICS Agent, and the event is skipped.

SLDS27BI: TransactionVision Agent: CICS %s 
Agent Driver is ending, return code = %d.

Informational message indicating the CICS 
Agent Driver is ending.

SLDS27CI: TransactionVision Agent: this 
terminal id (‘%s’) does not appear in filter 
rule

The terminal ID does not match the 
collection filter criteria.

SLDS27DI: TransactionVision Agent: this API 
type (‘%d’) does not appear in filter rule

The API type does not match the collection 
filter criteria.

SLDS27EI: TransactionVision Agent: this API 
(‘%d’) does not appear in filter rule

The API does not match the collection 
filter criteria.

SLDS27FI: TransactionVision Agent: this file 
(‘%s’) does not appear in filter rule

The file does not match the collection filter 
criteria.

SLDS280I: TransactionVision Agent: this TD 
queue (‘%s’) does not appear in filter rule

The TD queue does not match the 
collection filter criteria.

SLDS281I: TransactionVision Agent: this TS 
queue (‘%s’) does not appear in filter rule

The TS queue does not match the 
collection filter criteria.

SLDS282I: TransactionVision Agent: this 
EIBRESP (‘%d’) does not appear in filter rule

The response does not match the 
collection filter criteria.

SLDS400I: TVISION [TransactionVision 
Manager | CICS sysid TransactionVision 
agent] startup in progress.

Informational message issued in response 
to a start TransactionVision Manager 
command or a start agent command, 
where sysid is the SYSID of the CICS region 
to monitor.

SLDS401I: TVISION [TransactionVision 
Manager tvid | CICS sysid TransactionVision 
agent] startup complete.

Informational message issued when 
TransactionVision Manager startup or 
agent startup is complete, where tvid is the 
TVID of the TransactionVision Manager 
and  sysid is the SYSID of the CICS region 
to monitor.
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SLDS402I: tvid STOP command received. Informational message issued in response 
to a stop TransactionVision Manager 
command, where tvid is the TVID of the 
TransactionVision Manager.

SLDS404I: TVISION [TransactionVision 
Manager tvid | CICS sysid TransactionVision 
agent] termination in progress.

Informational message issued in response 
to a stop TransactionVision Manager 
command or a stop Agent command, 
where tvid is the TVID of the 
TransactionVision Manager and sysid is the 
SYSID of the monitored CICS region.

SLDS405I: TVISION [TransactionVision 
Manager tvid | CICS sysid TransactionVision 
agent] termination complete.

Informational message issued when 
TransactionVision Manager shutdown or 
Agent shutdown is complete, where tvid is 
the TVID of the TransactionVision 
Manager and sysid is the SYSID of the 
monitored CICS region.

SLDS406E: No parameters specified on the 
START command. The TVID parameter is 
required.

A start TransactionVision Manager 
command was issued without the required 
TVID parameter.

SLDS407E: The TVID parameter is missing 
from the START command.

A start TransactionVision Manager 
command was issued without the required 
TVID parameter.

SLDS408E: The TVID specified on the START 
command contains more than the maximum 
of 4 characters.

A start TransactionVision Manager 
command specified an invalid TVID 
parameter.

SLDS409E: The SYSID parameter is missing 
from the START command.

An incorrect START command has been 
issued and the TransactionVision CICS A 
start agent command was issued without 
the required SYSID parameter.

SLDS410E: The SYSID specified on the START 
command contains more than the maximum 
of 4 characters

A start agent command specified an invalid 
SYSID parameter.
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SLDS411E: TVISION tvid TransactionVision 
Manager already started.

A start TransactionVision Manager 
command specified a TVID value that 
matches a running TransactionVision 
Manager, where tvid is the TVID specified.

SLDS412E: TVISION CICS sysid 
TransactionVision agent already started.

A start agent command specified a SYSID 
value that matches a running agent under 
control of the same TransactionVision 
Manager, where sysid is the SYSID 
specified.

SLDS413E: TVISION CICS sysid 
TransactionVision agent already started by 
another TransactionVision Manager.

A start Agent command specified a SYSID 
value that matches a running agent under 
control of a different TransactionVision 
Manager, where sysid is the SYSID 
specified.

SLDS415E: TVISION The parameter value 
specified on the command is less than the 
required minimum of min_value.

A start Agent command specified a 
parameter value less than the minimum 
required, where parameter is the parameter 
keyword and min_value is the minimum 
value allowed.

SLDS416E: TVISION The parameter value 
specified on the command is greater than the 
maximum allowed of max_value.

A start Agent command specified a 
parameter value more than the maximum 
required, where parameter is the parameter 
keyword and max_value is the maximum 
value allowed.

SLDS418E: TVISION The parameter value 
specified on the command contains 
non-numeric characters.

A start Agent command specified 
non-numeric characters for a parameter 
value that is required to be numeric, where 
parameter is the parameter keyword.

SLDS420E: TVISION Command name, 
command_name, invalid.  Command 
ignored.

An invalid command was issued, where 
command_name is the command.
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SLDS421E: TVISION Command operand, 
operand_name, invalid for command_name 
command. Command ignored.

An invalid command operand was 
specified, where operand_name is operand 
specified and  command_name is the 
command.

SLDS422E: TVISION  Operand value specified 
on command name or operand that takes no 
value specification.  Command ignored.

A name(value) form was specified on a 
command when no value was expected for 
the command or operand name specified.

SLDS423E: TVISION Syntax error - misplaced 
“(“.  Command ignored.

Syntax error.

SLDS424E: TVISION Syntax error - misplaced 
“)”.  Command ignored.

Syntax error.

SLDS425E: TVISION Command input is all 
spaces.  Command ignored.

Syntax error.

SLDS427E: TVISION The agent driver startup 
procedure name contains more than the 
maximum of 8 characters.

The value of the DRVRPROC parameter on 
a start Agent command is invalid.

SLDS428E: TVISION The required operand 
value for the keyword operand, 
operand_name, is missing.

A value was not specified for an operand 
that required a value, where 
operand_name is the operand name.

SLDS429E: TVISION The required agent type 
operand is missing.

The Agent type, CICS, was omitted from 
the command. In this release, CICS is the 
only Agent type supported but subsequent 
releases will add other types.

SLDS430E: TVISION Invalid agent type 
specified.

The only valid agent type in this release is 
CICS.

SLDS431E: TVISION Unsupported agent type 
specified.

The only valid agent type in this release is 
CICS.

SLDS432E: TVISION The required 
command_name command operand, 
operand_name, is missing.

A required operand was not specified on 
the command, where command_name is 
the command and operand_name is the 
omitted operand.
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SLDS440E: TVISION The agent specified on 
the STOP AGENT command is not started.

A stop Agent command was issued for an 
agent that is not started.

SLDS441S: TVISION Unable to allocate the 
minimum size buffer queue. Diagnostic data 
follow:

This error probably results from an 
installation limit on the size of data spaces. 
If not, please contact HP Support and 
report the diagnostic data included in the 
message.

SLDS442W: TVISION The maximum number 
of allowed buffer queue blocks specified on 
the MAXQBLKS startup parameter has been 
reached.  Events may be lost.

The agent required an additional queue 
block but the maximum allowed was 
already allocated. When the current queue 
block is full and the maximum is still 
allocated, events will be lost.

SLDS443I: TVISION Agent quiescing: n events 
in buffer queue.

A stop agent command has been issued. 
The agent will wait until all events in the 
buffer queue have been retrieved before 
completing the shutdown.

SLDS445I: TVISION Agent quiesce 
completed.

All events in the buffer queue have been 
retrieved in response to an agent stop 
command. The agent will complete the 
shutdown.

SLDS446E: TVISION The agent manager 
component is not started.

This error may be caused by starting the 
agent driver manually. The agent driver is 
automatically started by the agent manager 
and should not be started any other way. If 
not the case, please contact HP Support.

SLDS448I: TVISION CICS CIC1 Agent 
statistics:

Events in queue: n

Events collected:n

Events dispatched: n

Events_lost:n

Informational message issued at agent 
shutdown or in reponse to an INQUIRE 
command.
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SLDS449W: TVISION agent events have been 
lost due to insufficient buffer queue storage.

The agent manager issues this message the 
first time an event is lost.

SLDS451S: TVISION CICS sysid 
TransactionVision agent stall condition 
detected. Diagnostic data follow:

The Agent manager is quiescing and 
detects that events are not being retrieved 
from the buffer queue by the agent driver, 
where sysid identifies the agent.  The agent 
will exit quiesce mode and complete 
shutdown.  Events in the buffer queue will 
be lost. Please contact HP Support and 
report the diagnostic data included in the 
message.

SLDS460I: TVISION Agent exits manager 
started.

Informational message issued in response 
to an SLDS transaction or PLTPI processing.

SLDS461I: TVISION Agent exits manager 
waiting for agent startup.

The agent exits manager has been started 
but a corresponding agent manager has 
not.

SLDS462I: TVISION Agent startup completed. 
Exits monitoring started.

The agent exits manager has detected the 
startup of a corresponding agent manager.

SLDS463W: TVISION The agent exits 
manager is already started. Request ignored.

An SLDS transaction was invoked but the 
agent exits manager is already started.

SLDS464I: TVISION exit_name exit [enabled | 
disabled].

The agent exits manager has enabled or 
disabled an exit, where exit_name is the 
name of the exit.

SLDS465I: TVISION Agent exits manager 
terminated.

An informational message issued when the 
agent exits manager completes shutdown 
as a result of an SLDP transaction, PLTSD 
processing, or the forced disablement of 
the program start exit.

SLDS466W: TVISION The agent exits 
manager is not started. Request ignored.

An SLDP or an SLDC transaction was 
invoked but the exits manager is not 
started.
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SLDS467W: TVISION The request (1st parm) 
was not En(able) or Dis(able).

An SLDC transaction was invoked but the 
first parameter was invalid.

SLDS468W: TVISION The request (2nd parm) 
was not: PS, KC, PC, IC, TD, TS, or FC.

An SLDC transaction was invoked but the 
second parameter was invalid.

SLDS469I TVISION The program start exit 
(PS) cannot be disabled.  The exit is stopped.

An SLDC transaction specified disablement 
of the program start exit, which must 
remain enabled for the exits manager to 
run. The exit is stopped instead.

SLDS498S: TVISION [TransactionVision 
Manager | CICS sysid TransactionVision 
agent] system error: message handler 
unavailable. Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLDS499S: TVISION [TransactionVision 
Manager | CICS sysid TransactionVision 
agent] system error. Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS101E: TransactionVision agent: failed to 
allocate space for %s

Out of memory error.

SLMS102E: TransactionVision agent: failed to 
reallocate space for %s

Out of memory error.

SLMS103E: TransactionVision agent: failed to 
create mutex lock

SLMS104E: TransactionVision agent: failed to 
lock mutex

SLMS105E: TransactionVision agent: failed to 
unlock mutex

SLMS106E: TransactionVision agent: failed to 
destroy mutex lock

SLMS107E: TransactionVision agent: error 
processing %s

Error processing given field within a 
configuration message.
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SLMS108E: TransactionVision agent: Cannot 
connect to configuration queue manager %s: 
%s

The specified WebSphere MQ error occurred. 
See WebSphere MQ documentation for 
explanation.

SLMS109E: TransactionVision agent: Cannot 
open configuration queue %s on queue 
manager %s: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS10AE: TransactionVision agent: Cannot 
reconnect to queue manager %s after user’s 
MQDISC call: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS10BE: TransactionVision agent: Cannot 
reopen configuration queue %s on queue 
manager %s after user’s MQDISC call: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS10CE: TransactionVision agent: Cannot 
connect event queue manager %s: %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS10DE: TransactionVision agent: Cannot 
open event queue %s on queue manager %s: 
%s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS10EE: TransactionVision agent: %d 
unsuccessful attempts were made to send an 
event message to queue (‘%s’ ‘%s’): %s 
Continuing to retry every %d ms...

Agent was unable to put an event message 
to the given event queue. Often, this is a 
result that occurs if the event queue 
becomes full if the agent is producing 
event messages faster than the Analyzer 
can pull them off the queue. The agent will 
continue to try to put to the event queue 
while the Analyzer is catches up. For 
information about configuring retry 
attempts, see "Event Options Page" on 
page 162.
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SLMS10FE: TransactionVision agent: Timed 
out (%d s) attempting %u times to put event 
message to queue (‘%s’ ‘%s’)”

Agent was unable to put an event message 
to the given queue after the stated number 
of attempts. Often this is a result that 
occurs if the event queue is full. For 
information about configuring retry 
attempts, see "Event Options Page" on 
page 162.

SLMS110I: TransactionVision agent: 
successfully put an event message on queue 
(‘%s’ ‘%s’) after %d unsuccessful attempts

Informational message stating that the 
agent has successfully put an event 
message on the event queue after it had to 
retry multiple times. For information about 
configuring retry attempts, see "Event 
Options Page" on page 162.

SLMS111E: TransactionVision agent: tried to 
use invalid handle for putting to event queue 
(‘%s’ ‘%s’)

An invalid handle was used to try to put to 
the event queue. This can occur if an 
application corrupts or passes a bad Hconn 
value to subsequent WebSphere MQ calls. 
The result is no event is sent to the 
Analyzer.

SLMS112E: TransactionVision agent: Event 
message too big for queue (‘%s’ ‘%s’) max 
message length. This error is reported only 
once per event queue and could be occurring 
more than once. Please increase max 
message length setting on the event queue.

The event queue max message length size 
is too small for an event message. For 
information about setting maximum 
message length, see "Event Options Page" 
on page 162.

SLMS113W: TransactionVision agent: attempt 
to disable crossing exit agent failed.

An internal error has occurred.

SLMS114W: TransactionVision agent: API Exit 
Agent has been disabled because the Library 
agent is active.

If the standard TransactionVision 
WebSphere MQ Agent library is active, the 
Crossing Exit Agent is automatically 
disabled. Only one type of WebSphere MQ 
Agent can be active at any time.
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SLMS115W: TransactionVision agent: 
unexpected internal error - agent turned off.

An internal error has occurred. The 
WebSphere MQ application will continue 
to run, but events will no longer be 
reported.

SLMS116W: TransactionVision agent: failed 
to close %s queue ‘%s’ ‘%s’

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS117W: TransactionVision agent: failed 
to get %s

The specified WebSphere MQ error 
occurred. See WebSphere MQ 
documentation for explanation.

SLMS118W: TransactionVision agent: error 
removing configuration message from queue 
(‘%s’ ‘%s’): %s

Failed to destructively get an expired or 
invalid configuration message from the 
configuration queue because of the 
specified WebSphere MQ error.

SLMS119W: TransactionVision agent: cannot 
extract %s from configuration message

Failed to extract a given field from a 
configuration message. Possibly an invalid 
configuration message.

SLMS11AE: TransactionVision agent: error in 
communication infrastructure %s: %s

An error occurred with the 
TransactionVision communication 
infrastructure. A WebSphere MQ error is 
included with the error.

SLMS11BI: TransactionVision agent: errors on 
queue manager (‘%s’) will be suppressed 
until successful communication resumes for 
this connection.

Informational message indicating that the 
agent will discontinue logging errors on 
the specified queue manager until it is able 
to communicate with the queue manager 
once again.

SLMS11CI: TransactionVision agent: 
Successful communication has been made to 
the queue manager (‘%s’). Logging will 
resume.

Informational trace message indicating 
that the agent is able to communication 
with the specified queue manager. Error 
logging had been suppressed for the queue 
manager while the agent was unable to 
communicate with it, but will now resume.
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SLMS11DI: TransactionVision agent: errors on 
configuration queue (‘%s’ ‘%s’) will be 
suppressed until successful communication 
resumes.

Informational message indicating that the 
agent will discontinue logging errors on 
the specified configuration queue until it is 
able to communicate with the queue once 
again.

SLMS11EI: TransactionVision agent: 
Successful communication has been made to 
the configuration queue (‘%s’ ‘%s’). Logging 
will resume.

Informational trace message indicating 
that the agent is able to communication 
with the specified configuration queue. 
Error logging had been suppressed for the 
queue while the agent was unable to 
communicate with it, but will now resume.

SLMS11FW: TransactionVision agent: failed to 
unmarshall configuration message.

The agent failed to unmarshall a 
configuration message. Possibly an invalid 
configuration message.

SLMS120W: TransactionVision agent: invalid 
%s version.

An invalid version of a given WebSphere 
MQ structure has been encountered when 
constructing the event message.

SLMS121W: TransactionVision agent: invalid 
message on configuration queue (‘%s’ ‘%s’) 
(not minimum configuration message size) 
(putting to dead letter queue).

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLMS122W:TransactionVision agent: invalid 
message on configuration queue (‘%s’ ‘%s’) 
(configuration length does not match 
message length) (putting to dead letter 
queue).

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLMS123W:TransactionVision agent: invalid 
message on configuration queue (‘%s’ ‘%s’) 
(product name incorrect in configuration 
message) (putting to dead letter queue).

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.
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SLMS124W: TransactionVision agent: 
unsupported configuration message version 
found on (‘%s’ ‘%s’) (putting to dead letter 
queue).

An invalid configuration message has been 
encountered on the configuration queue. 
The agent will put the invalid message on 
the exception message queue.

SLMS125W:TransactionVision agent: failed to 
remove configuration message from 
configuration queue (‘%s’ ‘%s’) and put to 
dead letter queue (‘%s’ ‘%s’): %s.

The agent was unable to remove a 
configuration message from the 
configuration queue and place it on the 
exception message queue. A WebSphere 
MQ error accompanies this message.

SLMS126W: TransactionVision agent: invalid 
data range value in configuration message.

SLMS127W: TransactionVision agent: missing 
expected token separator in configuration 
message when parsing %s.

SLMS128W: TransactionVision agent: missing 
expected space separator in configuration 
message when parsing %s.

SLMS129W: TransactionVision agent: missing 
expected subsection separator in 
configuration message when parsing %s.

SLMS12AW: TransactionVision agent: missing 
expected section separator in configuration 
message when parsing %s.

SLMS12BW: TransactionVision agent: missing 
expected data range dash in configuration 
message.

SLMS12CE: TransactionVision agent: bad 
checksum for %s.

SLMS12DI: TransactionVision agent: opening 
configuration queue ‘%s’ ‘%s’.

Informational trace message.
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SLMS12EI: TransactionVision agent: opening 
event queue ‘%s’ ‘%s’.

Informational trace message.

SLMS12FI: TransactionVision agent: got 
configuration message from ‘%s’ ‘%s’.

Informational trace message.

SLMS130I: TransactionVision agent: 
invalidating all previous configuration 
messages on ‘%s’ ‘%s’ from source analyzer.

Informational trace message. Invalidating 
and removing all configurations from a 
given Analyzer previous to the 
configuration message currently being 
processed.

SLMS131I: TransactionVision agent: 
invalidating specified configuration message 
on ‘%s’ ‘%s’ from source analyzer.

Informational trace message. Invalidating 
and removing a given configuration 
message from a given Analyzer specified by 
the configuration message currently being 
processed.

SLMS132I: TransactionVision agent: 
removing invalidated configuration message 
from ‘%s’ ‘%s’ MsgId: %s CorrelId: %s.

Informational trace message.

SLMS133I: TransactionVision agent: 
removing expired configuration message 
from ‘%s’ ‘%s’ current GMT: %s expire time: 
%s MsgId: %s CorrelId: %s.

Informational trace message

SLMS134I: TransactionVision agent: already 
have this configuration message from ‘%s’ 
‘%s’.

Informational trace message. A duplicate 
configuration message has been found on 
the configuration queue.

SLMS135I: TransactionVision agent: event 
message (%u bytes) too large for event 
queue. Removing user data to make event 
message smaller.

The event will be included in the project, 
but the user data buffer will not be 
available.

SLMS136I: TransactionVision agent: this host 
(‘%s’) does not appear in filter rule.

The host the agent is running on does not 
match the collection filter criteria for 
hosts.
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SLMS137I: TransactionVision agent: this user 
name (‘%s’) does not appear in filter rule.

The user name associated with the message 
does not match the collection filter criteria 
for user names.

SLMS138I: TransactionVision agent: this 
program (‘%s’) does not appear in filter rule.

The program name of the program using 
the agent does not match the collection 
filter criteria.

SLMS139I: TransactionVision agent: current 
time is out of filter start/stop time range: 
current GMT: %s start time: %s stop time: 
%s.

The current time does not match the 
collection time specified in the collection 
filter.

SLMS13AI: TransactionVision agent: this CICS 
SYSID (‘%s’) does not appear in filter rule.

The CICS SYSID does not match the 
collection filter criteria.

SLMS13BI: TransactionVision agent: this CICS 
transaction id (‘%s’) does not appear in filter 
rule.

The transaction id does not match the 
collection filter criteria.

SLMS13CI: TransactionVision agent: this job 
name (‘%s’) and step (‘%s’) pair does not 
appear in filter rule.

The z/OS Batch job name and step 
combination does not match the collection 
filter criteria.

SLMS13DI: TransactionVision agent: the job 
name (‘%s’) does not appear in filter rule.

The i5/OS job name does not match the 
collection filter criteria.

SLMS13EI: TransactionVision agent: the IMS 
identifier (‘%s’) does not appear in filter rule.

The IMS identifier does not match the 
collection filter criteria.

SLMS13FI: TransactionVision agent: the IMS 
region type (‘%s’) does not appear in filter 
rule.

The IMS region type does not match the 
collection filter criteria.

SLMS140I: TransactionVision agent: the IMS 
region identifier (‘%s’) does not appear in 
filter rule.

The IMS region identifier does not match 
the collection filtering criteria.

SLMS141I: TransactionVision agent: the IMS 
transaction name (‘%s’) does not appear in 
filter rule.

The IMS transaction name does not match 
the collection filtering criteria.
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SLMS142I: TransactionVision agent: the IMS 
PSB name (‘%s’) does not appear in filter rule.

The IMS PSB name does not match the 
collection filtering criteria.

SLMS143I: TransactionVision agent: API name 
(‘%s’) does not appear in filter rule.

The WebSphere MQ API does not match 
the collection filter criteria.

SLMS144I: TransactionVision agent: 
completion code (%u) does not appear in 
filter rule.

The WebSphere MQ API completion code 
does not match the collection filter criteria.

SLMS145I: TransactionVision agent: reason 
code (%u) does not appear in filter rule.

The WebSphere MQ API reason code does 
not match the collection filter criteria.

SLMS146I: TransactionVision agent: 
technology (‘%s’) in configuration does not 
match this technology (‘%s’).

The event technology does not match the 
collection filter criteria.

SLMS147I: TransactionVision agent: queue 
manager does not appear in filter rule: ‘%s’.

The queue manager does not match the 
data collection filter criteria.

SLMS148I: TransactionVision agent: queue 
manager and/or object name does not 
appear in filter rule: (Conn: ‘%s’) ‘%s’ ‘%s’.

The queue manager or WebSphere MQ 
object name does match the collection 
filter criteria.

SLMS149I: TransactionVision agent: ReplyTo 
queue manager and/or queue name does not 
appear in filter rule: ‘%s’ ‘%s’.

The ReplyTo queue manager or queue 
name does not match the collection filter 
criteria.

SLMS14AI: TransactionVision agent: severity 
(%d) does not appear in filter rule.

The BTTRACE severity does not match the 
collection filter criteria.

SLMS14BI: TransactionVision agent: 
collection mask does not match %s for %s.

The specified entity does not match the 
collection filter criteria.

SLMS14EI: TransactionVision agent: MQCMIT 
has been filtered out because all other events 
in the unit of work have been filtered out.

The MQCMIT was filtered out as specified 
in the collection filter criteria.

SLMS14FI: TransactionVision agent: Exit part 
of MQDISC has been filtered out.

The MQDISC exit was filtered out as 
specified in the collection filter criteria.

Identifier Description
393



Chapter 11 • Agent Error Messages
SLMS150I: TransactionVision agent: browsing 
MQGET has been filtered out.

The “Do not send browsing MQGET” 
option is selected in the collection filter 
criteria.

SLMS151I: TransactionVision agent: ignoring 
unmatched configuration message from ‘%s’ 
‘%s’.

Ignoring a configuration message because a 
standard collection filter criteria did not 
match with the running agent.

SLMS152I: TransactionVision agent: creating 
filter rule from matched configuration 
message from ‘%s’ ‘%s’ expire time: %s 
MsgID: %s CorrelId: %s.

The agent matches the standard collection 
filter criteria of a given configuration 
message.

SLMS153I: TransactionVision agent: 
removing expired filter rule from memory 
current GMT: %s expire time: %s.

A configuration message that has already 
been retrieved from the configuration 
queue has expired.

SLMS154I: putting event message on event 
queue (‘%s’ ‘%s’) MsgId: %s  CorrelId: %s.

Informational trace message.

SLMS155I: Management Initiated for 
MQSeries API Crossing Exit.

Informational trace message.

SLMS156I: TransactionVision agent: Disabling 
MQSeries API Crossing Exit.

Informational trace message.

SLMS157I: TransactionVision agent: Enabling 
MQSeries API Crossing Exit.

Informational trace message.

SLMS158I: TransactionVision agent: SLMC 
Exiting.

Informational trace message.

SLMS159I: TransactionVision agent: The 
agent is being used with another 
TransactionVision component. Please remove 
the agent path from the library search path 
before starting the analyzer or Java Agent.

The system library path environment 
variable has been set to load the agent 
instead of the real WebSphere MQ library. 
This library path should be set only for 
applications being monitored, but not for 
the Analyzer or the Servlet, JMS, or EJB 
Agents. 
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SLMS15AE: TransactionVision agent: An 
unexpected error occurred in an API exit. The 
agent will be turned off.

An internal error has occurred.

SLMS15BE: TransactionVision agent: An 
unexpected error occurred. The agent will be 
turned off.

An internal error has occurred.

SLMS15CE: TransactionVision agent: An 
unexpected error occurred. The agent will be 
turned off. Please contact HP Support with 
the stack trace that follows. %s.

An internal error has occurred.

SLMS15DE: TransactionVision agent: An 
unexpected error occurred. The agent will be 
turned off. A failure occurred while trying to 
produce a stack trace: %s%u.

An internal error has occurred.

SLMS15EE: TransactionVision agent: An 
unexpected error occurred. The agent will be 
turned off. A failure occurred while trying to 
produce a stack trace: %s.

An internal error has occurred

SLMS15FE: TransactionVision agent: invalid 
pointer passed to API exit ('%s'): %s.

An internal error has occurred

SLMS160E: TransactionVision agent: NULL 
parameter passed to API exit.

An internal error has occurred

SLMS161E: TransactionVision agent: NULL 
exit parameters passed to API exit.

An internal error has occurred

SLMS162E: TransactionVision agent: NULL 
exit user area passed to API exit.

An internal error has occurred

SLMS163E: TransactionVision agent: failed to 
register API exit: %d.

An internal error has occurred

SLMS164E: TransactionVision agent: failed to 
allocate space for %s, package 
size=%d,package count=%d,max size=%d.

The agent was unable to allocate sufficient 
space for the event package because the 
package size exceeds the maximum size.
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SLMS165E: TransactionVision agent: Failed to 
connect to queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s.

The agent was unable to connect to the 
specified queue manager.

SLMS166E: TransactionVision agent: Failed to 
disconnect from queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s.

The agent was unable to disconnect from 
the specified queue manager.

SLMS201E: TransactionVision agent: cannot 
initialize MQSeries library.

A general error reporting that the loading 
and initialization of the real WebSphere 
MQ library failed. WebSphere MQ may not 
be properly installed, or the library may 
not be in the library search path.

SLMS251E: TransactionVision agent: could 
not connect to queue manager: ‘%s’.

The agent was unable to connect to the 
queue manager (a WebSphere MQ message 
is supplied). For information about setting 
connection retry attempts, see "Event 
Options Page" on page 162.

SLMS252E: TransactionVision agent: could 
not connect to queue manager ‘%s’: %s The 
agent will attempt to reconnect after %d 
seconds. Events may not be collected during 
this time.

The agent was unable to connect to the 
queue manager (a WebSphere MQ message 
is supplied). It will attempt to reconnect, 
but no events will be collected until it 
succeeds. For information about setting 
connection retry attempts, see "Event 
Options Page" on page 162.

SLMS253E: TransactionVision agent: Error 
marshalling event data: null pointer ‘%s’.

SLMS254E: TransactionVision agent: 
Unknown error occurred (type=%d), Event 
Dispatcher is shutting down.

SLMS255I: TransactionVision agent: The 
routine that generated abend in Event 
Dispatcher is ‘%.80s’, and offset is %08X.
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SLMS256E: TransactionVision agent: Wrong 
number of parameters. Please specify Queue 
Manager name only.

Too many parameters were specified; 
specify the Queue Manager name only.

SLMS257E: TransactionVision agent: Input 
queue manager name (%s) length is bigger 
than %d (MQ limit).

The queue manager name is too long.

SLMS258E: TransactionVision agent: Event 
Dispatcher initialization failed.

SLMS259I: TransactionVision agent: Event 
Dispatcher initialization completed.

Informational trace message.

SLMS25AI: TransactionVision agent: Event 
Dispatcher is ending as requested by 
TVISIONB.

Informational trace message.

SLMS25BE: Unknown function ID.

SLMS25CE: TransactionVision agent: 
Unknown return code from SLMXGNE.

SLMS271E: WrongNumberOfParameters: E: 
%s%03XE %s:TransactionVision agent: 
wrong number of parameters.

The agent command contains an incorrect 
number of parameters. See the 
“Configuring the CICS Agent,” chapter in 
the the HP TransactionVision Deployment 
Guide PDF for instructions on starting and 
stopping the CICS Agent.

SLMS272E: TransactionVision agent: input 
queue manager name (%s) length is bigger 
than %d (MQ limit).

The specified queue manager name exceeds 
the allowed length.

SLMS273E: TransactionVision agent: Failed to 
allocate memory for SLDI.

Out of memory error. The CICS Agent will 
fail to initialize and stop. Please try to 
restart the CICS Agent, if the same problem 
happens, contact HP support.
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SLMS274E: TransactionVision agent: Failed to 
allocate memory for config table.

Out of memory error. The CICS Agent will 
fail to initialize and stop. Please try to 
restart the CICS Agent, if the same problem 
happens, contact HP support.

SLMS275E: TransactionVision agent: 
Unknown error occurred (type=%d), %s 
agent Driver is shutting down.

SLMS276I: TransactionVision agent: The 
routine that generated abend is '%.80s', and 
offset is %08X. Please contact HP Support 
with the dump information.

Please contact HP Support and report the 
diagnostic information included in the 
message.

SLMS277E: TransactionVision agent: %s %s 
agent Driver startup failed. QMGR=%s, 
CONFIGQ=%s.

CICS Agent driver program failed to 
initialize due to error(s) previous shown

SLMS278I: TransactionVision agent: %s %s 
agent Driver startup completed. QMGR=%s, 
CONFIGQ=%s.

Informational message indicating the CICS 
Agent Driver startup completed 
successfully.

SLMS279E: TransactionVision agent: 
Unknown event type (type=%d), skip this 
event.

The event type is not collectable by the 
CICS Agent, and the event is skipped. 

SLMS27AI: TransactionVision agent: %s %s 
agent Driver is ending, return code = %d.

Informational message indicating the CICS 
Agent Driver is ending.

SLMS27BI: TransactionVision agent: this 
terminal id ('%s') does not appear in filter 
rule.

The terminal ID does not match the 
collection filter criteria.

SLMS27CI: TransactionVision agent: this API 
type ('%s') does not appear in filter rule.

The API type does not match the collection 
filter criteria.

SLMS27DI: TransactionVision agent: this API 
('%s') does not appear in filter rule.

The API does not match the collection 
filter criteria.

SLMS27EI: TransactionVision agent: this file 
('%s') does not appear in filter rule.

The CICS file name does not match the 
collection filter criteria.
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SLMS27FI: TransactionVision agent: this TD 
queue ('%s') does not appear in filter rule.

The TD queue does not match the 
collection filter criteria.

SLMS280I: TransactionVision agent: this TS 
queue ('%s') does not appear in filter rule.

The TS queue does not match the 
collection filter criteria.

SLMS281I: TransactionVision agent: this 
EIBRESP ('%d') does not appear in filter rule.

The response code does not match the 
collection filter criteria.

SLMS282E: TransactionVision agent: Null 
pointer detected for the structure '%s'.

SLMS283E: TransactionVision agent: 
Sturcture ID '%s' does not match the 
expected value '%s'.

SLMS284E: TransactionVision agent: Internal 
error. This function '%s' should never be 
called. Please contact HP Support.

SLMS301I: TransactionVision WMQI Agent: 
%s.

Informational message regarding the 
WebSphere MQ Integrator-enabled Agent.

SLMS302I: TransactionVision WMQI Agent: 
inserting attribute ‘%s’.

Informational message regarding the 
WebSphere MQ Integrator-enabled Agent.

SLMS303I: TransactionVision WMQI Agent: 
inserting %s terminal entry for terminal ‘%s’.

Informational message regarding the 
WebSphere Business Integration-enabled 
Agent.

SLMS304I: TransactionVision WMQI Agent: 
getting attribute by index %d.

Informational message regarding the 
WebSphere Business Integration-enabled 
Agent.

SLMS305I: TransactionVision WMQI Agent: 
getting attribute ‘%s’.

Informational message regarding the 
WebSphere Business Integration-enabled 
Agent.

SLMS306I: TransactionVision WMQI Agent: 
setting attribute ‘%s’ to ‘%s’.

Informational message regarding the 
WebSphere Business Integration-enabled 
Agent.
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SLMS307E: TransactionVision WMQI Agent: 
failed to allocate space for %s.

Out of memory error.

SLMS308E: TransactionVision WMQI Agent: 
failed to initialize %s.

SLMS309E: TransactionVision WMQI Agent: 
invalid data type for %s.

SLMS30AE: TransactionVision WMQI Agent: 
failure terminal does not exist.

SLMS30BE: TransactionVision WMQI Agent: 
out terminal does not exist.

SLMS30CE: TransactionVision WMQI Agent: 
out terminal is not attached.

SLMS30DE: TransactionVision WMQI Agent: 
unknown attribute ‘%s’.

SLMS30EE: TransactionVision WMQI Agent: 
attribute index %d not found.

SLMS30FE: TransactionVision WMQI Agent: 
%s terminal ‘%s’ not found.

SLMS310I: TransactionVision WMQI Agent: 
loaded TransactionVision agent.

Informational message regarding the 
WebSphere Business Integration-enabled 
Agent.

SLMS311E: TransactionVision WMQI Agent: 
failed to load TransactionVision agent.

Ensure that the agent is properly installed. 
See the the HP TransactionVision 
Deployment Guide PDF for installation 
instructions.

SLMS312I: TransactionVision WMQI Agent: 
TransactionVision agent successfully loaded.

Informational message regarding the 
WebSphere Business Integration-enabled 
Agent.
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SLMS313E: TransactionVision WMQI Agent: 
Could not find Path value in the registry. 
Ensure that the TransactionVision agent is 
properly installed.

Ensure that the agent is properly installed. 
See the the HP TransactionVision 
Deployment Guide PDF for installation and 
configuration instructions.

SLMS314E: TransactionVision WMQI Agent: 
Could not open TransactionVision agent key 
in registry. Ensure that the TransactionVision 
agent is properly installed.

Ensure that the agent is properly installed. 
See the the HP TransactionVision 
Deployment Guide PDF for installation and 
configuration instructions.

SLMS315E: TransactionVision WMQI Agent: 
could not load TransactionVision agent library 
(‘%s’): %s.

Ensure that the agent is properly installed. 
See the the HP TransactionVision 
Deployment Guide PDF for installation and 
configuration instructions.

SLMS400I: TVISIONB startup in progress. Informational message. TVISIONB has 
been started and startup is in progress. This 
message should be followed by SLMS401I 
when startup is complete. 

SLMS401I: TVISIONB startup complete. Informational message. TVISIONB startup 
is complete and the MQSeries-IMS bridge 
Agent server component is ready to receive 
events from the bridge.

SLMS402I: STOP command received. Informational message. The MQSeries-IMS 
bridge Agent server component is shutting 
down. Bridge monitoring is disabled to 
prevent the sending of further events from 
the OTMA Input/Output Edit exit routine 
in the IMS control region(s) and all tasks in 
the TVISIONB address space are 
terminated. This message should be 
followed by SLMS403I when termination is 
complete. There may be a delay while 
in-flight events are dispatched.
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SLMS403I: TVISIONB termination complete. Informational message. All tasks in the 
MQSeries-IMS bridge Agent server 
component have been terminated. The 
TVISIONB and TVISIOND address spaces 
have been terminated.

SLMS4041: TVISIONB termination in 
progress.

TVISIONB is terminating in response to a 
STOP command or due to an error 
condition.

SLMS4051: TVISIONB dispatching remaining 
events in buffer queue.

TVISIONB is in quiesce mode in response 
to a STOP command. When all events in 
the buffer queue have been dispatched, 
TVISIONB termination will complete. The 
SLMS415I message follows to report the 
number of events in the buffer queue.

SLMS4061: Immediate TVISIONB termination 
requested. Events in buffer queue will be lost.

TVISIONB is terminating in response to a 
STOP IMMED command issued while there 
are events in the buffer queue. The 
SLMS415I message follows to report the 
number of events in the buffer queue.

SLMS410I: TVISIONB MQIMSBDG 
monitoring disabled.

Response to a DISABLE MQIMSBDG 
command. MQSeries-IMS bridge 
monitoring is disabled regardless of 
Analyzer requests.

SLMS411W: TVISIONB configuration 
messages have requested MQIMSBDG 
monitoring, which has been disabled by the 
system operator. Monitoring will not resume 
until enabled by the operator.

Warning message issued when 
configuration messages from an Analyzer 
request MQSeries-IMS bridge monitoring 
but monitoring has been disabled by a 
DISABLE MQIMSBDG command.

SLMS412I: TVISIONB MQIMSBDG 
monitoring already disabled.

Response to a DISABLE MQIMSBDG 
command when MQSeries-IMS bridge 
monitoring has already been disabled by a 
previous DISABLE MQIMSBDG command.
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SLMS413I: TVISIONB MQIMSBDG 
monitoring enabled.

Response to an ENABLE MQIMSBDG 
command. MQSeries-IMS bridge 
monitoring is enabled.

SLMS414I: TVISIONB MQIMSBDG 
monitoring already enabled.

Response to an ENABLE MQIMSBDG 
command when MQSeries-IMS bridge 
monitoring is already enabled.

SLMS419E: TVISIONB unable to process 
command.

An invalid command format or unknown 
command has been issued or TVISIONB 
encountered a system error attempting to 
process a command. If the command is 
correct, please contact HP Support and 
report the diagnostic data included in the 
message.

SLMS420W: Possible TVISIONB stall condition 
detected. Some requested events may be not 
be collected.

The TVISIONB event recording function is 
not responding in a timely manner. This 
condition may be caused by a full 
TransactionVision event queue because the 
queue has been defined too small or no 
Analyzer service is running to relieve the 
queue. If the event queue is full, expand its 
size and/or assure that an Analyzer is 
running. Otherwise, please contact HP 
Support.

SLMS421S: The event dispatcher task has 
unexpectedly terminated. TVISIONB will 
terminate.

TVISIOND is terminating due to an error 
condition.

SLMS430E: TVISIONB already started. An second instance of TVISIONB has been 
started. Only one instance is allowed. The 
second instance will be terminated.

SLMS431E: The MQSeries queue manager 
name missing. Please specify as follows: S 
TVISIONB,QMGR=CSQ1, for example.

The WebSphere MQ queue manager, to 
which TVISIONB connects to access its 
configuration and event queues, must be 
identified at startup.
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SLMS432E: The MQSeries queue manager 
name specified on the S TVISIONB command 
contains more than the maximum of 4 
characters.

WebSphere MQ queue manager names on 
z/OS are limited to four characters. 

SLMS433E: The MAXQ size specified on the S 
TVISIONB command is less than the 
minimum requirement of 3.

At least 3MB of storage are required for 
TVISIONB to manage its buffer queue

SLMS434E: The MAXQ size specified on the S 
TVISIONB command is greater than the 
maximum allowed of 2046.

The maximum amount of storage that 
TVISIONB can use to manage its buffer 
queue is 2046MB (2GB less 1MB).

SLMS435E: The MAXQ size specified on the S 
TVISIONB command contains non-numeric 
characters.

The TVISIONB MAXQ parameter must be 
numeric.

SLMS436E: The MAXQ size specified on the S 
TVISIONB command contains too many 
characters.

The TVISIONB MAXQ parameter must 
contain a maximum of 15 characters.

SLMS438E: The event dispatcher startup 
procedure name contains more than the 
maximum of 8 characters.

The EDPROC parameter on the TVISIONB 
startup command or procedure is incorrect.

SLMS440E: Invalid TVISIONB command 
entered.

An invalid command format or unknown 
command has been issued.

SLMS441E: Unknown target of TVISIONB 
DISABLE command.

A DISABLE command has been issued but 
the object name specified is unknown. In 
this version of TransactionVision, the only 
supported object is MQIMSBDG.

SLMS442E: Unknown target of TVISIONB 
ENABLE command.

A ENABLE command has been issued but 
the object name specified is unknown. In 
this version of TransactionVision, the only 
supported object is MQIMSBDG.

SLMS450S: TVISIONB ENQ error. Diagnostic 
data follow:

Please contact HP Support and report the 
diagnostic data included in the message.
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SLMS451S: TVISIONB unable to allocate 
required storage. Diagnostic data follow:

This may be caused by an too small 
REGION size for TVISIONB, which requires 
an address space size of the MAXQ 
specification plus 1MB. If the REGION size 
is sufficient, please contact HP Support and 
report the diagnostic data included in the 
message.

SLMS452S: TVISIONB unable to release 
obtained storage. Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS453S: TVISIONB ATTACH error. 
Diagnostic data follow:

This may be caused by a required program 
module missing from STEPLIB or 
SSLMLOAD libraries specified in the 
TVISIONB startup procedure. Please assure 
that all the modules listed in the 
installation instructions are located in the 
appropriate libraries and those libraries are 
specified in the TVISIONB startup 
procedure.

SLMS454S: TVISIONB LINK error. Diagnostic 
data follow:

This may be caused by a required program 
module missing from STEPLIB or 
SSLMLOAD libraries specified in the 
TVISIONB startup procedure. Please assure 
that all the modules listed in the 
installation instructions are located in the 
appropriate libraries and those libraries are 
specified in the TVISIONB startup 
procedure. If the setup is correct, please 
contact HP Support and report the 
diagnostic data included in the message.
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SLMS455S: TVISIONB LOAD error. Diagnostic 
data follow:

This may be caused by a required program 
module missing from STEPLIB or 
SSLMLOAD libraries specified in the 
TVISIONB startup procedure. Please assure 
that all the modules listed in the 
installation instructions are located in the 
appropriate libraries and those libraries are 
specified in the TVISIONB startup 
procedure. If the setup is correct, please 
contact HP Support and report the 
diagnostic data included in the message.

SLMS456S: TVISIONB DELETE error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS457S: TVISIONB OPEN error. Diagnostic 
data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS458S: TVISIONB CLOSE error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS459S: TVISIONB BLDL error. Diagnostic 
data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS460S: TVISIONB ASCE error. Diagnostic 
data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS461S: TVISIONB ASEXT error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS472S: TVISIONB IEANTCR error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS473S: TVISIONB IEANTRT error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS474S: TVISIONB IEANTDL error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS475S: TVISIONB ESTAEX error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.
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SLMS485S: Insufficient storage available for 
TVISIONB queue requirements. Diagnostic 
data follow:

This may be caused by a too small REGION 
size for TVISIONB, which requires an 
address space size of the MAXQ 
specification plus 1MB. This error occurs 
when TVISIONB attempts to allocate its 
initial buffer queue space of 2MB during 
startup. TVISIONB is terminated. If the 
REGION size is sufficient, please contact 
HP Support and report the diagnostic data 
included in the message.

SLMS486W: Insufficient storage available for 
TVISIONB queue expansion requirements. 
Events may be lost.

This may be caused by a too small REGION 
size for TVISIONB, which requires an 
address space size of the MAXQ 
specification plus 1MB. This error occurs 
when TVISIONB attempts to allocate 1MB 
to expand its buffer queue space within the 
MAXQ limitation specified at TVISIONB 
startup. When all already-allocated queue 
space is exhausted, subsequent events will 
be discarded. This condition may be caused 
by a full TransactionVision event queue 
because the queue has been defined too 
small or no Analyzer service is running to 
relieve the queue. If the event queue is full, 
expand its size and/or assure that an 
Analyzer is running. If the event queue is 
not full and the REGION size is sufficient, 
please contact HP Support.
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SLMS487W: Insufficient storage available for 
TVISIONB queue expansion requirements. 
MAXQ limit reached. Events may be lost.

TVISIONB has used almost all of the buffer 
queue space allowed by the MAXQ 
limitation specified at TVISIONB startup. 
When all allowed queue space is 
exhausted, subsequent events will be 
discarded. This condition may be caused 
by a full TransactionVision event queue 
because the queue has been defined too 
small or no Analyzer service is running to 
relieve the queue. If the event queue is full, 
expand its size and/or assure that an 
Analyzer is running. Otherwise, increase 
the MAXQ specification.

SLMS488S: TVISIONB system stall condition 
detected. Queued events will be lost.

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS498S: TVISIONB system error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.

SLMS499S: TVISIONB system error. 
Diagnostic data follow:

Please contact HP Support and report the 
diagnostic data included in the message.
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APIs Monitored by Agents

This chapter includes:

➤ "CICS Agent" on page 409

➤ "WebSphere MQ Agent" on page 410

➤ "WebSphere MQ-IMS Bridge Agent" on page 411

➤ "Servlet Technology in the Java Agent" on page 411

➤ "JMS Technology in the Java Agent" on page 413

➤ "EJB Technology in the Java Agent" on page 415

➤ "JDBC Technology in the Java Agent" on page 416

➤ "BEA Tuxedo Agent" on page 417

➤ "NonStop TMF Agent" on page 417

➤ ".Net Agent" on page 418

CICS Agent

The CICS Agent collects events for five groups of CICS APIs: file control, 
temporary storage, transient data, interval control, and program control. In 
addition, the CICS Agent collects Task Start, Task End and Program Start 
events as well. 

➤ File Control APIs

APIs: WRITE, REWRITE, READ, STARTBR, RESETBR, READNEXT, 
READPREV, ENDBR, DELETE, UNLOCK
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➤ Temporary Storage APIs

WRITEQ TS, READQ TS, DELETEQ TS

➤ Transient Data APIs

WRITEQ TD, READQ TD, DELETEQ TD

➤ Interval Control APIs

DELAY, START, ATTACH, CANCEL

➤ Program Control APIs

LINK, XCTL, RETURN

WebSphere MQ Agent

The WebSphere MQ library, API exit and the z/OS WebSphere MQ Agents 
collect events from the following MQ APIs.

➤ MQBACK

➤ MQBEGIN

➤ MQCLOSE

➤ MQCMIT

➤ MQCONN

➤ MQCONNX

➤ MQDISC

➤ MQGET

➤ MQINQ

➤ MQOPEN

➤ MQPUT

➤ MQPUT1

➤ MQSET

➤ MQSUB

➤ MQSUBRQ
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WebSphere MQ-IMS Bridge Agent

➤ MQIMS_BRIDGE_ENTRY 

➤ MQIMS_BRIDGE_EXIT 

These are events generated by the WebSphere MQ-IMS Bridge Agent when a 
MQ message is received by the MQ-IMS bridge and when a reply is 
generated by the WebSphere MQ-IMS bridge.

Servlet Technology in the Java Agent

The following servlet classes are instrumented:

➤ javax.servlet.http.HttpServlet 

➤ org.apache.jasper.runtime.HttpJspBase 

➤ com.ibm.servlet.PageListServlet 

The servlet technology tracks the following methods:

void doGet(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doPost(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doPut(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void service(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doDelete(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doHead(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doOptions(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)
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void doTrace(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void init()

void init(javax.servlet.ServletConfig)

void destroy()

void _jspService(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void jspInit()

void jspDestroy()

Note: The TRACE and OPTIONS requests are different from the other 
requests because the servlet container has the following default 
implementation of these two requests:

➤ For TRACE requests, the servlet container returns the whole request string 
made by the client.

➤ For OPTIONS requests, the servlet container returns the list of HTTP 
requests handled by that particular servlet.

If you do NOT override the doTrace and doOptions methods, 
TransactionVision is unable to trace these requests, although the client still 
gets the response.
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JMS Technology in the Java Agent

The JMS technology tracks the following methods:

Class:: ConnectionFactory
    createConnection
    createXAConnection

Class:: TopicConnectionFactory
    createTopicConnection
    createXATopicConnection

Class:: QueueConnectionFactory
    createQueueConnection

Class:: Connection
    createConnectionConsumer
    createDurableConnectionConsumer
    createSession
    createXASession
    close
    start
    stop
    setExceptionListener

Class:: QueueConnection 
    createQueueSession
    createXAQueueSession

Class:: TopicConnection
    createTopicSession
    createXATopicSession

Class:: Session
    createProducer
    createConsumer
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Class:: TopicSession
    createDurableSubscriber
    createPublisher
    createSubscriber
    unsubscribe
    commit
    recover
    rollback
    close

Class:: QueueSession
    createBrowser
    createReceiver
    createSender
    commit
    recover
    rollback
    createTemporaryQueue
    close

Class:: MessageProducer

Class:: MessageConsumer

Class:: QueueSender
    send
    close

Class:: TopicPublisher
    publish
    close

Class:: QueueBrowser
    close
    getEnumeration

Class:: QueueEnumeration
    nextElement
    hasMoreElements
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Class:: TopicSubscriber
    close
    receive
    setMessageListener

Class:: QueueReceiver
    close
    receive
    setMessageListener

Class:: Message
    acknowledge

EJB Technology in the Java Agent

The following EJB classes are instrumented:

➤ javax.ejb.EntityBean

➤ javax.ejb.SessionBean

➤ javax.ejb.MessageDrivenBean

➤ javax.ejb.EnterpriseBean (parent interface of all three above)

In addition to all business methods defined in public interfaces, the 
following methods are instrumented:

➤ ejbCreate()

➤ ejbPostCreate()

➤ ejbRemove() (session/entity/message driven bean)

➤ ejbLoad() (entity bean)

➤ ejbStore() (entity bean)

➤ onMessage() (message driven bean)
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JDBC Technology in the Java Agent

The JDBC technology monitors the following interfaces and methods:

➤ Interface java.sql.CallableStatement

➤ all execute methods 

➤ all set* methods

➤ Interface java.sql.Connection

➤ close

➤ commit

➤ releaseSavepoint

➤ rollback

➤ setSavePoint

➤ prepareCall

➤ prepareStatement

➤ Interface java.sql.Driver

➤ connect

➤ Interface java.sql.PreparedStatement

➤ execute

➤ executeQuery

➤ executeUpdate

➤ all set* methods

➤ Interface java.sql.ResultSet

➤ close

➤ deleteRow

➤ insertRow

➤ refreshRow
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➤ updateRow

➤ all get* methods

➤ cursor movement methods (next, first, etc.)

➤ Interface java.sql.Statement

➤ addBatch

➤ cancel

➤ clearBatch

➤ close

➤ execute

➤ executeBatch

➤ executeQuery

➤ executeUpdate

BEA Tuxedo Agent

The BEA Tuxedo Agent collects events from the following methods in the 
ATMI API:

➤ tpcall

➤ tpenqueue

➤ tpdequeue

NonStop TMF Agent 

The NonStop TMF Agent monitors the following operations on audited 
Enscribe files:

➤ Insert

➤ Modify

➤ Delete
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.Net Agent

The .NET Agent tracks Webservices in the ASP.NET environment. The .NET 
Agent tracks these Webservice method invocations by instrumenting the 
.NET code to collect events at the entry and exit of Webservice methods on 
the server and outgoing Webservice calls on the client.

The .NET Agent also tracks the following:

➤ HTTP calls, such as HTTP_POST, HTTP_GET, HTTP_PUT in the ASP.NET 
environment and ADO and .NET remoting outbound client calls and 
server invocations.

➤ NET WCF Client and Servicer Application calls. Services implemented 
with WCF similar to how Webservices are tracked in an ASP.NET 
environment.
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Troubleshooting

This chapter includes:

➤ "Enabling SHLIB_PATH on HP-UX" on page 420

➤ "Displaying Perl and Java Program Names" on page 420

➤ "Monitoring WebSphere MQ Triggered Programs" on page 420

➤ "Monitoring Client Applications" on page 422

➤ "Optimizing Performance" on page 422

➤ "Running TransactionVision Agents and Analyzers on VMWare Systems" 
on page 422

➤ "Missing Events" on page 423

➤ "Queue Manager or Event Broker Channel Limitations" on page 423

➤ "Servlet and EJB Technology Problems" on page 423

➤ "JMS Technology Problems" on page 424

➤ "Monitored Applications Troubleshooting" on page 425

➤ "Event Queue Cleanup" on page 425

➤ "Problems Importing System Tables into a Database" on page 428

➤ "Connection to Database Is Lost" on page 431

➤ "Problems Using International Characters" on page 432

➤ Schemas missing new tables on page 435

➤ Database Deadlocks in with IBM DB2 Databases on page 435
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Enabling SHLIB_PATH on HP-UX
When you run a program on HP-UX, the loader may use the library paths 
embedded in the program instead of the library paths specified in the 
SHLIB_PATH environment variable. You may use the chatr command to 
check the current settings on a program:

The output of this command may be as follows:

To enable run-time location of the WebSphere MQ Library Agent, you may 
use the following command to turn on the loader’s use of SHLIB_PATH as 
the first paths to search for libraries:

Displaying Perl and Java Program Names
By default, the TransactionVision displays Perl or java.exe as the program 
name for Perl or Java applications. To display the program name, set the 
TVISION_REPORT_ARGS environment variable to any value. to disable this 
behavior, unset TVISION_REPORT_ARGS. This environment variable can be 
set on any platform except z/OS. On Windows, it must be set to a value 
other than an empty string.

Monitoring WebSphere MQ Triggered Programs
WebSphere MQ triggered programs on UNIX platforms can be monitored if 
two conditions are met:

 1 The runmqtrm trigger monitor is not setuid/gid, or you are running 
runmqtrm as the mqm user. (This is because the programs started by the 
setuid/gid runmqtrm ignore any environment variables modifying the 
path if the user is not the setuid/gid user - the mqm user in this case.)

chatr executable_name

shared executable
shared library dynamic path search:
  SHLIB_PATH     disabled  second
  embedded path  enabled   first /opt/mqm/lib

chatr +s enable +b enable executable_name
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 2 You actually trigger a script instead of your program. The script sets the 
appropriate environment variable (based on the OS platform) to point to 
the agent and then runs the actual program. For example, on Solaris this 
script might be:

Where /usr/local/bin/trigproc was the program being triggered. The 
following table shows the appropriate environment variable and default 
installation directory for each platform:  

Note: The runmqtrm trigger monitor program cannot itself be sensed by the 
agent, because it uses internal WebSphere MQ functions which are not 
compatible with the agent. To sense the trigger monitor itself, use either the 
amqstrg0.c trigger monitor or build your own using only public WebSphere 
MQ APIs.

#!/bin/sh
LD_LIBARAY_PATH=/opt/HP/TransactionVision/lib
   export LD_LIBRARY_PATH
   /usr/local/bin/trigproc “$*”

Platform Environment Variable Default Directory

Windows PATH C:\Program 
Files\Hewlett-Packard\
TransactionVision Sensor\lib 

Sun Solaris LD_LIBRARY_PATH /opt/HP/TransactionVision/lib 

HP-UX SHLIB_PATH /opt/HP/TransactionVision/lib

Linux LD_LIBRARY_PATH /opt/HP/TransactionVision/lib

IBM AIX LIBPATH /usr/lpp/HP/TransactionVision/
lib 
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Monitoring Client Applications
If you are monitoring client applications and notice that the WebSphere MQ 
listener does not generate TransactionVision events when invoked from 
inetd, check the user id and group id of the mqm user as follows:

➤ id mqm

uid=nnn(mqm) gid=nnn(mqm)

Both the user and the group should be mqm. If not, the user mqm should be 
added to the group mqm. Alternately, you may change the group id on the 
listener binary to belong to the group that the user mqm belongs to.

Optimizing Performance
To achieve optimum performance when using TransactionVision, follow 
these guidelines:

➤ Install the Analyzer on a computer that is fast enough to keep up with the 
rate of incoming messages from agents. For a slower Analyzer host, 
increase the maximum queue depth on the event queue used for sending 
event messages from agents to the Analyzer.

➤ Use data collection filters to restrict event collection to event data 
absolutely necessary to resolve a particular problem. Be sure to delete the 
default Collect All data collection filter if you define a more restrictive 
filter, since events that meet any filter are collected by agents.

Running TransactionVision Agents and Analyzers on 
VMWare Systems
Running TransactionVision agents and Analyzers on VMWare systems can 
result in inaccurate event times. Because virtual machines work by 
time-sharing physical hardware, a virtual machine cannot exactly duplicate 
the timing behavior of a physical machine. This can result in a drift in the 
time reported by the guest operating system to the TransactionVision 
agents. The effect of this drift is that for transactions spanning multiple 
machines, relative transaction times are not accurate. For a detailed 
description of this issue, see this document on the VMWare website: https://
www.vmware.com/pdf/vmware_timekeeping.pdf.
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Missing Events
If it appears that events are missing from a schema, first make sure that no 
data collection filter or query is preventing the events from being collected 
or displayed. In the data collection filter, if the event retry timeout is set to a 
value other than Retry Forever and the timeout is being met, events are lost.

If the events are still missing and they are from WebSphere MQ, make sure 
that the WebSphere MQ API call uses a valid hConn parameter. The agent 
uses the hConn value to determine which queue manager or event broker to 
connect to for configuration messages; if this value is invalid, the agent 
cannot check for configuration messages.

Queue Manager or Event Broker Channel Limitations
MaxChannels and MaxActiveChannels queue manager or event broker 
properties have to be set to a reasonable amount for TransactionVision. By 
default, these properties are not set and there is no limitation. For each 
active communication link, the TransactionVision Analyzer requires two 
channels plus one channel for each listening thread defined in the 
communication link.

If these properties are set too low, the user sees strange behavior such as a 
partial connection to the communication link. It may at first appear that the 
Analyzer is connected, but it reports a connection error and puts the 
communication link in a “Trying to Connect” state. This behavior usually 
points to a problem with these queue manager or event broker properties 
not being set properly.
423



Chapter 13 • Troubleshooting
Servlet and EJB Technology Problems
If you are not able to collect servlet or EJB events from your web application, 
check the following:

 1 You have run SensorSetup.sh(bat) to install the TransactionVision Java 
Agent on the application server your web application is running on. The 
Application server name is case sensitive. “Default Server” is different 
from “default server” or “DefaultServer” (space counts). Run 
SensorSetup.sh(bat) again if needed.

 2 Check config/sensor/SensorConfiguration.xml from your 
TransactionVision home to make sure the information you provided there 
is correct and the queue manager or event broker is running. Run 
SensorSetup.sh(bat) to modify the setting if needed.

 3 Check sensor.log in your log file directory to see if there are any errors.

 4 Check WebSphere’s system.out and system.err log files to see if there are 
any errors.

JMS Technology Problems
If you are not able to collect JMS events from stand-alone JMS application, 
check the following:

 1 Make sure that file java\lib\com.ibm.mqjms.jar is in your 
TransactionVision home. Run SensorSetup.sh(bat) again if it is not there.

 2 Your ClassPath points to java\lib\com.ibm.mqjms.jar in 
TransactionVision home AHEAD of the same file from WebSphere MQ 
directory.

 3 Check config/sensor/SensorConfiguration.xml from your 
TransactionVision home to make sure the information you provided there 
is correct and the queue manager or event broker is running. Run 
SensorSetup.sh(bat) to modify the setting if needed.

 4 If JMS functions are called from servlets, make sure you answer “YES” to 
the question “Do you wish to monitor JMS methods along with Servlet 
methods?” when running SensorSetup.sh(bat).
424



Chapter 13 • Troubleshooting
Monitored Applications Troubleshooting
TransactionVision does not require changes to monitored applications. 
However, applications on the AIX platform may fail after installing a 
WebSphere MQ support pac. In WebSphere MQ support pacs, internal 
symbols exported from the TransactionVision WebSphere MQ Agent on the 
AIX platform may change. When an internal symbol that has been exported 
from the agent library is no longer available in the WebSphere MQ library, 
the application cannot start and fails with various symbol resolution errors.

To work around this problem, run the rebind_sensor script whenever a 
WebSphere MQ support pac that modifies the WebSphere MQ libraries 
(libmqm.a, libmqic.a, libmqm_r.a, libmqic_r.a) are modified. For more 
information about this script, see Administration Utilities on page 319.

Event Queue Cleanup
There may be times when messages that are not being collected by a 
TransactionVision Analyzer accumulate on the event queue. These events 
may be targeted for invalid schemas or communication links, or they may 
be erroneous messages. In either case, you can use the ManageQueue utility 
to remove or replay these messages.

To view a snapshot of the messages on an event queue 
(TVISION.EVENT.QUEUE on queue manager QMGR1 in this example), enter 
the following command:

For complete information about ManageQueue, see "ManageQueue" on 
page 339.

ManageQueue.sh –qm qmgr1 –input_queue TVISION.EVENT.QUEUE 
–show_event_ids
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Invalid Schema and Communication Link IDs

Events are targeted for a specific database, schema, and communication link 
identified within TransactionVision by a unique ID. If a schema is deleted or 
a communication link is changed, the unique ID no longer exists, and any 
events still on the event queue that targeted for that schema or 
communication link are no longer valid.

To display all schema and commlink IDs, enter the following command:

To delete events targeted for database schemas or communication links 
which no longer exist from the queue TVISION.EVENT.QUEUE on the 
queue manager QMGR1, enter the following command:

You can also use ManageQueue to replay events targeted for invalid schema 
or communication link IDs to a new schema and communication link so 
they can be processed by the Analyzer:

In this example, the schema ID for the new schema is 2 and the 
communication link ID for the new communication link is 11.

Erroneous Messages

Erroneous messages are messages on the event queue that do not appear to 
be TransactionVision event messages. Erroneous messages could include 
messages generated from other applications or WebSphere MQ COA report 
messages used by communication link time skew tests.

To remove erroneous messages from TVISION.EVENT.QUEUE on queue 
manager TransactionVision.qmgr, enter the following command:

EventQueueCleanup -showids

ManageQueue.sh –show_db_ids

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –output_queue 
TVISION.EVENT.QUEUE –move 2 11 -verbose

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –delete –
erroneous –orphaned –verbose
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Events Not Pulled from Event Queue

Event queues can be shared across Analyzers and communication links. 
Therefore, events have to be retrieved from the queue based on a specific 
message ID (correlation ID in the case of Java Agent events).

The following diagram shows the layout of the message ID (correlation ID in 
the case of Java Agent events) on TransactionVision events.  

Given an assigned communication link, an Analyzer gets events only by a 
specific message ID/correlation ID. Therefore, it is possible to have events on 
the event queue which may never be removed from the queue. Different 
sceneries can cause this.

WebSphere MQ Anomalies

TransactionVision events are not the only kinds of messages that may 
appear on a event queue.

For client connections to a host other than the one running the agent, 
TransactionVision uses WebSphere MQ Confirmation of Arrival (COA) 
messages to determine time skew across communication links. This means 
that a COA request message is sent to the configuration queue, and the COA 
report is sent back on the event queue.

If a remote (using multiple queue managers or event brokers) 
communication link is being used, the COA report has to travel across a 
WebSphere MQ channel to reach the final event queue destination. If there 
are problems in the WebSphere MQ environment (for example, the channel 
is down), the Analyzer may timeout waiting for a COA report message. If the 
WebSphere MQ problem is later fixed, the COA report message may finally 
arrive in the event queue. This COA report message is never removed from 
the event queue, because the Analyzer has given up on it.

12 Bytes
Database Name

4 Bytes
Database Host IP

4 Bytes
CommLink ID

4 Bytes
Schema ID
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There is also the possibility of other WebSphere MQ applications 
maliciously or accidently putting messages on the TransactionVision event 
queue. The Analyzer ignores these because they are most likely not to have a 
matching message ID/correlation ID it is looking for, and therefore remain 
on the event queue indefinitely.

Problems Importing System Tables into a Database

Oracle

The referential constraints of TransactionVision system tables prevent 
Oracle data import utility from loading data into existing tables. The Oracle 
data import utility returns an error similar to the following example:

If you encounter this error, disable the constraints, import the data, and 
then re-enable the constraints. 

For more information, see the following Oracle document:

http://download-west.oracle.com/docs/cd/A91202_01/901_doc/server.901/
a90192/ch02.htm#1005094 

IMP-00019: row rejected due to ORACLE error 2291
IMP-00003: ORACLE error 2291 encountered
ORA-02291: integrity constraint (TVISION.FK1_FILTER) violated - parent key not found
Column 1 17
Column 2 Collect All
Column 3 16
Column 4 00540001020C0000000100000001000000179F0700008ADC00... 0 rows 
imported
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Disabling Referential Constraints

To disable the referential constraints, use the following SQL commands:

Re-enabling Referential Constraints

To re-enable the referential constraints after importing the data, use the 
following SQL commands:

DB2

When importing system tables into a DB2 database, some tables may be 
placed in a Check Pending state. To resolve this problem, disable the 
constraints, import the data, and then re-enable the constraints. 

alter table TVISION.ANALYZER_PROJ_COMMLINK DISABLE CONSTRAINT 
FK2_ANLZ_PROJ_LINK;
alter table TVISION.ANALYZER_SCHEMA DISABLE CONSTRAINT 
FK2_ANLZ_SCHEMA;
alter table TVISION.COMMLINK_FILTER DISABLE CONSTRAINT FK1_LINK_FILTER;
alter table TVISION.COMMLINK_FILTER DISABLE CONSTRAINT FK2_LINK_FILTER;
alter table TVISION.FILTER DISABLE CONSTRAINT FK1_FILTER;
alter table TVISION.PROJECT DISABLE CONSTRAINT FK1_PROJECT;
alter table TVISION.PROJECT_COMMLINK DISABLE CONSTRAINT 
FK1_PROJ_LINK;
alter table TVISION.QUERY DISABLE CONSTRAINT FK1_QUERY;

alter table TVISION.ANALYZER_PROJ_COMMLINK ENABLE CONSTRAINT 
FK2_ANLZ_PROJ_LINK;
alter table TVISION.ANALYZER_SCHEMA ENABLE CONSTRAINT 
FK2_ANLZ_SCHEMA;
alter table TVISION.COMMLINK_FILTER ENABLE CONSTRAINT FK1_LINK_FILTER;
alter table TVISION.COMMLINK_FILTER ENABLE CONSTRAINT FK2_LINK_FILTER;
alter table TVISION.FILTER ENABLE CONSTRAINT FK1_FILTER;
alter table TVISION.PROJECT ENABLE CONSTRAINT FK1_PROJECT;
alter table TVISION.PROJECT_COMMLINK ENABLE CONSTRAINT 
FK1_PROJ_LINK;
alter table TVISION.QUERY ENABLE CONSTRAINT FK1_QUERY;
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Disabling Referential Constraints

To disable the referential constraints, use the following SQL commands:

alter table tvision.analyzer_proj_commlink alter FOREIGN KEY fk2_anlz_proj_link NOT 
ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK2_ANLZ_SCHEMA 
NOT ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK1_ANLZ_SCHEMA 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.FILTER alter FOREIGN KEY FK1_FILTER NOT ENFORCED;
alter table TVISION.PROJECT alter FOREIGN KEY FK1_PROJECT NOT 
ENFORCED;
alter table TVISION.PROJECT_COMMLINK alter FOREIGN KEY FK1_PROJ_LINK 
NOT ENFORCED;
alter table TVISION.QUERY alter FOREIGN KEY FK1_QUERY NOT ENFORCED;
alter table TVISION.STORAGE alter FOREIGN KEY FK1_STORAGE NOT 
ENFORCED;
alter table TVISION.REPORT_PARAMETERS alter FOREIGN KEY FK1_REP_PARMS 
NOT ENFORCED;
alter table TVISION.JOB_STATUS alter FOREIGN KEY FK1_JOB_ID NOT 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK3_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK1_ANLZ_PROJ_LINK NOT ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK2_ANLZ_PROJ_LINK NOT ENFORCED;
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Re-enabling Referential Constraints

To re-enable the referential constraints after importing the data, use the 
following SQL commands:

Connection to Database Is Lost
If the connection to the TransactionVision database is lost, the following 
message is displayed: 

"TransactionVision Error: The connection to the TransactionVision database 
has been lost. Please ensure that the database is accessible, and then 
re-login to BSM again." 

alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
fk2_anlz_proj_link ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK1_ANLZ_SCHEMA 
ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK2_ANLZ_SCHEMA 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
ENFORCED;
alter table TVISION.FILTER alter FOREIGN KEY FK1_FILTER ENFORCED;
alter table TVISION.PROJECT alter FOREIGN KEY FK1_PROJECT ENFORCED;
alter table TVISION.PROJECT_COMMLINK alter FOREIGN KEY FK1_PROJ_LINK 
ENFORCED;
alter table TVISION.QUERY alter FOREIGN KEY FK1_QUERY ENFORCED;
alter table TVISION.STORAGE alter FOREIGN KEY FK1_STORAGE ENFORCED;
alter table TVISION.REPORT_PARAMETERS alter FOREIGN KEY FK1_REP_PARMS 
ENFORCED;
alter table TVISION.JOB_STATUS alter FOREIGN KEY FK1_JOB_ID ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK3_LINK_FILTER 
ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK1_ANLZ_PROJ_LINK ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK2_ANLZ_PROJ_LINK ENFORCED;
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In some cases, making sure the database is accessible and re-logging into 
HP Business Service Management does not resolve the problem. In these 
cases, the problem can be resolved by first closing the browser window and 
then logging into Business Availability Center again. 

Problems Using International Characters
See Processing Server Page, Configuration Tab on page 62for instructions on 
how to configure TransactionVision and your DBMS to store and display 
unicode data.

Garbage Characters in Database Column Values

The most likely cause of this problem is inserting Unicode characters into a 
database that has not been created as a UTF-8 database. If your user data 
contains any Unicode that gets mapped to database tables, you must create 
the database with the UTF-8 code set.

Value Too Large For Column Exceptions

Database exceptions during event processing reporting that the inserted 
value is too large for the column indicates that, for custom XDM columns, a 
corresponding table column might not have been generated large enough to 
accommodate the number of characters specified in the XDM definition. To 
resolve this problem, set the attribute unicode=true on the column.

Unable to Make a Client Connection to a Queue Manager or 
Event Broker Using an International Character Set

The problem indicates that the queue manager or event broker is using a 
coded character set identifier (CCSID) of mixed mode character set (for 
example, Shift-JIS or another double-byte character set) and the CCSID has 
not been set correctly.
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Agent Configuration Queue Manager or Event Broker

The CCSID of the queue manager or event broker should be set during 
SensorSetup. If you are , you may see the following errors in the sensor.log 
file:

To resolve this problem:

 1 Run the following command to identify the CCSID of the target queue 
manager or event broker:

echo display qmgr ccsid | runmqsc <sensor_config_qmgr>

 2 Re-run SensorSetup and enter the correct CCSID.

2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - TransactionVision 
Error(FailedToCreateTransportSessionForListener): Failed to create a transport session 
for Sensor configuration listener.

2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - TransactionVision 
Error(TransportConnectFailed): Failed to connect ('jpsvr.tv1.manager' 'queue:///
TVISION.CONFIGURATION.QUEUE?priority=-1&persistence=-1&targetClient=1'). 
(2195) Unexpected error occurred.

2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - MQJMS2005: failed to create 
MQQueueManager for 'bristol-jpsvr:jpsvr.tv1.manager'
2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - 
javax.jms.JMSException: MQJMS2005: failed to create MQQueueManager for 
'bristol-jpsvr:jpsvr.tv1.manager'
  at com.ibm.mq.jms.services.ConfigEnvironment. 
    newException(ConfigEnvironment.java:546)
  at com.ibm.mq.jms.MQConnection.createQM(MQConnection.
    java:1450)
  at com.ibm.mq.jms.MQConnection.createQMNonXA(MQConnection. 
    java:960)
  at com.ibm.mq.jms.MQQueueConnection.<init>(MQQueueConnection. 
    java:159)
  at com.ibm.mq.jms.MQQueueConnection.<init>(MQQueueConnection. 
    java:77)
  at com.ibm.mq.jms.MQQueueConnectionFactory.createQueue
    Connection(MQQueueConnectionFactory.java:142)
  at com.bristol.tvision.transport.MQJMSTransportSession. 
    connect(MQJMSTransportSession.java:156)
  at com.bristol.tvision.sensor.configurationmgr.Configuration
   ListenerThread.run(ConfigurationListenerThread.java:196)
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Analyzer Configuration Queue Manager or Event Broker
The CCSID of the queue manager or event broker should be set in the 
communication link. If you are unable to make a client connection to the 
Analyzer configuration queue manager or event broker, you may see the 
following errors in the AppLog file: 

2006-03-10 10:44:44,718 [ConfigurationThread (id=10,action=timeskew)] FATAL 
AppLog - TransactionVision Fatal(MQConnectionFailed): Failed to connect 
('jpsvr.tv1.manager'): (2195) Unexpected error occurred.
2006-03-10 10:44:44,718 [ConfigurationThread (id=10,action=timeskew)] FATAL 
AppLog - 
com.ibm.mq.MQException: MQJE001: Completion Code 2, Reason 2195
  at com.ibm.mq.MQManagedConnectionJ11.<init>
    (MQManagedConnectionJ11.java:172)
  at com.ibm.mq.MQClientManagedConnectionFactoryJ11. 
    _createManagedConnection(MQClientManagedConnection
    FactoryJ11.java:270)
  at com.ibm.mq.MQClientManagedConnectionFactoryJ11. 
    createManagedConnection(MQClientManagedConnection
    FactoryJ11.java:290)
  at com.ibm.mq.StoredManagedConnection.<init>
    (StoredManagedConnection.java:80)
  at com.ibm.mq.MQSimpleConnectionManager.allocate
    Connection (MQSimpleConnectionManager.java:150)
  at com.ibm.mq.MQQueueManager.obtainBaseMQQueueManager
    (MQQueueManager.java:682)
  at com.ibm.mq.MQQueueManager.construct(MQQueueManager. 
    java:620)
  at com.ibm.mq.MQQueueManager.<init>(MQQueueManager. 
    java:393)
  at com.bristol.tvision.services.collection. 
    MQConfigurationThread.createConnection(MQConfiguration
    Thread.java:356)
  at com.bristol.tvision.services.collection. 
    MQConfigurationThread.getTimeSkew(MQConfiguration
    Thread.java:218)
  at com.bristol.tvision.services.collection.Configuration
    Thread.run(ConfigurationThread.java:141)
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To resolve this problem:

 1 Run the following command to identify the CCSID of the target queue 
manager or event broker:

echo display qmgr ccsid | runmqsc <analyzer_config_qmgr>

 2 Edit the communication link to set the correct CCSID.

Schemas missing new tables
When a new XDM file containing XML mappings to new tables is added, 
older schemas not containing these new tables fail to get loaded by 
TransactionVision. To work around this, add the new tables to the older 
schemas with the CreateSqlScript as follows: 

CreateSqlScript[.sh|.bat] –c –e –t table-name schema-name

Database Deadlocks in with IBM DB2 Databases
NOTE: Multiple threads performing concurrent database operations along 
with a DB2 behavior called Next Row Locking may lead to database 
deadlocks. To avoid deadlocks when using multiple event-processing 
threads, set the DB2 variable DB2_RR_TO_RS to ON with the following 
command:

     db2set DB2_RR_TO_RS=ON

This setting is only effective after a DB2 restart. It affects all DB2 
applications and cannot be used if other non-TransactionVision 
applications that require “Repeatable Read” semantics (Transaction Isolation 
Level RR) are using the same DB2 instance. If other applications using the 
same instance require “Repeatable Read” semantics, you must either create a 
separate DB2 instance for TransactionVision or set the number of event 
collection threads to 1.
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Introducing Transaction Management

This chapter includes:

Concepts

➤ Transaction Management Overview on page 440

➤ Business Transactions Overview on page 441

Tasks

➤ How To Choose a Transaction Management Workflow on page 444
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Concepts

Transaction Management Overview

Transaction Management is an HP Business Service Management 
application that provides the following:

➤ Transaction tracing

The tracking of business transaction instances across all tiers of the 
application environment. Payload information is also captured. Relies on 
data collected by the TransactionVision product.

All of the Transaction Management reports and topologies include 
transaction tracing information.

The transaction tracing data is sent to the BSM data repositories where it 
is used by other BSM applications. 

➤ Transaction monitoring

The collection of aggregate data from all transaction instances across all 
tiers of the application environment. Relies on data collected by the 
HP Diagnostics product.

Some of the Transaction Management reports and topologies include 
transaction information reported by HP Diagnostics.

The transaction monitoring data is sent to the BSM data repositories 
where it is used by other BSM applications. 
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Business Transactions Overview

A business transaction is a logical entity created by the user to represent a 
logical unit of work executed by a business application.

Business transactions can be defined in different ways throughout BSM.

In the Transaction Management application, there are two kinds of business 
transactions:

➤ Business transactions that are entities created by the work of the 
TransactionVision Analyzers. Collected events are fed into the Analyzer 
and it correlates them into end to end transactions. User-defined rules are 
then applied to these transactions to classify them into unique individual 
named business transactions. 

These transactions are said to be enabled for transaction tracing. 

➤ Business transactions that are entities created by mappings to a set of 
server requests from HP Diagnostics. 

These transactions are said to be enabled for transaction monitoring. 

Regardless of how they are created, business transactions represent a real life 
transaction of an application in a distributed computer network, as seen 
from the application specialist’s point of view. The application specialist 
works closely with the Transaction Management administrator to define the 
transaction. 

Business Transactions in Applications or Transaction 
Flows
A business transaction exists in the context of an application, a group, or a 
transaction flow. A Business Transaction Flow is a logical entity created by 
the user to represent a logical grouping of related Business Transactions.
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Business transactions can be logically grouped into transaction flows and 
applications: 

Note: In End User Management, an application and its transaction flows are 
significant entities. For best practices in working with transactions that are 
shared between End User Management and Transaction Management, group 
all business transactions in a transaction flow that can then be associated 
with a single business transaction flow CI.

For more information about End User Management, see Using End User 
Management.

Application Management View
Business transaction CIs are one of many CIs that are defined and stored in 
the BSM ODB. You use different views to manage particular sets of CIs. 

The Application Management view is the default view for Transaction 
Management Administration. The view displays business transaction data 
on the entire application hierarchy (applications, business transaction flows, 
CI collections, business transactions). The data is based on the transactions 
monitored by HP Diagnostics or traced by TransactionVision.
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You create and manage these CIs through the Transaction Management 
Administration > Monitoring > Transaction Configuration tab: 

The CIs display in the hierarchy represented by the diagram above.

Business Transaction CIs and other CIs can be configured in Transaction 
Management Administration. For user interface details, see "Business 
Transaction Tracing User Interface" on page 456.
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Tasks

How To Choose a Transaction Management Workflow

The application specialist works with the Transaction Management 
administrator to define the business transactions. This process involves the 
following tasks:

➤ Create a Business Transaction CI. See "How to Create a Business 
Transaction CI" on page 452.

➤ Determine which product to use to collect the transaction data:

➤ TransactionVision

➤ HP Diagnostics

Transaction Monitoring (HP Diagnostics) collects aggregate statistics 
only.  Transaction Tracing (TransactionVision) tracks actual transaction 
instances which allows for setting the transaction value, state, and 
other ways to show the business content

TransactionVision provides the finer grain information, and is the best 
way to manage mission-critical transactions. But there is a workload 
associated with this transaction tracking that may limit the number of 
transactions on which your system can perform transaction tracing. 
Transaction monitoring, because it captures less transaction data, has a 
smaller workload and can therefore cover more transactions. 

➤ If using TransactionVision, you will enable the transaction for tracing and 
then define the transaction tracing rules. You can use a wizard to define 
the rules automatically. See Chapter 15, "Business Transaction Tracing."

➤ If using HP Diagnostics, you will enable the transaction for monitoring 
and then choose the Server Requests that is the entry point of a 
transaction. See Chapter 16, "Business Transaction Monitoring."
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Business Transaction Tracing

This chapter includes:

Concepts

➤ Transaction Tracing Overview on page 446

Tasks

➤ How to Set Up a Business Transaction for Tracing on page 449

➤ How to Create a Business Transaction CI on page 452

➤ How to Stop Tracing on a Business Transaction on page 453

➤ How to Send Events to BPI on page 454

Reference

➤ Business Transaction Tracing User Interface on page 456

Troubleshooting and Limitations on page 470
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Concepts

Transaction Tracing Overview

A transaction that is enabled for tracing has two characteristics:

➤ A transaction tracing rule is assigned to it.

➤ Tracing properties are defined for it.

Transaction Tracing Rules
Tracing Rules control the process by which unclassified transactions become 
business transactions. The rules are executed by the Analyzer as it processes 
events. If the conditions are met the unclassified transaction becomes a 
fully-defined and named business transaction. 

Tracing rules exist in a repository. You assign one and only one tracing rule 
from the repository to a transaction. You also assign that tracing rule to the 
Analyzer collecting events for that transaction–that is, the event data is in 
that Analyzer’s schema. Each Analyzer executes its rules to define the 
corresponding business transaction when it completes
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There are three types of transaction tracing rules: 

➤ Classification rules

Classification rules contain match conditions. If all of the match 
conditions evaluate to true, the transaction being tested is classified as the 
business transaction. These rules define the business transactions. 

For example, if the event properties match the conditions listed below, 
the transaction is classified:

➤ Data rule

Once classification rules define a transaction, key attributes of the 
transaction are set by executing the data rules. Attributes tell the 
important and interesting information about the transaction, such as did 
it complete successfully, and how big of a transaction, in terms of 
monetary value, it was.

Data rules can be local to a specific transaction tracing rule, or they can be 
inherited from the global data rules.

➤ BPI rules

BPI rules define the conditions under which an event is propagated to 
BPI. For example, For example if you want to drive a step in a Business 
Process you have modeled in BPI by an event generated from a 
TransactionVision business transaction.
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Transaction Properties
Transaction properties are characteristics of the transaction that you specify 
in order for its collected data to be meaningful and accurate For example, 
what is the unit of currency for the Transaction Value and is the response 
time threshold for the transaction.
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Tasks

How to Set Up a Business Transaction for Tracing 

This task describes how to set up a business transaction for tracing.

 1 Create a new business transaction CI

If you are configuring an existing business transaction CI you can skip 
this step.

For information about creating a new business transaction CI, see "How to 
Create a Business Transaction CI" on page 452.

 2 Run a Transaction Tracing Rule Wizard if possible

Some business transactions can be set up by wizards. The wizard defines 
the transaction property settings and creates the transaction tracing rule 
for you, based on your input. 

➤ If the business transaction is based on Servlet technology, you can use 
the Transaction Tracing Rule wizard for Servlets.

➤ If the business transaction is based on a business transaction already 
configured for RUM, you can use the Transaction Tracing Rule wizard 
for RUM. This wizard will help you create a tracing configuration 
based on a RUM transaction configuration.

➤ If the business transaction is based on a business transaction already 
configured for BPM, you can use the Transaction Tracing Rule wizard 
for BPM. This wizard will help you create a tracing configuration by 
finding matching synthetic transaction generated by BPM and 
collected by TransactionVision, and using those instances to base the 
classification rules on.

➤ If the business transaction is based on a business transaction already 
configured for monitoring through HP Diagnostics, you can use the 
Transaction Monitoring wizard. This wizard will help you create a 
tracing configuration based on your Diagnostics configuration.
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To access the wizards, follow these steps:

 a Select Admin > Transaction Management > Monitoring. 

 b (left pane) Click the Transaction Configuration button.

 c Right-click the transaction that you want to enable for tracing and 
choose one of the following:

➤ Launch Transaction Tracing Rule Wizard for Servlets

➤ Launch Transaction Tracing Rule Wizard for BPM

➤ Launch Transaction Tracing Rule Wizard for RUM

➤ Launch Transaction Monitoring Wizard

 d (right pane) Click Configure Transaction Tracing.

These wizards are fully described within the interface of the wizard itself. 
The results of running each wizard is that the Transaction Configuration 
page’s Tracing tab is populated. For details about this interface, see 
"Transaction Configuration Page, Tracing Tab" on page 461.

Note: If the business transaction you need to define is not in the above 
categories, you need to specify the configuration and transaction tracing 
rule manually. 

 3 Configure the tracing rule and properties manually

If a wizard cannot be used to create the transaction rule, you must define 
the rule manually. To do this, follow these steps:

 a Select Admin > Transaction Management > Monitoring. 

 b (left pane) Click the Transaction Configuration button.

 c Right-click the transaction that you want to enable for tracing and 
choose New Transaction Tracing Configuration > Create New Rule 
Definition. 

 d Enter a name for the rule and click OK.
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 e The Transaction Tracing tab appears. On this tab, enter the transaction 
tracing properties, classification rules, data rules, and BPI rules as 
needed. See the "Transaction Configuration Page, Tracing Tab" on 
page 461.

 4 Assign the Transaction Tracing Rule to an Analyzer

Once you have a transaction tracing rule, either defined via a wizard or 
manually, you must assign it to the appropriate Analyzer. That is, the one 
that is receiving the events the rule applies to. 

 a Select Admin > Transaction Management > Monitoring. 

 b (left pane) Click the Transaction Tracing Rules button.

 c Select the transaction tracing rule that you want to assign. 

 d (right pane) On the General tab, locate the Analyzer to which you 
want to assign the rule and move it Assigned Analyzers column.

If the Analyzer you want to specify is not in the list, it is either not 
active or you do not have permission to access it. See the "Security" 
chapter in the HP TransactionVision Deployment Guide PDF. 

 e Click Apply.

 5 Verify the Business Transaction is Enabled for Tracing

 a Select Admin > Transaction Management > Monitoring. 

 b (left pane) Click the Transaction Configuration button.
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Each business transaction and its status appear:

A green arrow icon in the TV column indicates that the business 
transaction has been successfully enabled for tracing and is assigned to 
an Analyzer. A Warning icon indicates that the business transaction 
has been successfully enabled for tracing but not yet assigned to an 
Analyzer. 

How to Create a Business Transaction CI

This task describes how to create a new business transaction. 

 1 Select Admin > Transaction Management > Monitoring.

 2 (left pane) Click the Transaction Configuration button. 

 3 From the drop-down list, choose the view in which to define the 
transaction. 

You can use any view you want. The default view is Application 
Management. 

 4 Navigate to the parent container that you want to contain the business 
transaction. The parent container is one of the following: application, 
business transaction flow, or group. See "Business Transactions Overview" 
on page 441.

 5 Right-click the parent container and choose New Business Transaction.
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 6 The Business Transaction CI wizard appears. For details about this 
interface, see "Business Transaction CI Creation Dialog Box" on page 457.

For information about creating other types of CIs, see "Business 
Transaction Tracing User Interface" on page 456.

How to Stop Tracing on a Business Transaction 

There are a few ways to ways to stop tracing on a business transaction:

Unassign the transaction rule from an Analyzer:

 1 Select Admin > Transaction Management > Monitoring.

 2 (left pane) Click the Transaction Tracing Rules button.

 3 Select the tracing rule.

 4 (right pane) In the Assign Analyzers area, move the Analyzers from the 
Assign Analyzers column to the Available Analyzers column.

 5 Click Apply.

Disable tracing on the transaction:

 1 Select Admin > Transaction Management > Monitoring.

 2 (left pane) Click the Transaction Configuration button.

 3 Select the Business Transaction CI. You may have to first choose the CI 
view that contains the business transaction CI. By default, business 
transaction CIs are in the Application Management view.

 4 Right-click the Business Transaction CI and choose Disable Transaction 
Tracing.

Delete the Business Transaction CI:

Use the IT Universe Administration pages or ODB Administration pages to 
delete the Business Transaction CI. 

If the business transaction CI that you want to delete is enabled for 
transaction tracing or monitoring, you may want to first disable these before 
you delete the CI. 
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How to Send Events to BPI

As TransactionVision processes events into a business transaction, it can 
send data to BPI in the form of BPI events. These BPI events can be used to 
update BPI’s view of the progress of a monitored business process instance. 

This task describes how to designate which TransactionVision events are 
delivered to BPI.

 1 Determine Which Transaction has the Events You Want to 
Send to BPI

Identify the Business Transaction CI that contains the data you want to 
send to BPI.

The Business Transaction CI must be enabled and configured for tracing. 

 2 Add BPI Rules to the Transaction Tracing Rule

Use the BPI Definition Dialog to define the published BPI events. For 
details about this interface, see "BPI Definition Dialog Box" on page 469.

Handling of Date/Time Based Data sent to Business Process 
Insight

If you have a Date/Time value computed within TransactionVision, have 
assigned it to a custom attribute, and want Business Process Insight to be 
able to read that attribute, the following steps are required:

 1 When defining the attribute in the XDM column definition in 
TransactionVision, the field must be declared as a TIMESTAMP column. 

 2 The timestamp column must be populated by doing one of the following:

➤ setting the transaction attribute to a long value (using the standard 
milliseconds since January 1, 1970, 00:00:00 GMT)

➤ parsing a date. In this case you need to specify the date format in the 
XDM definition
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Example of setting a long value:

If no dateFormat <Param> is specified, the field must be set using a long value 
(milliseconds since Jan 1 1970).                       

 <Column name="order_date" type="TIMESTAMP" 
description="OrderDate" conversionType="Date">

<Path>/Transaction/OrderDate</Path>                                   

</Column>

Example of parsing a date:

Setting this field in the XDM definition file only allows input in the specified mm/
dd/yyyy hh:mm format.                   

<Column name="order_date" type="TIMESTAMP" 
description="OrderDate" conversionType="Date">

<Path>/Transaction/OrderDate</Path>

<Param name="dateFormat" value="mm/dd/yyyy hh:mm"/>

</Column>
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Reference

Business Transaction Tracing User Interface

This section describes:

 ➤ Business Transaction CI Creation Dialog Box on page 457

 ➤ Application CI Creation Dialog Box on page 458

 ➤ Business Transaction Flow Creation Dialog Box on page 459

 ➤ Group CI Creation Dialog Box on page 460

 ➤ Transaction Configuration Page on page 460

 ➤ Transaction Configuration Page, General Tab on page 461

 ➤ Transaction Configuration Page, Tracing Tab on page 461

 ➤ Transaction Tracing Rules Page on page 466

 ➤ Transaction Tracing Rules Page, General Tab on page 467

 ➤ Transaction Tracing Rules Page, Rules Definition Tab on page 467

 ➤ Create Match Condition Dialog Box on page 468

 ➤ BPI Definition Dialog Box on page 469
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Business Transaction CI Creation Dialog Box

This dialog box enables you to create a new business transaction CI. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management > 
Administration > Monitoring.

2  (left pane) Click the Transaction Configuration button. 

3  Choose the view in which to create the business 
transaction CI.

4  Navigate to the parent container that you want to 
contain the business transaction. If the parent 
container is not there, create it first. See "Business 
Transactions Overview" on page 441.

5  Right-click the parent container and choose New 
Business Transaction.

Important 
information

Business Transaction CIs created by this dialog are stored 
in the ODB and available to other applications in BSM.

UI Element Description

Name The name of the business transaction. The name must be 
unique to its parent container. 

Type Business Transaction 

Description A description of the business transaction.
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Application CI Creation Dialog Box

This dialog box enables you to create a new business transaction CI. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management > 
Administration > Monitoring.

2  (left pane) Click the Transaction Configuration button. 

3  Choose the view in which to create the application CI.

4  Right-click the parent container and choose New 
Application.

Important 
information

Application CIs created by this dialog are stored in the 
ODB and available to other applications in BSM.

UI Element Description

Name The name of the application. The name must be unique 
throughout the ODB. 

Type Application 

Description A description of the application. 
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Business Transaction Flow Creation Dialog Box

This dialog box enables you to create a new business transaction flow CI. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management > 
Administration > Monitoring.

2  (left pane) Click the Transaction Configuration button. 

3  Choose the view in which to create the business 
transaction flow CI.

4  Navigate to the parent container that you want to 
contain the business transaction flow. If the parent 
container is not there, create it first. See "Business 
Transactions Overview" on page 441.

5  Right-click the parent container and choose New 
Business Transaction Flow.

Important 
information

Business Transaction Flow CIs created by this dialog are 
stored in the ODB and available to other applications in 
BSM.

UI Element Description

Name The name of the business transaction flow. The name 
must be unique to its parent container. 

Type Business Transaction Flow

Description A description of the business transaction flow. 
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Group CI Creation Dialog Box

This dialog box enables you to create a new group CI. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Transaction Configuration Page

The Business Transaction page enables you to enable and disable transaction 
tracing or monitoring, and to view or modify other properties, of an existing 
Business Transaction. This page has the following tabs:

➤ "Transaction Configuration Page, General Tab" on page 461

➤ "Transaction Configuration Page, Monitoring Tab" on page 475

➤ "Transaction Configuration Page, Tracing Tab" on page 461

To access 1  Select Admin > Transaction Management > 
Administration > Monitoring.

2  (left pane) Click the Transaction Configuration button. 

3  Choose the view in which to create the group CI.

4  Navigate to the parent container that you want to 
contain the group. If the parent container is not there, 
create it first. See "Business Transactions Overview" on 
page 441.

5  Right-click the parent container and choose New 
Group.

Important 
information

Group CIs created by this dialog are stored in the ODB 
and available to other applications in BSM.

UI Element Description

Name The name of the group. The name must be unique to its 
parent container. 

Type Group

Description A description of the group.
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Transaction Configuration Page, General Tab

This tab enables you to view the name and description of an existing 
business transaction CI. These values were specified when the Business 
Transaction CI was created. One way to do this is by running the Business 
Transaction CI wizard. See "Business Transaction CI Creation Dialog Box" on 
page 457. 

Transaction Configuration Page, Tracing Tab

This tab enables you to define transaction tracing properties and rules for a 
business transaction. 

To access 1  Select Admin > Transaction Management 
>Administration > Monitoring. 

2  (left pane) Click the Transaction Configuration button. 

3  Navigate to the business transaction on which you 
want to view or set transaction tracing properties or 
rule definitions. 

4  (right pane) Click the Tracing tab.

Important 
information

➤ If you ran a wizard to set up the business transaction, 
this tab is populated based on the values you specified 
in the wizard. 

➤ If you did not run a wizard, the transaction tracing 
properties and rules do not appear. Instead you are 
given options to set up these items. 

Relevant tasks "How to Set Up a Business Transaction for Tracing" on 
page 449
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Tracing Tab, Tracing Properties Tab
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Aggregation delta The time period allocated for the delay while the 
business transaction data sample is created. 

For more information about the data sample, see "How 
TransactionVision Data is Exported to BSM" on page 314. 

Default value: 360 seconds (6 minutes)

Assign Analyzers Choose an Analyzer from the Available Analyzers column 
to move to the Assign Analyzer column. The current 
transaction tracing rule is then assigned to this Analyzer. 

Collection Interval The time period, in seconds, covered by each data sample 
received for this business transaction. Default value: 300 
seconds (5 minutes)

Cost per Transaction You can assign a cost to this transaction, for example if 
there are internal costs associated with completing the 
transaction. 

The Cost per Transaction is different from the 
Transaction Value.

Currency Code The applicable currency for the Transaction Value. This 
currency unit is displayed where the Transaction Value is 
displayed. 

Current Rule 
Definition

The transaction tracing rule currently assigned to this 
business transaction. 

Disable Tracing Disables tracing on this business transaction. 

Load Rule Loads a tracing rule from the repository.

The Transaction has 
a/no Exception Rule 
Defined

Indicates whether an Exception rule is defined for the 
transaction. If the rule is defined, the Exception-related 
KPIs are calculated for the business transaction. 

The Transaction has 
a/no Failure Rule 
Defined

Indicates whether a Failure rule is defined for the 
transaction. If the rule is defined, the Failure and Success 
related KPI s are calculated for the business transaction. 
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Tracing Tab, Classification Rules Tab

The Classification Rules tab of the Rules Definition tab enables you to 
specify the rules that cause the business transaction to be identified as such.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

The Transaction has 
a/no Value Rule 
Defined

Indicates whether a Value rule is defined for the 
transaction. If the rule is defined, the Value-related KPI s 
are calculated for the business transaction. 

Threshold The response time threshold for the business transaction. 
Instances of the transaction that take longer than this 
time are considered late.

UI Elements Description

New menu with following commands: New Match 
Condition, New Match Condition using Servlet Wizard, 
New Evaluation Block

Delete button. Deletes the selected entity. 

Edit button. Opens the Edit Match Condition dialog box, 
which is similar to the "Create Match Condition Dialog 
Box" on page 468.

Copy button. Copies selected entities for a subsequent 
Paste operation. 

UI Element (A-Z) Description
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Tracing Tab, Data Rules Tab

The Data Rules tab of the Rules Definition tab enables you to specify the 
rules that cause the State and Result attributes to be set, as well as any other 
attribute that you want to have set.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Paste button. Pastes the copied entities. 

Match Conditions The current set of match conditions for the tracing rule. 

See "Transaction Tracing Overview" on page 446.

Match conditions can be created by running one of the 
tracing rule wizards or by using the Create Match 
Condition dialog. 

UI Elements Description

(Toolbar 
elements)

The same toolbar buttons are used on the Classification 
Rules tab. See "Tracing Tab, Classification Rules Tab" on 
page 463.

Set the 
Transaction State

The conditions under which the transaction is considered 
complete or in-process. 

UI Elements Description
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Set the 
Transaction 
Result 

The conditions under which the transaction is considered 
successful or failed. 

The transaction 
Sets the 
following data 
rules

Any data value in the transaction model that needs to be set 
to certain value. For example, /Transaction/Value:

The Account, BondIssue, TradeType and Value attributes are 
defined with corresponding event properties. 

Summary of 
Global 
Transaction Rules 
this Transaction 
Inherits

All rules that impact this transaction. 

UI Elements Description
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Tracing Tab, BPI Rules Tab

The BPI Rules tab of the Rules Definition tab enables you to specify the BPI 
action that is associated with a specific rule.User interface elements are 
described below (unlabeled elements are shown in angle brackets):

Transaction Tracing Rules Page

The Transaction Tracing Rules page enables you to define classification rules. 
The page lists all the rules currently available. You can browse to a specific 
rule or group them by Analyzer.

This page has the following tabs:

➤ "Transaction Tracing Rules Page, General Tab" on page 467

➤ "Transaction Tracing Rules Page, Rules Definition Tab" on page 467

UI Elements Description

(Toolbar elements) The same toolbar buttons are used on the Classification 
Rules tab. See "Tracing Tab, Classification Rules Tab" on 
page 463.

Event Group See "BPI Definition Dialog Box" on page 469.

Event Name

Transaction 
Attributes

Publish Events to BPI
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Transaction Tracing Rules Page, General Tab

This tab enables you to assign a rule to an Analyzer.

User interface elements are described below:

Transaction Tracing Rules Page, Rules Definition Tab

The Rules Definition tab enables you to configure the classification rules. 
The Rules Definition tab has three tabs, which have the same content as the 
tabs in the Transaction Configuration page:

➤ "Tracing Tab, Classification Rules Tab" on page 463

➤ "Tracing Tab, Data Rules Tab" on page 464

➤ "Tracing Tab, BPI Rules Tab" on page 466

To access 1  Select Admin > Transaction Management > 
Monitoring. 

2  (left pane) Click the Transaction Tracing Rules button. 

3  Navigate to a particular rule. 

4  (right pane) Click the General tab.

UI Element Description

Add a selected Analyzer to the Assigned Analyzer 
column. 

Remove a selected Analyzer from the Assigned Analyzer 
column. 

Available Analyzers The list of Analyzers in the deployment environment for 
which you have permission to manage. 

Assigned Analyzers The Analyzers to which the rule is assigned; this Analyzer 
applies the rule continuously to the events it has 
collected to produce business transactions of the type.

Rule Definition Name The name of the selected rule. 
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Create Match Condition Dialog Box

This dialog enables you to create a match condition for a transaction 
classification rule.

User interface elements are described below:

To access For a rule associated with a Business Transaction CI:

1  Select Admin > Transaction Management > 
Administration > Monitoring. 

2  (left pane) Click the Transaction Configuration button. 

3  Navigate to a particular Business Transaction. 

4  (right pane) Select Tracing > Classification Rules.

5  Click  and then select New Match Condition.

For a rule not associated with a Business Transaction CI:

1  Select Admin > Transaction Management > 
Administration > Monitoring. 

2  (left pane) Click the Transaction Tracing Rules button. 

3  Navigate to a particular rule. 

4  (right pane) Select Tracing > Classification Rules.

5  Click  and then select New Match Condition.

UI Elements (A-Z) Description

Available Properties Shows all available XPaths. If you selected a transaction 
and/or event, all XPaths that occur within that event/
transaction display.

Enable advanced 
XPath string parsing

The TransactionVision XPath parser does not support all 
XPath syntax. If you need to use features not supported 
by TransactionVision, this option enables an external 
XPath parser (Xalan). Use the TransactionVision XPath 
parser whenever possible. 

Filter Properties by 
Selected Events

Use this area to choose an existing transaction’s events as 
candidates for property names and values in the new 
match condition.

Name The Name to be used in the match condition.
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BPI Definition Dialog Box

This dialog enables you to define the mapping of events to BPI.

User interface elements are described below:

Operator The Operator to be used in the match condition.

Value The Value to be used in the match condition.

To access For a rule associated with a Business Transaction CI:

1  Select Admin > Transaction Management > 
Administration > Monitoring. 

2  (left pane) Click the Transaction Configuration button. 

3  Navigate to a particular Business Transaction. 

4  (right pane) Select Tracing > Classification Rules.

5  Click  and then select New BPI Event.

For a rule not associated with a Business Transaction CI:

1  Select Admin > Transaction Management > 
Administration > Monitoring. 

2  (left pane) Click the Transaction Tracing Rules button. 

3  Navigate to a particular rule. 

4  (right pane) Select Tracing > Classification Rules.

5  Click  and then select New BPI Event.

Relevant tasks "How to Send Events to BPI" on page 454

See also Using Business Process Insight

UI Elements Description

Event Group The BPI group name. This is defined within the BPI 
Modeler for the TransactionVision process. 

Event Name The BPI event name. This is defined within the BPI 
Modeler for the TransactionVision process. 

UI Elements (A-Z) Description
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Troubleshooting and Limitations

This section includes the following topics:

Assign Transaction Tracing Rules to only one Analyzer
Correlation cannot occur across Analyzers. All the events for one transaction 
instance should be coming into the same Analyzer.

Incorrect Sample Counts - Classify Rule Problems
If the classify rules for a transaction class are too general such that different 
parts of a transaction can be classified while the transaction is still being 
processed, it is possible that incorrect sample counts are sent in the BSM 
Aggregate TV Data sample. To avoid this, make the classify rules for a 
transaction class specific enough so that they do not match multiple events 
for a transaction.

Transaction 
Attributes

From the drop-down list, check the attributes to be 
exported to BPI. These events are imported to the BPI 
Modeler. The rule is exported to BPI when it is saved.

Default value: all attributes are exported

Publish Events to BPI Events are published at one of these occurrences:

➤ Only once, when this transaction is classified

➤ Any time the specified condition is matched

Default value: Only once, when this transaction is 
classified. 

UI Elements Description
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Business Transaction Monitoring

This chapter includes:

Concepts

➤ Business Transaction Monitoring Overview on page 472

Tasks

➤ How to Set Up a Business Transaction for Monitoring on page 473

Reference

➤ Business Transaction Monitoring User Interface on page 475
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Concepts

Business Transaction Monitoring Overview

A business transaction that is enabled for monitoring is one that is 
configured by selecting a top-level (starting) server request as an entry point 
into the transaction. A top-level server request is one which does not have 
any inbound calls. The probes and server automatically identify all the other 
server requests that are reachable by this top-level server request.
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Tasks

How to Set Up a Business Transaction for Monitoring 

This task describes how to configure a business transaction for monitoring.

 1 Prerequisites

HP Diagnostics must be deployed to the same BSM deployment 
environment.

 2 Create a new business transaction if necessary

If you are configuring an existing business transaction you can skip this 
step.

For information about creating a new business transaction, see "How to 
Create a Business Transaction CI" on page 452.

 3 Enable the business transaction for monitoring

 a Select Admin > Transaction Management > Monitoring. 

 b (left pane) Click the Transaction Configuration button. 

 c Navigate to and right-click the business transaction for which you 
want to enable monitoring.

 d (right pane) Click the Monitoring tab. 

 4 Identify the server requests to comprise the business 
transaction

On the Monitoring tab, you choose from the current set of server requests 
to identify which ones comprise this business transaction. For details 
about this interface, see "Transaction Configuration Page, Monitoring 
Tab" on page 475.
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 5 Verify the business transaction

In the left pane, click the Refresh button.

A green arrow icon in the Diag column indicates that the business 
transaction has been successfully enabled for monitoring:
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Reference

Business Transaction Monitoring User Interface

This section describes:

 ➤ Transaction Configuration Page, Monitoring Tab on page 475

Transaction Configuration Page, Monitoring Tab

This tab enables you to define a business transaction based on 
HP Diagnostics server requests. 

Available Top-Level Server Requests Area
This area provides two ways to choose the server requests that comprise the 
business transaction: browse and select, or search. 

To access 1  Select Admin > Transaction Management > 
Monitoring. 

2  (left pane) Click the Transaction Configuration button. 

3  Navigate to the business transaction on which you 
want to enable transaction monitoring. 

4  (right pane) Click the Monitoring tab.

Important 
information

➤ HP Diagnostics must be deployed to the BSM 
deployment environment. 

➤ Business Transactions set up for monitoring in this 
way appear in the Transactions - Business Transactions 
view in HP Diagnostics. See the HP Diagnostics User’s 
Guide.
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User interface elements are described below:

Selected Top-Level Server Requests Area
This area builds the list of server requests that comprise the business 
transaction. 

User interface elements are described below:

UI Element Description

Browse tab Use this tab to browse to the top-level Server request on 
which the transaction is based.

The available top-level server requests are provided by 
the HP Diagnostics Server. 

Select the desired server request, then click the right 
arrow to add it to the business transaction monitoring 
definition. 

Search tab You can use this tab to locate top-level Server requests.

Search Criteria. Enter any of the following search criteria:

➤ Probe. The name of the probe. 

➤ Probe group. The name of the probe group. 

➤ Server Request. The name of the server request.

➤ Type. You can qualify the probe or server request by 
choose a type from this drop-down list. 

Search Results. After you click the Search button, the 
Server Request list is populated. Select the desired server 
request, then click the right arrow to add it to the 
business transaction monitoring definition. 

UI Element Description

Server Request The name of the server request.

Type The type of the server request. 

Probe The name of the probe. 

Probe Group The name of the probe group.
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Business Transaction Data Model

This chapter includes:

Concepts

➤ Business Transaction Data Model Overview on page 478

Tasks

➤ How to Add a Column of Data to the Transaction Data Model 
on page 480

Reference

➤ Transaction Data Model User Interface on page 481
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Concepts

Business Transaction Data Model Overview 

Business Transactions CIs that are enabled for tracing have corresponding 
data structures that are used in the Analyzer cache and database schema to 
store the data. 

You can view the columns of the data structure in the Transaction Data tab:
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The following table describes the locations in this page:

When you define the database column you are defining the location where 
the information is actually stored. This allows for it to be used as an 
attribute in a transaction instance. 

The XPath is the identifier used to reference this bit of data within 
TransactionVision. 

Once the new attributes are added to the transaction data model, you can 
view them on the Transaction Tracking or Transaction Details reports. 

Callout number Description

1 The Standard Data Definition folder contains the 
predefined columns.

2 You can view the details of a selected column.

3 In some cases, you need to customize the structure. You can 
add new columns to the Customized Data Definitions 
folder.
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Tasks

How to Add a Column of Data to the Transaction Data 
Model

This task describes how to add a custom attribute to a transaction. A new 
attribute is represented as a column in the Transaction Data model. 

 1 Determine the requirements of the new column. You will need to know 
how big it should be, its data type, and its currency type if applicable.

You can choose from these data types: 

Currency
Date
Decimals
Double
Integer
String

 2 Navigate to Admin > Transaction Management > Monitoring > 
Transaction Data.

 3 (left pane) Click . The Create New Data Definition dialog box appears. 
For details about this interface, see "Create New Data Definition Dialog 
Box" on page 483.

 4 Restart the Analyzer.
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Reference

Transaction Data Model User Interface

This section describes:

 ➤ Transaction Data Page on page 481

 ➤ Create New Data Definition Dialog Box on page 483

Transaction Data Page

This page enables you to view the column details for the current business 
transaction data model. 

To access 1  Select Admin > Transaction Management > 
Monitoring. 

2  (left pane) Click the Transaction Data button. 

3  Navigate to the column for which you want to view or 
edit the definition.

Important 
information

➤ The columns appear in two categories:

➤ Standard Data Definitions. The predefined 
transaction data model. You cannot delete or 
modify these. 

➤ Customized Data Definitions. The additions to the 
predefined transaction data model. You can add 
columns here. 

➤ For more information about customizing the 
transaction data model, see the HP TransactionVision 
Advanced Customization Guide PDF.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element Description

Column Description Description of the column. 

Column Type The data type of the column. 

Currency Settings For columns that represent currency, the location from 
which to take the currency code setting:

Default Currency Code. 

Use Currency Code from Transaction.

Use Currency Code from Transaction Path.

See "Currency Columns" in the the HP TransactionVision 
Advanced Customization Guide PDF.

Database Column 
Name

The column name. 

Precision For columns of numeric type, the precision. 

Scale For columns of numeric type, the scale. 

Size The size of the column. 

Transaction Path The XPath column path. This is how you reference the 
attributes.
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Create New Data Definition Dialog Box

This page enables you to customize the business transaction data model by 
adding a new column. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Admin > Transaction Management > 
Monitoring. 

2  (left pane) Click the Transaction Data button. 

3  Click the  New button.

Important 
information

➤ This dialog allows you to modify the model for the 
business transaction CI by adding a new column data. 

➤ All transactions are affected by this model change. 

➤ For more information about customizing the 
transaction data model, see the HP TransactionVision 
Advanced Customization Guide PDF.

Relevant tasks "How to Add a Column of Data to the Transaction Data 
Model" on page 480

UI Element Description

Column Description These elements are the same that appear on the 
"Transaction Data Page" on page 481.

Column Type

Currency Settings

Database Column 
Name

Precision

Scale

Size

Transaction Path
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Introducing Transaction Management 
Reports and Topologies

This chapter includes:

Concepts

➤ Reports and Topologies Overview on page 488

➤ How the Reports and Topologies Are Related on page 490

➤ Key Information Reported For a Transaction on page 491

➤ Reports and Topologies Workflows on page 494
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Concepts

Reports and Topologies Overview

The Transaction Management reports and topologies present the 
information that has been collected from the TransactionVision agents and 
processed by the TransactionVision Analyzers. 

Some reports and topologies can also include HP Diagnostics or Real User 
Monitor (RUM) information related to the business transaction. 

Transaction Management provides the following reports, grouped by the 
categories in the Transaction Management application:

Topologies are graphical flow maps of a transaction that show the 
transaction execution from front-end real user experience through the 
back-end server level components (such as application servers, message 
middleware servers, database servers, mainframe transaction and batch 
jobs).

Summary ➤ Transaction Summary report

➤ Web Session report

Analysis ➤ Transaction Over Time report

➤ Transaction Tracking report

➤ Transaction Detail report

➤ Event Analysis report

Infrastructure ➤ Application Server Statistics report

User-created reports You can develop custom reports that either use the 
TransactionVision-provided QueryServices classes or 
make direct JDBC SQL calls to perform queries to 
extract the data you want. The presentation of the 
reports can be in any browser support technology 
such as HTML, SVG or Java applets. 
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Transaction Management provides the following topologies:

➤ Aggregated and Instance Topologies

➤ Component Topology
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How the Reports and Topologies Are Related

The Transaction Management reports are designed to first present the 
highest level view of transaction information and offer drilldowns to more 
detailed reports as necessary. The following diagram shows the main 
hierarchical drill paths of the reports and topologies:

The following diagram shows the standalone Transaction Management 

Transaction Summary

Aggregate Transaction 
Topology

Transaction Tracking

Transaction Detail

Event Analysis

Event Detail

Transaction Over Time

Web Session

Component Topology

Transaction Instance 
Topology
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reports, that is, those that are not on a drilldown path:

Key Information Reported For a Transaction

As TransactionVision collects and analyzes transactions, it gathers statistics. 
related to transactions, events, and infrastructure elements. These statistics 
as well as other data appears on the various reports and topologies. 

The frequently-appearing information related to transactions is as follows:

Transaction Name
The transaction name is the business transaction name that is specified 
when the business transaction is defined. See "How to Create a Business 
Transaction CI" on page 452. 

Transaction Count (or Volume)
The transaction count is the number of completed instances of a particular 
business transaction in the specified time frame. 

The transaction count is also referred to as transaction volume in some 
reports. 

You can see this information on the Transaction Summary, Web Session, or 
Transaction Over Time report. 

Response Time
TransactionVision provides the transaction response time of a transaction 
instance. Only completed transaction instances can provide a transaction 
response time.

Application Server 
Statistics

User-created Reports 
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To calculate the response time, TransactionVision subtracts the start time of 
the first event in the transaction from the last event in the transaction (after 
correlation has occurred). The response time is reported in units of 
milliseconds or seconds; the column heading in the report indicates the 
unit.

If an application is monitored by RUM and TransactionVision, the end user 
response time is available. The end user response time is combined with the 
back end response time (reported by TransactionVision and HP Diagnostics, 
if present) to produce the total end-to-end response time:

There can be overlap between end user response time and back end response 
time because all products (RUM, TransactionVision, HP Diagnostics) 
measure the time it takes the J2EE Server to complete the request. The 
overlap also includes the time it takes to reach the J2EE Server from the end 
user;, backend time additionally includes the time spent processing any 
parts of the transaction that occur asynchronously to the request. 

If RUM is not monitoring the application then the transaction end-to-end 
response time does not include the end user time:

J2EE Server J2EE Server
queue

End User

End User Time

Backend Time

End to End Transaction Time

J2EE Server J2EE Server
queue

End User

Backend Time

End to End Response Time
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Note: One important way the response time is used is to flag whether a 
transaction has exceeded its response time threshold This causes the 
transaction to be flagged as late and be seen as such in other reports and 
System Health. For information about specifying target response times, see 
"Transaction Configuration Page, Tracing Tab" on page 461. 

You can see the response times on the Transaction Summary, Transaction 
Over Time, Transaction Tracking, and Event Analysis reports. The 
end-to-end transaction time is sometimes referred to as the transaction 
response time. 

Transaction States
Each transaction instance has the following state information:

➤ Completion State. Indicates whether the transaction completed. The 
completion is determined by classification rules. See "Transaction Tracing 
Rules Page" on page 466.

➤ Result State. For completed transactions, indicates whether the 
transaction met the criteria for a successful completion. See the 
Transaction Result success and failure rules on "Transaction Tracing Rules 
Page" on page 466.

➤ SLA State. For completed transactions, indicates whether the transaction 
met the Threshold criteria. For information about the Threshold, see 
"Transaction Configuration Page, Tracing Tab" on page 461.

Transaction states appear on the Transaction Tracking report.

Threshold
The number of milliseconds representing the target end-to-end response 
time of the transaction. The Threshold is specified when the business 
transaction CI is configured. See "Transaction Configuration Page, Tracing 
Tab" on page 461.

You can see the Threshold on the Transaction Detail area of the Transaction 
Tracing report.
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Value
The monetary value of the transaction. The Value is specified as part of a 
data rule when the business transaction CI is configured. See "Transaction 
Tracing Rules Page" on page 466.

The Value is affected by the currency code. Currency code is a 3-letter code 
as defined by the IS0 4217 standard. Some common codes are:

USD
EUR
ILS
HKD
INR

The currency code is specified as a property of the transaction when the 
business transaction CI is configured. See "Transaction Tracing Rules Page" 
on page 466.

You can see the Value on the Web Session report, Transaction Over Time 
report, and Transaction Tracking report.

Reports and Topologies Workflows

There are many workflows supported by the Transaction Management 
reports and topologies. Some of the key workflows are as follows:

Show me the status of my transaction

Go to the Transaction Tracking Report, and use the Transaction Filter to 
choose the Business Transaction by its name. Run the report and view the 
Completion state column to see whether the transaction is completed. 

Drill to the Transaction Detail for more information.

Show me all transaction instances with specific criteria

Go to the Transaction Tracking report, access the Transaction Filter Metrics 
tab to specify the Business Transaction attributes you want to base the 
search on. For example, those that have violated their threshold or those 
that are still in-process.
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Show me the high and low runs of my transaction

Go to the Transaction Tracking Report, and use the Transaction Filter to 
choose the Business Transaction by its name. Run the report and view the 
scatter graph.

Hover over each instance and view the response time metrics. 

Show me which application infrastructure elements my 
transaction is flowing across

Run the Aggregated Topology report.

How does the performance of one transaction instance 
compare to the average performance?

Go to the Transaction Tracking Report, and use the Transaction Filter to 
choose the Business Transaction by its name. Run the report and drill to the 
Instance topology.

Enable the labels for each performance metric you want to see. Instance and 
aggregate performance metrics are shown.

What is the performance of the different application 
infrastructure elements for transaction instance X?

Go to the Transaction Tracking Report, and use the Transaction Filter to 
choose the Business Transaction by its name. Run the report and drill to the 
Component topology.

These reports display information for servers, message queue latency, 
infrastructure performance, SQL statement statistics and WebSphere MQ 
and JMS components statistics. See"Component Topology" on page 573 for 
details.
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Transaction Management Reports

This chapter includes:

Concepts

➤ Reports Overview on page 498

Tasks

➤ How to View Metrics Aggregated by Transaction Type on page 500

➤ How to View Metrics Aggregated by Web Session on page 500

➤ How to View Metrics for a Particular Transaction Type on page 500

➤ How to View Metrics at the Event Level on page 501

➤ How to View Metrics Aggregated by Application Server on page 501

Reference

➤ Reports User Interface on page 502
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Concepts

Reports Overview

Each Transaction Management report is designed for different levels of 
transaction or event analysis: 

Additional Information Provided by Drill-Down to Diagnostics

➤ You can drill down from the Transaction Summary report to the 
Diagnostics Business Transactions Path view. 

➤ You can drill down from the Transaction Detail (part of the Transaction 
Tracking report) to the Diagnostics Server Requests view.

➤ You can drill down from the Event Analysis report to Diagnostics to get 
the following types of information:

➤ The drill down to a Diagnostics Hosts view provides system metrics 
like CPU utilization and memory utilization that can help you 
determine if the problem is a system issue.

If you want to: Access this report: 

Perform aggregated transaction level analysis; 
aggregated by transaction CI type.

Transaction Summary

Perform aggregated transaction level analysis; 
aggregated by web session. 

Web Session

View graphs of aggregated transaction level 
information; aggregated by transaction CI type. 

Transaction Over Time

Perform individual transaction level analysis. Transaction Tracking

Perform event-level analysis. Event Analysis

Perform aggregated event level analysis; 
aggregated by application server component.

Application Server Statistics
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➤ The drill down to a Diagnostics Server Requests view can help you 
study the performance of these server requests over time and look at 
detailed instance trees (call profiles, methods, exceptions and faults) 
associated with the server requests, to identify where the issue lies.

From the Server Request data you can navigate to the corresponding 
probe entity and look at the application server metrics (for example, 
JMX metrics) to see if the issue lies with the application server.

Additional Information Provided by Drill-Down to EUM

➤ You can drill down from the Transaction Summary report to the EUM 
Transaction Summary report.

➤ You can drill down from the Transaction Tracking report to the EUM End 
User Summary report.
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Tasks

How to View Metrics Aggregated by Transaction Type

For All Transactions

To view Business Transaction metrics aggregated by each Business 
Transaction CI type, access the Transaction Summary report.

For information about this report, see "Transaction Summary Report" on 
page 503.

For a Specific Transaction Type 

To view time slices of Business Transaction metrics aggregated by a single 
Business Transaction CI type, access the Transaction Over Time report.

For information about this report, see "Transaction Over Time Report" on 
page 516.

How to View Metrics Aggregated by Web Session

To view Business Transaction metrics aggregated by Web Session, access the 
Web Session report.

For information about this report, see "Web Session Report" on page 514.

How to View Metrics for a Particular Transaction Type

To view Business Transaction metrics for a particular instance of a Business 
Transaction type, access the Transaction Tracking report.

For information about this report, see "Transaction Tracking Report" on 
page 525.
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How to View Metrics at the Event Level

To view event data that has been collected, access the Event Analysis report.

For information about this report, see "Event Analysis Report" on page 535.

How to View Metrics Aggregated by Application Server

To view business transaction metrics aggregated by application server, access 
the Application Server Statistics report.

For information about this report, see "Application Server Statistics Report" 
on page 547.
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Reference

Reports User Interface

This section describes:

 ➤ Transaction Summary Report on page 503

 ➤ Transaction Filter Dialog Box on page 508

 ➤ Web Session Report on page 514

 ➤ Transaction Over Time Report on page 516

 ➤ Transaction Tracking Report on page 525

 ➤ Event Analysis Report on page 535

 ➤ Application Server Statistics Report on page 547
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Transaction Summary Report

This report displays volume and response time metrics for transactions and 
a graph of these metrics for a selected transaction. Metrics are aggregated by 
Business Transaction CI type.

The following is an example of the Transaction Summary report.

Report Content: 
Transaction Metrics 

Table

Report Settings

Report Content: 
Graph
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To access Select Applications > Transaction Management > 
Transaction Summary > Transaction Summary.

This report is also accessed from RUM reports. 

Important 
information

➤ Transactions that have completed in the specified 
View time range are displayed in alphabetical order by 
business transaction name.

You can change the sort order and the column on 
which the transactions are sorted by clicking the 
column heading in the Transaction Metrics table. 

➤ You can limit which transactions appear by using the 
Transaction Filter. 

➤ The Transaction Summary report provides drill downs 
to the following Transaction Management reports: 
Transaction Over Time report, Transaction Tracing 
report, or the Aggregated Topology for a selected 
transaction.

➤ The Transaction Summary report provides a drill down 
to the EUM Transaction Summary report. 

Relevant tasks "How to View Metrics Aggregated by Transaction Type" 
on page 500

See also "Key Information Reported For a Transaction" on 
page 491
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Report Content: Transaction Metrics Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

View The reporting time period. Choose an option from the 
drop-down list. For some time periods, also choose:

From. The date and/or time for the beginning of the 
reporting time period; click to access a calendar from 
which to select the date/time.

To. The date and/or time for the ending of the reporting 
time period.

Transaction Filter Launches the Transaction Filter dialog box, where you 
can select the business transactions to include in the 
report. See "Transaction Filter Dialog Box" on page 508.

Default: All business transactions in the specified View 
range are selected.

(Clear All) Clears any active filters. All business transactions in the 
reporting time period are selected. 

UI Elements Description

 Drill to the Aggregated Topology for the selected business 
transaction. 

Drill to the Transaction Over Time report for the selected 
business transaction. 

Drill to the Transaction Tracking report for the selected 
business transaction. 
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Drill to the HP Diagnostics Business Transaction Path 
view. 

Drill to the RUM Transaction Summary report. 

Reset column widths. 

Select columns to show in the report. 

Transaction Name Name of the transaction. Select a transaction name to 
determine what is shown in the graphs below. 

Transaction Count Sum of transaction instances that have completed in the 
selected time frame. 

Avg End to End 
Response Time (sec.)

Average end-to-end response time of transaction 
instances that have completed in the selected time frame. 
This values is a sum of the backend and end user 
response times. See "Key Information Reported For a 
Transaction" on page 491.

Avg Response Time 
of Back End (sec.)

Average response time of the transaction over monitored 
application components, such as application servers, 
message middleware servers, database servers, mainframe 
transactions and batch jobs. 

Avg End User 
Response Time (sec.)

Average response time of end user as measured by RUM. 
If RUM is not monitoring the application, this value is 0 
or blank.

Min Response Time 
(sec.)

Minimum end-to-end transaction response time of 
transaction instances that have completed in the selected 
time frame.

Max Response Time 
(sec.)

Maximum end-to-end transaction response time of 
transaction instances that have completed in the selected 
time frame.

UI Elements Description
506



Chapter 19 • Transaction Management Reports
Report Content: Volume and Response Time Graph

The bar graph indicates the transaction volume and the line graph indicates 
the average end-to-end response time for the business transaction selected 
in the Transactions Metrics table.
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Transaction Filter Dialog Box

This dialog box enables you to find and select a business transactions on 
which a a report or topology is based. The Transaction Filter dialog includes 
different tabs depending on where it was launched from. All tabs are 
described here. 

The following is an example of the Transaction Filter dialog box and the 
three basic steps in using it.

1. Choose the CI Type 
of Business Transaction.

2. Control-click to select
one or more business 

3. Click OK. 

transactions, transaction 
flows, or applications.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Browse Views Tab

User interface elements are described below:

To access The Transaction Filter link on any of the following:

➤ Transaction Summary report

➤ Transaction Over Time report

➤ Transaction Tracking report

➤ Aggregated Topology

Important 
information

➤ The Metrics and Locations tabs are included on the 
dialog only when it is launched from the Transaction 
Tracking report.

➤ Filtering business transactions is optional. If no filter is 
specified then all business transactions are used to 
generate the report. 

See also "Business Transactions in Applications or Transaction 
Flows" on page 441.

The "Security" chapter in the HP TransactionVision 
Deployment Guide PDF.

UI Elements Description

<business transaction 
tree>

Displays the configured applications, groups, transaction 
flows and transactions for which you have permission to 
view. Select one or more of these items that you want to 
include in the filter. 

Note: When you select an item in the hierarchical tree, 
its children are also selected. 
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Include Unclassified 
Transactions

Check to include unclassified instances of transactions. 
Unclassified transactions are transaction instances that 
TransactionVision has identified but not mapped to a 
business transaction CI. 

This option appears only when the filtering for the 
Transaction Tracking reports. 

Exclude BPM-only 
Transactions

BPM generated transactions do not provide information 
that is relevant to the Transaction Management reports 
or topologies so by default these types of transactions are 
excluded. If you want to include them, clear the 
checkbox. 

UI Elements Description
510



Chapter 19 • Transaction Management Reports
Search CIs Tab

User interface elements are described below:

UI Elements Description

Search CIs tab Click the Search CIs tab to search for CI names that 
contain a specific string, or for CIs of a specific CI type. 

Search results are displayed in the lower part of the 
search tab. Right-click a CI in the search results table to 
open a Shortcut menu and click: 

Select in tree. Displays the hierarchical tree with the CI's 
check box selected. 

Locate in tree. Displays the hierarchical tree with the CI 
visible (that is, if the tree is too long for all of it to be 
visible without scrolling, the area that includes the CI is 
displayed). 

Note: 

The search is made on the hierarchical tree of relevant 
CIs displayed in the Browse Views tab.

The search is not case sensitive.

When searching for a CI name, you can use the asterisk 
(*) wildcard in your string to match one or more words of 
text.

In the Locations filter, location names in the hierarchical 
tree include extra text showing for what they are 
configured (RUM for Real User Monitor and BPM for 
Business Process Monitor). To find a location name, you 
must either enter the name in full including this extra 
text, or use the asterisk (*) wildcard. 

Click to start the search. 
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Type Choose a CI type of business_transaction. Only business 
transactions are eligible for the reports and topologies. 

Click the Search CIs tab to search for CI names that 
contain a specific string, if desired. 

Search results are displayed in the lower part of the 
search tab. Right-click a CI in the search results table to 
open a Shortcut menu and click Select in tree to display 
the hierarchical tree with the CI's check box selected. 

Note: 

The search is not case sensitive.

When searching for a CI name, you can use the asterisk 
(*) wildcard in your string to match one or more words of 
text.

Exclude BPM-only 
Transactions

Check to include BPM generated transactions. BPM 
generated transactions do not provide information that 
is included on the Transaction Management reports or 
topologies so typically you would not include these types 
of transactions.

Name The search results. Choose the items you want to include. 

UI Elements Description
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Metrics Tab

User interface elements are described below:

Locations Tab

User interface elements are described below:

UI Elements Description

 Completion State Check one or more of the following options to filter the 
report or topology by the Completion State of a 
transaction:

➤ Unknown

➤ Processing

➤ Completed

Result State: Check one or more of the following options to filter the 
report or topology by the Result State of a transaction:

➤ Unknown

➤ Success

➤ Failed

SLA State: Check one or more of the following options to filter the 
report or topology by the SLA State of a transaction:

➤ None

➤ Violated

➤ Aged Out

UI Elements Description

<location tree> Displays locations of business transactions that are both 
both enabled for TransactionVision tracing data and 
EUM monitoring. Select the locations for transactions 
you want to include. 

The TransactionVision deployment environment must be 
set up for RUM data. See "How to Verify or Modify 
Communication Between BSM and TransactionVision" 
on page 315.
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Web Session Report

The Web Session report displays transaction volume and value for each 
completed Web session.

The following is an example of the Web Session report.

 

To access Select Applications > Transaction Management > 
Transaction Summary > Web Session.

Important 
information

➤ Only agents that monitor servlets can collect Web 
session data. To generate this report the Analyzer must 
be configured to extract and store Session ID 
information. See "How to Enable Session Tracking" on 
page 291.

➤ You can drill-down to the Transaction Tracking report.

See also "How to Enable Session Tracking" on page 291
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Report Content

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

View The reporting time period. Choose an option from the 
drop-down list. For some time periods, also choose:

From. The date and/or time for the beginning of the 
reporting time period; click to access a calendar from 
which to select the date/time.

To. The date and/or time for the ending of the reporting 
time period.

Sort by Attribute Choose the field on which you want to sort from the 
drop-down list.

UI Elements Description

Session Start The start time for the first event within this session. 

Click on this link to display the Transaction Tracking 
report on the transactions within this session. See 
"Transaction Tracking Report" on page 525 for details.

Session End The session end time.

Transaction Count The total number of transactions within this session.

Value (Dollars) The dollar value of all transactions within this session.
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Transaction Over Time Report

Displays graphs of various combinations of the business transaction metrics, 
including forward projections of the metric values. Metrics are aggregated 
by transaction CI type.

The following is an example of the Transaction Over Time report.

 

Report Settings

Report Content: 
Graphs
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access ➤ Select Applications > Transaction Management > 
Transaction Analysis > Transaction Over Time.

➤ Drill-down from the Transaction Summary report.

Important 
information

➤ You can limit which transactions appear by using the 
Transaction Filter. 

➤ The report includes the following graphs:

➤ Volume/Response

➤ Volume Analysis

➤ Transaction State

➤ Capacity Planning

➤ Transaction Measurements Correlation

See also "Key Information Reported For a Transaction" on 
page 491

UI Elements Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

View The reporting time period. Choose an option from the 
drop-down list. For some time periods, also choose:

From. The date and/or time for the beginning of the 
reporting time period; click to access a calendar from 
which to select the date/time.

To. The date and/or time for the ending of the reporting 
time period.

Transaction Filter Launches the Transaction Filter dialog box, where you 
can select the business transactions to include in the 
report. See "Transaction Filter Dialog Box" on page 508.

Default: The last business transactions that was specified 
is selected. If this is the initial viewing of the report, you 
are prompted to specify the business transaction.
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(Clear All) Clears any active filters. All business transactions in the 
reporting time period are selected. The reporting time 
period is determined by the View setting on this dialog. 

Forward Projections 
Time Frame

The amount of time (relative to the selected time frame 
for the report) over which projections occur in the 
Capacity Planning graph. Options are:

One Time Period. 
Two Time Periods. 
Three Time Periods. 

For example, if a user is viewing a one hour report and 
specifies Two Time Periods, then the graph spans 3 hours, 
1 hour of data and 2 hours (1 hour times 2 time periods) 
of projections.

Projections 
Polynomial Degree

Alters the projection algorithm for the Capacity Planning 
graph. Changing the value will modify the way the 
projections are calculated and result in different 
projection values. Specify Linear to use the linear based 
algorithm; choose Quadratic to use the quadratic based 
algorithm. 

UI Elements Description
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Show Transaction 
State for

Options are:

Transaction Value. The graphs display results based on 
the monetary value of each instance for the business 
transaction. 

Transaction Volume. The graphs display results based on 
the volume of instances for the business transaction.

Correlation 
Measurement 1 and 
Correlation 
Measurement 2

Choose one or two measurements to display in the 
Measurements Correlation graph:

Avg End User Response Time (sec.)
Avg Response Time of Backed (sec.)
End to End Response Time (sec)
In Process Count
In Process Total Value
Max End User Response Time (sec)
Max Response Time of Backend (sec)
Maximum Transaction Response Time (sec)
Min End User Response Time (sec)
Min Response Time of Backend (sec)
Minimum Transaction Response Time (sec)
Total Value Exception
Total Value Failed
Total Value Late
Transaction Volume

For example, you can compare In Process Count with 
Maximum Transaction Response Time to see if there is a 
relationship.

UI Elements Description
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Report Content Common to All Tabs

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

 Drill to the Aggregated Topology for the selected business 
transaction. 

Drill to the Transaction Tracking report for the selected 
event.

Show/Hide Legend.

Dock Legend.
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Report Content: Volume/Response Tab

The Volume/Response tab displays a graph of transaction volume and 
end-to-end response time for the selected transaction.

The following is an example of the Volume/Response tab.
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Report Content: Volume Analysis Tab

The Volume Analysis tab displays transaction volume and counts of 
successful, late, and failed transactions.

The following is an example of the Volume Analysis tab.

Report Content: Transaction State Tab

The Transaction State tab displays the time period on the x-axis, and 
percentage on the y-axis. A separate bar is shown for each transaction state 
during each time period included in the graph.

For information about the transaction states, see "The Transaction States 
Relevant to Service Health" on page 305.
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The following is an example of the Transaction State tab.

Report Content: Capacity Planning Tab

The Capacity Planning tab displays volume and response time metrics, and 
projects future response time levels based on the algorithm you specified in 
the report settings.

For example, the following graph shows a projection over two time periods. 
The flat line indicates that the response time is stable, or more importantly, 
not heading in the direction that the response time threshold will soon be 
exceeded. So at this time you do not need more capacity in your 
infrastructure to handle the current trends in performance.
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The following is an example of the Capacity Planning tab.
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Report Content: Measurement Correlation Tab

The Measurement Correlation tab displays the time period on the x-axis, 
and the units for the selected measurements on the y-axes. Each point on 
the graph shows the total or average for the preceding time period.

The following is an example of the Measurement Correlation tab configured 
to show the Value of the Failed transactions and how many transactions are 
in-process.

Transaction Tracking Report

The Transaction Tracking report displays transaction information for all 
transactions that have completed in the specified time period, and allows 
drill-down into the Transaction Details report which provides additional 
details. The report filtering criteria can limit the displayed results to only 
those transactions of certain completion state, result state, SLA state, or 
location (if the application is also monitored by RUM).
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The following is an example of the Transaction Tracking report.

 

Report Content: 
Scatter Graph

Report Content: 
Transaction Table
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access ➤ Select Applications > Transaction Management > 
Transaction Analysis > Transaction Tracking.

➤ Drill-down from the Transaction Summary report.

➤ Drill-down from the Event Details report.

➤ Drill-down from the Transaction Over Time report.

Important 
information

➤ The report can show unclassified transactions. These 
are transaction instances that TransactionVision tracks 
in the same way it tracks named business transaction 
but they have not been classified. You may want to 
view unclassified transaction to see what is being 
collected so that you can examine them and 
determine which filtering or classification rules are 
needed.

➤ You can drill to the Transaction Detail view of a 
particular transaction: click the Drill to Transaction 
Detail button for a selected transaction in the table, or 
right click on a point in the scatter graph and choose 
Drill to Transaction Detail.

Relevant Tasks "How to View Metrics for a Particular Transaction Type" 
on page 500

See also "Key Information Reported For a Transaction" on 
page 491

UI Elements Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

Sort Order Choose Ascending or Descending. 
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Report Content: Transaction Table

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

View The reporting time period. Choose an option from the 
drop-down list. For some time periods, also choose:

From. The date and/or time for the beginning of the 
reporting time period; click to access a calendar from 
which to select the date/time.

To. The date and/or time for the ending of the reporting 
time period from a calendar control.

Sort by Attribute Select an attribute to sort results by, if desired. Custom 
attribute columns are available if you have added custom 
data definitions. See "Business Transaction Data Model" 
on page 477.

Note: If the report is set to sort on the Class ID attribute, 
results are sorted in the order in which the Transaction 
CI was defined.

Search for Enter text for a specific search. 

Transaction Filter Launches the Transaction Filter dialog box, where you 
can select the business transactions to include in the 
report. See "Transaction Filter Dialog Box" on page 508.

Default: All business transactions in the specified View 
range are selected.

(Clear All) Clears any active filters. All business transactions in the 
reporting time period are selected. The reporting time 
period is determined by the View setting on this dialog. 

UI Elements Description

 Drill to Instance Topology. 

 Drill to Transaction Detail. 

UI Elements Description
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 Drill to RUM End User Summary report.

Reset column widths. 

Select columns to show in the report. 

Transaction Name Name of the transaction. Select a transaction name to 
determine what is shown in the table below. 

Start Time The start time of the transaction.

End to End Response 
Time (sec.)

End-to-end transaction response time of transaction 
instances that have completed in the selected time frame. 
This value is a sum of the backend and end user response 
times. See "Key Information Reported For a Transaction" 
on page 491.

Response Time of 
Back End (sec.)

Response time of the transaction over TransactionVision 
monitored application components, such as application 
servers, message middleware servers, database servers, 
mainframe transactions and batch jobs. 

End User Response 
Time (sec.)

Response time of end user as measured by RUM. If RUM 
is not configured, this value is 0 or blank.

Value The value of the transaction as determined by the Value 
property. 

Completion State The completion state of the transaction:

 Completed.

 Processing. 

 Unknown.

UI Elements Description
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Report Content: Scatter Graph

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Result State Displays the result state of the transaction:

 Success.

 Unknown.

Only transactions where the result state matches that 
selected in the report settings display in the report.

SLA State The SLA state of the transaction: 

 None.

 Violated.

UI Elements Description

<hover over a symbol 
representing a 
transaction on the 
graph>

Start Time. Same as above.

End to End Response time. Same as above.

Completion State. Same as above.

Result State. Same as above.

SLA State. Same as above.

<drag select a group 
of symbols on the 
graph>

Start Time. Same as above.

End to End Response time. Same as above.

Completion State. Same as above.

Result State. Same as above.

SLA State. Same as above.

UI Elements Description
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Transaction Detail Report
The following is an example of the Transaction Detail report.

Report Content: 
Summary

Report Content: 
Transaction Flow
531



Chapter 19 • Transaction Management Reports
Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access From the Transaction Tracking report, click the  Drill 
to Transaction Detail button for a selected business 
transaction. 

See also "Key Information Reported For a Transaction" on 
page 491

UI Elements Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.
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Report Content

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Summary Shows the transaction name and several metrics 
including response time, status, start time, result, and the 
value for any custom data definitions for the transaction.

 Drill to Diagnostics. The Server Requests Snapshots 
Analysis view opens.

Transaction Flow The local transaction ID, application name, start time, 
and processing time for each local transaction within the 
selected business transaction. An icon indicates whether 
the local transaction starts a message flow, accesses a 
queue, accesses a resource, or creates a thread.

If a message flow starts from the application in a local 
transaction, a sub-row appears. The direction of the 
arrows in the message flow icon in the sub-row indicates 
whether a message flow starts or ends from the 
application. Arrows pointing right indicate a message 
flow start; arrows pointing left indicate a message flow 
end. The message flow icon is followed by the name of 
the application where the message flow starts or ends. 

Both the queue icon and the application name link to 
the local transaction where the message flow ends. Click 
this link to navigate to the local transaction where the 
message flow ends.

A sub-row without an icon indicates that a control flow 
starts from the application. The sub-row specifies the 
name of the application where the control flow ends. 
Click the application name in the sub-row to navigate to 
the local transaction where the control flow ends.Note 
that processing time for each program does not include 
the CICS TASK_START and TASK_END events, because 
these events do not contain a program name. Therefore, 
the processing time in this report differs slightly from the 
execution times in the Transaction Analysis view.
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Show in Event 
Analysis Report

To display the Event Details report for an event message 
in the Transaction Details report, click the message link 
in the Transaction Flow table or the latency link in the 
Message Flow table. 

The Event Details report opens. For a message flow, 
separate panes show a side-by-side comparison of the 
departure and arrival user data buffer. For a control flow, 
only the event details for the event that corresponds to 
the destination event in the control flow are shown. For 
information about the Event Details report, see "Event 
Analysis Report" on page 535.

Show in Topology Display the current business transaction in the 
Component Topology. See "Aggregated and Instance 
Topology User Interface" on page 565.

Show in Component 
Topology 

Display the current business transaction in the 
Component Topology. See "Component Topology" on 
page 573.

UI Elements Description
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Event Analysis Report

Displays all of the events in the database that match the query you specify. 
The query reduce the number of events displayed by restricting the hosts, 
queue managers, programs, times, or APIs associated with displayed events. 
You can also specify which data of the events display.

The following is an example of the Event Analysis report.

 

Report Content: Event 
List Table

Report Settings

Report Content: Event 
Details for Selected 

Event

Report Content: Event 
Details for a Second Event 
Selected for Comparison
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Report Settings: General

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access ➤ Select Applications > Transaction Management > 
Transaction Analysis > Event Analysis.

➤ From the Transaction Tracking report’s Transaction 
Flow pane, click Show in Event Details Report. 

Important 
information

➤ If the events are sorted, an arrow in the column 
heading indicates the column and direction on which 
sorted occurs. Click another column heading to 
change the sort column. Sorting is for the current page 
only.

➤ The Event Detail area of this report requires that the 
Event XML document is stored in the database. See the 
Store event document option on "Miscellaneous 
Information Page" on page 165.

➤ If the associated data collection filter assigned is 
configured to collect the API Names Only data range, 
the Event Detail area does not display details for 
events recorded with that filter. See "Data Collection 
Filters" on page 165 for more information.

Relevant tasks "How to View Metrics at the Event Level" on page 501

See also ➤ "Key Information Reported For a Transaction" on 
page 491

UI Elements Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

Query Select one of the following from the drop-down list:

➤ All (a built-in query)

➤ Last 24 Hours (a built-in query)

➤ A custom query. See "Queries" on page 225 for 
information about custom queries.
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Number of User 
Bytes to Display in 
Event Data

The number of bytes of user buffer data to display in the 
Event Details report. Default value: 1024.

Sort Order Check to sort events chronologically when the number 
of events exceeds the threshold.

Show Column 
Options

Check to enable the column selection fields. Check the 
categories of columns first, then choose from those 
which ones to move to the Selected Columns list: 

By default, the Common options are included on the 
report.

See the table below for information about the columns.

UI Elements Description
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Report Settings: Event Analysis Columns Available for Display

The categories and columns are described below.

Category Available Columns

Common API Name. The WebSphere MQ or JMS API name, the HTTP 
request, or EJB methods name.

Data Size. For WebSphere MQ events, The size in bytes of 
the user data buffer for MQGET, MQPUT, and MQPUT1 
calls. For JMS events, the size of JMS user data in send and 
receive calls. For Servlet events, the size of the returning 
HTML page.

Entry Time. The time stamp of when the event initiated.

Event Time. The time used to order the event 
chronologically. It may be either the value of the event 
entry time or the event exit time, depending on the API. For 
some event types such as those that receive messages, the 
important time is not when the event was first called, but 
when it returned (when the message was received). For 
those events, the event time is the event exit time; for all 
other events, the event time is the event entry time.

Exit Time. The time stamp of when the event finished.

Host Name. The host running the application that called 
the WebSphere MQ or JMS API or the host the WebSphere 
application server is running on.

Host IP. The host IP address of the machine the events 
occurred on.

Program Name. The name of the program making the 
event.

Technology. The technology used by the event. Currently, 
WebSphere MQ, JMS, Servlet, and EJB technologies are 
supported.

EJBGROUP EJB Name. For EJB events, the EJB name associated with the 
event. If the Program Name column is displayed, the EJB 
name also appears as the program name.
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JDBC SQL Type. For JDBC events, type of SQL statement — 
batched SQL statements such as DELETE, INSERT, MERGE, 
SELECT, Stored Procedure, UPDATE.

JDBC Class. For JDBC events, the JDBC class associated with 
the event.

SQL Objects. For JDBC events, tables, stored procedures, 
views, this event accesses.

Database. For JDBC events, the database name that these 
events are connected to.

SQLCode. For JDBC events, SQL code used by JDBC. The 
code is based on the underlying database vendor.

SQLState. For JDBC events, SQL State values used by JDBC. 
The values are based on the underlying database vendor.

JMS JMS Class. For JMS events, the JMS class associated with the 
event.

JMS Queue. For JMS events, the name of the JMS queue 
associated with the event.

Topic. For JMS events, the name of the topic associated with 
the event.

JMS Exception Code. For JMS events, the exception code 
associated with the event.

Category Available Columns
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OS390CICS CICS API Type. For CICS events, the API type (File Control, 
Interval Control, Program Control, Program Start, Start 
Attach, Task End, Task Start, Temporary Storage, and 
Transient Data).

CICS Appl ID. The name by which CICS is known to the 
network.

CICS Resource ID. For CICS events, the resources used by 
CICS transactions. Currently, these resources are file name, 
transient data (TD) queue name, and temporary storage (TS) 
queue name.

CICS Response Code. For CICS events, the CICS response 
code associated with the event.

CICS Start Code. A two character code indicating how the 
CICS transaction associated with the event was started. 
Refer to the CICS Application Programming Reference 
(ASSIGN command) for the range of Startcode values and 
meanings. 

CICS SYSID. The CICS SYSID associated with the event.

CICS Task. The CICS task associated with the event.

CICS Transaction. The CICS transaction ID associated with 
the event.

CICS Terminal ID. The CICS Terminal ID associated with the 
event. 

Category Available Columns
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Servlet Application Server. For servlet events, the name of the 
WebSphere MQ application server associated with the 
event. For WebSphere Application Server 5.0 Express 
Edition, the application server name default is server1; 
other names are an alias for this server name.

Servlet. For servlet events, the name of the servlet 
associated with the event.

Status Code. For servlet events, the status code associated 
with the event. Note: The TransactionVision servlet agent is 
unable to get the response status code and any headers in 
the response object for servlet events generated from an 
HTTP_HEAD request. Therefore, the status code value for 
HTTP_HEAD events is always N/A.

Web Application. For servlet events, the name of the web 
application associated with the event.

User Event User Event Class. For user events, the class associated with 
the event. For information about implementing user events 
in your application, see the the HP TransactionVision 
Advanced Customization Guide PDF.

User Event Completion Code. For user events, the 
completion code associated with the event. For information 
about implementing user events in your application, see the 
the HP TransactionVision Advanced Customization Guide PDF.

User Event Status. For user events, the status associated 
with the event. For information about implementing user 
events in your application, see the the HP TransactionVision 
Advanced Customization Guide PDF.

User Event Object. For user events, the object associated 
with the event. For information about implementing user 
events in your application, see the the HP TransactionVision 
Advanced Customization Guide PDF.

Category Available Columns
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WebSphere MQ Completion Code. The completion code in the WebSphere 
MQ API call return from the WebSphere MQ library. 

Reason Code. The reason code in the WebSphere MQ API 
call return from the WebSphere MQ library.

Connection Name. For all technologies, the connection 
name represents the connection the event is using. For 
WebSphere MQ, the connection name and queue manager 
are typically the same, except in the case where you open a 
queue on one queue manager using a connection (specified 
with the hConn parameter) to a different queue manager 
over a transmission queue. For example, suppose your 
program opens queue QM1.Q using a connection to queue 
manager QM1, then later opens QM1.Q using a connection 
to queue manager QM2. This event shows QM1.Q as the 
object name, QM1 as the queue manager, and QM2 as the 
connection name.

Queue Manager. The WebSphere MQ queue manager 
associated with the WebSphere MQ event. The queue may 
not be always be the same as the connection name. For 
example, it is different when you are putting to a queue on 
a different queue manager from your connection over a 
transmission queue.

Object Name. The WebSphere MQ object (queue, 
distribution list, namelist, etc.) associated with the event.

Reply To Queue Manager. The WebSphere MQ or JMS 
queue manager in the Reply To field.

Reply To Queue. The WebSphere MQ or JMS queue in the 
Reply To field.

WebSphere MQ 
OS390Batch

z/OS Job Name. The z/OS Batch job name associated with 
the event.

z/OS Job Step. The z/OS Batch step name associated with 
the event.

Category Available Columns
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WebSphere MQ 
OS390MS

z/OS IMS Region ID. The z/OS IMS region identifier 
associated with the event.

z/OS IMS Region Type. The z/OS IMS region type associated 
with the event.

z/OS IMS Id. The z/OS IMS identifier associated with the 
event.

z/OS IMS Transaction. The z/OS IMS transaction name 
associated with the event.

z/OS IMS PSB. The z/OS IMS PSB name associated with the 
event.

WebSphereMQOS
400

i5/OS Job Name. The i5/OS job name associated with the 
event.

Transactions Txn ID. The transaction identifier.

Txn Class. The business transaction CI name.

Txn Start Time. The transaction start time.

Txn End Time. The transaction end time.

Txn Response Time. The end-to-end transaction response 
time, in milliseconds. 

Txn State. The events from transactions that are in a 
Completed/Processing/Unknown state.

Txn Result. The events from transactions that have a Failed/
Success/Unknown result.

Txn Label. The events from transactions based on matching 
the transaction label.

Txn SLA State. The SLA state of Aged out/None/Violated.

Category Available Columns
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Report Content: Events List

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

 Drill to the Component Topology for the events in the 
selected business transaction.

Drill to the Transaction Detail report for the selected 
event. Applies only when the events are viewed as Local 
Transaction or Business Transaction.

Send the selected event to the right-hand pane so that it 
is available for a side-by-side comparison. Select a 
different event in the event list view to populate the 
left-hand pane. 

Reset column widths. 

<navigation links> If the Event Analysis report contains more than one page 
of events, use the navigation links to navigate between 
pages.

View events as: No transaction. Show all events. 

Local transaction. Filter the events to show only those in 
the same local transaction. 

Business transaction. Filter the events to show only those 
in the same classified business transaction. 
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Report Content: Event Detail for a Selected Event

For a selected event in the events list, event details display below the events 
list.

The event details are displayed in a hierarchy, enabling you to view different 
levels of detail.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access 1  Select Applications > Transaction Management > 
Transaction Analysis > Event Analysis.

2  Select an event and scroll down to reach the Event 
Detail tables. 

UI Elements Description

(from Host) Drill to HP Diagnostics. The Hosts view opens with the 
TransactionVision host selected, data for the host is 
shown in the graph, and metrics for the host are 
displayed in the details pane. This is useful for 
troubleshooting as you see system metrics and can 
identify if the problem is a system issue.

Some of the metrics available in the details pane for the 
host system include: Average CPU Utilization, Average 
Memory Utilization, Average Disk IO in Bytes/Second, 
Average Network IO in Bytes/Second.

From this Hosts view in Diagnostics you can see the 
performance of the host system charted over various time 
periods. Also you can check to see if the system has 
recently experienced a performance degradation or if the 
system has consistently under performed.

(from URI) Drill to HP Diagnostics. The Analyze Snapshot view 
opens.

Send the selected event to the right-hand pane so that it 
is available for a side-by-side comparison. Select a 
different event in the event list view to populate the 
left-hand pane. 

Event Details The field names that comprise the event and values are 
displayed. 

Click - or + to collapse or expand the field.

Collapse All Click to collapse all nodes.

Expand All Click to expand all nodes.
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Application Server Statistics Report

Displays statistics on the activities of EJB and Servlet components including 
average method execution time and call counts.

The following is an example of the Application Server Statistics report.

Save as XML Click to save a copy of the current event as an XML 
document. 

User Data For an event with user data, the user data fields are 
displayed.

To access Select Applications > Transaction Management > 
Transaction Infrastructure > Application Server Statistics.

Important 
information

You can filter the EJBs or Servlets for which you want to 
view statistics.

UI Elements Description
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports. 

View The reporting time period. Choose an option from the 
drop-down list. For some time periods, also choose:

From. The date and/or time for the beginning of the 
reporting time period; click to access a calendar from 
which to select the date/time.

To. The date and/or time for the ending of the reporting 
time period from a calendar control.

Servlet Filter Restrict the report by setting the filter. Specify a ';' 
delimited list of servlets to include or include wildcards 
such as '*servlet' or 'servlet*'. By default all servlets from 
this project are selected. 

EJB Filter Restrict the report by setting the filter. Specify a ';' 
delimited list of EJBs to include or include wildcards such 
as '*EJB' or 'EJB*'. By default all EJBs from this project are 
selected. 
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Report Content

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

EJB Statistics EJB. EJB name. 

EJB method. The method in the EJB that was called. 

Success Call Count. The number of calls to the method 
that did not have an error. Click the call count link to 
view the total call count bar graph.

Error Call Count. The number of calls to the method that 
did have an error. Click the call count link to view the 
total count bar graph.

Average Method Time (sec). Average method execution 
time, in seconds, for the method.

Servlet Statistics Servlet. Servlet name. 

Success Call Count. The number of calls to the servlet 
request call that did not have an error. Click the call 
count link to view the total call count bar graph.

Error Call Count. The number of servlet request calls that 
did have an error. Click the call count link to view the 
total count bar graph.

Average Method Time (sec). Average method execution 
time, in seconds, for the servlet.
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Report Content: Total Call Count Graph

The Total Call Count graph displays the number of successful and error 
calls.

The following is an example of the Total Call Count graph for an EJB.
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Transaction Topologies

This chapter includes:

Concepts

➤ Transaction Topology Overview on page 552

➤ A Closer Look at the Flow Map on page 553

Tasks

➤ How to View the Aggregated Topology of a Business Transaction 
on page 563

➤ How to View the Instance Topology of a Business Transaction 
on page 564

Reference

➤ Aggregated and Instance Topology User Interface on page 565

Troubleshooting and Limitations on page 571
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Concepts

Transaction Topology Overview

A transaction topology is a flow map for a business transaction CI. That is, it 
shows the components through which the business transaction executes. 
The flow map includes metrics about the data flow at specific points. These 
metrics display in arrow labels and tooltips:

You specify the Business Transaction CI type for which you want to view a 
transaction topology as well as the time frame for which you want to view 
data.

Each component appears as a 
node with arrows indicating 
message flows between 

t

Labels can be enabled that 
indicate details of the data 
flow between components. 

Tooltips provide more details 
for an arrow or a component. 
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Along with the flow map, the Transaction Topology includes detail 
information about selected components, including KPI information where 
applicable. Components that do not have KPIs or are not ODB components 
do not present this information.

Aggregated Versus Instance Transaction Topologies
There are two versions of the transaction topology:

➤ The Aggregated Topology displays information about all transaction 
instances that exist in the time frame. The metrics that display are 
aggregated. For example, the data flowing from the TradeDemo to the 
Bond component show above had 2 instances, one completed 
successfully and one completed late. 

➤ The Instance Topology displays information about a single transaction 
instance along with the aggregated information described above. The 
instance is specified by drilldown from the Transaction Tracking report.

A Closer Look at the Flow Map

The following sections describe the key areas of the flow map:

➤ "Completed Versus In-Process Data" on page 554

➤ "Components" on page 554

➤ "Connecting Arrows" on page 555

➤ "Tooltips" on page 559

➤ "Graph Mode: Show/Hide Tiers" on page 561
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Completed Versus In-Process Data
The Aggregated Topology divides all the transaction instances into these 
categories, each represented by a tab: 

➤ Completed: Metrics and flow map are only for transaction instances that 
have completed in the given time frame. A transaction is completed when 
the Transaction State property is completed. 

➤ Currently In-Process: Metrics and flow map are only for transactions that 
have not completed in the given time frame. You can view this tab to 
locate any instances that appear to be bottlenecked and on which 
component that occurs. You can also compare the metrics of a given 
instance with the average reported on the Completed tab. 

The Instance Topology does not have multiple transaction instances, so the 
tabs do not appear.

Components
Each component that appears in the flow map is one through which the 
selected business transaction passed data. You can select a component in the 
flow map to display additional information about that component in the 
tables below the flow map. These details include:

➤ ODB properties display if the selected object is known to the ODB.

➤ KPIs display if there are any being monitored on the selected object.

➤ Additional custom details per application display.

Components in the flow map are multi-tiered. That is, application servers 
are shown inside of hosts, queues are shown inside of queue managers, and 
so forth.

Components on the map can be re-arranged, and the map itself can be 
panned and zoomed. The toolbar contains buttons to change the labeling of 
components, as well as pan, center, zoom, and select components in the 
map.
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The component icons each represent a specific type of software or hardware 
element that the transaction instances have passed through. The flow map 
always shows the backend server-level components such as application 
servers, message middleware servers, database servers, mainframe 
transaction and batch jobs.

Other icons are used for elements that originated from an instance of the 
transaction, such as a Web Client. If RUM is also monitoring the 
transaction, the flow map displays an End User Group component icon if 
the transaction originates from an end user group.

Not all component types have a specific icon that appears in the flow map.

The icon for each component type is determined by the ODB class type for 
that component. For a list of the component icons used in the Transaction 
Topology flow map, see "Aggregated Topology" on page 565.

Connecting Arrows
Communication between components in the flow map is represented by 
links (directed arrows). The following link patterns between the component 
icons can be seen in the flow map: 

➤ A directional link between two components

A directional arrow shows direction of message flow or a call from one 
component to another.

➤ Two links between two components, each link going in the opposite 
direction

Many times this shows an exchange of request and response data flow.

➤ A component with a self-directed link

The transaction spent multiple processing steps at the same component. 
Such a link is common when viewing nodes that may contain lower level 
components (for example one Web Application can contain several 
Servlets and EJBs which call each other).

➤ A flow with several end points
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Many times this can represent an asynchronous transaction and some 
components either did not send a response or they sent a response to a 
component that is not monitored by TransactionVision.

➤ A circular flow

May indicate that the request was answered by something other than the 
component that took the request.

➤ Unconnected flow paths 

This can occur when there are elements that cannot be interpreted by 
TransactionVision, for example, if the technology is not supported.

Labels on the Arrows
Labels can be enabled on each arrow to display metrics related to the flow of 
transaction instances (either completed or currently in-process, as relevant) 
between the two components connected by the arrow. The metrics are 
totaled for each transaction state:

for Successful Transactions

for Late Transactions

for Failed Transactions
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For the Instance Topology, the instance-level metrics appear alongside the 
aggregate-level metrics in brackets:

Data You Can Display as Labels

By default, no labels display. You can choose to display any or all of the 
following labels:

Label/Metric Description

Volume Displays the count of the transaction instances that either passed 
between the two components or are currently in-process of being 
passed.

The count is displayed in each of the three transaction state 
categories: Successful, Late, and Failed.

Value Displays the total monetary value associated with the transaction 
instances that either passed between the two components or are 
currently in-process of being passed.

The count is displayed in each of the three transaction state 
categories: Successful, Late, and Failed.

Latency Displays the average latency (response time) for the transaction 
instances that either passed between the two components or are 
currently in-process of being passed (in milliseconds).

The count is displayed in each of the three transaction state 
categories: Successful, Late, and Failed.

for Successful Transactions

for Late Transactions

for Failed Transactions
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The Business Transaction States

The Business Transaction state categories are:

Note: Transactions can be classified in more than one state category, for 
example, as both late and as successful.

If a metric is not applicable for a link, or if there is no criteria set in 
TransactionVision for late status or failed status, then the relevant metric 
shows a dash.

Transaction State 
Category

Description

Successful The total count of successful transaction instances. 

Failed The total count of failed transaction instances, that is, those 
that met the transaction’s Failure rule. 

For information about specifying the failure data rule, see 
"Tracing Tab, Data Rules Tab" on page 464.

Late

(Also referred to as 
delayed.)

The total count of transaction instances with a response 
time that exceeded the threshold defined for the business 
transaction. For information about setting the Threshold, 
see "Transaction Configuration Page, Tracing Tab" on 
page 461.
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Tooltips
You can hover over elements in the flow to view additional details. 

Example of Tooltip Metrics for a Component

The component icon tooltip that contains more information about how the 
components is relevant to the transaction. For example: 

The tooltip contains additional information if transaction is also monitored 
by HP Diagnostics or RUM.

The component tooltip may include additional data from the software or 
hardware upper layers. For example, if a transaction instance passed through 
a J2EE application, the map shows a flow component for the J2EE 
application, and may include additional data for the application server and 
the host in the tooltipFlow Map Metrics
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Example of Tooltip Metrics for a an Aggregated Topology 
Arrow

This example shows a tooltip for an Aggregated Topology link showing the 
Late and Failed metrics with no criteria set.

Example of Tooltip Metrics for an Instance Topology Arrow

This example shows a tooltip for an Instance Topology link that compares 
the metrics of the path taken by a Business Transaction instance with the 
path taken by other instances of that Business Transaction. The dotted line 
represents the Aggregated Topology of the Business Transaction with respect 
to the Instance Topology, which is a solid line.
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Graph Mode: Show/Hide Tiers
You can display tier information for each component. At the top level of the 
tier is the host hardware that contains the software components which 
make up the Transaction Topology. From that tier you can drill to the server 
tier, and from that to the application tier. 

The following table shows the tiers that appear when the tiers are enabled. 

Topology Tier Content in the tier

Host Tier host. Generic host.
nt. Windows host.
unix. UNIX host.
mainframe. Mainframe host.

Server Tier Expanded from mainframe:

ims_program. IMS Program.
batch_job. Batch job.
cics_transaction. CICS transaction.

Expanded from host:

websphereas. Websphere Application Server
weblogicas. WebLogic Application Server
sqlserver. SQL server database instanc
iis. Windows internet information services instanc
j2eeserver. Generic java enterprise server
db2. DB2 database instance
oracle. Oracle Database instance
jmsserver. Generic JMS messaging server
running_software. Software application
customer. User
rum. End user group (a collection of users specified 
by rules in RUM) 
mqqueuemanager. WebSphere MQ Queue Manager

Host Tier Server Tier Application  Tier
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Application Tier Expanded from jmsserver:

jms_queue. JMS message queue
jms_topic. JMS message topic
jmsdestination. JMS destination

Expanded from j2eeserver:

j2eeapplication. Software application running on a 
J2EE server

Expanded from iis:

webservice. Software application running on an IIS 
server

Expanded from mqqueuemanager:

mqqueue. Generic WebSphere MQ Queue
mqqueuelocal. WebSphere MQ Local Queue
mqqueueremote. WebSphere MQ Remote Queue
mqqueuealias. WebSphere MQ Alias Queue

Other Types mqcluster. WebSphere MQ Cluster Queue

This node has no parent and is at the Host level.

Topology Tier Content in the tier
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Tasks

How to View the Aggregated Topology of a Business 
Transaction

This task contains the following steps: 

➤ "Determine the Transaction Category You Need" on page 563

➤ "View the topology for completed Business Transactions" on page 563

➤ "View the topology for in-process Business Transactions" on page 564

Determine the Transaction Category You Need

The Aggregated Topology can display the topology for completed or in 
process business transactions. Review the information "Completed Versus 
In-Process Data" on page 554 to determine which category you need. 

View the topology for completed Business Transactions

 1 Select Applications > Transaction Management > Transaction Topology > 
Aggregated Topology.

By default the Completed tab should be displayed, if not click it.

The topology displays based on the last business transaction that was 
specified. If this is the initial viewing of the report, use the Transaction 
Filter link to specify the business transaction. 

 2 To specify a different business transaction, access the Transaction Filter 
dialog box. See "Transaction Filter Dialog Box" on page 508 for details.
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View the topology for in-process Business Transactions

 1 Select Applications > Transaction Management > Transaction Topology > 
Aggregate Topology.

 2 Click the In Process tab.

The topology displays based on the last business transaction that was 
specified. If this is the initial viewing of the report, use the Transaction 
Filter link to specify the business transaction.

 3 To specify a different business transaction, access the Transaction Filter 
dialog box. See "Transaction Filter Dialog Box" on page 508 for details.

How to View the Instance Topology of a Business 
Transaction

 1 Run the Transaction Tracking report so that the transaction instance for 
which you want to view the topology is on the report.

For details about this interface, see "Transaction Tracking Report" on 
page 525.

 2 Select the transaction instance and click the Drill to Instance Topology 
button.
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Reference

Aggregated and Instance Topology User Interface

This section describes:

 ➤ Aggregated Topology on page 565

Aggregated Topology

The Aggregated Topology page displays a flow map and response time and 
volume metrics for a business transaction. The following page shows an 
example of an aggregated topology.
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Flowmap

Properties for a 
Selected Component

Report Settings

Flow Map Toolbar
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Aggregated Topology Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Flowmap Toolbar

The following toolbar options are included:

UI Elements Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

View The reporting time period. Choose an option from the 
drop-down list. For some time periods, also choose:

From. The date and/or time for the beginning of the 
reporting time period; click to access a calendar from 
which to select the date/time.

To. The date and/or time for the ending of the reporting 
time period.

Transaction Filter Launches the Transaction Filter dialog box, where you 
select the business transaction on which to base the 
transaction topology. See "Transaction Filter Dialog Box" 
on page 508.

(Clear All) Clears any active filters. 

Select Topology 
Sources

The transaction on which the topology is based can be 
monitored by any or all of these products. You can 
choose which product’s data the topology is based on. 

UI Elements Description

Interactive Zoom. Click the button and then drag to the 
area of the flow map you want to zoom in to or out from.

Pan. Click the button and then click and drag the flow 
map to view different areas of the flow map.
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Select. 

➤ click an entity in the map to select it.

➤ click and drag an entity in the map to reposition it 
within the flow map. For example, you can click on 
the elbow of a link arrow and drag it to a different 
location.

➤ click and drag over an area to select the entities within 
that area.

Click again outside the selected area to deselect.

Fit to screen. Click to resize the flow map to fit the 
available viewing space.

Toggle presentation type. Click to change the 
component rectangles to icons, which can sometimes 
make the topology easier to view.

Toggle graph mode. Click to enable or disable showing 
the components in their associated tiers. 

Link Labels. Choose the data you want to display on the 
link arrows: 

➤ Value. Displays value metrics for each link, alongside 
each link arrow.

➤ Volume. Displays volume metrics for each link, 
alongside each link arrow.

➤ Latency. Displays latency metrics for each link, 
alongside each link arrow.

For more information on these options, see "Labels on 
the Arrows" on page 556.

Default Value: no data displays on the link arrows. The 
data is available on the tooltip however.

Drill to the Transaction Tracking report. 

If HP Diagnostics is monitoring the transaction, you can 
also drill to the Business Transaction Paths view. 

UI Elements Description
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Aggregated Topology Content: Flow map

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Collapses all groups so only the highest level tiers are 
showing. See "Graph Mode: Show/Hide Tiers" on 
page 561. 

Expands the groups so that all tiers are showing. 

UI Elements Description

<Component icon> Each flow component (for example, Application, Servlet, 
MQ Queue, and so forth) is represented by an icon:

Tooltip: Hold the pointer over a component icon to 
display a tooltip containing information for that 
component.

For the Web Clients and End User Group components, 
the tooltip displays information relating to end user 
transactions that are mapped to the Business Transaction.

For more information on the data in the tooltips, see 
"Tooltips" on page 559.

Program component

J2EE application component

Web Clients component

IBM WebSphere MQ Queue component

IBM WebSphere MQ Cluster Queue component

UI Elements Description
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JMS Topic component

JMS Queue component

CICS Transaction component

IMS Program component

Batch Job component

End User Group component

Other database types 

Oracle database

SQL Server database

Sybase database

UI Elements Description
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Troubleshooting and Limitations

There is a limit on how many instances can be retrieved from the database 
to present the transaction topology. For TransactionVision, the number of 
transaction instances retrieved is limited to 100,000. 

<Link arrow>

Example:

The link arrows, each connecting two component icons, 
indicate the direction of the transaction flow. 

If the Transaction Topology flow map is set to show data 
(according to the selections made in the Link Labels 
toolbar menu), then the Transaction Topology flow map 
displays these metrics, broken down by three transaction 
state categories, along the edge of each link arrow. The 
format <successful>/<late>/<failed> is used to display the 
metrics across each transaction state category, for 
example: Volume: 100/2/1. For more information see 
"Labels on the Arrows" on page 556. 

Tooltip: Hold the pointer over a link arrow to display a 
tooltip that shows the metrics broken down by 
transaction state. For more information, see "Tooltips" on 
page 559.

UI Elements Description
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Component Topology

This chapter includes:

Concepts

➤ Component Topology Overview on page 574

➤ Static Mode Versus Dynamic Mode on page 576

➤ A Closer Look at the Graph on page 577

Tasks

➤ How to View the Component Topology on page 584

➤ How to Change the Layout of the Graph on page 585

➤ How to Modify Component Groupings on page 589

➤ How to Configure Arrow and Node Labels on page 593

➤ How to Print the Component Topology Graphs on page 598

Reference

➤ Component Topology User Interface on page 603

Troubleshooting and Limitations on page 617
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Concepts

Component Topology Overview

The Component Topology provides a graphical representation of all system 
components from which agents have collected events. These events are 
correlated and used to draw a visual map of the flow of information 
throughout the system:

The Component Topology is helpful in determining which components 
have a bottleneck or on which component the flow has stopped.
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Note: Unlike other metrics and data presented in the Transaction 
Management reports and topologies, these statistics are not aggregated by 
the transaction. However you can drill in-context to the Component 
Topology from the Event Analysis report which allows you to see data only 
for those events related to a business transaction or local transaction 
instance.

By default, the flow is presented in a hierarchical layout as shown above so 
that you can easily see the overall flow from component to component. 

You can change the layout by symmetrical instead as in the following 
example.

This layout allows the information on the arrows to be easier to read in 
some cases.
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Static Mode Versus Dynamic Mode

You choose one of two modes for the Component Topology:

Static mode
In Static mode, the Component Topology graph is created from statistics 
gathered automatically during event collection. You specify the time range 
for which you want to view statistics.

Static mode includes data about the relationships between the components. 
This data is aggregated by component to component relationship. For 
example, if program A puts 100 messages on JMS queue B, then 100 events 
of that put operation are collected by the corresponding TransactionVision 
agent. The Analyzer create a statistic metric representing the Program 
A-to-JMS Queue B operation with its count, in this case, 100. 

In Static mode, the granularity of data is at the program level or higher, 
whereas the granularity of data in dynamic mode is at the program instance 
level and higher. For more information about granularity of data, see "How 
to Modify Component Groupings" on page 589. 

By default, the Component Topology displays in static mode. The graph is 
rendered much faster in Static mode than in Dynamic mode.

The statistics used to support static mode are stored in a specific cache. Two 
configuration options are provided for this cache. See the Flush Interval and 
TimeSlice interval options in "Configuration Tab, Cache Tab" on page 103. 

Dynamic mode 
In Dynamic mode, the Component Topology graph is created based on 
events returned by a query. Only the correlation data related to those events 
is shown in the graph. You define the query to be used; the query can 
choose events of a certain technology, host, program, or other criteria. 

This mode enables you to view very specific information in the graph, but 
takes longer than Static mode to render.

For information about writing queries, see "Queries" on page 225.
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A Closer Look at the Graph

By default, the Component Topology is arranged in a hierarchical layout 
according to the flow of messages through your system. 

The flow starts with the leftmost component representing the first message 
in the requested time frame, and flows to other components. In the 
following example, the web page calls the TradeServlet and 
TradeSimulationServlets. These each in turn call the same Java server page.  

A component on which 
the first event occurred.

Labels on the arrow provide data 
about the flow such as latency or 
event delivery status. 

Arrows show the relationship 
between components. 
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Resource Icons 
Resource icons represent system components and appear as nodes in the 
graph. For a list of the resource icons, see "Resource Icons" on page 613.

Arrows
For WebSphere MQ, JMS, and CICS events, solid arrows represent message 
flows. For servlet, Java user events, and EJB events, arrows represent one 
component calling another component. For JDBC events, arrows represent 
access to database resources. 

Dashed arrows represent a relationship between components, such as 
between a remote, alias, or model queue and the local queue it is associated 
with. In the following example, the DataFlowEngine and FX Listener 
programs write to and read from the FX queue, respectively. The FX queue is 
an alias queue for the local FX_LOCAL queue.
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Other arrow labels are dependent on the technology of the associated 
components, as follows: 

WebSphere MQ and JMS Events
For WebSphere MQ and JMS events, an arrow represents message flow. For 
example, the following diagram shows that the DataFlowEngine application 
puts messages on the EQUITY and BOND queues of the TRADING queue 
manager. The EquityTradeProcessor and BondTradeProcessor programs 
retrieve messages from the EQUITY and BOND queues, respectively, and put 
a message on REPLY. 

When monitoring JMS events from stand-alone Java applications, the 
Component Layout view displays the top level class name as the program 
name. The top level class name is the outmost name in the stack trace. For 
example, the class name in the following stack trace is taken from the last 
line in the following example:

at java.lang.Thread.dumpStack(Thread.java:993)
at Test.<init>(Test.java:29)
at Test.main(Test.java:62)
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However, this class does not necessarily contain the public static void 
main(String[] args). Instead, it might be a class derived from 
java.lang.Thread, which runs in other threads than the main thread.

If the correct program name is not displayed, set the 
com.bristol.tvision.programname system property in the command line 
when running the stand-alone application. For example, to set the program 
name to MyProgram, start it as follows:

java -Dcom.bristol.tvision.programname=MyProgram ...

CICS Events
Like WebSphere MQ and JMS events, arrows represent message flow for 
CICS events. For example, in the following diagram, the CKPB CICS 
transaction reads from the SYSTEM.CICS.BRIDGE.QUEUE queue and the 
ACCTFIL file.

It then writes to the REMOTE.TO.HUDONGWPC queue, which is a remote 
queue for HUDONG.TEST.QUEUE.
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Servlet and EJB Events
For servlet and EJB events, arrows represent control flow. In the following 
example, the web page calls the TradeServlet and TradeSimulationServlets. 
TradeServlet calls the TradeSession EJB, while TradeSimulationServlet calls a 
Java server page.
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JDBC Events
For JDBC events, arrows represent access to database resources. An 
application has a link to an SQL object, which represents the type of SQL 
statement and which tables it accesses. Various statistics on this operation 
are available on this arrow. Additionally, an SQL object has links to database 
table objects that were accessed by the SQL statement.

In the following example, you see the JDBCStmt application execute an SQL 
statement that does a SELECT on the table TVISION.USER_PREF.

WebSphere MQ-IMS Bridge Events
The following example shows a batch job HUDONGWA with a job step, 
STEP 1, putting messages onto a MQ-IMS bridge input queue. On receiving 
these messages on the input queue, the WebSphere MQ-IMS bridge invokes 
an IMS transaction TRTIB3 in IMS job IMS71CR1. That transaction places 
reply messages on the IMS.BRIDGE.REPLY.QUEUE, which is read by the job 
step, STEP 2 of the job HUDONGWA.
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Java User Events
When monitoring Java User events, arrows show calling relationship. For 
example:  
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Tasks

How to View the Component Topology 

Determine the View Mode You Need

By default, the Component Topology is created in static mode. Review the 
information "Static Mode Versus Dynamic Mode" on page 576 to determine 
which mode you need. 

View the graph in Static Mode

 1 Select Applications > Transaction Management > Transaction Topology > 
Component Topology.

If the graph displays in Dynamic mode, click Switch to Static Mode.

The Graph displays based on the last time period that was specified.

 2 Change the time period as desired:

➤ To display all events, set the Show all statistics check box and click 
Run.

➤ To display events from a predefined time period, choose a time period 
from the Set Time to drop-down list and click Run.

➤ To display a custom time period, choose Custom from the Set Time to 
drop-down list, enter the desired start and end dates and times in the 
Display Static Data from and to fields and then click Run.

Note: For custom time periods, the time slice interval in effect for the 
Analyzer is the smallest increment of time period in which you can view 
your data in static mode. See "Configuring the Caches" on page 75.
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View the graph in Dynamic Mode

 1 Select Applications > Transaction Management > Transaction Topology > 
Component Topology.

If the graph displays in Static mode, click Switch to Dynamic Mode.

The Graph displays based on the last query that was specified or if this is 
the initial viewing, based on the All Events built-in query.

 2 To specify a different query, choose the query name from the Query 
drop-down list and click Run. 

The list includes all the existing queries for which you have permission to 
view. 

For information about creating or modifying queries, see Chapter 6, 
"Queries."

How to Change the Layout of the Graph

The layout of the graph is highly customizable. The following sections 
describe the types of layout customizations you can perform. 

Move Components
To move any component in the graph, select the component in the view 
area and drag it to the desired location. The arrows automatically adjusts to 
and from the component.

Show/Hide the Status Bar
Use the Show/Hide arrow buttons to show, hide, or resize the status message 
pane. 

To hide the status bar, click the down arrow button. To show a hidden status 
bar, click the up arrow button. To resize the status bar, point the cursor to 
either arrow button so that the cursor changes to a double arrow and drag.
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Adjust the Zoom Level
By default, the Component Topology is sized to fit in the view window. 
There are several ways to adjust the zoom level:

➤ Choose the Zoom > Zoom > Zoom In menu item to increase the zoom 
level. 

➤ Choose the Zoom > Zoom > Zoom Out menu item to decrease the zoom 
level. 

➤ Click the Selective Zoom icon or choose Zoom > Selective Zoom to 
change to selective zoom mode. The cursor changes to the selective zoom 
cursor. Click on the view area and then drag the cursor to select an area to 
zoom. TransactionVision adjusts the zoom level so that the selected area 
fills the view area. Click the Selection icon to return to selection mode.

➤ Click the Interactive Zoom icon or choose Zoom > Interactive Zoom to 
change to interactive zoom mode. The cursor changes to the interactive 
zoom cursor. Click in the view area and drag the cursor to the top or left 
to decrease the zoom level or drag to the bottom or right to increase the 
zoom level. Click the Selection mode icon to return to selection mode.

➤ Click the Zoom Fit Window icon or choose Zoom > Zoom > Fit Window 
to adjust the zoom level so that the entire graph appears in the view 
window.

➤ Enter a custom zoom percentage or choose a predefined zoom percentage 
from the zoom percentage list.
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➤ Choose the Zoom > Show Overview Window menu item to open a small 
secondary window that contains a read-only view of the view window. 
Change the view in the view window by moving the blue selection box in 
the Overview window. This allows you to see in-context areas of the 
graph.

➤ To resize the selection box, click one of the corner handles and drag 
your cursor to the desired size. Note that the selection box maintains a 
constant aspect ratio to match the size of the active view window.

➤ To move the selection box, click inside the selection box and drag your 
cursor to the desired location. 
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➤ To create a new selection box, click outside of the current selection box 
and drag your cursor to the desired size.

Note: Any time the Component Topology is refreshed, the zoom level 
reverts to Fit Window. 

Set Background Color
You can specify the background color of the Component Topology graph. 
See "Layout Menu" on page 608.

Set White Space Options

You can specify options relating to the spring model of the graph. See 
"Layout Properties Dialog, General Properties Tab" on page 610

Spacing Model

You can specify options that determine the amount of white space around 
nodes in the graph. Two spacing models are available: 

➤ Proportional Spacing. The amount of white space around the perimeter 
of an object is based on the area of the object. For example, if a 
component's width and height increase, the white space between the 
component and an adjacent component also increases. The margins of 
the graph can be controlled through the Graph Margin Spacing fields. 
You can set independent proportional spacings for the left, right, bottom, 
and top sides of the graph. 

➤ Constant Spacing. A constant space is allocated between like objects in a 
graph. For example, in hierarchical layout a fixed distance is set between 
each pair of adjacent components within a level, regardless of the width 
and height of the nodes. The margins of the graph can be controlled 
through the Graph Margin Spacing fields below. You can set independent 
constant spacing values for the left, right, bottom, and top sides of the 
graph.
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Note: Additional spacing controls are available on the Layout Properties 
dialog.

Label Positions

This option allows you to tailor the automatic positioning of arrow labels. 
See "Layout Properties Dialog, General Properties Tab" on page 610.

How to Modify Component Groupings

Changing component groupings changes the granularity of the information 
displayed in the view, depending on the level of information you need. For 
example, viewing each process thread as a separate component provides 
very fine granularity, but can make it difficult to spot an information flow 
problem between programs.

Note that proxy objects do not support grouping by thread, process, 
transaction name, transaction ID, TCB, and PCB. Selecting these grouping 
criteria have no effect on proxy objects. For more information about proxy 
objects and the proxy agent, see the HP TransactionVision Deployment Guide 
PDF. 

Select the following options from the Component Topology Grouping 
menu to configure the display granularity:

Queues and Queue Managers
Select one of the following Queue Grouping Criteria menu items:

➤ MQSeries Object/Queue Manager Combination. Shows each object/
queue manager combination as a separate component. This is the default. 

➤ Queue Manager. Shows all objects on a single queue manager as a single 
component.
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➤ Show Model Queue Resolution. Turns model queue resolution on/off. A 
model queue is a template of a queue definition that is used when 
creating a dynamic queue. When you call MQOPEN on a model queue, 
the queue manager creates a temporary or permanent local dynamic 
queue using the attributes of the model queue. Select this menu item to 
show model queues in the Component Topology.

The arrows between a model queue node and its model queue definition, 
remote queue definition, alias queue definition, or cluster queue node 
representation are displayed as dashed arrows because they represent a 
relationship rather than a message flow.

Distributed Platforms
For UNIX and Windows NT hosts, select one of the following Distributed 
Program Grouping Criteria menu items:

➤ Program Name. Displays each program name on all hosts as a single 
component.

➤ Host. Displays all programs on a single host as a single component.

➤ Program Name/Host Combination. Shows the default component 
grouping.

z/OS CICS
For z/OS CICS hosts, select one of the following z/OS CICS Program 
Grouping Criteria menu items:

➤ Transaction ID/Region/Host Combination. Shows the default component 
grouping.

➤ Transaction ID/Host Combination. Shows the transaction and host 
combination for all regions as a single component.

➤ Region/Host Combination. Shows all transaction IDs for a single region 
on a host as a single component.

➤ Host. Shows all transaction IDs for all regions on a single host as a single 
component.
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z/OS Batch
For z/OS Batch hosts, choose one of the following z/OS Batch Program 
Grouping Criteria menu items:

➤ Individual Job Step. Shows each job step as a separate component.

➤ Individual Job. Shows each job as a separate component.

➤ Host. Shows all TCBs on a single host as a single component.

➤ Host/Job Name/Step Name Combination. Shows the job name, job step, 
and host combination as a single component. This is the default.

➤ Host/Job Name Combination. Shows all jobs on a host as a single 
component.

z/OS IMS
For z/OS IMS hosts, select one of the following z/OS IMS Program Grouping 
Criteria menu items:

➤ Individual PSB Name. Shows each PSB as a separate component. This is 
the default.

➤ IMS Transaction Name. Shows each transaction as a separate component.

➤ IMS Region Identifier. Shows each region as a separate component.

➤ IMS Identifier. Shows each IMS identifier as a separate component.

➤ Job Name. Shows each job name as a separate component.

➤ IMS Type. Shows each IMS type as a separate component.

z/OS IMS Bridge
For z/OS IMS hosts, select one of the following z/OS IMS Bridge Grouping 
Criteria menu items:

➤ Transaction Name. Shows each transaction name as a separate 
component. This is the default.

➤ Job Name. Shows each job name as a separate component.
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Servlet/JSP/EJB
For Servlet/JMS/EJB events, select one of the following Servlet/JSP Grouping 
Criteria menu items:

➤ Servlet/JSP/EJB. Shows servlet, JSP, and EJB icons. This is the default.

➤ Web Application. Shows web application icons.

➤ Application Server. Shows WebSphere Application Server icons.

➤ Host. Shows all programs on a single host as a single component.

JDBC
For JDBC events, select one of the following Grouping > Database Grouping 
Criteria menu items:

➤ Database. Groups JDBC components by which database they access. This 
is the default.

➤ Database object. Groups JDBC components by SQL statements, and 
shows the tables on which the SQL statements operate.

➤ Sql Object. Groups JDBC components by SQL statements.

Show Publish-Subscribe Topic

TransactionVision is able to correlate these publish-subscribe topics into a 
single transaction as follows:

You can change the JMS icon from the underlying queue to topic. Choose 
Grouping > Show Publish-Subscribe Topic.
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Group Method Calls On The Same EJB
To group similar method calls on the same EJB as a single arrow, choose 
Grouping > Group Method Calls On the Same EJB. Otherwise, an arrow is 
drawn on the graph to represent each method call between EJB beans.

How to Configure Arrow and Node Labels

Labels are the text that appear on an arrow or next to a node:

You can configure arrow and node labels to provide more information about 
the components and events they represent as follows:

Remove/Show Labels
Use the Edge & Node menu to toggle the display of various types of labels 
that appear on the arrows and nodes. Each menu option shows or hides the 
label, and the sub-menu options specify the label details. 
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Message Count/Byte Count Data
This label indicates the total number of successful message calls between the 
resources, along with the number of bytes transferred. Note that 
MQIMS_BRIDGE_ENTRY and MQIMS_BRIDGE_EXIT calls are not included 
in the message count/byte count.

To specify a unit of measure for the byte count, choose one of the following 
from the Edge & Node > Show Byte Counts menu:

➤ In MegaBytes

➤ In KiloBytes

➤ In Bytes

This menu item is only enabled if the message count/byte count is 
displayed.
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Error, Warning, and Success Count Data
This label indicates the number of error events, warning events, and 
successful events between components. Events include the following:

➤ All WebSphere MQ MQGET, MQPUT, MQPUT1, MQINQ, MQSET, 
MQOPEN, MQIMS_BRIDGE_ENTRY, and MQIMS_BRIDGE_EXIT calls.

➤ All JMS receive, receiveNoWait, OnMessage, OnException, createReceiver, 
createSubscriber, createBrowser, publish, send, createSender, 
createPublisher, and nextElement calls.

➤ All servlet HTTP_PUT, HTTP_GET, and HTTP_POST requests.
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Latency Times
This label indicates the minimum, average, and maximum transaction times 
for each connection. Use this information to identify potential performance 
bottlenecks. Transaction times are defined as the time from when a message 
is put onto the queue and when it was pulled off that queue. For 
transactions involving a proxy object, TransactionVision shows a latency of 
N/A.

Note: For EJB and servlet events, the time on the arrow pointing to a bean 
represents the time spent in that bean's or servlet's methods; not a latency 
time. 

By default, latency times are calculated using a resolution of 1/100 seconds. 
To modify the latency resolution, change the value of the Latency 
Resolution setting for the Analyzer. For more information, see 
"Configuration Tab, Events Tab" on page 105.
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Arrow (Edge) Connection Name
Arrow labels indicate the connection associated with the arrow.

Click Edge Label to toggle the display of the connection name. 

EJB Methods
This label provides details about the EJB Methods. Select the following menu 
items to display or hide the method information:

➤ Show Standard EJB Methods. Includes standard EJB methods in the arrow 
labels showing the error/warning/success count. 

➤ Show Access Methods. Includes access methods in the arrow labels 
showing the error/warning/success count. 

➤ Show Bean Relationships. Indicates EJB relationships.
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JDBC Methods
This label provides details about the JDBC Methods. Select the following 
JDBC Statistics menu items to display or hide the method information:

➤ Cursor Iteration/Get Count. Indicates the number of result rows that were 
retrieved using this statement, and the number of calls made to the JDBC 
resultset to get results from the row.

➤ Min/Avg/Max Execute. Displays statistics showing timing of how long it 
took to execute this SQL statement.

➤ Min/Avg/Max Cursor time. Displays statistics showing the total time 
spent iterating through result rows and retrieving data from the JDBC 
resultset.

➤ Avg Time (Cursor, Execute) per statement/Total Statement time. Displays 
statistics showing the combined average time and total time spent on 
operations using this SQL statement.

➤ Commit time (Database grouping only). Displays statistics showing the 
commit time. Note that this aggregate data is not available on individual 
statements, so this statistic only displays when viewing your topology 
with the Database grouping level enabled.

➤ Total time (Cursor, Execute, commit)(Database grouping only). Displays 
statistics showing the total time spent in JDBC calls, including Cursor 
time, Execute time and commit time. Note that this aggregate data is not 
available on individual statements, so this statistic only displays when 
viewing your topology with the Database grouping level enabled.

How to Print the Component Topology Graphs

To print the Component Topology graph using the current print setup, click 
the Print icon and choose Print Graph. TransactionVision invokes the 
standard printing mechanism for your platform.
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Note: Setting the page orientation to landscape on the Windows Print 
dialog has no effect. Instead, use the TransactionVision Page Setup dialog to 
set page orientation if you wish to print in landscape mode. For more 
information about this dialog, see "Page Setup" on page 602.

When you print a graph, a Java warning appears asking permission to print. 
This message is generated by the Java security feature to prevent 
unauthorized use of printers. The first time you print in a session, it appears 
multiple times; it appears once after the first time you print. To disable this 
message, add the following lines in the java.policy file in your home 
directory on the client computer:

grant {
  permission java.lang.RuntimePermission "queuePrintJob";
};

Print Preview

To display a print preview, choose the  > Print Preview menu item. The 
Print Preview window opens so you can see how changes in print setup 
options affect the graph.

Note: Do not change the printing orientation options on the Print Setup > 
Page Setup dialog through the Print Preview window. Instead, use the 
TransactionVision Page Setup dialog to change the orientation options. For 
more information about this dialog, see "Page Setup" on page 602.

In the Print Preview window, you can zoom in on a preview image by 
moving the mouse over it and clicking.
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You can also use the following buttons to control the appearance of the 
print preview:  

Print Setup

To customize the printed graph, choose the  > Print Setup menu item. 
The Print Setup dialog opens.

Set the following options, then click OK to apply your changes. Click Cancel 
to close the dialog without applying your changes, Default to revert to 
default values, or Page Setup to display the Page Setup dialog for selecting 
paper size, orientation, and margins.

 

Button Description

Print Invokes the standard printing mechanism for your platform.

Print Setup Opens the Print Setup dialog for setting printing options.

Zoom In Increases the zoom level for the preview image.

Zoom Out Decreases the zoom level for the previous image.

Zoom Percentage Shows the current zoom percentage. You may select a 
pre-defined zoom percentage from the list or enter a custom 
zoom percentage.

Fit in Window Scales the preview image to display the complete image in 
the preview window.

Close Closes the Print Preview window.

Option Description

Print Select the part of the graph you want to print. You can print 
the entire graph, only the part of the graph currently visible 
in the view window, or only the selected graph component.

Scale By Set options related to page size. Select Pages and specify the 
number of page rows and columns to scale the image to fit 
the specified page size. The image is not scaled if Actual Size 
is selected. Choose Zoom Level to scale the image to the 
zoom level specified in the view.
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Print Caption Select to print the page caption in the Caption field.

Caption Enter text for the page caption. You must select Print 
Caption to enable caption printing. To select the font for 
the caption, click Font to display the Choose Font dialog.

Position Select the position on the page for the caption to be 
printed.

Margins Set the distances in inches between the edge of the paper 
and the edge of the graph. Set margins for the top, bottom, 
left, and right edges.

Print Page 
Numbers

Select to print page numbers on each page when printing 
multiple pages. Page numbers are printed just outside the 
crop marks.

Print Crop Marks Select to print crop marks when printing multiple pages. 
Crop marks are the lines drawn on the margins of pages 
that connect to other pages.

Print Border Select to print a border around the graph. Click Color to 
open the Choose Color dialog for setting the border color.

Print Background Select to print the background color. To set the background 
color, choose the Layout > Background Color menu item on 
the Component Topology or Transaction Analysis view.

Print Grid Select to print a background grid.

Option Description
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Page Setup

Click Page Setup on the Print Setup dialog to open the Page Setup dialog. 
Set the following options, then click OK to activate your changes or Cancel 
to close the dialog without applying the changes.  

Caption Font

Click Font on the Print Setup dialog to open the Choose Font dialog.

Use this dialog to select the font to use for the captions when printing a 
Component Topology graph.

Select a font family, text attributes, and font size from the drop-down lists. 
The sample window shows how text on the graphic looks.

Click OK to make your changes active or Cancel to close the dialog without 
activating your changes.

Border Color

Click Color on the Print Setup dialog to open the Choose Color dialog. Use 
this dialog to set the border color for the printed Component Topology 
graph. 

Set the border color in the same way you set the background color for the 
graph. For more information, see "A Closer Look at the Graph" on page 577.

Option Description

Paper Size Select a page style from the list.

Paper Source Select a source from the list.

Margins Set the distance between the text and the edge of the printed 
page (in inches). Set margins for the top, bottom, left, and 
right edges.

Orientation Select whether to use Portrait or Landscape for setting up the 
page. Portrait is default (the height of the page is greater 
than the width). For Landscape, the width of the page is 
greater than the height.

Sample Displays a preview of the selected settings.
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Reference

Component Topology User Interface

This section describes:

 ➤ Component Topology on page 604
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Component Topology

The Component Topology provides a graphical representation of all system 
components from which agents have collected events, and includes data 
about the relationships between the components. The following is an 
example of the Component Topology in Static mode:

Topology Graph

Report Settings

Mode Selection
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Applications > Transaction Management > 
Transaction Topology > Component Topology

Important 
information

➤ There are two view modes: static and dynamic. See 
"Static Mode Versus Dynamic Mode" on page 576

➤ The nodes in the graph are resource icons that 
represent system components. 

➤ Edges refer to the arrows that show the interaction 
between two components. 

Relevant tasks "How to View the Component Topology" on page 584

"How to Change the Layout of the Graph" on page 585

"How to Modify Component Groupings" on page 589

"How to Configure Arrow and Node Labels" on page 593

"How to Print the Component Topology Graphs" on 
page 598

See also ➤ "Component Topology Overview" on page 574

➤ "Static Mode Versus Dynamic Mode" on page 576

➤ "A Closer Look at the Graph" on page 577

UI Elements Description

Print the current Component Topology. See "How to 
Print the Component Topology Graphs" on page 598 for 
details.

Enable selection mode, which allows you to drag a node.

Enable interactive zoom mode. The cursor changes to the 
interactive zoom cursor. Click in the view area and drag 
the cursor to the top or left to decrease the zoom level or 
drag to the bottom or right to increase the zoom level. 
Click the selection mode button to return to selection 
mode.
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Enable selective zoom mode. The cursor changes to the 
selective zoom cursor. Click on the view area and then 
drag the cursor to select an area to zoom. The zoom level 
is adjusted o that the selected area fills the view area. 
Click the selection mode button to return to selection 
mode.

Automatically adjust the zoom level so that the entire 
graph appears in the view window.

<zoom > drop-down Select a zoom percentage or enter a custom zoom 
percentage to adjust the zoom level of the Component 
Topology graph.

Display Statistics 
Data from: <date and 
time> to: <date and 
time>

The time period on which the graph is based. 

Edge & Node menu See "Edge and Node Menu" on page 608

Grouping menu Menu options to define component groupings for the 
Component Topology graph. See "How to Modify 
Component Groupings" on page 589 for descriptions of 
each menu item.

Layout menu See "Layout Menu" on page 608.

Run Click to refresh a view with information about 
transactions that have completed since the graph was 
opened.

Save Settings Click to save changes and make the current settings the 
default settings for your user ID.

UI Elements Description
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Set Time to: Select one of the following predefined time periods:

➤ Today

➤ Yesterday

➤ Past Week

➤ This Month

➤ Last 48 hours of data

➤ Custom. Choose a time period. The time period must 
be greater than or equal to the current statistics cache 
time slice setting. See "Configuring the Caches" on 
page 75.

The date and time fields are automatically populated 
with the corresponding information. 

Show all statistics Check to use all events and click Run to view all statistics. 
Clear if you want to view a pre-defined or custom time 
period.

Zoom menu Menu options to adjust the zoom level of the 
Component Analysis Topology graph. By default, the 
Component Topology graph is sized to fit in the view 
window. See "Tasks" on page 584 for descriptions of each 
menu item.

UI Elements Description
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Edge and Node Menu

Layout Menu

UI Elements Description

Edge Widths See "How to Configure Arrow and Node Labels" on 
page 593.

Edge Color Coding

Error/Warning/
Success Count

Min/Avg/Max 
Latency Times

Edge Label

Show Byte Counts

EJB Methods

JDBC Statistics

Node Label

UI Elements Description

Hierarchical Style Components are arranged in a hierarchical organization 
based on the flow of messages through your system.

Symmetrical Style Components are distributed evenly to minimize edge 
crossings. 
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Layout Properties Layout Properties appear on the following tabs:

"Layout Properties Dialog, General Properties Tab" on 
page 610

"Layout Properties Dialog, Disconnected Tab" on 
page 610

"Layout Properties Dialog, Hierarchical Tab" on page 611

"Layout Properties Dialog, Symmetric Tab" on page 613

Set Background 
Color

There are three ways to select a background color:

➤ On the Swatches page, click the desired color. The 
preview area shows what your choice looks like.

➤ On the HSB page, click the desired color in the color 
area. Use the sliding bar to adjust the hue, saturation, 
and brightness levels individually.

➤ On the RGB page, enter specific values for red, green, 
and blue, or click the desired value on the scale.

Click OK to make your changes active, Cancel to close 
the dialog without activating your changes, or Reset to 
reset the background color to the default.

UI Elements Description
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Layout Properties Dialog, General Properties Tab

Layout Properties Dialog, Disconnected Tab

UI Elements Description

Spacing Adjust the spacing between objects of a graph. 

Constant Spacing. Specify the minimum amount of 
white space between adjacent rows and columns.

Proportional Spacing. Specify a factional value. The 
margin around disconnected objects is calculated as the 
product of this fractional value and half the height of the 
node.

Graph Margin Spacing. This group of fields affects the 
margins for graphs. Separate frame values are stored for 
the Constant Spacing and Proportional Spacing models, 
but only one spacing model is in effect at any given time.

Labeling Customize the automatic positioning of arrow labels.

Incremental Layout. Maintains the relative positioning of 
labels from a graph's previous layout whenever the graph 
is modified. Incremental Layout results in graphs that 
maintain the same overall form when changes are made.

UI Elements Description

Components Modify disconnected component properties.

These options only have effect if more than one 
disconnected object exists within the graph.

Disconnected Nodes Modify disconnected node properties.

These options only have effect if more than one 
disconnected object exists within the graph.
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Layout Properties Dialog, Hierarchical Tab

UI Elements Description

Orientation Left To Right. Positions components so that the roots of 
the graph are near the left of the viewing area, and the 
leaves of the graph are near the right. The levels are 
vertical.

Top To Bottom. Positions components so that the roots 
of the graph are near the top of the viewing area, and the 
leaves of the graph are near the bottom. The levels are 
horizontal.

Right To Left. Positions components so that the roots of 
the graph are near the right of the viewing area, and the 
leaves of the graph are near the left. The levels are 
vertical.

Bottom To Top. Positions components so that the roots 
of the graph are near the bottom of the viewing area, and 
the leaves of the graph are near the top. The levels are 
horizontal.

Default value: Left to Right.

Level Alignment Changes the alignment of components on the same 
level. It is similar to text alignment within a paragraph. 

If Orientation is horizontal (Top To Bottom or Bottom To 
Top), you can set the Level Alignment as either Top, 
Center or Bottom. If Orientation is vertical (Left To Right 
or Right To Left), you can set the Level Alignment as 
either Left, Center or Right.
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Spacing Adjusts spacing between levels of components and 
between component within the same level in a graph by 
adjusting the frames that surround them. 

Variable Level Spacing. When enabled, variable level 
spacing considers the density of arrows between adjacent 
levels when adjusting the level spacing. For example, if 
too many arrows cross at the same point between levels, 
then the level spacing is automatically increased. 
Consequently, not all levels would have the same 
spacing. Variable level spacing is usually used in 
combination with orthogonal arrow routing.

Proportional Spacing. Sets the spacing around each node 
to a fractional value (between 0 and 1) based on the node 
size.

Constant Spacing. Allows the spacing around each node 
to be a constant value, independent of the size of the 
node.

Between Levels. Allows you to set the spacing between 
each level in the graph. In left-to-right and right-to-left 
views, levels run vertically. In top-to-bottom and 
bottom-to-top views, levels run horizontally.

Between Nodes. Allows you to set the spacing between 
adjacent components within a level.

Edge Routing The following options allow you to tailor arrow routing: 

Orthogonal Routing. Each arrow is drawn as a sequence 
of line segments that run parallel to the x- and y-axes. 
arrows have bend points of 90 degrees only. The 
orthogonal routing style works best in combination with 
variable level spacing and ports.

Straight Edges. Merges the incoming arrows of a node 
into a single fork-like structure. Clearer drawings result 
provided the graph is not too dense. This feature is only 
available when orthogonal routing is enabled.

UI Elements Description
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Layout Properties Dialog, Symmetric Tab

Resource Icons
Resource icons represent system components. Depending on your system, 
the following resource icons can appear in the Component Topology:

 

UI Elements Description

Spring Options These controls allows you to set the options relating to 
the spring model of the graph. 

Node Spacing. This value is used in determining the 
white space between components. It specifies the length 
of each arrow as a function of the width and height of 
the components to which the arrow connects. A node 
spacing of zero specifies that arrow lengths be just long 
enough to keep components from touching — there is no 
white space between components. The larger the node 
spacing value, the greater the amount of white space 
between components.

Random Seed. The initial layout of the graph is keyed to 
a random number sequence. The value set in this field is 
used to generate the random number sequence to set 
initial coordinates for each components. Each different 
non-negative value can produce a different layout. This 
field is active when Incremental Layout is not checked.

Icon Resource Description

CICS transaction. Note that TransactionVision automatically filters out 
all CICS transactions that begin with “C” because they are internal CICS 
transactions. One exception is CKBP, which denotes a WebSphere 
MQ-CICS bridge transaction. All CICS DPL programs invoked through 
MQ-CICS bridge have this transaction name.

CICS file
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CICS Transient Data (TD) queue

CICS indirect TD queue. Similar to a TD queue, the indirect TD queue is 
an alias to other TD queues.

CICS temporary storage (TS) queue. Used for temporarily passing data, 
users can create and destroy TS queues on the fly.

EJB session bean

EJB entity bean

EJB message-driven bean

Internet

JMS queue

JMS topic

Java server page

Icon Resource Description
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Java servlet

Program

Process object

Proxy object. Proxy objects involve applications that are not monitored 
by a TransactionVision agent. See tthe HP TransactionVision Deployment 
Guide PDF for information about the proxy agent and proxy objects.

SQL queue. Represents access and execution of an SQL statement.

A user defined system resource object that participates in one or more 
user events included by the query. All user defined objects share the 
same icon with the label “Resource.” For information about 
implementing user events, see the the HP TransactionVision Advanced 
Customization Guide PDF.

Web application

WebSphere web application server

WebSphere MQ cluster node relating multiple queue instances in a 
clustering environment

Icon Resource Description
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WebSphere MQ distribution list

WebSphere MQ message queue

WebSphere MQ remote queue

WebSphere MQ alias queue

WebSphere MQ dead letter queue

WebSphere MQ namelist

WebSphere MQ queue manager

WebSphere MQ local queue

Icon Resource Description
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Troubleshooting and Limitations

If an empty graph appears when you view the Component Topology in 
dynamic mode, it is likely due to the associated query returning an 
extremely large number of events. The status window may contain a 
message with more information.

Modify the query or time period so that fewer events are selected and re-run 
the Component Topology. 

WebSphere MQ model queue

WebSphere MQ IMS Bridge node. If you do not have a custom bean to 
add queue and queue manager information for IMS Bridge events, an 
“unknown queue” node is shown for each IMS Bridge node associated 
with the MQIMS_BRIDGE_ENTRY event. For more information about 
the TransactionVision IMS Bridge Agent, see the HP TransactionVision 
Deployment Guide PDF.

Icon Resource Description
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